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Humerus Length

To measure humerus length, make one distance measurement:

1. Select HL; an active caliper displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points.

5. To complete the measurement, press Set.

The system displays the humerus length in the Results 
Window.

Nuchal Translucency (NT)

To measure nuchal translucency, make one distance 
measurement:

1. Select NT; an active caliper displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points.

5. To complete the measurement, press Set.

The system displays the nuchal translucency in the Results 
Window.

NOTE: Nuchal Translucency is not available through the factory default. 
To enable Nuchal Translucency, add NT to the measurement 
folder in Utility -> Measure -> M&A -> Add measurement 
(Insert).
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Occipitofrontal Diameter

To measure occipitofrontal diameter, make one distance 
measurement:

1. Select OFD; an active caliper displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points.

5. To complete the measurement, press Set.

The system displays the occipitofrontal diameter in the 
Results Window.

% Stenosis 

In B-Mode, you can calculate % Stenosis by diameter or by 
area. See �% Stenosis� on page 7-69 for more information.
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Spinal Length (SL)

To measure spinal length, make one distance measurement:

1. Select SL; an active caliper displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points.

5. To complete the measurement, press Set.

The system displays the spinal length in the Results 
Window.

US
A
Eu
ro
pe

To
ky
o

Os
ak
a

AS
UM



OB Measurements and Calculations

Versana Active � Basic User Manual 9-35
Direction 5840764-100 English Rev. 10

Transverse Abdominal Diameter

To measure transverse abdominal diameter, make one distance 
measurement:

1. Select TAD; an active caliper displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points.

5. To complete the measurement, press Set.

The system displays the transverse abdominal diameter in 
the Results Window.

Transverse Cerebellar Diameter

To measure transverse cerebellar diameter, make one distance 
measurement:

1. Select TCD; an active caliper displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points.

5. To complete the measurement, press Set.

The system displays the transverse cerebellar diameter in 
the Results Window.
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Thorax Transverse Diameter

To measure thorax transverse diameter, make one distance 
measurement:

1. Select ThD; an active caliper displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points.

5. To complete the measurement, press Set.

The system displays the thorax transverse diameter in the 
Results Window.
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Tibia Length

To measure tibia length, make one distance measurement:

1. Select Tibia; an active caliper displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points.

5. To complete the measurement, press Set.

The system displays the tibia length in the Results Window.

Ulna Length

To measure ulna length, make one distance measurement:

1. Select Ulna; an active caliper displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points.

5. To complete the measurement, press Set.

The system displays the ulna length in the Results Window.

Volume

See �Volume� on page 7-71 for more information.
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M-Mode Measurements

In M-Mode you can measure % stenosis, A/B ratio, and heart 
rate.

% Stenosis 

In M-Mode, you measure % Stenosis by diameter. See �% 
Stenosis� on page 7-77 for more information.

A/B Ratio

In M-Mode you can measure A/B ratio by diameter, time, or 
velocity. See �A/B Ratio� on page 7-78 for more information.

Heart Rate

See �Heart Rate� on page 7-79 for more information.
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Doppler Mode Measurements

You can use Doppler mode to study fetal blood flow in the heart, 
umbilical cord, placenta, and middle cerebral arteries. OB/GYN 
Doppler mode also allows you to study uterine and ovarian 
blood flow. 

The OB/GYN vessel study includes the following vessels:

� Aorta (Ao)

� Umbilical

� Placenta

� Desc. Aorta

� Uterine (right and left)

� Middle Cerebral Artery (MCA) (right and left)

� Ovarian (right and left)

Figure 9-2. OB/GYN Vessels
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Doppler Mode Measurements  (continued)

For each of these studies, you can make any of the following 
measurements. See �Doppler Mode Measurements� on 
page 7-80 for more information.:

� Peak Systole (PS)

� End Diastole (ED)

� Minimum Diastole (MD)

� Heart Rate

� TAMAX

� Pulsatility Index (PI)

� Resistive Index (RI)

� PS/ED Ratio

� ED/PS Ratio

� Acceleration

� AT

� TAMEAN

� Volume Flow

� PV

 Figure 9-3. OB/GYN Vessal Menu
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To select OB/GYN vessel measurements

OB/GYN Vessel measurements use the auto sequence feature. 
With this feature, when you select a folder for the vessel you 
want to measure, the system automatically starts the first 
measurement. It then continues with each of the other 
measurements in that study.

1. Select the folder for the vessel you want to measure.

The system shows all the measurements for that vessel. 
The caliper for the first measurement is automatically 
displayed.

2. Make the measurement.

After you complete each measurement, the system starts 
the next measurement. After the last measurement is 
complete, the system returns to the OB/GYN Vessel.

Your system is set up to show the measurements that you 
usually make for each vessel. To make a measurement that is 
not shown for the selected vessel:

1. Select the folder for the vessel you want to measure.

2. Select Show All.

The system display all possible vessel measurements.

3. Select the desired measurement.
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OB Report

The OB Report lists patient information, and all measurement 
and calculation data.

To view the OB Report:

1. Press the Report key on the control panel. 

The report appears as follows. 

 Figure 9-4. OB Report

The OB Report has four sections of information:

1. Patient data

2. Measurement information

3. Calculation information

4. Report menu list
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Patient data

The Patient data section, at the top of the report, lists 
information from the Patient Data Entry screen. 

You can select the following fields:

� FetusNo � if this is a multi-gestational patient, you can 
select the fetus in this field. You can also adjust the Fetus 
selection to change the fetus.

� CUA/AUA � select the ultrasound age calculation method

� Composite Ultrasound Age (CUA) � regression 
calculation

� Average Ultrasound Age (AUA) � an arithmetic average

You can select the method in this field, or adjust the Select 
CUA/AUA control.

NOTE: CUA/AUA is only available when you select USA OB Type in 
Utility -> System -> System Measure menu.

You can enter information in the following fields:

� FetusPos � type information about the fetus position.

� PLAC � type information about the placenta.
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Measurement information

This section lists the results of all measurements. 

� CUA or AUA � If this field is checked, the system uses the 
measurement to calculate the ultrasound age. 

� Value � The measured value. If more than one 
measurement was made for an item, the system uses the 
specified method (average, maximum, minimum, or last) to 
determine this value.

� m1�m3 � Up to three measurement values for each item. If 
you make more than three measurements, the report uses 
the last three.

� Method � When there is more than one measurement for an 
item, this specifies the method used to calculate the 
measurement value listed in the Value column. Choices are 
average, maximum, minimum, last, or off. To change the 
method: 

a. Move the Trackball to the Method field. 

b. Press Set.

c. Move the Trackball to select from the list.

d. Press Set.

� AGE � The fetal age for this measurement.

� Range � The typical range of fetal age for this 
measurement.
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Calculation information

This section of the report provides calculation choices and lists 
calculation results.

� EFW � lists the parameters used to calculate EFW. This is 
followed by the calculation result. 

To change which parameters are used:

a. Select this field or press Select EFW.

b. Select the desired parameters.

� EFW GP � lists the source used to calculate EFW�GP 
(growth percentile). This is followed by the growth 
percentile.

To change the source:

a. Select this field or press Select GP.

b. Select the desired source.

The remaining calculation information shows ratios for several 
measurements, and the Cephalic Index (CI). 

The report shows if any of the ratios are out of range (OOR). Out 
of range indicates one of the following:

� The measurement is out of the normal range based on the 
gestational age that is calculated from the LMP. The system 
determines OOR from the ultrasound age compared to the 
gestational age. The gestational age is calculated from the 
last menstrual period or the estimated delivery date.

� The measurement is outside of the range for the data used 
in the calculation. That means that the measurement is 
either less than or more than the range of measurements 
used to determine fetal age based on the measurement.

For more information about how to use the report, see �Viewing 
and Editing Worksheets� on page 7-61 for more information.
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Report Menu list

Use following report menu list to switch between different 
summary reports.

 Figure 9-5. Report menu list
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Anatomical Survey

Overview

The Anatomy page provides a checklist of the Fetus.

 Figure 9-6. Anatomical Survey
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Editing

� To activate the Anatomical Survey, select Anatomy on the 
OB Report screen.

� Fill the required field.

Select Exit to return to the Scan screen.

NOTE: The patient specific contents input on the Anatomical Survey 
page are returned to the factory default settings after starting a 
new patient. 

Table 9-2:  Anatomical Survey

Field Description

Fetus Pos Indicate the fetal position within the uterus.

PLAC Identify the location of the placenta.

Normal Select to set all the values in the checklist to �Normal�.

Abnormal Select to set all the values in the checklist to �Abnormal�.

Scanned Select to set all the values in the checklist to �Scanned�.

Clear Select to clear all the values in the checklist.
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OB Graphs

Overview

OB Graphs allow you to assess fetal growth compared to a 
normal growth curve. When a patient has completed two or 
more ultrasound exams, you can also use the graphs to look at 
fetal trending. For multi-gestational patients you can plot all 
fetuses and compare the growth on the graphs. 

The Versana Active provides the following two basic types of 
graphs:

� Fetal Growth Curve graphs � show one measurement per 
graph. These graphs show the normal growth curve, 
positive and negative standard deviations or applicable 
percentiles, and ultrasound age of the fetus using the 
current measurement. For multi-gestational pregnancies, 
you can view all fetuses. If previous exam data is available, 
the graph can show fetal trending.

� Fetal Growth Bar graph � shows the ultrasound age and 
the gestational age based on patient data. Plots all 
measurements on one graph. 
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To View OB Graphs

To view OB graphs:

1. Press Report key on the control panel.

2. Select Graph in the report menu list. 

Fetal Growth Curve Graph

 Figure 9-7. Fetal Growth Curve Graph

The horizontal axis shows the fetal age in weeks. The system 
determines this age from the data on the Patient Data Entry 
screen. The vertical axis shows one of the following:

� For measurements, mm or cm

� For ratios, percent

� For fetal weight, grams
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Fetal Growth Curve Graph  (continued)

The Fetal Growth Curve Graph shows the following information 
for the selected measurement:

� The normal growth curve

� The standard deviations or relevant percentiles

� The gestational age of the fetus, using patient data (vertical 
dotted line)

� Using the current ultrasound measurement data, where the 
fetus is on the growth curve 

The legend at the bottom of the graph shows the symbols and 
colors that indicate data for fetal trending (Past and Present) 
and multiple gestation (Fetus).

To select the measurement

To select which measurement you want to display on the Fetal 
Growth Curve Graph, do one of the following:

� To select a specific measurement:

a. On the graph display, move the Trackball to the 
Measurement Type field and press Set. 

The system displays a list of measurements.

b. Move the Trackball to select the desired measurement 
and press Set.

The system displays the Fetal Growth Curve Graph for 
the selected measurement.

� To scroll through all Fetal Growth Curve Graphs, adjust the 
Fetus control on the second menu.
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Fetal Growth Curve Graph  (continued)

To select the age to use

To plot the fetus age, the system allows you to use the 
gestational age (GA) from the LMP, or to use the composite 
ultrasound age (CUA). To select, adjust the Select GA control. 
The information in the left column changes between CUA and 
GA(EDD), and the data may change. 

To view a single or four graphs

You can view either a single Fetal Growth Curve Graph or you 
can view four graphs at the same time. To select each view, 
press Single or Quad. 

Figure 9-8. Fetal Growth Curve Graph: Quad View

The measurement values are displayed at the bottom of the 
graph. 
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Fetal Growth Curve Graph  (continued)

To change measurements in quad view 

When you view four graphs simultaneously, you can select 
which four you want to see. To change each graph in quad view:

1. On the graph display, use the Trackball to move the cursor 
to the small box that is upper left of each graph, then press 
Set.

The system displays a list of measurements.

2. Move the Trackball to select the desired measurement and 
press Set.

The system displays the Fetal Growth Curve Graph for the 
selected measurement.

To scroll through all Fetal Growth Curve Graphs, adjust the 
Graph Change control. 

3. Select Save button to save the current quad view.

Figure 9-9. Select Save Button
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Fetal Trending 

When you have ultrasound data for more than one exam for a 
patient, you can use the data to look at fetal trending on the 
Fetal Growth Curve Graphs.

1. Select Graph and select the desired Fetal Growth Curve 
Graph.

2. Select Plot Both. 

The system automatically finds the data from previous 
ultrasound exams, and displays it on the graph with the 
present data.

The legend at the bottom of the graph shows the symbols and 
colors that indicate Past and Present data.
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To edit patient data

When you are working with graphs, you can change or enter the 
following patient data.

� GA(LMP) � this field is computed using the LMP date on the 
Patient Data Entry screen. To change this field:

NOTE: You can only change this field on the Fetal Growth Curve 
Graph in single view.

a. Move the Trackball to the field, which is left of the 
graph. To select the field, press Set.

The system displays a window with the GA weeks and 
days.

b. To select each field, move the Trackball to move to the 
field and press Set.

c. Type the correct weeks or days.

d. Select OK.

The system makes the following changes:

� GA (LMP) is now GA (GA) and shows the age you 
entered.

� In the Patient Data section, the GA changes.

� In the Patient Data section, The EDD (LMP) changes to 
EDD(GA) and shows an updated date, using the GA 
you entered.

The LMP is erased.

� FetusPos � type information about the fetus position.

� PLAC � type information about the placenta.

To return from a graph to the scan display

After viewing graphs, to return to the scan display, do one of the 
following:

� On the graph display, select Exit.

� Press Freeze/Report on the control panel.
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Fetal Growth Bar Graph

The fetal growth bar graph shows current exam measurements 
and the normal growth range based on the gestational age. It 
shows all measurements on one graph.

To view the Fetal Growth Bar Graph: 

1. Press Report.

2. Select Graph.

3. Select Bar.

 Figure 9-10. Fetal Growth Bar Graph

� The horizontal axis shows the gestational weeks. 

� The red vertical line shows the gestational age using the 
patient data. 

� The blue dotted vertical line shows the ultrasound age using 
the current measurements. 

� The yellow x shows the ultrasound age for each 
measurement.

� The green rectangle shows the normal age range for the 
measurement.

You cannot do fetal trending or view multiple gestation data on 
the bar graph.
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OB-Multigestational

Multiple Fetus

Versana Active allows you to measure and report multiple fetus 
development. The system can report a maximum of four 
fetuses.

To enter the number of fetuses 

If more than one fetus is imaged during the exam, select the 
number of fetuses in the Patient Data Entry Menu.

 Figure 9-11. Fetus Number

When you start an OB exam, the system automatically fills in the 
Fetus # field with 1. To change the number:

1. Move the cursor to the fetus number and press Set.

The number is highlighted.

2. Select the correct number and press Set.

The system displays a message to confirm that you want to 
change the fetus number.

3. Select Yes.
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To identify each fetus

For measurements, calculations, and report displays, the 
system labels each fetus A, B, C, or D. Each fetus is identified 
by a letter and the total number of fetuses. For example, fetus A/
4 is fetus A from a total of 4.

When scanning, you can enter information about the fetus 
position and placenta location. You can enter the information in 
the Patient Data section of the reports and the graphs. You can 
type up to 20 characters in the FetusPos field and 16 characters 
in the PLAC fields. 

 Figure 9-12. Patient Data section of the OB Report
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To select a fetus

During measurements and calculations, to change between 
fetuses, do one of the following: 

� Adjust the Fetus selection.

� Move the Trackball to move to the Summary Window and 
select the fetus.

Figure 9-13. Summary Window: Multiple fetus

 You can change between fetuses at any time during the exam.

NOTE: After you change to the next fetus, any measurements you 
make are recorded and reported to that fetus. If you have any 
active measurement or calculation that is not completed when 
you change the fetus, the system cancels the measurement or 
calculation.
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To view multiple fetuses data on graphs

You can view multiple gestation data on fetal growth curve 
graphs. After you have made measurements for each fetus, 
select Graph. 

1. To view the graph for each fetus, do one of the following:

� Adjust the Fetus selection.

� In the Patient Data section, move the Trackball to 
highlight the FetusNo field. In the list of fetuses, move 
the Trackball to select the fetus you want, and press 
Set.

2. To display data for multiple fetuses on the same graph, 
select Fetus All.

The legend at the bottom of the graph shows the symbols and 
colors that represent each fetus.
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To compare multiple fetus data on a worksheet

With multiple fetuses, you can list and compare measurements 
of the fetuses on the report. 

Select Report, then select Fetus Compare. 

 Figure 9-14. OB Worksheet Display
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To compare multiple fetus data on a worksheet  (continued)

When you select Fetus Compare, the system lists the 
measurement results for each fetus on the worksheet.

 Figure 9-15. Worksheet Display with Fetus Compare
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OB Table Editor

Overview

You can add user programmable OB tables to the system.

OB Table Settings Menu

You add OB Tables in the Measurement & Analysis menu. To 
open the menu:

1. Enter Utility -> Measure, then select M&A.

2. Check the Exam Category. Make sure that Obstetrics is 
selected.

If it is not selected, select Obstetrics and continue selecting 
the folders until the appropriate area is selected as to where 
this new OB Table will be entered. For example, select 
Obstetrics, then select OB-2/3. If there are further folders 
within OB-2/3, select that appropriate folder.
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OB Table Settings Menu  (continued)

3. On the monitor display, select the OB Table tab.

The system displays the OB Table settings menu. 

 Figure 9-16. OB Table settings
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OB Table Settings Menu  (continued)

4. The OB Table settings menu lists OB Table parameters. 
Specify the following parameter values as appropriate:

� Study: Shows the study to which this measurement 
table belongs.

� New/Edit: To create a new OB table, select New Table. 
To edit an existing user-programmable OB table, select 
Edit Table.

NOTE: You cannot edit the system�s OB Tables.

� OB Table Template: To create a new OB table, select 
the Template (1 - 7) which you want to use as the basis 
of the user programmable OB Table. See �OB Table 
Templates� on page 9-66 for more information.

To edit an existing user OB table, select the desired OB 
table to edit.

� Tool Type: Select the type of measurement: Distance or 
Circumference.

� Measure Name: Type the name of measurement that 
will display on the menu.

� Author Name: Type the author�s name.

� Table Type: If necessary, select the Table Type: Fetal 
Age or Fetal Growth.

� Measure Type: Select a measurement type that can be 
used to calculate EFW, for example BPD. 

NOTE: Measure Type is used only when calculating EFW.

NOTE: The following items are display only: Table Format, Table 
Unit, SD/GP Range, and Graph Range. The system 
determines these values automatically, based on the type of 
OB table you are creating.

5. After specifying all parameter values, move the Trackball to 
Edit Table and press Set.

The system displays the Edit Menu.

NOTE: If any of the OB table parameters are not correct, the Edit 
Menu is not displayed.
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OB Table Templates

Tool Type:

� Distance: 2D Caliper

� Circumference: 2D Ellipse, 2D Trace, 2D Caliper

Template 1

Table 9-3:  Template 1 (based on Hadlock)

Template 1: SD Range Table

Fetal Age Table Table Format MEAS MEAN SD

Table Unit mm Week Week

Table Range 1SD

Graph Range 1SD

Measurement Result Value [cm]

GA [#w#d]

Min [#w#d]

Max [#w#d]

Fetal Growth Table Table Format AGE MEAN SD

Table Unit Week mm Week

Others are same as above
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Template 2

Table 9-4:  Template 2 (based on Tokyo)

Template 2: SD Range Table

Fetal Age Table Table Format MEAS MEAN SD

Table Unit mm Day Day

Table Range 1SD

Graph Range 1SD

Measurement Result Value [cm]

GA [#w#d]

SD: day(+/-)

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MEAN SD

Table Unit Day mm Day

Others are same as above
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Template 3

Table 9-5:  Template 3 (based on Osaka)

Template 3: SD Table

Fetal Age Table Table Format MEAS MEAN SD

Table Unit mm Day mm

Table Range 1SD

Graph Range 1SD

Measurement Result Value [cm]

GA [#w#d]

SD: sd=(mv-pv)/sd

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MEAN SD

Table Unit Day mm mm

Others are same as above
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Template 4

Table 9-6:  Template 4 (based on several European tables)

Template 4: 5%-95% Table

Fetal Age Table Table Format MEAS MIN MEAN MAX

Table Unit mm WeekDay WeekDay WeekDay

Table Range 5%:95%

Graph Range 5%:95%

Measurement Result Value [cm]

GA [#w#d]

GP [%]

GP is calculated by Fetal Growth Table. If you did not edit 
Growth Table, GP is not calculated by the system,

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MIN MEAN MAX

Table Unit WeekDay mm mm mm

Table Range 5%:95%

Graph Range 5%:95%
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Template 5

Table 9-7:  Template 5 (based on several European tables)

Template 5: 5% - 95% Table

Fetal Age Table Table Format MEAS MEAN SD

Table Unit mm WeekDay mm

Table Range 1SD

Graph Range 5%:95%

Measurement Result Value [cm]

GA [#w#d]

GP [%]

GP is calculated by Fetal Growth Table. If you did not edit Growth Table, 
GP is not calculated by the system,

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MEAN SD

Table Unit WeekDay mm mm

Table Range 1SD

Graph Range 5%:95%
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Template 6

Table 9-8:  Template 6 (based on several European tables)

Template 6: 10% - 90% Table

Fetal Age Table Table Format MEAS MIN MEAN MAX

Table Unit mm WeekDay WeekDay WeekDay

Table Range 10%-90%

Graph Range 10%-90%

Measurement Result Value [cm]

GA [#w#d]

GP [%]
GP is calculated by Fetal Growth Table. If you did not edit Growth Table, GP is 
not calculated by the system,

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MIN MEAN MAX

Table Unit WeekDay mm mm mm

Table Range 10%-90%

Graph Range 10%-90%
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Template 7

Table 9-9:  Template 7 (Based on several European tables)

Template 7: 10% - 90% Table

Fetal Age Table Table Format MEAS MEAN SD

Table Unit mm WeekDay mm

Table Range 1SD

Graph Range 10%:90%

Measurement Result Value [cm]

GA [#w#d]

GP [%]

GP is calculated by Fetal Growth Table. If you did not edit Growth Table, 
GP is not calculated by the system,

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MEAN SD

Table Unit WeekDay mm mm

Table Range 1SD

Graph Range 10%:90%
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OB Table Edit Menu

The data you enter in the OB Table Edit Menu depends on 
whether the table type is Fetal Age or Fetal Growth.

Fetal Age Table

If you are creating or editing a Fetal Age table, the OB Table Edit 
Menu is as follows:

 Figure 9-17. OB Table Edit Menu: Fetal Age Table
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Complete the field

1. Input value to Min, Max and Interval of the Parameters field. 

The system automatically fills in the MEAS column.

Input value to the columns of MEAN and SD.

NOTE: To move between the fields in the table, use the up, down, 
left, and right arrow keys.

NOTE: You must enter a minimum of two rows of data. Any lines 
with a blank cell are not saved. 

To save the Table Data, move the Trackball to Exit to Save 
and press Set. If you want cancel this table, move the 
Trackball to move to Cancel and press Set.
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Fetal Growth Table

If you are creating or editing a Fetal Growth table, the OB Table 
Edit Menu is as follows:

 Figure 9-18. OB Table Edit Menu: Fetal Growth Table 

Complete the field

1. Input value to the required columns.

NOTE: To move between the fields in the table, use the up, down, 
left, and right arrow keys.

NOTE: You must enter a minimum of two rows of data. Any lines 
with a blank cell are not saved. 

2. To save the Table Data, move the Trackball to Exit to Save 
and press Set. If you want to cancel this table, move the 
Trackball to Cancel and press Set.

After you complete the OB table, it is now available for the 
selected study. To use the measurement, you must assign it to a 
menu.   See �Measurement and Calculation Setup� on page 7-13 
for more information.
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EFW for OB User Table/Formula Editor

EFW Table Editor

You can edit an EFW Formula at the OB Table Editor. 

1. Select Utility -> Measure -> OB Table.

2. Select the appropriate parameters and press Edit Table.

a. New/Edit: Select �New Table�

b. OB Table Template: Select appropriate template.

c. Tool Type: Select �Weight�

d. Measure Name: Enter measurement name.

e. Author Name: Enter author�s name.

f. Table Type: Select �Fetal Age�

 Figure 9-19. OB Table Tab Screen
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EFW Table Editor  (continued)

3. Edit the table data and press Exit To Save.

Figure 9-20. OB Table Editor Screen
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EFW Formula Editor

Select the M&A tab and select Edit Calc. The Modify User 
CALC window displays.

Select the user table previously added from the User Defined 
pull-down menu and press OK.

Figure 9-21. Modify User CALC window

NOTE: When you edit a formula, be careful of the following points.

� If you want to calculate EFW by centimeter, add �*100� to 
the {parameter}.

� If EFW is calculated in grams, add �/1000� to the formula.

or example,

10^(1.56{AC[Hadlock]}*100+0.08*{FL[Hadlock]}*100)/1000
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GYN Measurements

Introduction

The Gynecology exam category includes the following three 
studies:

� Generic. This study is common to all exam categories. See 
�Generic Measurements� on page 7-66 for more information. 

� General Gynecology. This study includes uterine, ovarian, 
ovarian follicle, and endometrium measurements.

� OB/GYN Vessel. This study includes the following vessels: 
uterine, ovarian, umbilical, middle cerebral artery, aorta, 
placenta, and descending aorta.

NOTE: The calculation formulas are listed in the Advanced Reference 
Manual.
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To Start a Gynecology Exam

To begin a gynecology exam, you enter patient data or, if the 
patient data from a previous exam is saved in the system, find 
the patient information. 

For details about how to start an exam, See �To Start an 
Obstetrics Exam� on page 9-4 for more information.

After you complete the patient information, you can begin the 
scan. 

1. To change from the Patient screen to the Scan screen, do 
one of the following:

� On the keyboard, press Esc.

� Select Scan.

� On the Control Panel, select Freeze.

� On the Control Panel, press the B-Mode key.

The system displays the Scan screen.

2. To choose the appropriate probe, select the probe on the 
Probe page.

3. On the Control Panel, press Measure.

The default Gynecology study is displayed on the menu. 
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B-Mode Measurements

In B-Mode, you make the measurements in the General 
Gynecology study. These measurements include: 

� Uterine length, width, and height 

� Ovarian length, width, and height

� Ovarian follicle

� Cervix

� Endometrium thickness

Figure 9-22. General Gynecology study
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Follicle measurements

You can make left and right ovary follicle measurements from 
one, two, or three distances. 

One distance

1. To select the left or right, adjust the Side selection.

2. Select Follicle; an active caliper displays.

3. To position the active caliper at the start point, move the 
Trackball.

4. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

5. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points.

6. To complete the measurement, press Set.

7. Press Clear.

The system displays the ovary follicle measurement in the 
Results Window.
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Follicle measurements  (continued)

Two distances

1. To select the left or right, adjust the Side selection.

2. Select Follicle; an active caliper displays.

3. Make the first distance measurement:

a. To position the active caliper at the start point, move the 
Trackball.

b. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

c. To position the second active caliper at the end point, 
move the Trackball.

A dotted line connects the measurement points.

d. To complete the measurement, press Set.

The system displays the distance value in the Results 
Window and displays an active caliper.

4. To make the second distance measurement, repeat steps 
a�d above.

5. Press Clear.

The system displays the ovary follicle measurement in the 
Results Window.
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Follicle measurements  (continued)

Three distances

1. To select the left or right, adjust the Side selection.

2. Select Follicle; an active caliper displays.

3. Make the first distance measurement:

a. To position the active caliper at the start point, move the 
Trackball.

b. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

c. To position the second active caliper at the end point, 
move the Trackball.

A dotted line connects the measurement points.

d. To complete the measurement, press Set.

The system displays the distance value in the Results 
Window. After the first and second distance 
measurement, the system displays an active caliper.

4. To make the second and third distance measurement, 
repeat steps a�d above.

After the third measurement, the system displays the ovary 
follicle measurement in the Results Window.



GYN Measurements

Versana Active � Basic User Manual 9-85
Direction 5840764-100 English Rev. 10

Endometrium thickness

To measure the endometrium thickness, make one distance 
measurement.

1. Select Endometrium; an active caliper displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points.

5. To complete the measurement, press Set.

The system displays the endometrium thickness in the 
Results Window.
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Ovary length, width, and height 

You can measure the length, width, and height of the left and 
right ovaries. Each measurement is a typical distance 
measurement made in the appropriate scan plane. 

Typically, length and height are measured on the sagittal plane 
while the width is measured on the axial/transverse plane.

To measure ovarian length, width, or height:

1. Scan the patient's right or left ovary in the appropriate plane.

2. To select left or right, adjust the Side selection.

3. Select the OV folder, then select OV L, OV W, or OV H. 

4. Perform a standard distance measurement: 

a. To position the active caliper at the start point, move the 
Trackball.

b. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper, if preset accordingly.

c. To position the second active caliper at the end point, 
move the Trackball.

A dotted line connects the measurement points.

d. To complete the measurement, press Set.

The system displays the distance value in the Results 
Window. After the first and second measurement, the 
system displays an active caliper for the next 
measurement.

5. To make the second and third distance measurements, 
repeat steps 3�4. 

After you complete the length, width, and height 
measurements, the system displays the ovarian volume in 
the Results Window.
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Uterus length, width, and height

Each of these is a standard distance measurement. Typically, 
length and height are measured on the sagittal plane while the 
width is measured on the axial/transverse plane.

To measure uterus length, width, or height:

1. Scan the patient in the appropriate scan plane. 

2. Select the UT folder, then select UT L, UT W, or UT H. 

An active caliper displays.

3. Perform a standard distance measurement: 

a. To position the active caliper at the start point, move the 
Trackball.

b. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

c. To position the second active caliper at the end point, 
move the Trackball.

A dotted line connects the measurement points.

d. To complete the measurement, press Set.

The system displays the distance value in the Results 
Window. After the first and second measurement, the 
system displays an active caliper for the next 
measurement.

4. To make the second and third distance measurement, 
repeat steps 2�3. 

After you complete the third distance measurement, the 
system displays the uterine volume in the Results Window.
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Cervix measurements

You can make cervix measurements from one distance or spline 
trace. 

One Distance

1. Select CX; an active caliper displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points.

5. To complete the measurement, press Set.

6. The system displays the cervix measurement in the Result 
Window.

Spline Trace

1. Select CX Trace; an active caliper displays.

2. To position the caliper at the start point, move the Trackball.

3. To fix the trace start point, press Set. The first caliper turns 
yellow. The second caliper appears at the same position as 
the first caliper and is green. 

4. To position the second caliper, move the Trackball and 
press Set. The third caliper appears at the same position.

The spline trace requires at least three points to draw the 
trace. Continue setting the points of the trace until the 
desired points are set.

5. Press Set again after the last caliper is fixed to finalize the 
spline trace. All points are removed from the line and the 
spline trace turns yellow.

NOTE: Pressing Set twice finishes the trace measurement.

6. The system displays the cervix measurement in the Result 
Window.
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Chapter 10

Cardiology

Describes how to perform cardiac measurements and 
calculations.
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Cardiology Exam Preparation

Introduction

Measurements and calculations derived from ultrasound images 
are intended to supplement other clinical procedures available 
to the attending physician. The accuracy of measurements is not 
only determined by the system accuracy, but also by use of 
proper medical protocols by the user. When appropriate, be sure 
to note any protocols associated with a particular measurement 
or calculation. Formulas and databases used within the system 
software that are associated with specific investigators are so 
noted. Be sure to refer to the original article describing the 
investigator's recommended clinical procedures.

General Guidelines

New Patient information must be entered before beginning an 
exam. See �Scanning a New Patient� on page 4-10 for more 
information.

Any measurement can be repeated by selecting that 
measurement again from the menu.
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Cardiology Measurements

Overview

Cardiology measurements offer two different types of 
measurement studies, Generic and Cardiac. 

 Figure 10-1. Cardiac Exam Calc

� Generic � Each exam category has a Generic study. The 
Generic studies provide you quick access to measurements.

� Cardiac � This study includes all cardiac measurements. 



Cardiology

10-4 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10

Naming Format for Cardiac Measurements

When you make a measurement, you select the abbreviation for 
the measurement on the menu. Most abbreviations are made 
using acronyms. The following table lists acronyms used for 
naming cardiac measurements. 

Table 10-1:  Cardiology Abbreviations

Acronym Name

% STIVS % Interventricular Shortening

A Area

Acc Acceleration

AccT Flow Acceleration Time

ALS Aortic Leaflet Separation

Ann Annulus

Ao Aorta

AR Aortic Regurg

Asc Ascending

ASD Atrial Septal Defect

AV Aortic Valve

AV Cusp Aortic Valve Cusp Separation

AVA Aortic Valve Area

AV-A Aortic Valve Area by Continuity Equation

BSA Body Surface Area 

CI Cardiac Index

CO Cardiac Output

d Diastolic

D Diameter

Dec Deceleration

DecT Deceleration Time

Desc Descending

Dur Duration

EdV End Diastolic Volume

EF Ejection Fraction

EPSS E-Point-to-Septum Separation
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EsV End Systolic Volume 

ET Ejection Time

FS Fractional Shortening

FV Flow Volume

FVI Flow Velocity Integral

HR Heart Rate

IVRT IsoVolumetric Relaxation Time

IVS Interventricular Septum

L Length

LA Left Atrium

LAA Left Atrium Area

LAD Left Atrium Diameter

LPA Left Pulmonary Artery

LV Left Ventricle

LVA Left Ventricular Area

LVID Left Ventricle Internal Diameter

LVL Left Ventricle Length

LVM Left Ventricular Mass

LVPW Left Ventricle Posterior Wall

ML Medial to Lateral

MPA Main Pulmonary Artery

MR Mitral Regurgitation

MV Mitral Valve

MVcf Mean Velocity Circumferential Fiber Shortening

MVO Mitral Valve Orifice

OT Outflow Tract

P Papillary Muscles

PA Pulmonary Artery

PAP Pulmonary Artery Pressure

PDA Patent Ductus Arterosis

Table 10-1:  Cardiology Abbreviations

Acronym Name
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PEP Pre-Ejection Period

PFO Patent Foramen Ovale

PG Pressure Gradient 

PHT Pressure Half Time

PI Pulmonary Insufficiency

PISA Proximal Isovelocity Surface Area

PR Pulmonic Regurgitation

PV Pulmonic Valve

PV-A Pulmonic Valve Area by Continuity Equation

PVein Pulmonary Vein

PW Posterior Wall

Qp Pulmonic Flow or CO

Qs Systemic Flow or CO

RA Right Atrium

RAA Right Atrium Area

Rad Radius

RAD Right Atrium Diameter

RPA Right Pulmonary Artery

RV Right Ventricle

RVA Right Ventricle Area

RVAW RIght Ventricle Anterior Wall

RVD Right Ventricle Diameter

RVID Right Ventricle Internal Diameter

RVL Right Ventricle LEngth

RVOT Right Ventricle Outflow Tract

s Systolic

SI Stroke Index

ST Shortening

SV Stroke Volume

SVI Stroke Volume Index

Table 10-1:  Cardiology Abbreviations

Acronym Name
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In this manual, the abbreviation for each measurement is listed 
in parenthesis after the measurement, as follows:

� Aortic Root Diameter (Ao Diam)

� Left Ventricle Posterior Wall Thickness, Diastolic (LVPWd)

For example, to measure the Aortic Root Diameter, you select 
Ao Diam.

T Time

TA Tricuspid Annulus

TAML Tricuspid Annulus Medial to Lateral

TR Tricuspid Regurgitation

TV Tricuspid Valve

TVA Tricuspid Valve Area

Vcf Velocity Circumferential Fiber Shortening

Vel Velocity

VET Valve Ejection Time

Vmax Maximum Velocity

Vmean Mean Velocity

VSD Ventricular Septal Defect

VTI Velocity Time Integral

Table 10-1:  Cardiology Abbreviations

Acronym Name
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Cardiac Measurements

This section lists cardiac measurements and the steps to 
perform them. The measurement information in this section is 
organized by mode, then by region of interest, and then by type 
of measurement. The organization is as follows:

� Mode; there is a section for B-Mode, M-Mode, Color Flow 
Mode, and Doppler Mode. There is also a Combination 
Mode section, which includes calculations that are a result 
of measurements made in more than one mode.

� Within each mode section, there are sections for region of 
interest, such as aorta or mitral valve.

� Within each region of interest section, there are sections for 
type of measurement, such a one distance, two distance, 
trace, or velocity flow trace. Each measurement type section 
lists all cardiac measurements that are that type, and then 
describes the steps to perform that type of measurement.

Some measurements, such as Aortic Root Diameter or Aortic 
Valve Cusp Separation, can be made in B-Mode or M-Mode. 
The information for these measurements is included in both 
B-Mode and M-Mode sections.

NOTE: You can select the diastole frame/systole frame (ED/ES or ES/
ED) with the assigned control.
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Steps to perform a measurement

Making a one distance measurement

1. Select the measurement; an active caliper displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points.

5. To complete the measurement, press Set.

The system displays the measurement in the Results 
Window.

Making two distance measurements

1. Select the measurement; an active caliper displays.

2. Make the first distance measurement:

a. To position the active caliper at the start point, move the 
Trackball.

b. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

c. To position the second active caliper at the end point, 
move the Trackball.

A dotted line connects the measurement points.

d. To complete the measurement, press Set.

The system displays the distance value in the Results 
Window. After the first measurement, the system 
displays an active caliper.

3. To make the second distance measurement, repeat steps 
a�d above.

The system displays the measurements and ratio in the 
Results Window.
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Steps to perform a measurement  (continued)

Making a trace measurement

1. Select the measurement; an active caliper displays.

2. To position the caliper at the start point, move the Trackball.

3. To fix the trace start point, press Set.

The system displays a vertical dotted line.

4. To trace the measurement area, move the Trackball.

A line shows the traced area.

5. To complete the measurement, press Set.

The system displays the measurement in the Results 
Window.

Making a slope measurement

1. Select the measurement; an active caliper displays.

2. To position the caliper at the start point, move the Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second caliper at the end point, move the 
Trackball.

A dotted line shows the slope.

5. To complete the measurement, press Set. 

The system displays the slope measurement in the Results 
Window.



Cardiology Measurements

Versana Active � Basic User Manual 10-11
Direction 5840764-100 English Rev. 10

Steps to perform a measurement  (continued)

Making a time interval measurement

1. Select the measurement.

The system displays an active caliper and a vertical dotted 
line. 

2. To position the caliper at the start point, move the Trackball.

3. To fix the first caliper, press Set.

The system displays a second active caliper.

4. To position the caliper at the end point, move the Trackball.

5. To complete the measurement, press Set.

The system displays the time interval in the Results 
Window.

Making a velocity flow trace measurement

1. Select the measurement; an active caliper displays.

2. To position the caliper at the start point, move the Trackball.

3. To fix the trace start point, press Set.

The system displays a vertical dotted line.

4. To trace the envelope, move the Trackball.

A line shows the traced area.

5. To complete the trace, press Set.

The system displays a second vertical dotted line.

6. To position the second dotted line at the start of the next 
envelope, move the Trackball.

7. To complete the measurement, press Set.

The system displays the measurement in the Results 
Window.
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Steps to perform a measurement  (continued)

Making a peak velocity measurement

1. Select the measurement; an active caliper with a vertical 
dotted line displays.

2. To position the caliper at the desired measurement point, 
move the Trackball.

3. To complete the measurement, press Set. 

The system displays the velocity measurement in the 
Results Window.

Making a time interval/slope measurement

1. Select the measurement; an active caliper displays.

2. To position the caliper at the start point, move the Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second caliper at the end point, move the 
Trackball.

A dotted line shows the slope.

5. To complete the measurement, press Set. 

The system displays the time interval and slope 
measurements in the Results Window.
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B-Mode Measurements

Aorta

One distance measurement

� Aortic Root Diameter (AO Diam)

� Aortic Arch Diameter (AO Arch Diam)

� Ascending Aortic Diameter (Ao Asc Diam)

� Ascending Aortic Diameter (Ao Asc Diam)

� Aorta Annulus Diameter (Ao Annulus Diam)

� Aorta Isthmus (Ao Isthmus)

� Aorta ST Junction (Ao st junct)

Aortic Valve

One distance measurement

� Aortic Diameter (Ao Diam)

� Aortic Valve Cusp Separation (AV Cusp)

� Aortic Valve Diameter (AV Diam)

One trace measurement

� Aortic Valve Area Planimetry (AVA Planimetry)

� Transverse Aortic Valve Area (Trans AVA (d), Trans AVA 
(s)) 
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Left Atrium

Two distance measurements

� Left Atrium Diameter to AO Root Diameter Ratio (LA/AO 
Ratio)

One distance measurement

� Left Atrium Diameter (LA Diam)

� Left Atrium Length (LA Major)

� Left Atrium Width (LA Minor)

One trace measurement

� Left Atrium Area

� Diastolic (LAA (d)) 

� Systolic (LAA (s))

One trace measurement and one distance measurement

� Left Atrium Volume, Single Plane, Method of Disk 

� Diastolic (LAEDV A2C) (LAEDV A4C)

� Systolic (LAESV A2C) (LAESV A4C)
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Left Ventricle

NOTE: The user can select the Straight/Line (polygonal line) with the LV 
study tool. Adjust the appropriate control on the Primary Menu 
Key to make the selection.

One distance measurements

� Left Ventricle Mass Index 

� Diastolic (LVPWd)

� Systolic (LVPWs)

� Left Ventricle Volume, Teichholz

� Diastolic (LVIDd)

� Systolic (LVIDs)

� Left Ventricle Volume, Cubic

� Diastolic (LVIDd)

� Systolic (LVIDs)

� Left Ventricle Internal Diameter

� Diastolic (LVIDd)

� Systolic (LVIDs)

� Left Ventricle Length

� Diastolic (LVLd)

� Systolic (LVLs)

� Left Ventricle Outflow Tract Diameter (LVOT Diam)

� Left Ventricle Posterior Wall Thickness

� Diastolic (LVPWd)

� Systolic (LVPWs)

� Left Ventricle Length (LV Major)

� Left Ventricle Width (LV Minor)
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Left Ventricle  (continued)

One trace measurements

� Left Ventricle Outflow Tract Area (LVOT Diam)

� Left Ventricle Area, Two Chamber

� Diastolic (LVA (d))

� Systolic (LVA (s))

� Left Ventricle Area, Four Chamber

� Diastolic (LVA (d))

� Systolic (LVA (s))

� Left Ventricle Area, Short Axis

� Diastolic (LVA (d))

� Systolic (LVA (s))

� Left Ventricle Endocardial Area, Width (LVA (d))

� Left Ventricle Epicardial Area, Length 

� Diastolic (LVAepi (d))

� Systolic (LVAepi (s))

One time interval measurements

� Heart Rate, Teichholz 

� Heart Rate for Two Chamber study

� Heart Rate for Four Chamber study

� Heart Rate for Two Chamber Area-Length study

� Heart Rate for Two Chamber Method of Disk study

� Heart Rate for Four Chamber Area-Length study

� Heart Rate for Four Chamber Method of Disk study

� Heart Rate for Bi-Plane Method of Disk study
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Left Ventricle  (continued)

Two distance measurements 

� Ejection Fraction, Teichholz (LVIDs)

� Ejection Fraction, Cubic (LVIDs)

� Left Ventricle Posterior Wall Fractional Shortening (LVPWs)

� Left Ventricle Stroke Index, Teichholz (LVIDs, and Body 
Surface Area)

� Left Ventricle Fractional Shortening (LVIDs)

� Left Ventricle Stroke Volume, Teichholz (LVIDs)

� Left Ventricle Stroke Volume, Cubic (LVIDs)

Body surface area and stroke volume measurements

� Left Ventricle Stroke Index, Single Plane, Two Chamber, 
Method of Disk (LVIDd, LVIDs)

� Left Ventricle Stroke Index, Single Plane, Four Chamber, 
Method of Disk (LVIDd, LVIDs)

� Left Ventricle Stroke Index, Bi-Plane, Bullet 

� Left Ventricle Stroke Index, Bi-Plane, Method of Disk (LVAd, 
LVAs)

The system calculates body surface area from the patient�s 
height and weight.

Left Ventricle Study

� Diastolic (LVd)

� Systolic (LVs)

The Left Ventricle study automatically sequences the 
following measurements:

� Interventricular Septum (IVSd, IVSs) 

� Left Ventricle Internal Diameter (LVIDs, LVIDd)

� Left Ventricle Posterior Wall Thickness (LVPWs, 
LVPWd)
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Mitral Valve

One distance measurements

� Mitral Valve Annulus Diameter (MV Ann Diam)

� E-Point-to-Septum Separation (EPSS)

One trace measurement

� Mitral Valve Area by Pressure Half Time (MVA By PHT)

� Mitral Valve Area Planimetry (MVA Planimetry)

Pulmonic Valve

One distance measurement

� Pulmonic Valve Annulus Diameter (PV Ann Diam)

� Pulmonic Diameter (Pulmonic Diam)

Right Atrium

One distance measurement

� Right Atrium Diameter, Length (RA Major)

� Right Atrium Diameter, Width (RA Minor)

One trace measurements

� Right Atrium Area (RA Area)

� Right Atrium Volume, SIngle Plane, Method of Disk (RAAd)

� Right Atrium Volume, Systolic, SIngle Plane, Method of Disk 
(RAAs)
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Right Ventricle

One trace measurement

� Left Pulmonary Artery Area (LPA Area)

� Right Pulmonary Artery Area (RPA Area)

One distance measurements

� Right Ventricle Internal Diameter

� Diastolic (RVIDd)

� Systolic (RVIDs)

� Right Ventricle Diameter, Length (RV Major)

� Right Ventricle Diameter, Width (RV Minor)

� Right Ventricle Wall Thickness

� Diastolic (RVAWd)

� Systolic (RVAWs)

� Right Ventricle Outflow Tract Diameter (RVOT Diam)

� Left Pulmonary Artery (LPA)

� Main Pulmonary Artery (MPA)

� Right Pulmonary Artery (RPA)
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System

One distance measurements

� Interventricular Septum Thickness

� Diastolic (IVSd)

� Systolic (IVSs)

� Inferior Vena Cava (IVC)

� Main Pulmonary Artery Diameter (MPA Diam)

� Systemic Vein Diameter (Systemic Diam)

� Patent Ductus Arterosis Diameter (PDA Diam)

� Patent Foramen Ovale Diameter (PFO Diam) 

� Pericardial Effusion Diastole (PEd)

� Ventricular Septal Defect Diameter (VSD Diam)

� Atrial Septal Defect Diameter (ASD Diam)

Body surface area and stroke volume measurements

� Interventricular Septum (IVS) Fractional Shortening (IVSs)

The system calculates body surface area from the patient�s 
height and weight.

Tricuspid Valve

One distance measurements

� Tricuspid Valve Annulus Diameter (TV Ann Diam)

� Tricuspid Valve Area (TV Area)
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Auto EF Measurements (Option)

Automated Ejection Fraction (AutoEF) is a semi-automatic 
measurement tool used for measurement of the global EF 
(Ejection fraction). The AutoEF tool is used as an optional 
decision support tool.

The AutoEF tool tracks and calculates the myocardial tissue 
deformation based on feature tracking on B-mode cine loops.

AutoEF is performed on either one or both apical 4-chamber or 
2-chamber views, in any order.

The result is presented as Ejection Fraction value for each view 
and average Ejection Fraction for the whole LV. All values are 
stored to the worksheet after the results are approved (see 
�Tracking Validation� on page 10-31).

NOTE: The AutoEF tool is intended for adult cardiology and is not 
intended to be used in pediatrics cardiology.
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Acquisition

1. Create an exam, connect the ECG device and make sure to 
obtain a stable ECG trace.

2. Acquire B-mode cineloops of an Apical 4 chamber view 
(4-ch) and an Apical 2 chamber view (2-ch).

� The frame rate should be between 37 and 80 frames 
per second. A higher frame rate is recommended for 
high heart rate.

� Versana Active should be configured to store at least 
100 ms before and after each heart cycle.

� If the acquisition has more than one heart cycle, the 
analysis will be done on the second last heart cycle.

� The entire myocardium should be visible.

� A depth range that includes the entire left ventricle 
should be used

NOTE: The AutoEF processed image loop runs slower than the actual 
cardiac motion. To see the loop in correct playback speed, exit 
AutoEF.
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Starting AutoEF

1. Recall any one of the stored views and press Measure.

2. In the Measurement menu, select AutoEF.

The View selection menu is displayed.

Figure 10-2. View Selection Menu

3. Select the name of the current view: 4-ch or 2-ch. A ROI is 
defined and tracked through the entire heart cycle as 
detailed below.
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Defining the endocardial border (EB)

When selecting a view to analyze, the system automatically 
displays a frame where the endocardial border is usually clearly 
visible. The system automatically displays the ROI for tracking 
on the screen and the tissue tracking starts. When the tracking 
is completed and displayed, you can either accept the results or 
recalculate/redraw the endocardial border (EB).

Selecting �Recalc�

When selecting Recalc, you have the option to correct the EB 
manually or to revert to the semi-automatic 3 Point EB definition 
mode. (To revert to semi-automatic mode, press Auto ROI.) If 
you adjust any point in the EB and wait a few seconds, the 
system automatically starts reprocessing.

You can also choose another frame to redefine the EB. To 
choose another frame, turn off the YOYO function, and adjust 
the Left/Right marker.

It is also possible to define an EB in semi-automatic 3 Point 
mode.
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Defining Endocardial Border (EB) in semi-automatic 3 Point mode

To define the endocardial border, place three points at the 
endocardial border; two annular points at the base and one at 
the apex. Follow the indications displayed on the screen when 
placing the three points.

After placing the third point on the Apex, an endocardial border 
will automatically be traced (Figure 10-3 on page 10-26).

After Selecting 3 Points, the old EB is cleared from the screen 
and you can redefine a new EB using the 3 Point EB Definition 
method as described above.

NOTE: Correct border tracing is important for an accurate EF 
measurement. The system has an adaptive border tracing 
function: using the endocardial three points as a guide, the 
system will analyze the image and automatically adapt the 
border tracing to an optimal position.

NOTE: The YOYO function is turned on to help finding the correct 
location for the points.
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Editing the endocardial border trace

1. If required, use the Edge Shift Left/Right controls to 
delineate separately the left or right portions of the 
endocardial border visually as best as possible.

2. If required, move the trackball cursor over the border trace, 
select an anchor point (red circle), press SET and correct 
the trace by dragging the anchor point to a new location 
(Figure 10-4 on page 10-27). The shape of the border trace 
will update accordingly.

3. In case you wish to start over, press 3 Points and re-position 
the 3 points defining the basal and apex points.

 Figure 10-3. Defining a ROI
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Editing the endocardial border trace  (continued)

4. Place the trackball cursor over the desired point.

5. Selected Point is marked by a red circle.

6. Click over the red circle, it will turn to a square.

Figure 10-4. Selected anchor point on the inner border trace

7. Move the square to re-align the border trace.

8. Press the Process button when ready.

NOTE: Data processing is configured by default to start automatically if 
the cursor is not moved for a few seconds. If the trace needs to 
be adjusted, make sure to make the changes immediately after 
the ROI is displayed.
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EF results screen

When processing is complete, the EF results screen is displayed 
(Figure 10-5 on page 10-29).

NOTE: The bi-plane results (BiP) will only appear on screen 
(Figure 10-5) after measuring both 2-Ch and 4-Ch views.

The AutoEF processed image runs slower than the original loop 
speed. In order to see the loop in correct playback speed, exit 
AutoEF.

The running loop is shown on the left. A green dotted line marks 
the inner border of the chamber. In case of poor tracking, the 
system will automatically display parts of the border in red.

The system will automatically pick the frames with the maximal 
area (ED) and minimal area (ES) and place them on the right 
area of the display.

The End Diastolic volume (EDV) and end Systolic Volume (ESV) 
is calculated and shown above each frame.

The resulting EF calculation is displayed on the top of the 
screen.
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EF results screen  (continued)

 Figure 10-5. AutoEF Result Multi Screen
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EF results screen  (continued)

 Figure 10-6. AutoEF Results Dual Screen - Alternative screen mode
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Tracking Validation

The tracking must be visually controlled and validated. If the 
tracking results are visually correct press the red Approve 
button. The button turns green and is labeled Approved. The 
calculated values will be stored and appear in the worksheet.

The following can be done if tracking needs correction:

� Press EF Dual to enlarge ES and ED frames and position 
them side-by-side (Figure 10-6 on page 10-30).

� You may manually select a different ED frame or ES frame 
using the ED frame or ES frame rotary.

� You may edit any misaligned point on either ED or ES 
frames. This is done by:

a. Placing the trackball cursor over the desired point.

b. Clicking over the red circle, it will turn to a square.

c. Pressing Set and moving the square to re-align the 
border trace.

d. The ESV, EDV and EF will be recalculated accordingly.

Figure 10-7. Border trace edit
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Tracking Validation  (continued)

e. In case these results are incorrect, you may go back to 
the previous step by pressing the Recalc button and 
editing the endocardial border (�Defining the endocardial 
border (EB)� on page 10-24).

f. In case editing the endocardial border is too difficult, you 
may start all over again by pressing Auto ROI and 
retrace the border (�Defining the endocardial border 
(EB)� on page 10-24).

Possible causes of poor tracking

Poor tracking quality could result from a variety of causes. The 
common causes for bad tracking are:

� Erroneous placement of the basal points when defining the 
border. If the basal points are placed too far from the 
annular region, the border segments at the annular base will 
not move together with the underlying 2D image throughout 
the entire heart beat.

� Erroneous placement of the apex point when defining the 
border. The point should be placed so that the resulting 
border trace covers mainly the endocardium. If the apex 
point is placed too high, the border trace will mainly cover 
the epicardium resulting in poor tracking.

� Too much clutter. Images with too much static clutter will 
result in poor tracking.
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Results

For each of the views, a results screen containing the EF 
calculation, appears (Figure 10-5 on page 10-29) in a 
mini-report. The mini-report appears on the left side of the 
results window.

Figure 10-8. Mini Report
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Results  (continued)

The results are summarized in the worksheet and in the report. 
AutoEF calculations are displayed with a Q in the worksheet to 
designate these are from an Auto measure. 

 Figure 10-9. Results in Worksheet - Page 1
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Results  (continued)

 Figure 10-10. Results in Report template
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Exit AutoEF

Press Exit to end AutoEF.

Pressing Report, Patient or Scan also closes the AutoEF 
package.

NOTE: Do not disable any sub-measurement of AutoEF in Utility --> 
Measure, as this will disable the whole set of AutoEF 
measurements.

NOTE: For consistent results, do not delete individual AutoEF 
measurements from the worksheet. Always delete a full column.
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M-Mode Measurements

Aorta

One distance measurement

� Aortic Root Diameter (AO Root Diam)

Aortic Valve

One distance measurements

� Aortic Valve Cusp Separation (AV Cusp)

Left Atrium

One distance measurement

� Left Atrium Diameter (LA Diam)

Two distance measurement (ratio)

� Left Atrium Diameter to AO Root Diameter Ratio (LA/AO)
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Left Ventricle

One distance measurements

� Left Ventricle Volume, Teichholz 

� Diastolic (LVIDd)

� Systolic (LVIDs)

� Left Ventricle Volume, Cubic

� Diastolic (LVIDd)

� Systolic (LVIDs)

� Left Ventricle Internal Diameter

� Diastolic (LVIDd)

� Systolic (LVIDs)

� Left Ventricle Posterior Wall Thickness

� Diastolic (LVPWd)

� Systolic (LVPWs)

One time interval measurement

� Heart Rate, (R-R)

� Left Ventricle Ejection Time (LVET)

� Left Ventricle Pre-Ejection Period (LVPEP)

� Velocity Circumferential Fiber Shortening (Vcf)

Left Ventricle Study

The Left Ventricle study (LV Study) automatically sequences 
the following measurements:

� Interventricular Septum (IVSd, IVSs) 

� Left Ventricle Internal Diameter (LVIDd, LVIDs)

� Left Ventricle Posterior Wall Thickness (LVPWd, LVPWs)
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Mitral Valve

One distance measurements

� E-Point-to-Septum Separation (EPSS)

One slope measurements

� Mitral Valve Anterior Leaflet Excursion (D-E Excursion)

� Mitral Valve D-E Slope (D-E Slope)

� Mitral Valve E-F Slope (E-F Slope)

Right Ventricle

One distance measurements

� Right Ventricle Internal Diameter

� Diastolic (RVIDd)

� Systolic (RVIDs)

� Right Ventricle Wall Thickness

� Diastolic (RVAWd)

� Systolic (RVAWs)

One time interval measurements

� Right Ventricle Ejection Time (RVET)

� Right Ventricle Pre-Ejection Period (RVPEP)

Right Ventricle Study

The Right Ventricle study (RV study) automatically sequences 
the following measurements:

� Right Ventricle Internal Diameter (RVIDd, RVIDs))



Cardiology

10-40 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10

Pulmonic Valve

One time interval measurements

� QRS complex to end of envelope (Q-to-PV close)

System

One distance measurements

� Interventricular Septum

� Diastolic (IVSd)

� Systolic (IVSs)

� Pericardial Effusion (PEd)

Two distance measurement:

� Interventricular Septum (IVS) Fractional Shortening (LVD - 
LVS / LVD x 100)

Tricuspid Valve

One time interval measurements

� QRS complex to end of envelope (Q-to-TV close)
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Doppler Mode Measurements

Aortic Valve

Velocity flow trace measurements

� Aortic Insufficiency Mean Pressure Gradient (AI Trace)

� Aortic Insufficiency Peak Pressure Gradient (AI Vmax)

� Aortic Insufficiency Mean Velocity (AI Trace)

� Aortic Insufficiency Mean Square Root Velocity (AI Trace)

� Aortic Insufficiency Velocity Time Integral (AI Trace)

� Aortic Valve Mean Velocity (AV Trace)

� Aortic Valve Mean Square Root Velocity (AV Trace)

� Aortic Valve Velocity Time Integral (AV Trace)

� Aortic Valve Mean Pressure Gradient (AV Trace)

One peak velocity measurements

� Aortic Valve Peak Pressure Gradient (AR Vmax)

� Aortic Insufficiency Peak Velocity (AR Vmax/AI Vmax)

� Aortic Insufficiency End-Diastolic Velocity (ARend Vmax/ 
AIend Vmax)

� Aortic Valve Peak Velocity (AV Vmax)

� Aortic Valve Peak Velocity at Point E (AV Vmax)

� Aorta Proximal Coarctation (Coarc Pre-Duct)

� Aorta Distal Coarctation (Coarc Post-Duct)

One slope measurements

� Aortic Valve Insufficiency Pressure Half Time (AR PHT)

� Aortic Valve Flow Acceleration (AV Trace)

� Aortic Valve Pressure Half Time (AV Trace)
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Aortic Valve  (continued)

One time interval measurements

� Aortic Valve Acceleration Time (AV AccT)

� Aortic Valve Deceleration TIme (AI PHT)

� Aortic Valve Ejection Time (AVET)

� Aortic Valve Heart Rate 

� Time

Two time interval measurement

Slope through aortic valve trace:

� Aortic Valve Acceleration to Ejection Time Ratio (AVET)

� Aortic Valve Area according to PHT 
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Left Ventricle

One peak velocity measurements

� Left Ventricle Outflow Tract Peak Pressure Gradient (LVOT 
maxPG)

� Left Ventricle Outflow Tract Peak Velocity (LVOT Vmax)

One velocity flow trace measurements

� Left Ventricle Outflow Tract Mean Pressure Gradient (LVOT 
Trace)

� Left Ventricle Outflow Tract Mean Velocity (LVOT Trace)

� Left Ventricle Outflow Tract Mean Square Root Velocity 
(LVOT Trace)

� Left Ventricle Outflow Tract Velocity Time Integral (LVOT 
Trace)

One time interval measurements

� Left Ventricle Heart Rate (LVOT Trace)

� Left Ventricle Ejection Time (LVET)
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Mitral Valve

NOTE: When measuring the MV E/A velocity, Auto/Manual trace can be 
modified with the appropriate Primary Menu Key control.

One velocity flow trace measurements

� Mitral Valve Regurgitant Flow Acceleration (MV Trace)

� Mitral Valve Regurgitant Mean Velocity (MV Trace)

� Mitral Regurgitant Mean Square Root Velocity (MR Trace)

� Mitral Regurgitant Mean Pressure Gradient (MR Trace)

� Mitral Regurgitant Velocity Time Integral (MR Trace)

� Mitral Valve Mean Velocity (MV Trace)

� Mitral Valve Mean Square Root Velocity (MV Trace)

� Mitral Valve Velocity Time Integral (MV Trace)

� Mitral Valve Mean Pressure Gradient (MV Trace)

One peak velocity measurements

� Mitral Regurgitant Peak Pressure Gradient (MR Vmax)

� Mitral Valve Peak Pressure Gradient (MV Vmax)

� Mitral Regurgitant Peak Velocity (MR Vmax)

� Mitral Valve Peak Velocity (MV Vmax)

� Mitral Valve Velocity Peak A (MV A Velocity)

� Mitral Valve Velocity Peak E (MV E Velocity)

One slope measurements

� Mitral Valve Area according to PHT (MV PHT)

� Mitral Valve Flow Deceleration (MV DecT)

� Mitral Valve Pressure Half Time (MV PHT)

� Mitral Valve Flow Acceleration (MV AccT)
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Mitral Valve  (continued)

Two distance measurement

� Mitral Valve E-Peak to A-Peak Ratio (A-C and D-E) (MV E/A 
Ratio)

One time interval/slope measurements

� Mitral Valve Acceleration Time (MV AccT)

� Mitral Valve Deceleration Time (MV DecT)

One time interval measurement

� Mitral Valve Ejection Time (M VET)

� Mitral Valve A-Wave Duration (MV A Dur)

� Mitral Valve Time to Peak (MV TTP)

� Time

Two time interval measurement

Body surface area and stroke volume measurements:

� Stroke Volume Index by Mitral Flow (MV Trace)

The system calculates body surface area from the patient�s 
height and weight.

One distance and two velocity measurement:

� Mitral Valve Area from Continuity Equation (MV Vmax)
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Pulmonic Valve

One peak velocity measurements

� Pulmonic Insufficiency Peak Pressure Gradient (PI Vmax)

� Pulmonic Insufficiency End-Diastolic Pressure Gradient (PR 
Trace)

� Pulmonic Valve Peak Pressure Gradient (PV Vmax)

� Pulmonic End-Diastolic Pressure Gradient (PR Trace)

� Pulmonic Insufficiency Peak Velocity (PR Vmax)

� Pulmonic Insufficiency End-Diastolic Velocity (PRend 
Vmax)

� Pulmonic Valve Peak Velocity (PV Vmax)

� Pulmonic End-Diastolic Velocity (PV Trace)

One velocity flow trace measurements

� Pulmonary Artery Diastolic Pressure (PV Trace)

� Pulmonic Insufficiency Mean Pressure Gradient (PR Trace)

� Pulmonic Valve Mean Pressure Gradient (PV Trace)

� Pulmonic Insufficiency Mean Velocity (PR Trace)

� Pulmonic Insufficiency Mean Square Root Velocity (PR 
Trace)

� Pulmonic Insufficiency Velocity Time Integral (PR Trace)

� Pulmonic Valve Mean Velocity (PV Trace)

� Pulmonic Valve Mean Square Root Velocity (PV Trace)

� Pulmonic Valve Velocity Time Integral (PV Trace)
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Pulmonic Valve  (continued)

One slope measurements

� Pulmonic Insufficiency Pressure Half Time (PR PHT)

� Pulmonic Valve Flow Acceleration (PV AccT)

One time interval measurements

� Pulmonic Valve Acceleration Time (PV AccT)

� Pulmonic Valve Ejection Time (PVET)

� Pulmonic Valve Pre-Ejection Period (PVPEP)

� QRS complex to end of envelope (Q-to-PV close)

� Time

Two time intervals measurements

� Pulmonic Valve Acceleration to Ejection TIme Ratio (PV 
AccT, PVET)

� Pulmonic Valve Pre-Ejection to Ejection Time Ratio 
(PVPEP, PVET)
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Right Ventricle

One peak velocity measurements

� Right Ventricle Outflow Tract Peak Pressure Gradient 
(RVOT Vmax)

� Right Ventricle Systolic Pressure (RVOT Vmax)

� Right Ventricle Outflow Tract Peak Velocity (RVOT Vmax)

One velocity flow trace measurement

� Right Ventricle Diastolic Pressure (RVOT Trace)

� Right Ventricle Outflow Tract Velocity Time Integral (RVOT 
Trace)

One time interval measurement

� Right Ventricle Ejection Time (PVET)
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System

One peak velocity measurements

� Pulmonary Artery Peak Velocity (PV Vmax)

� Pulmonary Vein Velocity Peak A (reverse) (P Vein A)

� Pulmonary Vein Peak Velocity 

� End-Diastolic (P Vein D)

� Systolic (P Vein S)

� Systemic Vein Peak Velocity 

� End-Diastolic (PDA Diastolic)

� Systolic (PDA Systolic)

� Ventricular Septal Defect Peak Velocity (VSD Vmax)

� Atrial Septal Defect Peak Velocity (ASD Vmax)

One velocity flow trace measurements

� Pulmonary Artery Velocity Time Integral (Pulmonic VTI)

� Systemic Vein Velocity Time Integral (Systemic VTI)

One time interval measurements

� Pulmonary Vein A-Wave Duration (P Vein A Dur)

� Time

� IsoVolumetric Relaxation Time (IVRT)

� IsoVolumetric Contraction Time (IVCT)

Two peak velocity measurements

� Pulmonary Vein S/D Ratio (P Vein D, P Vein S)

� Ventricular Septal Defect Peak Pressure Gradient (VSD 
maxPG)

Two velocity flow trace measurements:

� Pulmonic-to-Systemic Flow Ratio (Qp/Qs)
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Tricuspid Valve

One peak velocity measurements

� Tricuspid Regurgitant Peak Pressure Gradient (TR Vmax)

� Tricuspid Valve Peak Pressure Gradient (TV Vmax)

� Tricuspid Regurgitant Peak Velocity (TR Vmax)

� Tricuspid Valve Peak Velocity (TV Vmax)

� Tricuspid Valve Velocity Peak A (TV A Velocity)

� Tricuspid Valve Velocity Peak E (TV E Velocity)

One velocity flow trace measurements

� Tricuspid Regurgitant Mean Pressure Gradient (TR Trace)

� Tricuspid Regurgitant Mean Velocity (TR Trace)

� Tricuspid Regurgitant Mean Square Root Velocity (TR 
Trace)

� Tricuspid Regurgitant Velocity Time Integral (TR Trace)

� Tricuspid Valve Mean Pressure Gradient (TV Trace)

� Tricuspid Valve Mean Velocity (TV Trace)

� Tricuspid Valve Mean Square Root Velocity (TV Trace)

� Tricuspid Valve Velocity Time Integral (TV Trace)

One time interval measurements

� Tricuspid Valve Time to Peak (TV TTP)

� Tricuspid Valve Closure to Opening (TCO)

� Tricuspid Valve A-Wave Duration (TV A Dur)

� QRS complex to end of envelope (Q-to-TV close)
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Tricuspid Valve  (continued)

One slope measurements

� Tricuspid Valve Pressure Half Time (TV PHT)

One velocity flow trace and one area measurement

� Stroke Volume by Tricuspid Flow (TV SV)

Two peak velocity measurement

� Tricuspid Valve E-Peak to A-Peak Ratio (TV E/A Velocity)
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Color Flow Mode

Aortic Valve

One distance measurements

� Proximal Isovelocity Surface Area: Regurgitant Orifice Area 
(PISA AR)

� Proximal Isovelocity Surface Area: Radius of Aliased Point 
(PISA AR)

One velocity flow trace measurements

� Proximal Isovelocity Surface Area: Regurgitant Flow (PISA 
AR)

� Proximal Isovelocity Surface Area: Regurgitant Volume Flow 
(PISA AR)

One peak velocity measurement

� Proximal Isovelocity Surface Area: Aliased Velocity (PISA 
AR)

Mitral Valve

One distance measurements

� Proximal Isovelocity Surface Area: Regurgitant Orifice Area 
(PISA MR)

� Proximal Isovelocity Surface Area: Radius of Aliased Point 
(PISA MR)

One velocity flow trace measurements

� Proximal Isovelocity Surface Area: Regurgitant Flow (PISA 
MR)

One peak velocity measurement

� Proximal Isovelocity Surface Area: Aliased Velocity (PISA 
MR)
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Cardiac Worksheet

After you make cardiac measurements, you can review all the 
data on the cardiac worksheet. To view the worksheet, select the 
Report on the control panel.

The cardiac worksheet has a heading for each mode, and for 
each folder. In Figure 10-11, the mode heading is B-mode 
Measurements, followed by Cube/Teichholz. Each 
measurement from that folder is listed next. The next folder is 
then listed, in this example, RV/LV.

Figure 10-11. Cardiac Worksheet: Page 1

If a worksheet has more data on a second page, to view the next 
page, select Page Change.

To return to scanning, select the Report or press Esc.
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Worksheet information

The information on the cardiac worksheet is as follows:

� Parameter � This column lists the mode, the measurement 
folder, and the specific measurement.

� Value � The measured value. If more than one 
measurement was made for an item, the system uses the 
specified method (average, maximum, minimum, or last) to 
determine this value.

� m1-mN - All measurement values for each item. If you make 
more than six measurements, the worksheet has a scroll bar 
to show all values (cardiac worksheet only).

� Method � When there is more than one measurement for an 
item, this specifies the method used to calculate the 
measurement value listed in the Value column. Choices are 
average, maximum, minimum, or last. To change the 
method: 

a. Move the Trackball to the Method field. 

b. Press Set.

c. Move the Trackball to select from the list.

d. Press Set.

For more information about working with worksheets, See 
�Viewing and Editing Worksheets� on page 7-61 for more 
information.
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Setting up and Organizing Measurements and Calculations

When you receive your Versana Active system, the studies and 
measurements are organized for typical work flows. If you want, 
you can change this set up. You can change studies, create 
studies, and specify which measurements and calculations are 
in each study. You can change the measurements that are 
available on the Primary Menu Key. The Versana Active allows 
you to quickly and easily set up your system so that you can 
work most efficiently. 

For information about how to customize studies and 
measurements, See �Measurement and Calculation Setup� on 
page 7-13 for more information.

When you make cardiac measurements, the results you see in 
the Results Window and the Worksheet can vary, depending on 
what you have set up in the Utility screens. 
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Generic Study

The Cardiology B Mode Generic exam category includes the 
following measurements:

� Area (Trace)

� Volume

� Volume (d)

� Volume (s)

� Dist (Distance) Ratio

� Area Ratio

� R-R

The Cardiology M Mode Generic exam category includes the 
following measurements:

� LV Study

� LA/Ao

� RV Study

� D-E Excursion

� Slope Caliper

� Caliper

� Time

� HR

� Dd/Ds Study

The Cardiology Doppler Mode Generic exam category includes 
the following measurements: 

� Point

� Manual Trace

� MV E/A Ratio

� PHT

� Time

� HR
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Cardiac Doppler Measurements

Cardiac Output (CO)

To measure CO (Cardiac Output), make a velocity measurement 
in the Doppler Spectrum. A FCA (Flow Cross-Sectional Area) is 
measured on the vessel in B-Mode. These two measurements 
are used to calculate SV (Stroke Volume). Finally, a HR (Heart 
Rate) measurement is taken in the Doppler Spectrum. SV and 
HR are then used to calculate cardiac output.

1. Select CO from either the B-Mode or Doppler menu. 

The caliper (horizontal dotted line) appears in the Doppler 
spectrum.

2. Measure the Stroke Volume.

After the stroke volume measurements have been 
completed, a vertical line caliper appears in the Doppler 
spectrum. 

3. Measure the Heart Rate. See �Heart Rate� on page 7-79 for 
more information.

CO (Cardiac Output) is computed from the SV and HR 
values and is displayed.

Automatic CO calculation

If the following measurements have previously been made in 
any order, CO (Cardiac Output) automatically calculates when it 
is selected from the Calculation menu:

� Velocity in Doppler Mode

� Functional Cross Sectional Area in B-Mode (Circumference/
Area)

� Heart Rate in Doppler Mode

E/e� Ratio

The ratio of early transmitral velocity to early diastolic velocity of 
the mitral annulus (E/e�) is measured in Doppler Mode and TVD 
mode.

1. First, measure MV E/A Velocity to get �E�.

2. Measure e�.

NOTE: The system displays �e� in place of �e�� on the menu.

3. The system calculates E/e� ratio automatically.
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Stress Echo (Option)

Introduction

The Versana Active Ultrasound system provides an integrated 
stress echo package, with the ability to perform image 
acquisition, review, image optimization, and wall segment 
scoring and reporting for a complete, efficient stress echo 
examination.

The stress package provides a protocol template for the two 
types of stress exams (exercise and pharmacological stress). 

In addition to preset factory protocol templates, templates can 
be created or modified to suit your needs.

You can define various quad screen review groups, in any order 
and combination, that will suit your normal review protocol.

When reviewing stress examination images, the images are 
viewed at their original image quality, and different 
post-processing and zoom factors may be applied to the images 
under review for effective image optimization.

The protocol template may be configured for Continuous 
Capture.

A stress echo examination consists of three steps:

� Selection of a stress test protocol template

� Image acquisition

� Stress Analysis

NOTE: If WallMotion Segment Score is not displayed on the screen, 
select the �WallMotion� preset in the Utility -> Measure ->  M&A 
-> Plot -> Available Folders and Measurements. 
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Getting started with a stress study

1. After selecting the appropriate application and probe and 
connecting ECG, press the user defined key for Stress 
echo. The protocol screen displays the layout of the default 
stress protocol for the current probe. This layout is also 
known as a template.

Table 10-2:  Protocol Tab

Parameter Description

Analyze Display the Analysis screen

Template Editor Display the template editor screen

Add Level Add Level to the template

Delete Images Delete the selected image

Move Image Move the selected image to the another cell

Sync. Select Synchronize the selected images.

End CC End Continuous Capture

Begin/Cont. Begin or continue the acquisition

Template Display the template list

T1 Display/Hide the timer T1

T2 Display/Hide the timer T2

Cancel Cancel Stress Echo
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Getting started with a stress study  (continued)

2. To use the current template, press Begin/Cont. to initiate 
scanning. 

To use another template, press Template. The template list 
displays.

Figure 10-12. Template List

3. Trackball to the desired template and press Set.
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Getting started with a stress study  (continued)

4. The selected template displays.

 Figure 10-13. Template (Example)

a. Level

b. Projection

c. Current Acquisition (green)

5. Press Begin/Cont. to initiate scanning using the new 
template.
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Image acquisition

Images are acquired in a pre-defined order, according to the 
selected template. The highlighted (green) cell of the template 
matrix, displayed in the Clipboard window, indicates which view 
is currently being acquired.

The names of the view and levels for the current cell are 
displayed on the top left corner of the image area and under the 
template matrix.

Acquisition Screen

 Figure 10-14. Acquisition Screen

1. Current View Level

2. Timer

3. Template Matrix

4. Current View (Green cell)
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Starting acquisition

1. Select the template.

2. Press Begin/Cont.

3. Perform a scan that conforms with the view that is 
highlighted in the template matrix on the Clipboard window.

4. Press P1 key.

� If the actual stress level is configured to preview the 
cine loop before storing, use the cine loop controls to 
select the most appropriate heart cycle and if desired 
adjust the loop markers. Press P1 again to save the 
selected cine loop.

or

If you do not want to store the cine loop, press Freeze to 
cancel. Return to the scan screen.

� If the actual stress level is not configured to preview the 
cine loop before storing, the system automatically 
stores the last heart cycle.

Stress levels can be configured for side-by-side display/
comparison of the reference loop from baseline or previous level 
and the loop to acquire.

5. After storing the cine loop, the system automatically 
highlights the next view in the matrix to be acquired.

6. Repeat previous steps until all required views are 
completed.

7. If you select Auto Start Analysis on the Template Editor for 
this template, a dialogue asking �Do you want to start 
protocol analysis now?� displays when the last acquisition is 
complete. If you select Yes, the Stress Echo Analysis screen 
is displayed.

The template used can be configured so that analysis 
automatically starts by displaying the first protocol group. The 
wall segment scoring diagrams for each view is displayed in the 
Parameter window on the left side of the screen.
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Starting acquisition  (continued)

If Stress echo is selected during acquisition, the following 
Protocol Mode displays.

Table 10-3:  Protocol Mode during acquisition

Parameter Description

Stop Stop Stress Echo.

Pause Pause Stress Echo. The template matrix continues in display. Even if you 
press P1, the cine loop does not store to the matrix.

Select Cycles The Continuous Capture Selection screen is displayed (only available in 
Continuous Capture mode).

Analyze Enter Analysis screen.

Template Enter Template screen.

Add Level Add level to the template.

T2 Display (Start)/Hide Timer T2.



Stress Echo (Option)

Versana Active � Basic User Manual 10-65
Direction 5840764-100 English Rev. 10

Selecting a view during acquisition

A fixed protocol is provided for scanning, based on the selected 
template. The system automatically highlights the next view to 
be acquired in the template matrix, as images are stored. 
However, the order of scanning may be changed manually as 
follows:

Manual selection of a view during acquisition

1. Use the Trackball or the arrow keys upwards and 
downwards on the alphanumeric keyboard to move the 
cursor to the cell that represents the view to be acquired.

The selected cell in the template matrix, highlighted in red, 
indicates the non-default position. When blinking, it contains 
a previously-stored acquisition.

2. Scan and save the selected loop as explained in the 
previous section.

After storage, the system automatically highlights the next 
available view to be acquired.
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Moving an acquired image

An image can be moved from one cell to another during 
acquisition.

Procedure 1

1. When in the Protocol screen, press Move Image.

2. Use the Trackball to move the cursor to the desired image.

3. Press Set. 

4. Use the Trackball to move the cursor to the destination cell.

5. Press Set. The image is moved from the source cell to the 
destination cell.

Procedure 2

1. In the Protocol screen, use the Trackball to move the cursor 
to the cell containing the image to move (source cell).

2. Press and hold down Set.

3. With the Set key still depressed, move the Trackball to the 
desired cell.

4. Release the Set key. The image is moved from the source 
cell to the destination cell.

If the destination cell contains an image, the images from the 
source and destination cells is exchanged when moving an 
acquired image.



Stress Echo (Option)

Versana Active � Basic User Manual 10-67
Direction 5840764-100 English Rev. 10

Timers

Two timers can be displayed in the Stress mode acquisition 
screen, beside the template matrix.

Timers

� T1 displays the elapsed time from the start of stress 
examination.

� T2 starts when entering live scanning on the second stress 
level.

Both T1 and T2 timers can be manually stopped and restarted 
during the acquisition.

The display of T1 and T2 is user-configurable.

NOTE: If you activate the Timer in Stress Echo, the T1 timer is 
displayed in the lower left-hand corner of the image area after 
exiting Stress Echo. 
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Continuous Capture mode

Continuous Capture mode enables the user to perform 
acquisition continuously for all views at any level depending on 
the selected template configuration. Continuous Capture 
consists of temporary saving images acquired in a storage 
buffer. To enable best possible use of the limited storage buffer 
capacity, a Pause/Capture mode is provided, as opposed to the 
normal Freeze/Scan mode. The Pause mode enables scanning 
and live display on the screen, without any capture, thereby 
leaving the buffer available.

To run Continuous Capture, the user has to select a template 
where this feature is activated.

The buffer bar

When entering a level with Continuous Capture enabled, a 
buffer bar displays in the window.

The Buffer bar displays the following information:

� The scanning state

� Pause (live scanning without storing)

� Capture (live scanning with storing to buffer)

� The percentage of the buffer that is filled

� The buffer filling progression showed by a filling gage

� The capturing sessions, reflected by the red lines along the 
buffer bar

Figure 10-15. Buffer Bar
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Controlling the capture process

When entering a stress level with Continuous Capture enabled, 
the system is automatically set in Pause mode.

1. Press P1 to start image capture.

�Capture� is displayed in the buffer bar, the gage starts filling 
and the percentage of filled memory buffer increases.

2. Press P1 again to stop capture.

�Pause� is displayed in the buffer bar.

When 90% of the memory buffer is filled up, the text display in 
the buffer bar turns red.

The system enters Freeze mode automatically once the buffer is 
full and the captured loops display in the Continuous Capture 
selection screen.

Activating Continuous Capture

1. Do all your pre-stress acquisitions in the Cardiac 
application.

2. Press the user defined key for Stress echo. The Protocol 
screen displays.

3. Press Template. The template list displays.

4. Select the template Exercise 2x4 from the list.

5. Press Begin/Cont..

6. Acquire the resting loops in all four views.

NOTE: Use the P1 key to store the images.

7. Once the fourth loop is acquired, the system enters into a 
waiting mode where Continuous Capture is in a pause state 
awaiting the patient to exercise.

8. When the patient is back on the bed, press P1. The 
Continuous Capture acquisition starts.

9. Acquire all your views.

The memory buffer gage increases. When memory exceeds 
90%, the percent number turns red.

10. Press Freeze to finish.
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Activating Continuous Capture  (continued)

11. Press Select Cycle.

The Continuous Capture selection screen displays.

If the buffer is full, the system automatically displays the 
Continuous Capture Selection screen.

Refer to the next section if additional image acquisitions are 
necessary after the buffer is full.

 Figure 10-16. Continuous Capture Selection Screen
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Activating Continuous Capture  (continued)

12. Assign the cine loops to the four views. 

a. Trackball to the desired loop.

b. Press Set. A drop-down menu appears with the 
available choices.

c. Trackball to the appropriate view.

d. Press Set.

 Figure 10-17. Drop-down Menu

e. Continue these steps until all views are selected.

NOTE: To access additional cycles, use the arrow keys on the 
lower left portion of the select cycle screen.
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Activating Continuous Capture  (continued)

f. Select Done when complete. A dialogue window 
displays, asking whether the entire Continuous Capture 
acquisition should be saved.

Figure 10-18. Dialogue Window

13. Press Delete to discard the loop or press Store all to keep 
the entire loop.

14. Perform Analysis and scoring.
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Continuous Capture with additional image acquisition

If the buffer is filled up before all the image acquisitions are 
done, additional loops can be stored in the clipboard before 
doing image assignment to the views.

1. Perform the Continuous Capture. See �Activating 
Continuous Capture� on page 10-69 for more information. 
(Steps 1 to 11).

2. In the Continuous Capture selection screen, press Select 
Later.

The Continuous Capture screen displays.

3. Perform the additional acquisition.

4. In order to resume the stress echo exam and assign loops 
for the views from the Continuous Capture buffer, press the 
user defined key for Stress echo. Then press Template. If 
not displayed, select the template Exercise 2x4 from the 
template list.

5. Click the continuous capture images on the Protocol 
Template screen.

The Continuous Capture selection screen displays.

6. Assign the cine loops to the view. See �Activating 
Continuous Capture� on page 10-69 for more information. 
(Step 12 a - f).

7. Press Delete to discard the loop or press Store all to keep 
the entire loop.

The normal procedure is to discard the loop. The loop is 
very big and requires a lot of disk space.

8. Perform Analysis and Scoring.
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Postponed image assignment

The assignment of the cine loops to the view can be done on a 
later stage on a stored Continuous Capture acquisition.

1. Perform the Continuous Capture.  See �Activating 
Continuous Capture� on page 10-69 for more information. 
(Steps 1 to 11).

2. Press Store all.

The entire Continuous Capture acquisition is stored. The 
examination can be ended and the image assignment, 
analysis and scoring can be done later.

3. Re-open the examination, if necessary.

4. Press the user defined key for Stress echo. Then press 
Template. The Protocol screen displays.

5. Click the continuous capture images on the Protocol 
Template screen.

The Continuous Capture selection screen displays.

6. Assign the cine loops to the view.  See �Activating 
Continuous Capture� on page 10-69 for more information. 
(Step 12 a - f).

7. Select Done.

8. Perform analysis and scoring.

Restart capture from the Continuous Capture Selection

� Press Restart Capture.

The recording in memory is deleted and the Continuous 
Capture starts again.

Resume Continuous Capture

� Press Continue Capture.

Resumes Continuous Capture recording (only if the 
Continuous Capture buffer is not full).
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Assiging and storing the cine loop

The cine loops captured in the buffer are assigned to the stress 
protocol views and stored from the Continuous Capture 
selection screen.

 Figure 10-19. Continuous Capture Selection Screen

a. Highlighted loop

b. Cycle number and total number of cycles

c. Blue Gauge: Position of the highlighted loop within 
buffer area. 

d. Navigation Controls: << < > >> (back to first selection, 
back to previous selection, forward to next selection, 
and forward to final selection). 
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Assigning a cine loop to a view

1. Use the Trackball to move the cursor to the desired cine 
loop in order to assign it to a particular view of the stress 
template.

The frame of the loop is highlighted.

2. Press Set.

A pop-up menu displays with the view names of the 
template.

 Figure 10-20. Loop Assignment

a. Already assigned view

b. Views pop-up menu

NOTE: A checkmark appears on the Views pop-up after you 
have assigned a view to an image.
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Assigning a cine loop to a view  (continued)

3. Use the Trackball to select the required view name.

4. Press Set.

The name of the view displays above the timers in the 
window.

5. Repeat steps 1 through 4 to assign loops to the other views 
of the level.

6. Press Done when complete.

A dialogue window displays asking whether the entire 
Continuous Capture acquisition should be saved.

7. Press Delete to discard the loop or press Store all  to keep 
the entire loop.

The normal procedure is to discard the loop. The loop is 
very big and requires a lot of disk space.
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Post Acquisition Features

Post acquisition, you can utilize Raw Data to adjust the following 
in B-Mode: 

� Zoom

� SRI HD

� Rejection

� Frame Average

� TGC

� Maps

� Dynamic Range

� Gain

� Rotation

You can also take measurements post Stress Echo acquisition. 
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Analysis

Analysis consists of viewing previously saved loops and 
assigning scores to each cardiac segment, in order to quantify 
the function of the muscle or wall segment.

Depending on the protocol configuration, the analysis stage can 
start manually or automatically after completion of the stress 
test. In this case, the usual procedure consists of sequentially 
opening all image groups (if defined) and performing scoring 
from image to image.

The quad screen is the standard display for comparing heart 
cycles. The heart cycle loops in the display are synchronized to 
enable comparison. Each loop in the quad screen can be 
magnified, using the zoom control.

Image Selection for Analysis

Images can be selected manually or from a pre-defined group in 
the Protocol screen.

Selection of Images from a group

If groups of images have been defined in the protocol template, 
you can select a group of images for analysis and sequentially 
analyze all images from all groups from within the Analysis 
screen.

1. In a stress examination, press Template. A preview of the 
acquisition displays.

2. Press Analyze. A pre-defined group appears in the display 
with a Wall Segment window on the left. 

3. To advance to other groups, use the Trackball to move the 
cursor to the arrows at the bottom of the Wall Segment 
window. Select an arrow to advance to another group. For 
further clarification, see callout F in Figure 10-21. 
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Manual selection of images from Analysis screen

1. When currently in the protocol analysis screen in the Stress 
analysis quad screen, hold down the SHIFT key while 
performing Steps 2 through 4.

2. Use the Trackball to move the cursor to the first image to 
select in the template matrix.

3. Press Set. The frame of the selected loop is in the Stress 
analysis screen and the next window in the quad screen is 
automatically selected.

4. Repeat step 2 and 3 to select other images.

5. Depress SHIFT .

Manual selection of images in the Protocol screen

1. In a stress examination, press Template. A preview of the 
acquisition displays.

2. Use the Trackball to move the cursor to the first image to 
select.

3. Press Set. The frame of the selected loop highlights.

4. Repeat Steps 2 and 3 to select other images.

5. Press Analyze to open images in the Analysis screen.



Stress Echo (Option)

Versana Active � Basic User Manual 10-81
Direction 5840764-100 English Rev. 10

Scoring acquired loops

1. After image selection, press Analyze.

The Stress Echo analyze screen displays.

 Figure 10-21. Analysis Screen

a. Wall segment diagram

b. Selected loop (Highlighted frame)

c. Displayed loops (Highlighted frames)

d. Exit Wall motion scoring

e. Change page or enter next image group
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Scoring acquired loops  (continued)

2. Use the Trackball to move the cursor to a segment in one of 
the scoring diagrams and press Set.

The Score pop-up list displays.

3. Use the Trackball to move the cursor to a score.

4. Press Set.

The score displays in the relevant segment area in the 
diagram.

NOTE: To edit a score, select it and choose a new score.

5. Repeat step 1 through 3 to score relevant segments.

6. Press the Change Page arrow to display the next group of 
images.

7. Repeat step 1 through 3 to score relevant segments on the 
new loops.

Figure 10-22. Segment Scoring

NOTE: Since Cine changes into sync mode, subsequent scans are also 
synchronized. Exit sync mode from the Cine menu.
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Editing/Creating template

The stress package provides protocol templates for exercise as 
well as pharmacological stress examinations.

The user can create new templates or modify existing templates 
to suit the individual needs. Up to ten projections and fourteen 
stress levels can be created in a template.

Templates created may be temporary, used only during the 
current examination, or saved as new templates, for future use 
and reference.

The editions that may be performed include:

� Adding/Deleting levels and projections.

� Assigning new labels to levels and projections.

� Defining level options.

� Defining new groups.

Templates are edited/created from the Template editor screen.

Entering the Template editor screen

1. Press the user defined key for Stress echo.

2. Press Template.The template list displays.

3. Use the Trackball to select the Template Editor.

4. Press Set. The Template Editor screen displays.

OR

1. Press the user defined key for Stress echo.

2. Press Template Editor on the primary menu. The Template 
Editor screen displays.
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Template Editor screen overview

 Figure 10-23. Template Editor Screen

Table 10-4:  Template

Parameter Description

Template Select a pre-defined template from the pull-down menu. The protocol 
template preview updates accordingly.

Table 10-5:  Protocol Template Preview

Parameter Description

Protocol Template Preview � Displays an updated preview of the template accordingly to the settings 
applied.

� To change Projection and Stress level labels, select a pre-defined label 
from the pull-down menu or press Set in the actual label field and type a 
new name.
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Table 10-6:  Template Settings

Parameter Description

Template Settings � Cycles: select the number of cine loop heart cycles to store for each level 
from the pull-down menu or enter the desired value manually.

� Continuous Capture: Checking this parameter enables continuous image 
acquisition throughout the level. The images acquired are temporarily 
stored in the system�s storage buffer.

� Preview of store: Checking this parameter enables review and 
adjustment of cine loops before store.

� Show reference: Checking this parameter displays a dual screen with the 
reference level (first or previous level) on the left and the live image on 
the right.

Table 10-7:  Scan Mode

Parameter Description

Scan Modes � 2D, Color, PW (Pulsed Wave Doppler), CW (Continuous Wave Doppler), 
MM (M-Mode), Color MM, Color PW, Color CW

Table 10-8:  Other options

Parameter Description

Other Options � Grid Size: Enter the number of levels and projections for the selected 
template.

� Timers: If you check this parameter, starts T1 and T2 timers 
automatically.

� Auto-start analysis: If you check this parameter, displays the Stress Echo 
Analysis when the last acquisition is performed.

� Show Systole in Analysis: When selected, the systolic part of the cardiac 
or ECG cycle is only displayed. The whole cycle is not displayed. 

� Smart Stress: Check Smart Stress to store a subset of the image 
acquisition settings (e.g., Zoom, Gain, Compress, etc.) for each view in 
the protocol. Smart Stress enables you to set image acquisition settings 
for each view at a baseline level and automatically get the same image 
settings in the corresponding views in the next levels. 

� Reference image: When Show Reference is selected, selects either 
corresponding baseline loop or corresponding loop from the previous 
level to be displayed as reference image during acquisition.

Table 10-9:  Pre-defined groups

Parameter Description

Pre-defined groups � Shows the image groups created.
� New group: Creates a new image group. Select the desired images on 

the template preview.
� Update group: Edits a selected group after new loop selection on the 

template preview.
� Delete group: Deletes a selected group.
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Selecting a base template to edit

1. Select the base template from the template pull-down menu 
on the upper left corner.

2. Press Set.

The selected template displays in the protocol template 
preview field, showing the levels, projections and their 
labels.

Adding/Deleting levels and projections 

1. Enter the number of levels and projections in the Grid size 
field.

The new grid size displays in the protocol template preview 
field.

2. Press New Template to create a new template.

or

Press Save Template to update the base template.

Display timers

1. Check the box(es) to display timer(s) as specified.

NOTE: The timers can also be started or stopped at any time during 
stress examination by using the T1 and T2 Primary Menu 
key.

Start analysis automatically

1. Check Auto Start Analysis to display the Stress Echo 
Analysis screen when the last acquisition is performed.
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Smart Stress

1. Check Smart Stress to store and automatically reuse a 
subset of the image acquisition settings in the baseline level 
view in the corresponding views in the next levels. 

Configuring levels

The following options can be set up for each level:

Number of cycles to be stored in the cine loop:

1. Enter or select the desired number in the Cycles field.

Continuous Capture

1. Check Continuous Capture if continuous image acquisition 
throughout the level is desired.

When Continuous Capture is selected, preview of the cine 
loop and reference display during acquisition are not 
possible.

Preview of store

1. Check Preview of store if review and adjustment of cine 
loops before storage is desired.

Show reference

1. Check Show reference if the display of the corresponding 
reference loop is desired during acquisition (Dual screen 
mode).

Adding a group

1. In the Protocol template preview field, select the cells to be 
part of the group.

2. In the Pre-defined group field, press New group.

A dialogue box displays to ask the user to enter a name for 
the new group.

3. Enter the group name.

4. Press OK. The new group displays in the pre-defined group 
field.
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Updating an existing group

1. In the Pre-defined group field, select the group to edit.

The selected cells are highlighted in the Protocol template 
preview field.

NOTE: The selected group is highlighted by a Green frame.

2. Either select a new cell(s) to add to the group or deselect an 
existing cell(s) to remove from the group.

3. Press Update group.

The display in the Protocol template preview field is updated 
accordingly.

Deleting a group

1. In the Pre-defined group field, select the group to delete. 

NOTE: The selected group is highlighted by a Green frame.

2. Press Delete group.

The group is removed from the list in the pre-defined group 
field.

Specifying Scan Mode for each Projection

1. Specify the Scan Mode for each Projection: 2D (B-Mode), 
Color Flow Mode, M-Mode, Color M-Mode, PW Mode, Color 
PW Mode, CW Mode, or Color CW Mode. 
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Saving the Template

You can save the template using controls at the bottom of the 
Template Editor page, or use the controls on the primary menu. 

Table 10-10:  Template Editor Saving Options

Parameter Value

New Template Select this option to create an entirely new template. 

Save As Template If you would like to create a new template based on the existing template with 
your modifications, select to Save this Template As, and give it a name. 

Save Template Select this option to save the default template with your modifications. 

Delete Template Select this option to delete a template. 
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Wall Motion Segment Setup 

You can set up the following parameters for Wall Motion 
Segment in the Utility screen (Utility--> Measure--> Advanced--> 
Cardiac).

Figure 10-24. Cardiac Wall Motion Segment Setup

Table 10-11:  Wall Motion Segment Parameters

Parameter Value

WMS freeze loop at ES Specify to freeze the Loop at End Systole

WMS Segment Model Select 16 or 18 segments

WMS initial scoring Undefined or Normal

WMS scoring legend ASE, ASIA or European
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Utility Application Settings for Protocol

Figure 10-25. Protocol Setup 

Table 10-12:  Protocol Parameters

Parameter Description

Template Select the default template.
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Report

If you set up the Wall Motion Analysis field on the Report, you 
can insert the results. 

Select Report to view either the Bull�s Eye or Cut Plane Report. 

 Figure 10-26. Bull�s Eye Report Sample
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Report  (continued)

 Figure 10-27. Cut Planes Report Example

HINTS Select either Bull�s Eye or Cut Plane on the Reports--> Adult 
Template. 
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ECG Option

Overview

WARNING DO NOT USE the physiological traces of the Versana Active 
Ultrasound system for diagnosis and monitoring.

CAUTION � ECG electrodes should not make contact with other 
conductive parts, including earth.

� After the defibrillator stimulates the patient, the ECG needs 
4 to 5 seconds for recovery.

� The quality of the ECG trace depends on the stability and 
conductivity of the electrodes during the test, especially 
during high stages when the patient�s movements can 
cause artifacts.

� Make sure that the lead wires do not swing.

� The device is not waterproof. Do not expose the device to 
water or any kind of liquid. Maintain in a dry place:

� The exterior of the recorder may be wiped clean with a 
soft cloth. Do not use harsh cleaning agents to clean 
the unit. Do not immerse the unit in any liquid.

� Clean the cables with a hospital approved cleaning 
procedure such as those recommended by AAMI or 
AORN. Do not immerse cables in water.

� Worn or damaged patient cables are the most common 
cause of poor ECG signals. ECG signals (or wave 
patterns) that consistently contain noise or artifact may 
suggest need for ECG wire or cable replacement.

� Store the device in a dry place.

� Always protect the recorder from coming into contact 
with moisture. In rain or snow conditions, protect the 
recorder from bad weather elements by wearing the 
recorder inside a coat.
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ECG connecting

The ECG module is connected to the system via USB ports.

Figure 10-28. Connecting ECG to the system

ECG Trace Monitor Display
The scanned image is synchronized with the ECG trace. In 
Doppler or M-Mode, the traces are synchronized with that 
particular mode�s sweep.

The user can control the gain, position and sweep speed of the 
traces.

Figure 10-29. ECG Trace Display
1. ECG

2. Auto Heart Rate Display
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ECG menu

The ECG menu provides for control of the input signals.

Without the ECG option, the ECG menu is not displayed.

 Figure 10-30. ECG Primary Menu
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ECG menu  (continued)

Table 10-13:  ECG parameters

Parameter Description

Sweep Speed Change the speed of the trace. The sweep speed of the 
physio signal on the B-Mode image can be set independent of 
the timeline (Doppler and M-Mode) sweep speed.

ECG Trigger Enables intermittent imaging based on the ECG. The trigger 
location(s) relative to the R trigger are set with the Delay Time 
key.

� Press ECG Trigger and select one of the options (None, 
Trig1, Trig2, and Both) and adjust the delay time using the 
Delay Time key.

ECG Trig 1 specifies the delay (ms) from R-wave to triggered 
frame.
ECG Trig 2 specifies the delay from R-wave to second 
frame.
Both activates ECG Trig 1 and ECG Trig 2 simultaneously. 
Trig 2 must be greater than Trig 1 for dual triggering (Both) to 
be active.

ECG Display Provides the ability to turn on the ECG trace and Auto Heart 
Rate for display on the monitor.

ECG Trigger Period The control specifies the number of heart cycles (R-waves) 
that are skipped between ECG triggers. 

The default is 1 or no skipping.

Delay Time In ECG Trigger Mode: If only ECG Trig1 or ECG Trig2 is 
selected via the ECG Trigger key, the Delay Time key controls 
the R-Delay time of the active trigger. If both triggers are 
selected (Both), press this key to toggle ECG Trig1 and ECG 
Trig2 and rotate the key to change the delay time. Once the 
trigger is set, the snap shot image is displayed each time the 
update line passes the active trigger(s).

In Timer Trigger Mode: Adjusting the key changes the delay 
time between images.

ECG Gain/Position Allows for the amplitude control of the ECG trace or allows for 
the vertical positioning of the ECG trace on the image display.

Press the key to toggle between Gain and Position. The 
default is Gain.
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Chapter 11

Vascular

Describes how to perform Vascular measurements and 
calculations.
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Vascular Exam Preparation

Introduction

Measurements and calculations derived from ultrasound images 
are intended to supplement other clinical procedures available 
to the attending physician. The accuracy of measurements is not 
only determined by the system accuracy, but also by use of 
proper medical protocols by the user. When appropriate, be sure 
to note any protocols associated with a particular measurement 
or calculation. Formulas and databases used within the system 
software that are associated with specific investigators are so 
noted. Be sure to refer to the original article describing the 
investigator's recommended clinical procedures.

General Guidelines

Patient information must be entered before beginning an exam. 
See �Scanning a New Patient� on page 4-10 for more 
information.

Any measurement can be repeated by selecting that 
measurement again from the menu.
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Vascular Measurements

Introduction
Vascular measurements offer several different types of 
measurement studies:

 Figure 11-1. Vascular Exam Category
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Introduction  (continued)

� Generic � Common to all applications. See �Generic 
Measurements� on page 7-66 for more information.

� Carotid

� LEA (Lower Extremity Artery)

� LEV (Lower Extremity Vein)

� TCD (Trans Cranial Doppler)

� UEA (Upper Extremity Artery)

� UEV (Upper Extremity Vein)

� Renal

� Bypass Graft

� UEV (Upper Extremity Vein) Map

� LEV (Lower Extremity Vein) Map

To change an exam calc:

1. Press Second Menu on the primary menu.

2. To select another exam study, select the desired exam study 
folder.

A vascular study is a group of particular vessels. You can 
customize the vessel exam calcs in the configuration menu. See 
�Measurement and Calculation Setup� on page 7-13 for more 
information.

When you use Auto Vascular calculation, you use the vessel 
keys to post-assign vascular calculations. When you are not 
using Auto Vascular calculation, the vessel key is used for 
manual measurement.

IMT Measurement

You can measure the average of the intima media thickness for 
use as the index of arterial sclerosis. 

IMT can be measured both on the posterior and the anterior 
walls of the vessel.

NOTE: Due to the physical properties of ultrasound imaging, the 
posterior IMT measurement is generally more accurate than the 
anterior IMT measurement.
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IMT Measurement - Auto 

Auto IMT automatically measures the thickness of the Intima 
Media on the far and near vessel walls. Near Wall IMT is the 
distance between the trailing edges of the adventitia and intima; 
the Far Wall IMT is the distance between the leading edges of 
the adventitia and intima. 

Set up the parameters you want to record on the report on the 
Utility -> Measure -> M&A page while are in the Carotid 
application. Select CCA/ICA/BIF -> IMT Far/Near -> Parameter 
(Average, Max, Min., Standard Deviation, Points, or Distance). 

 Figure 11-2. Configuring Auto IMT
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IMT Measurement - Auto  (continued)

In the Vascular Carotid application, the Auto IMT measurement 
is available. 

Figure 11-3. Auto IMT menu

The following controls are available. 

Table 11-1:  Auto IMT description

Parameter Description

IMT Far Select to begin the Far Field IMT measurement. 

IMT Near Select to begin the Near Field IMT measurement. 

Length/Offset 
Rotary

Push to save Length/Offset as a preset. 
-40/+40 Length. At zero, you can freely adjust the length, but only vertically. 
Press key to save value as default.
Offset distance, -20 (Left) / +20 (Right)

Overall / IMT Trace 
Fit / Intima

Adjusts (re-measures) the IMT automatically measured by the system. 

Rt / Lt Side Select Left / Right Side. 

Cursor Select Allows you to update cursor placement. 
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IMT Measurement - Auto  (continued)

To measure the IMT,

1. In the Carotid application, press Freeze, press Measure. 

2. Select the appropriate IMT measurement. For example, If 
measuring the IMT of the far wall of the right common 
carotid artery, select Rt CCA folder, and then IMT Far. 

3. Use the Trackball to set the length. Or use the IMT Length 
/ IMT Offset control to set the length and offset distance. 
The Offset key controls how far away from the vertical line 
the measurement starts. Length is the length of the tool 
itself. If set to zero, you can adjust it anywhere on the image. 

4. Press Set. 

You can either adjust the trace prior to pressing P1 key or 
press P1 key to store the image which also saves the 
measurement to the Report.

To adjust the trace, use the IMT Overall control. The Trace 
fit (up/down) adjusts the inter luminal line whereas the 
overall (rotate) adjusts both IMT lines.

Figure 11-4. Example of Auto IMT Far Measurement
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IMT Measurement - Auto  (continued)

5. Position the cursor, then select IMT Near. 

6. Use the Trackball to set the length. Or use the Length / 
Offset control to set the length and offset distance.

7. Press Set. �Store image to accept IMT measurement� 
displays in the message area. If the traces fit both layers of 
the wall, approve the measurement by press the P1 key to 
store the image. 

To adjust the trace prior to pressing P1 key, use Cursor 
Select on the primary menu. The measurement is saved to 
the Report. 

NOTE: Since the IMT measurements are done semi-automatically, 
the operator has to approve the detection by visual 
inspection before storing the results in report.
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Auto Vascular Calculation Overview

Auto Vascular Calculation enables the Versana Active to detect 
and identify a cardiac cycle. It allows you to assign 
measurements and calculations during live timeline imaging, 
while the image is frozen, or in CINE. Peak values are detected 
for venous flow.

During cardiac cycle detection, the system identifies the cardiac 
cycle using calipers, vertical bars, and/or highlighting of timeline 
data. Use of identifiers is based on measurements and 
calculations selected by an operator for the current application. 
The system may place calipers at early systolic peak, peak 
systole, minimum diastole and end diastole. Vertical bars may 
also be placed to indicate the beginning and end of the cardiac 
cycle. The peak and/or mean trace may be highlighted. You can 
edit the cardiac cycle identified by the system or select a 
different cardiac cycle.

You can select the calculations to be displayed in the M&A 
Result window during live scanning or on a frozen image. These 
calculations are displayed at the top of M&A Result Window 
located adjacent to the image. These calculations are 
presettable by application which means you can set up the 
default calculations to be displayed for each application.
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Auto Vascular Calculation

Activating Auto Vascular Calculation

To activate Auto Vascular Calculation, select Auto Calc from 
Live (calculations displayed on the real-time image) or Freeze 
(calculations displayed on the frozen image).

To deactivate Auto Vascular calculation, select Off.

Setting up Auto Vascular Calculation Parameters

� Selecting Auto Trace

You can select to have a continuous auto trace of the max or 
mean velocities.

� Select Max or Mean from Trace Method in Utility -> 
Imaging -> PW page.

� Selecting Trace Direction

Trace Direction lets you use peak timeline data above, 
below, or composite (above and below) the baseline. 

� Select Above, Below, or Both to set the peak timeline 
data in Utility -> Imaging -> PW page.

� Modify Calculation

a. Press PW key on the control panel.  

b. Select Modify Auto Calcs on the primary menu. Or 
select Second Menu after pressing Measure key.  

The Modify Calculation menu is displayed. 

c. Select which measurements and calculations are to be 
displayed in the Auto Vascular calculation window.

You can select the following parameter: PS, ED, MD, 
HR, TAMAX, PI, RI, Accel, PS/ED, ED/PS, AT, Volume 
Flow, PV.



Vascular Measurements

Versana Active � Basic User Manual 11-11
Direction 5840764-100 English Rev. 10

Auto Vascular Calculation  (continued)

Auto Vascular Calculation Exam

1. Preset the system.

2. Perform the scan and press Freeze.

3. Activate Auto Vascular Calculation.

The system performs a calculation automatically.

 Figure 11-5. Auto Vascular Calculation
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Auto Vascular Calculation Exam  (continued)

The Auto Vascular calculation is assigned to particular vessel 
measurements.

1. Press Measure to display the Measurement menu.

2. Select the location of the vessel (Prox, Mid, or Dist) and 
Side (Right or Left).

3. Select the desired vessel name from the menu. 

Selected vessel measurements are automatically assigned 
with the Auto Vascular calculation. The results are then 
displayed in the Results Window.

 Figure 11-6. Assigned Vessel

NOTE: When you want to cancel the assignment, you can use the 
Cancel Transfer. See �Cancel Transfer� on page 7-81 for more 
information.
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Auto Vascular Calculation  (continued)

During the course of an exam, the cardiac cycle may be 
indicated between two yellow bars; the peak trace and the mean 
trace may appear in green; calculation indicators appear on the 
spectral trace as a caliper identifier (these vary, depending on 
the selected calculation in the Results Window). 

The right-most, most complete cycle is typically chosen to be the 
selected cardiac cycle. You can select a different cardiac cycle. 

To select a different cardiac cycle:

� Move through CINE memory with the Trackball until the 
desired cardiac cycle is selected by the system.

NOTE: You need several good cycles in front of the new cardiac 
cycle for this to be successful. Oftentimes, this is 
problematic near a freeze bar.

� Use the Cycle Select control to cycle to a different cardiac 
cycle.

NOTE: You need several good cycles in front of the new cardiac cycle 
for this to be successful. Oftentimes, this is problematic near a 
freeze bar.

To move the systole or diastole position:

� Use the Cursor Select control to move the start systole 
position or the end diastole position.
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Manual Vascular Calculation

You can perform the following calculations manually when Auto 
Doppler Calculation is not activated.

1. Press Measure.

If necessary, you can select another Exam Calc and then 
select parameters from Modify Calculation.

2. Select the location of the vessel (Prox, Mid, or Dist) and 
Side (Right or Left).

3. Select the desired vessel folder.

The Measurement menu is displayed.

Figure 11-7. Measurement Menu Example

4. Make the required measurements according to the system, 
or select your preferred measurements.
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Manual Vascular Calculation  (continued)

For each vessel in Doppler mode, you can make any of the 
following measurements. See �Doppler Mode Measurements� on 
page 7-80 for more information.:

� Peak Systole (PS)

� End Diastole (ED)

� Minimum Diastole (MD)

� Heart Rate

� TAMAX

� TAMEAN

� Pulsatility Index (PI)

� Resistive Index (RI)

� S/D Ratio

� D/S Ratio

� Acceleration (Accel)

� Acceleration Time (AT)

� Volume Flow

� Peak Value (PV)
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To select vascular measurements

Your system is set up to show the measurements that you 
usually make for each vessel. To make a measurement that is 
not shown for the selected vessel:

1. Select the folder you want to measure.

 Figure 11-8. Aorta folder - example

2. The system displays all possible vessel measurements.
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To select vascular measurements  (continued)

3. Select the desired measurement.

 Figure 11-9. Vascular Measurements

NOTE: The following instructions assume that you first scan the patient 
and then press Freeze.
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Naming format for vessels

When you want to measure a vessel, you select the folder for 
the vessel. Many vessel folders are labeled with an 
abbreviation. The following table lists abbreviations used for 
naming vascular vessels. 

Table 11-2:  Vascular Vessel Abbreviations

Acronym Name

ACA Anterior Cerebral Artery

AComA Anterior Communicating Artery

ATA Anterior Tibial Artery

ATV Anterior Tibial Vein

Axill Axillary Artery

Axill V Axillary Vein

BA Basilar Artery or Brachial Artery

Ba V Basilic Vein

Br V Brachial Vein

CCA Common Carotid Artery

Ceph V Cephalic Vein

CFV Common Femoral Vein

CHA Common Hepatic Artery

Com Femoral Common Femoral Artery

CIA Common Iliac Artery

CIV Common Iliac Vein

Com Iliac A Common Iliac Artery

DFA Deep Femoral Artery

DFV Deep Femoral Vein

Dors Pedis Dorsalis Pedis

DPA Dorsalis Pedis Artery

ECA Exterior Carotid Artery

EIA External Iliac Artery

EIV External Iliac Vein

FV Femoral Vein

GSV Greater Saphenous Vein



Vascular Measurements

Versana Active � Basic User Manual 11-19
Direction 5840764-100 English Rev. 10

ICA Internal Carotid Artery (Transcranial Doppler)

ICA Interior Carotid Artery (Carotid Artery)

IJV Internal Jugular Vein

IMA Inferior Mesenteric Artery

Inn Innominate

IVC Inferior Vena Cava

LSV Lesser Saphenous Vein

MCA Middle Cerebral Artery

Mcub V Median Cubital Vein

Mid Hep V Middle Hepatic Vein

MRA Main Renal Artery

PCA Posterior Cerebral Artery

PComA Posterior Communicating Artery

Peron Peroneal

POP Popliteal

PTA Posterior Tibial Artery

PTV Posterior Tibial Vein

RA Radial Artery

SMA Superior Mesenteric Artery

SMV Superior Mesenteric Vein

SUBC Subclavian Artery

SUBC V Subclavian Vein

SFA Superficial Femoral Artery

TCD Transcranial Doppler

TIPS Transjugular Intrahepatic Portosystemic Shunt

UA Ulnar Artery

VERT Vertebral Artery

Table 11-2:  Vascular Vessel Abbreviations

Acronym Name



Vascular

11-20 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10

Vascular Worksheet

Overview
The vascular report is structured to automatically display 
vascular measurements made at specific anatomical sites. The 
report can also display an average, last, maximum, or minimum 
value of the latest three measurements. Calculated ratios are 
automatically summarized and displayed.

To view the Vascular Worksheett
1. Press Measure.

2. Select Report.

The system displays the report.

Figure 11-10. Vascular Worksheet - Example
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To view the Vascular Worksheett  (continued)

Only measured parameters are displayed. Location information 
is labeled with vessel name first. Measured parameters of the 
vessel are grouped under the vessel label.

Selected value by method is highlighted, however, when the 
average method is selected, the highlighted cursor is removed.

When an entire vessel measurement does not have sides (left or 
right), the side label is not displayed in that vessel study report.

HINTS Some fields on the report are view only, and others you can 
change or select. To easily see which fields you can change or 
select, move the Trackball. As the cursor moves over a field 
that you can change or select, the field is highlighted.
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Report Display

1. Generic: Select this key to display the Generic Report. 
Generic study measurements/calculations, such as volume 
and velocity, are displayed on this report.

2. Vessel: Select this key to display the Vessel Report.

Values can be edited from this page.

3. Summary: Select this key to display the Vessel Summary.

4. Comments: Select this key to display the Examiner�s 
comment window. See �To edit a worksheet� on page 7-62 
for more information.

5. Delete Value: Use to delete a value (each measurement 
value). See �To edit a worksheet� on page 11-23 for more 
information.

6. Exclude Value: Use to exclude a value from the result line. 
See �To edit a worksheet� on page 11-23 for more 
information.

7. Intravessel Ratio: Select this key to display the Intravessel 
Ratio Calculation window. See �Intravessel ratio� on 
page 11-28 for more information.

8. Page Change: If a report has more data, to view the next 
page, adjust the Page Change control.
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To edit a worksheet

To change data on a report:

1. Press Report.

2. To position the cursor at the field you want to change, move 
the Trackball.

Press Set. The field is highlighted.

3. Type the new data in the field and move the cursor to 
another place. Press Set. The new data is displayed in blue 
and asterisk are appended to value and resultant value to 
indicate that it was manually entered. 

The average measurements, calculations and ratios are 
automatically updated to reflect the edited values.

 Figure 11-11. Display of the edited value

NOTE: If the user moves the cursor to the edited value and presses the 
Set key once, the value returns to the original value before the 
edit.
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To edit a worksheet  (continued)

To delete data: 

1. Select Report.

2. To position the cursor at the field you want to delete or 
exclude, move the Trackball.

The field is highlighted.

3. Select Delete Value from the primary menu.

For Example:

1. If the user measured RI 4 times, however, latest 3 sets of 
measurements were displayed in the report.

1. Then, the user deleted PS value of #3 from the report.

2. The whole set of #3 measurements is deleted from the 
report and #1 set of measurements is shifted and displayed 
as below.

Table 11-3:  Example of Latest Measurements in Report

Result Number #2 #3 #4

PS 0.500 0.600 0.700

ED 0.100 0.200 0.300

RI 0.800 0.667 0.571

Table 11-4:  Example of Report after Value Deleted

Result Number #1 #2 #4

PS 0.400 0.500 0.700

ED 0.000 0.100 0.300

RI 1.000 0.800 0.571
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To edit a worksheet  (continued)

To exclude data: 

When the user selects a particular value on the Report and 
selects Exclude Value, this value is excluded from result line 
and resultant value is re-calculated without this value and also 
calculation values using this value is �blank�.

1. Select Vessel Worksheet.

2. To position the cursor at the field you want to delete or 
exclude, move the Trackball.

Press Set. The field is highlighted.

3. Select Exclude Value from the primary menu.

4. The data in the field is not visible and is not included in 
report calculations as below.

5. To add back in a previously excluded value:

Select Exclude Value from the primary menu. The value(s) 
are now visible and included in the report calculations.

 Figure 11-12. Display of the excluded value
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To edit a worksheet  (continued)

The user can select the method for calculating the cumulative 
value.

This value is only calculated by using displaying values. If the 
user takes parameters more than 3 times, the last 3 values are 
used for this calculation.

1. Move cursor to method column and press Set. 

2. The pull-down menu is displayed. Move the cursor to any 
one of methods and press Set. The selected method is 
displayed in the column.

Figure 11-13. Pop-up menu of methods
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Examiner�s Comments

To type a comment on a report:

1. Select Comments on the report screen.

2. Type comments about the exam.

3. To close the Examiner�s Comments window, select Report 
Preview. The comments appear on the report.

 Figure 11-14. Examiner�s comments field
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Intravessel ratio

To calculate Intravessel ratio, you need a measurement of 
assessing pressure and stenotic velocities.

1. Select Intrav. Ratio to display the pop-up window in the 
header section of the report.

 Figure 11-15. Intravessel Pop-up Window

2. Select the first velocity. 

The value is displayed in the window.

 Figure 11-16. Intravessel ratio one
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Intravessel ratio  (continued)

3. Select the second velocity.

The second value and Result value are displayed in the 
window.

 Figure 11-17. Intravessel ratio two

� To save the Intravessel ratio to the Vessel Summary, move 
the cursor to Save and press Set.

� To clear values, move the cursor to Clear and press Set.

� To cancel and exit Intravessel ratio, move the cursor to 
Cancel and press Set.

NOTE: Intravessel Ratio is only displayed and saved in the Vessel 
Summary as Intra-Ratio.
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Vessel Summary

The Summary is designed to automatically display 
measurements made at specific anatomical sites. Calculated 
ratios are automatically summarized and displayed.

The Summary can be displayed at any time during the exam by 
selecting Summary from the Vascular report menu.

 Figure 11-18. Vessel Summary - Example
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Vessel Summary  (continued)

1. The first row, indicating Right or Left, is not displayed when 
the side is not defined in the vessel. In the third column on 
the second line, you select the calculations. Move the cursor 
to the third column, and the pop-up menu is displayed. The 
selected parameter is displayed in every third column.

 Figure 11-19. Pop-up menu

2. Vessel Name with location information.

3. Check Box. Use to select the vessel velocity for calculating 
the vessel ratio (ex. ICA/CCA). You can only select one 
location (position) in a vessel.

4. Result value column. This value cannot be changed or 
excluded from this page.

5. Calculation name and result. ICA/CCA: The ICA/CCA ratio 
selects the highest systolic ICA and CCA velocities when 
calculating this ratio, and displays the velocities.
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Carotid Study

In the configuration page for ICA/CCA ratio, you can specify 
which portion of the CCA vessel (Prox, mid, distal) is chosen. 
You can override the selections on the Vessel summary.

The ICA/CCA ratio is able to be configured for either systole or 
diastole.

The vertebral vessel also has systole and diastole selections. In 
the summary page, there is a box to select flow reversal for 
vertebral flows. The choices are Ante (Antegrade), Retr 
(Retrograde), and Abs (Absent).

To select the method: 

Move cursor to the box and press Set. After the pop-up menu 
(Blank, Ante, Retr, Abs) is displayed, select from a menu of 
choices. The selected choice is displayed in the column.

The box is independent of Left and Right.

Renal Artery Study

For renal arteries, you can calculate RENAL/AORTIC ratio 
(RAR) based on peak systolic velocities. 

You can combine the two renal summary pages, and have a 
heading to separate the different measurements (main renal, 
intra renal). You can scroll between the measurements. The 
most commonly used, the main renal artery, is the default.

Lower Extremity Artery Study

For the lower extremity artery, you need an intra vessel ratio 
(assessing pre vs. stenotic velocities). You can specify which 
(ratio is stenotic/pre).

The intra-vessel ratio needs to be available for all vascular 
measurements. This appears on the report only if used.
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Recording Worksheet

The report can be saved as you would any ultrasound image. 
Once it is displayed on the screen, it can be recorded on the 
DVR, printed on the B/W printer, stored on media with the Image 
Archive option.



Vascular

11-34 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10



Versana Active � Basic User Manual 12-1
Direction 5840764-100 English Rev. 10

Chapter 12

Urology

Describes how to perform Urology measurements and 
calculations.
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Urology Exam Preparation

Introduction

Measurements and calculations derived from ultrasound images 
are intended to supplement other clinical procedures available 
to the attending physician. The accuracy of measurements is not 
only determined by the system accuracy, but also by use of 
proper medical protocols by the user. When appropriate, be sure 
to note any protocols associated with a particular measurement 
or calculation. Formulas and databases used within the system 
software that are associated with specific investigators are so 
noted. Be sure to refer to the original article describing the 
investigator's recommended clinical procedures.

General Guidelines

New Patient information must be entered before beginning an 
exam. See �Beginning an Exam� on page 4-2 for more 
information.

Any measurement can be repeated by selecting that 
measurement again.

The system retains all measurements, but the report retains only 
the last six measurements of each type.
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Urology Calculations

Introduction

Urology measurements offer three different types of 
measurement studies:

� Generic�Common to all applications. See �Generic 
Measurements� on page 7-66 for more information.

� Urology

� This chapter describes Urology B-Mode measurements.

� The Urology M-Mode measurements are common to 
other applications. See �M-Mode Measurements� on 
page 7-77 for more information. 

� The Urology Doppler measurements are common to 
other applications. See �Doppler Mode Measurements� 
on page 7-80 for more information.

� Pelvic Floor. See �Pelvic Floor Measurements� on 
page 12-10 for more information.

To change a study:

1. Press the Second Menu button, the Urology exam category 
menu is displayed.

2. To select another study, select the desired study.
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Urology B-Mode Measurements

In B-Mode, the Generic Exam Calcs for Urology includes the 
following measurements:

� % Stenosis

� Volume

� Angle

� A/B Ratio

See �B-Mode Measurements� on page 7-68 for more 
information.

The following measurements are located specifically in the 
Urology Exam Calcs. Those specific measurements (Bladder 
Volume, Prostate Volume and Renal Volume) are listed on the 
following pages.

Press Measure key. Then select the Second Menu button, the 
following category is displayed. 

Figure 12-1. Urology Exam Calcs B-Mode 

NOTE: Bladder(0.7) Vol, Bladder Vol, Post Void Vol, Prostate Vol, Renal 
Vol, Renal (0.8) Vol and Volume can be displayed if preset at the 
Utility -> Measure screen.
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Bladder Volume

This calculation uses a standard distance measurement. Length 
is typically measured in the sagittal plane. Width and height are 
measured in the axial plane.

Figure 12-2. Bladder Volume

To measure Bladder Volume:

1. Scan the patient in the appropriate scan plane. 

2. Select the Bladder folder, an active caliper displays.

3. Perform a standard distance measurement. 

The system displays the distance value in the Results 
Window.

4. To make the second and third distance measurement, 
repeat steps 2�3. 

After you complete the third distance measurement, the 
system displays the bladder volume in the Results Window.
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Prostate Volume

This calculation uses a standard distance measurement. Length 
is typically measured in the sagittal plane. Width and height are 
measured in the axial plane.

Figure 12-3. Prostate Volume

To measure Prostate Volume:

1. Scan the patient in the appropriate scan plane. 

2. Select the Prostate folder, an active caliper displays.

3. Perform a standard distance measurement. 

The system displays the distance value in the Results 
Window.

4. To make the second and third distance measurement, 
repeat steps 2�3. 

After you complete the third distance measurement, the 
system displays the prostate volume in the Results Window.
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Prostate Volume  (continued)

PSA Measurement

If you enter the value of PSA (Prostatic Specific Antigen) and 
PPSA Coefficient at the Urology Patient screen, PSAD and 
PPSA are automatically calculated.

The values are displayed on the Report (if set appropriately on 
the Report Designer page).

Figure 12-4. Urology Patient Screen
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Prostate Volume  (continued)

Figure 12-5. Measurement result window

PSAD: Prostatic Specific Antigen (PSA) Density � defined as: 
PSAD = PSA/Volume

PPSA: Predicted Prostate Specific Antigen � defined as: PPSA 
= Volume x PPSA Coefficient 

Report

� For the prostate volume calculation, you can select the 
method �m1, m2...� in addition to Avg., Max., Min. and Last.

� The value of PSA and PPSA are displayed.

 Figure 12-6. Urology Report
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Renal Volume

This calculation uses a standard distance measurement. Length 
is typically measured in the sagittal plane. Width and height are 
measured in the axial plane.

Figure 12-7. Renal Volume

To measure Renal Volume:

1. Scan the patient in the appropriate scan plane. 

2. Select Side.

3. Select the Renal folder, an active caliper displays.

4. Perform a standard distance measurement: 

The system displays the distance value in the Results 
Window.

5. To make the second and third distance measurement, 
repeat steps 2�3. 

After you complete the third distance measurement, the 
system displays the renal volume in the Results Window.
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Pelvic Floor Measurements

Pelvic floor measurements can be performed in the Pelvic Floor 
study. The measurements are located in the Exam Calc folder in 
the Urology preset. 

Figure 12-8. Pelvic Floor Measurements

Bladder Neck Rest

Obtain an image with the patient at rest (relaxed).

1. Create a straight line (zero or baseline) to line up with the 
inferior/posterior of symphysis pubis bone.

2. Once the baseline is positioned, a caliper appears. Position 
the caliper at the anterior margin of the bladder neck. A 
positive number displays since the caliper is placed below 
the baseline.

3. A distance is calculated in millimeters.
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Pelvic Floor Measurements  (continued)

Bladder Neck Stress

Obtain an image after the patient performs the Valsalva 
maneuver.

1. Create a straight line (zero or baseline) to line up with the 
inferior/posterior of symphysis pubis bone.

2. Once the baseline is positioned, a caliper appears. Position 
the caliper at the anterior margin of the bladder neck. 

If the bladder neck is below the baseline, the Bladder Neck 
Stress is a positive number. If the bladder neck is above the 
baseline (closer to the transducer face), the number is 
negative.

Bladder Neck Descent (BND)

The Bladder Neck Descent is a calculation that should be 
calculated after measuring the Bladder Neck Rest and Bladder 
Neck Stress. 

BND = Bladder Neck Rest - Bladder Neck Stress

NOTE: If the Bladder Neck Stress is a negative number, it becomes 
positive and is added to the bladder neck rest measurement.

Detrusor Wall Thickening (DWT)

Three distance measurements of the bladder wall dome are 
calculated into a mean dimension and displayed in millimeters.

Uterine Descent Max

1. Create a straight line (zero or baseline) to line up with the 
inferior/posterior margin of symphysis pubis bone.

2. Measure using a 2-caliper dimension to the inferior position 
of the uterus in a stress image and display in millimeters
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Pelvic Floor Measurements  (continued)

Rectal Ampulla Descent Max

1. Create a straight line (zero or baseline) to line up with the 
inferior/posterior margin of symphysis pubis bone.

2. Measure using a 2-caliper dimension to the inferior position 
of the rectal ampulla in a stress image and displayed in 
millimeters

Rectocele Depth

Two 2-caliper diameter measurements to measure depth and 
width of the rectocele. Displayed in millimeters.

Levator Hiatus Stress

Two 2-caliper diameter measurements and calculate an area 
displayed as cm squared.

Residual Urine

Two 2-caliper diameter measurements calculate as: (x) times (y) 
times 5.9 minus 14.9 equals Residual Volume displayed in ml.
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Auto Bladder Volume Measurement (Whizz On)

Auto Bladder Volume automatically measures the Bladder 
Volume. It�s main application is to measure three longest 
orthogonal lines (L, H and W) from two bladder slices.

It provides �Auto Bladder LxH� and �Auto Bladder W� to take L, 
H and W values, then automatically calculate the Bladder 
Volume.

Set up the parameters you want to record on the report in 
Utility -> Measure -> M&A page -> Select the Auto Bladder 
Volume Tool.

The following controls are available. 

Table 12-1:  Auto Bladder Volume description

Parameter Description

L L value from bladder slice.

H H value from bladder slice.

W W value from the bladder slice.

Vol Bladder volume calue calculated by 0.7xLxHxW or 0.5xLxHxW.
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Auto Bladder Volume Measurement (Whizz On)  (continued)

To measure the bladder volume while whizz is turned on:

1. Select Bladder application.

2. Enter Utility -> Whizz -> Whizz page, check Preset as 
Bladder and select Auto IQ Optimization, Auto 
Measurement and Auto Annotation.

Figure 12-9. Utility -> Whizz -> Whizz page

3. Press Whizz key on the control panel to turn on Whizz.

Figure 12-10. Whizz On



Urology Calculations

Versana Active � Basic User Manual 12-15
Direction 5840764-100 English Rev. 10

Auto Bladder Volume Measurement (Whizz On)  (continued)

4. Activate the M&A package, press Measure. 

5. Auto Bladder(0.7) is selected automatically. If user wants to 
select Auto Bladder(0.5), press Return to continue. 

6. Place the caliper anywhere outside the bladder and position 
it. Press Set.

7. The first caliper is anchored in place and rectangle appears, 
free to adjust.

Move the second caliper to the right or to the left to generate 
a dotted rectangle connecting the two cursors.

8. Press Set and complete the measurement. Annotation of 
Bladder will appear automatically in the screen.

 Figure 12-11. Auto bladder L & H
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Auto Bladder Volume Measurement (Whizz On)  (continued)

 Figure 12-12. Auto Bladder Width

9. After a measurement, the length of lines are displayed in the 
result window as �Bladder L/H/W and Bladder Vol�.

10. User could select and adjust the calipers of lines by �Cursor 
Select�.

NOTE: Do not select the region of interest including many 
non-bladder area. Do not select the region of interest inside 
the bladder area.

NOTE: The accuracy for auto bladder volume measurement is 
±30%.
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Chapter 13

Pediatrics

Describes how to perform Pediatrics measurements 
and calculations.
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Pediatrics Exam Preparation

Introduction

Measurements and calculations derived from ultrasound images 
are intended to supplement other clinical procedures available 
to the attending physician. The accuracy of measurements is not 
only determined by the system accuracy, but also by use of 
proper medical protocols by the user. When appropriate, be sure 
to note any protocols associated with a particular measurement 
or calculation. Formulas and databases used within the system 
software that are associated with specific investigators are so 
noted. Be sure to refer to the original article describing the 
investigator's recommended clinical procedures.

General Guidelines

New Patient information must be entered before beginning an 
exam. See �Beginning an Exam� on page 4-2 for more 
information.

Any measurement can be repeated by selecting that 
measurement again.

The system retains all measurements, but the report retains only 
the last six measurements of each type.

The six report measurements can be averaged and the average 
used in other calculations.
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Pediatrics Calculations

Overview

Pediatrics measurements offer two different types of 
measurement studies:

� Generic. The Generic Calculations study is common to all 
applications. See �Generic Measurements� on page 7-66 for 
more information.

� Pediatric Hip (PedHip). 

� This chapter describes Pediatrics B-Mode 
measurements.

� The Pediatrics M-Mode measurements are common to 
other applications. See �M-Mode Measurements� on 
page 7-77 for more information. 

� The Pediatrics Doppler measurements are common to 
other applications. See �Doppler Mode Measurements� 
on page 7-80 for more information.

 Figure 13-1.  Pediatrics Exam Category
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Pediatrics

 Figure 13-2. Pediatrics B-Mode Measurement 



Pediatrics Calculations

Versana Active � Basic User Manual 13-5
Direction 5840764-100 English Rev. 10

Hip Dysplasia Measurement

The HIP calculation assists in assessing the development of the 
infant hip. In this calculation, three straight lines are 
superimposed on the image and aligned with the anatomical 
features. The two angles are computed, displayed, and can be 
used by the physician in making a diagnosis.

The three lines are:1

1. The baseline connects the osseous acetabulum convexity to 
the point where the joint capsule and the perichondrium 
unite with the iliac bone.

2. The inclination line connects the osseous convexity to 
labrum acetabulare.

3. The Acetabulum roof line connects the lower edge of the 
osilium to the osseous convexity.

The  (Alpha) angle is the supplement of the angle between 1 
and 3. It characterizes the osseous convexity. The  (Beta) 
angle is the angle between lines 1 and 2. It characterizes the 
bone supplementing additional roofing by the cartilaginous 
convexity.

Figure 13-3. Hip Dysplasia 

1Source: R GRAF, journal of Pediatric Orthopedics, 4: 
735-740(1984)

Anatomical Landmarks

a. Ilium d. Bony Roof

b. Iliac Bone e. Cartilaginous acetabular roof

c. Labrum f. Femoral Head
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Hip Dysplasia Measurement (continued)

To make a Hip Dysplasia measurement: 

1. Select either the right or left side (orientation) and then 
select HIP. 

A horizontal dotted line displays. 

2. To place the baseline, move the Trackball. Position the 
crosshairs edge at the osseous convexity of the ilium.

3. To rotate or change inclination, adjust the Ellipse control or 
Hip Rotate. 

4. To fix the baseline, press Set. 

The system displays a second dotted line at an angle.

5. To place the line along the inclination line of the osseous 
convexity to labrum acetabulare, move the Trackball. 

6. To rotate or change inclination, adjust the Ellipse control or 
Hip Rotate. 

7. To fix the second measurement line, press Set.

The system displays a third dotted line at an angle.

8. To place the caliper along the acetabular roof line, move the 
Trackball. 

9. To rotate or change inclination, adjust the Ellipse control or 
Hip Rotate. 

10. To fix the third measurement line and complete 
measurement, press Set. 

The system displays the hip measurements (  and ) in the 
Results Window.
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Alpha HIP

The Alpha HIP measurement measures the angle between the 
iliac baseline and the bony roof line. To make an Alpha HIP 
measurement: 

1. Select either the right or left side (orientation) and then 
select Alpha HIP. 

A horizontal dotted line displays. 

2. To place the baseline, move the Trackball. Position the 
crosshairs edge at the osseous convexity of the ilium.

3. To rotate or change inclination, adjust the Ellipse control or 
Hip Rotate.

4. To fix the baseline, press Set. 

The system displays a second dotted line at an angle. 

5. To place the caliper along the acetabular roof line, move the 
Trackball.

6. To rotate or change inclination, adjust the Ellipse control or 
Hip Rotate. 

7. To fix the second measurement line, press Set. 

The system displays the alpha hip measurement ( ) in the 
Results Window.
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d:D Ratio Measurement

The d:D Ratio measurement measures the percentage of the 
femoral head coverage under the bony roof. To make this 
measurement:

1. Select either the right or left side (orientation) and then 
select d:D Ratio. 

A horizontal dotted line displays. 

2. Use the Trackball to place the baseline along the ilium. 
Position the crosshairs edge at the osseous convexity of the 
ilium.

3. Use the Ellipse control to adjust or change inclination or Hip 
Rotate. 

4. Press Set to fix the baseline. 

5. The system displays a circle representing the femoral head. 
Use the Trackball to position the circle.

6. Use the Ellipse control to size the femoral head 
circumference.

7. Press Set to fix the femoral head circumference. 

The system displays the d:D ratio for the femoral head in the 
Results Window.
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Chapter 14

ReportWriter

Describes how to generate reports.
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Standard Report Pages

Introduction

The Versana Active enables the generation of patient reports 
based on the examination performed and the analyses that were 
made during the exam. The reports are generated using the 
data stored in the system with pre-selected template.

You may edit a report while performing the exam; customize, 
delete, or add measurements; and save changes until you use 
the Store command. Once Stored, the reports are read-only.

It is recommended that the data be saved often, and then 
carefully reviewed before the report is Stored. Use the 
worksheet to facilitate the review and adjust data before storing 
a report. The final report can be printed on a standard printer.
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Creating a report

Reports summarize the data obtained in the examination. They 
can contain data, images, and cine loops.

Once generated, the report can be viewed, images can be 
added, and the patient�s personal data can be modified. The 
examination data itself CANNOT be changed.

 Figure 14-1. Report Example
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Activating the Report

1. Select Report on the keyboard. 

2. Select Report Preview. 

Figure 14-2. Report Menu Display Example

3. The system displays the default report for the current 
application on the monitor. 

The information entered during the examination is 
automatically filled in the appropriate fields (e.g. 
demographic, diagnosis, comments).

The preview image appears when the cursor is over the 
clipboard image.
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Activating the Report  (continued)

4. Adjust the Page Change control to move down the page.

 Figure 14-3. Worksheet Page Example

Table 14-1:  Report Button Controls

Button Description

Page Change Changes to another page of the report.

Save As Exports the report page to storage media as CHM or PDF format. 

Designer Accesses template editor screen.

Template Selects templates from the list of selected applications.

Store Stores the report page into Archive as CHM file.

Retrieve Retrieves the report page from Archive.
Stored Date/Time is appended to the name of stored report.

Print Prints out the report to the default printer.

Delete Deletes the report page from Archive.

Worksheet Accesses Worksheet Page.

Graph Accesses OB Graph page (applies only to OB).

Anatomical Page Accesses Anatomical Survey page (applies only to OB).

*CHM is a compressed HTML help file.
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Selecting another template

You can select another template for the current patient:

1. Select TEMPLATE on the primary menu at the bottom of the 
monitor display.

2. A list of available templates and exam categories displays.

Figure 14-4. Application List Example
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Selecting another template  (continued)

3. Select the desired template using the Trackball and press 
Set.

The selected template displays on the monitor.

NOTE: If you select another exam category, the template list of the 
selected category displays. Select the desired template.

Figure 14-5. Available Template list

4. Select the desired template name and press Set.

5. The report changes to the selected template.
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Factory Templates

The system has factory templates for each application. You can 
modify these templates or create user-defined templates. You 
need to save revised/new templates with unique names. 

A template may include one or more of the following:

� Measurements

� Worksheet or Vessel Summary Images

� Anatomical Surveys or Biophysical Profiles

� Anatomical Graphics

� Graphs

� Images areas

� Score Boxes

NOTE: Additional factory templates can be added from the 
Utility-->Reports menu (OB for multiple gestation, Renal, etc.). 
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Editing a Report

NOTE: It is recommended that the user DO NOT use the special 
characters like !, @, #, $, %, ^, &, *, (, ), |, :, ;, <, >, ?, /, ~, [,], {, }, 
in the report. When these characters are entered into a report, 
the characters may be deleted.

Entering the hospital address

When using a factory template, the area for the hospital 
information is usually placed in the upper portion of the report.

To make a new area, See �Fixed Text� on page 14-52 for more 
information.

To modify the factory template:

1. Select Report on the control panel.

2. Select Report Review.

3. Select Designer.

4. Double-click on the area for the hospital information in the 
template. The Fixed Text dialogue box displays.
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Entering the hospital address  (continued)

 Figure 14-6. Fixed Text Dialogue Box

5. Make changes as necessary.

a. Enter the hospital address in the text area.

b. Modify Box Properties (box width, box border line width, 
text align, box height, box left margin, and font).

6. Select OK.
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Entering the hospital address  (continued)

7. Save the template.

To keep the same template name:

� Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

� Select Yes. The template retains the same name and 
appends �[user]�. For example, OB23-Basic[user]. 

To save the template with a new name:

� Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

� Enter the name of the new template, and press Set. The 
template receives the new name and appends �[user]�. 
For example, NewReport[user].

8. Exit the Report Designer. The report with the hospital 
address displays.
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Inserting the hospital logo

When using a factory template, the area for the logo is usually 
placed in the upper left portion of the report.

To make a new area, See �Fixed Text� on page 14-52 for more 
information. 

To modify the factory template:

1. Save the preferred hospital logo in either a jpeg or bmp 
format on the removable media.

NOTE: Label the logo with a unique name (e.g. 
HospitalNameLogo.bmp). If the different logo is printed on 
the report, rename the logo image you want to use and 
insert it into the report template again.

2. Insert the removable media.

3. Select Report on the control panel.

4. Select Designer.

5. Double-click logo box at the left top so that the frame is 
highlighted. The logo box displays.

Figure 14-7. Logo Box
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Inserting the hospital logo  (continued)

6. Select Import Logo (1). Select the removable media first and 
then the hospital logo.

7. Select OK. The hospital logo displays in the logo list (2). 
Click the logo to select.

NOTE: Scroll the logo list using the left/right arrow key (3).

8. Modify Appearance (4).

9. Select OK.

10. Save the template.

To keep the same template name:

� Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

� Select Yes. The template retains the same name and 
adds �[user]�. For example, OB23-Basic[user]. 

To save the template with a new name:

� Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

� Enter the name of the new template, and press Set. The 
template receives the new name and adds �[user]�. For 
example, NewReport[user].

11. Exit the Report Designer. The template with the hospital 
logo displays.

NOTE: If a different logo prints on the report, rename the logo image 
which you want on the report and insert it into the report 
template again.
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Changing the Archive Information

When using a factory template, the Archive Information is 
usually placed below the hospital name and logo. 

The contents of the Archive Information is inserted through the 
related page automatically. If you want to change the 
description, such as Information or Comments that was entered 
in the patient menu:

1. Double-click the yellow text to be changed, e.g. Information 
or Comments.

The area where the description was entered (e.g. Patient 
menu) displays.

2. Change the existing data as necessary.

3. Select Report to return to the report.

 Figure 14-8. Patient Information Area (Example)
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Modifying the displayed objects of Archive Information

1. Select Designer.

2. Double click on the area for the Archive Information in the 
template. The Archive Information Box displays.

 Figure 14-9. Archive Information Box

3. Click the checkboxes to select and deselect the objects. 
Objects with checkmarks will appear in the report template.

4. Select Box Properties to change the font, font size, font 
color, or box size, and select OK.

5. Select OK to return to the Report Designer.

6. Save the template.

To keep the same template name:

� Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

� Select Yes. The template retains the same name and 
adds �[user]�. For example, OB23-Basic[user]. 

To save the template with a new name:

� Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

� Enter the name of the new template, and press Set. The 
template receives the new name and adds �[user]�. For 
example, NewReport[user].

7. Select File -> Exit to leave the Report Designer.
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Entering free text

You can enter free text to the report using the alphanumeric 
keyboard.

The factory template terms their text area as �Summary or 
Comments�. 

1. Move the cursor to the text field and press Set.

NOTE: You can enter the text only to the field set as free text in the 
Report Designer.

NOTE: DO NOT enter �%s� in a free text field and then try to edit/
save the template in the Report Designer. 

2. Type the text.
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Inserting Text

1. Select Designer.

2. Move the cursor where the text is to be inserted and press 
Set.

3. Select the Text Field from the Insert menu. The Text Field 
dialog box displays.

 Figure 14-10. Text Field Dialogue Box

4. Select the appropriate display items:

� Ref. Reasons: Retrieves this information from the Direct 
Report

� Comments: Retrieves this information from the 
Comment field of the patient screen and the Exam 
Comment field of the worksheet.

� Diagnosis: Retrieves this information from the Direct 
Report

� Free Text 1 - 8
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Inserting Text  (continued)

5. Type the heading Text.

6. Modify box properties, the heading text and font, and data.

7. Select OK or Cancel. 

8. Save the template.

To keep the same template name:

� Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

� Select Yes. The template retains the same name and 
adds �[user]�. For example, OB23-Basic[user]. 

To save the template with a new name:

� Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

� Enter the name of the new template, and press Set. The 
template receives the new name and adds �[user]�. For 
example, NewReport[user].
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Inserting an image to the report

Some factory templates include an image area. If you want to 
insert or modify the image area, See �Insert Image� on 
page 14-43 for more information.

To insert images from clipboard into the image field of the report:

1. Move the cursor to the desired image on the clipboard.

NOTE: The preview image appears when the cursor is over a 
clipboard image.

2. Press and hold down the Set key and drag the selected 
image to the report by using the Trackball or double click 
the Set key on the desired image. 

3. To move images between image areas, press and hold 
down the Set key and using the Trackball, drag the 
selected image to the new location.

To remove an image from the report, press and hold down 
the Set key and using the Trackball, drag the select image 
back to the clipboard.
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Measurement result section

Measurement results for the current patient display 
automatically if you have the measurement section in the report 
template.

The factory template has an appropriate measurement result 
area. If you want to insert or modify the measurement area, See 
�Measurements� on page 14-49 for more information.

 Figure 14-11. Measurement section
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Inserting the worksheet

You can insert the worksheet (like you can insert an image) to 
the image display field. To set an image display field in the report 
template, See �Insert Image� on page 14-43 for more 
information.

1. Display the worksheet on the monitor display.

2. Save the worksheet using the P1 key.

3. Select Report Preview.

4. Drag the worksheet into the report.

a. Move the cursor to the desired worksheet on the 
clipboard.

b. Press and hold down the Set key. Use the Trackball to 
drag the selected worksheet into the Image Display 
Field.

c. Release Set.

NOTE: You can also move the cursor to the desired worksheet on 
the clipboard, double-click the worksheet, move the cursor 
to the Image Display Field, and select Set.

5. The worksheet displays on the report.

NOTE: You can double-click the worksheet in the report to change 
the background color to white to save ink during printing. 
Double-click the worksheet again to return the worksheet to 
the original color.

 Figure 14-12. Worksheet in Report
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Placing objects side-by-side

If you want to place images, the image and comment, 
anatomical graphic and comment, etc. side-by-side, you must 
first place a table, which has two (or more) columns, into the 
report template.

1. Press Report on the control panel.

2. Select Designer to display the Report Designer.

3. Place the cursor where you want to insert the object.

4. Select Table from the Insert menu. Insert Table box displays.

 Figure 14-13. Insert Table Box

5. Set the number of columns to 2 (or more, as required) and 
change the table parameters, if needed. Select OK.

NOTE: If you do not need a table border, set the Border to 0. Add 
additional rows if required.

6. Place the cursor in the column and select the desired items 
from the Insert menu (e.g. logo, image, free text). Specify 
those items.

7. Repeat step 6 for each column as required.
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Placing objects side-by-side  (continued)

8. Save the template.

To keep the same template name:

� Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

� Select Yes. The template retains the same name and 
adds �[user]�. For example, OB23-Basic[user]. 

To save the template with a new name:

� Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

� Enter the name of the new template, and press Set. The 
template receives the new name and adds �[user]�. For 
example, NewReport[user].

You can insert the images in the order preferred, by row or 
column, on the factory templates. See �Inserting the Table� on 
page 14-35 for more information.
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Accessing Worksheet, OB Graph and Anatomical Survey Pages

If the Worksheet, OB Graph, and/or Anatomical Survey pages 
have been saved for the current patient, you can access these 
pages from the report page.

NOTE: OB Graph and Anatomical Survey pages apply only to OB.

1. Select either Worksheet, Graph or Anatomical Page on 
the primary menu.

There is also Fixed Text set up as hyper links for these 
pages. Cursor to the fixed text and press Set.

2. The system displays the appropriate page (Worksheet, OB 
Graph or Anatomical Survey).

3. Select Report Preview to return to the Report page.

Retrieving an Archived Report 

1. Select Retrieve. The Retrieve menu displays.

Figure 14-14. Retrieve Menu

2. Select the desired report and press Set.

NOTE: The retrieved report cannot be edited.
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Deleting a Report from Archive

1. Select Delete. The delete menu appears on the screen.

Figure 14-15. Delete Reports Menu

2. Select the report to delete and press Set.

Printing the Report

1. Select P2 to print out the report.

The Report is printed on the default printer.

NOTE: To preview the Print Layout before printing, See �Preview the 
Print Layout� on page 14-32 for more information.

NOTE: Double-click the worksheet and/or image in the report to change 
the background color to white A white background will save ink 
during printing. Double-click the worksheet or image again to 
return to the original color.

Storing the Report

1. Select Store.

The Report is saved as a CHM file to Archive. 

NOTE: The archived report cannot be edited; therefore, it is 
recommended that the data is carefully reviewed before the 
report is saved.
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Exporting the Report to Media

Reports can also be saved in a user-defined locations in the 
following formats:

� Compiled HTML (.CHM) files: readable from any web 
browser.

� Portable Document Format (.PDF) files: readable with 
Adobe Acrobat reader.

1. Select File.

2. Select Save As.

The Save As dialog box appears on the screen.

Figure 14-16. Save as dialog box

3. Enter the Report title in the File Name field.

4. Select the media to export the Report. The system supplies 
a name (numeric DICOM UID, unique identifier). 

5. Select PDF or CHM from the Save as type pull down menu.

6. Select Save.

Exiting the report

1. Select Store to save the report.

NOTE: If the user is working on a report and leaves the report 
screen for any reason, all information added to the report is 
automatically saved without loss of data.

2. Select Exit key to close the report page.
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Designing Your Own Template

Template Designer

You can design and create your own customized template from 
a blank template page, or you can use an existing template 
(factory or user-defined) and save the changes.

Display the desired template and select Designer to open the 
Template Designer page.

 Figure 14-17. Report Designer
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File Menu

Enter File Menu:

1. Select a Template.

2. Select Designer.

3. Click on File.

Create a new template

To design a new template without using a pre-existing factory 
template:

1. Select Designer to open the Report Designer.

2. Select New from the File menu, and press Set. 

The blank template displays.

3. Create the report template as needed.

4. Select Save from the File menu, and press Set.

The Save Template As dialogue box displays.

5. Enter a template name and click OK.

6. To exit Report Designer, select Exit from the File menu, and 
press Set.

� Yes: Saves changes and exits Report Designer.

� No: Does not save changes and exits Report Designer.

Table 14-2:  File Menu

Description

New Creates a new template. A blank template appears. 

Save Overwrites the existing template.

Save As Saves as a new name.

Page Setup Enters Print Layout screen.

Print Preview Executes print preview.

Exit Exits Report Designer page.
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Create a new template and save as a factory template name 

To design a new template by modifying an existing factory 
template and keeping the same name of the factory template:

1. Select and display the existing factory template.

2. Select Designer to open the Report Designer.

3. Modify the report template as needed.

4. To save changes, select Save from the File menu, and 
press Set.

The Save Template dialog box displays.

� Yes: Saves changes.

� No: Does not save changes.

� Cancel: Returns to Report Designer.

NOTE: The template name displays in the template list, retains the 
same name, and adds �[user]�. For example, 
�OB23-Basic[user]�. You do not lose the original factory 
template.

5. To exit Report Designer, select Exit from the File menu, and 
press Set.

� Yes: Saves changes and exits Report Designer.

� No: Does not save changes and exits Report Designer.

� Cancel: Returns to Report Designer.

HINTS Save changes frequently as you modify your template. Saving 
often reduces the risk of losing all your changes.
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Create a new template and save with a new name

To design a new template by modifying or copying an existing 
factory template and saving it with a new name:

1. Select and display the existing factory template.

2. Select Designer to open the Report Designer.

3. Modify the report template as needed.

4. Select Save as from File menu and press Set.

 The Save Template As dialog box displays.

5. Type the new template name and click OK.

6. Select Exit from the File menu and Set.

7. The Report Designer closes and returns to the Report Page.

NOTE: The template receives the new name and adds �[user]�. For 
example, NewReport[user].
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Page Setup

1. Modify the factory template as necessary in Designer.

2. Select Page Setup from File menu and press Set.

3. Change the paper size or orientation to fit the print layout, as 
necessary.

To define the header and footer for the printed report, type 
text and enter the required variables listed in the table 
below. Select �Different for first page� and enter a specific 
header/footer for that page.

NOTE: Default is left aligned. Report will appear as black ink on 
white background.

4. Select OK or Cancel.

 Figure 14-18. Page Setup Dialog

Table 14-3:  Variable and Definition

Variable Definition Variable Definition

{pid} Patient ID {prt} Current time (printing time)

{pnm} Patient name {cp} Current page

{pbd} Patient date of birth {tp} Page count

{exd} Examination date {c} Subsequent text is centered

{prd} Current date (printing date) {r} Subsequent text is right aligned.

{inm} Institution name
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Preview the Print Layout

1. Select Template to choose the Report Template.

2. Select Designer.

3. Select Print Preview from File Menu, and press Set.

4. The Print Preview screen displays.

If changes need to be made, select Close to exit the 
Preview page. Modify the template or return to the Report 
and modify the contents.
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Edit Menu

Deleting a template object

1. Select the object to be deleted.

2. Select Delete from the Edit menu, and press Set. The object 
is deleted from the template.

Undoing the operation

1. Select Undo from the Edit menu, and press Set.

2. Repeat as required.

Table 14-4:  Edit Menu

Description

Delete Deletes the selected object from the report template.

Undo Restores the previous state(s) of the report template.
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Insert Menu

Inserting the Page Break

1. Place the cursor where the Page Break is to be inserted and 
press Set.

2. Select Page Break from the Insert menu and press Set. The 
page break line displays on the template.

Table 14-5:  Insert Menu

Description

Page Break Inserts a Page Break.

Table Inserts a Table.

Logo Inserts a Logo Bitmap File.

Archive Info Inserts Archive Information.

Anatomical Graphics Selects anatomical graphics by category to be inserted into a 
field.

Image Inserts the image display field to the template.

Wall Motion Analysis Selects Cut Planes, Bull�s Eye, or Score Table Box.

OB/GYN Selects OB Graph, Bar Graph or Anatomiy.

Measurements Inserts the measurement display field in the template.

Text Field Edits text field.

Fixed Text Enters any comments as Fixed Text.

Dropdown Text Edits dropdown text.
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Inserting the Table 

1. Place the cursor where the table is to be inserted and press 
Set.

2. Select Table from the Insert menu and press Set. The Insert 
Table dialog box displays.

 Figure 14-19. Insert Table Dialog

3. Specify each parameter as required.

NOTE: To set the table border as not visible, set �Border� parameter 
to 0 (zero)

4. Select OK to insert the table or Cancel. 

NOTE: To insert/delete a row/column from the table or access table 
properties, double click the Set key in any empty area inside 
the table. A table menu appears with those options.
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Inserting Images in a Table

You can choose the order in which images are inserted into 
tables: by row (default) or by column.

Image Order by Row

The system default inserts images in the cells of the first row, 
then to the next row. 

Figure 14-20. Image Order�Row Preference 
(System Default)

1. Follow the instruction for inserting a table. When specifying 
parameters, specify:

No. of Columns=2; No. of Rows=2

2. After inserting the table, insert an image box in each cell of 
the table. 

a. Move the cursor to the first cell and select Insert -> 
Image.

b. Repeat this step for each cell in the table.

After the template is saved and you are working in the 
ReportWriter, when you select images to be inserted in the 
table, they are placed in the default order.
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Inserting Images in a Table  (continued)

Image Order by Column

If you prefer to have the image placement by column, images 
are inserted in each cell of the first column, then the next 
column.

Figure 14-21. Image Order�Column preference

In order to achieve the column preference, you need to create a 
table with 2 columns and 1 row. In each cell of this table, you 
need to insert another table.

1. Follow the instructions for inserting a table. When specifying 
parameters, specify:

No. of Columns=2; No. of Rows=2

2. After inserting the table, create a table inside each of the 
existing table�s cells. 

a. Move the cursor to the left column�s cell and press Set.

b. Select Table from the Insert menu and press Set.

c. When specifying parameters, specify:

No. of Columns=1; No. of Rows=2; Width=290 pixels; 
Height=500 pixels.

Select OK. 

d. Repeat steps a-c for the right column.

3. Insert an image box to each table cell. 

a. Move the cursor to the first cell and select Insert -> 
Image.

b. Repeat this step for each cell in the 2 tables.

After the template is saved and you are working in the 
ReportWriter, when you select images to be inserted in the 
table, they are placed with your column preference.
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Inserting Logos

1. Place the cursor where you want to insert the logo and 
press Set.

2. Select Logo from the Insert menu and press Set. The Logo 
Box displays.

3. Select a logo that you want to insert (1) or import a bmp or 
jpg file from the removable media (2). Scroll the images 
using the arrow key (3). Specify the appearance (4).

Figure 14-22. Logo box

4. Select OK to insert the logo or Cancel.

Changing a logo:

1. Place the cursor on the logo to be changed and press Set 
twice. The Logo Box displays.

2. Select a different logo. If the desired logo is not shown, 
select Import Logo to import a different logo.

3. Specify the appearance.

4. Select OK or Cancel.
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Inserting Archive Information

Archive information contains all the objects from the different 
information menus (Patient, Exam, and Site Information). This 
box accumulates different information menu selections that can 
be grouped together and displayed in one table.

1. Place the cursor where you want to enter the archive 
information and press Set.

If you use a factory template, double click on the current 
archive information area to display the Archive Information 
Box.

2. Select Archive Info from the Insert menu and press Set. The 
Archive Info Box displays.

 Figure 14-23. Archive Information Box

3. Type the Heading, select a heading link from the pull-down 
menu, and select the parameters you want to display in the 
report.
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Inserting Archive Information  (continued)

4. Select Box Properties to change the Font, Alignment, 
Appearance, etc.

NOTE: To set the same font to all fields, select Set All fields. 

 Figure 14-24. Table Properties

5. Select OK or Cancel. The contents of the Archive 
Information is inserted to the related page automatically.
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Inserting Archive Information  (continued)

Editing displayed Archive Information:

1. Select Designer.

2. Move the cursor to Archive Information field to be edited.

3. Press Set twice. The Archive Information Box displays.

4. Edit the heading, the Heading Link and Information 
parameters, as necessary.

5. Select OK to save or Cancel.



ReportWriter

14-42 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10

Anatomical graphics

1. Place the cursor where you want to insert the Anatomical 
Graphics and press Set.

2. Select Anatomical Graphics from the Insert menu.

Figure 14-25. Anatomical Graphics Menu Example

3. Select the desired category and press Set. The graphic box 
displays.

Figure 14-26. Anatomical Graphics Box Example

4. Select the graphic to be inserted to the template or import a 
bmp or jpg file from the removable media. Scroll the images 
using the arrow key. 

5. Select Appearance.

6. Select OK or Cancel.
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Insert Image

1. Place the cursor where you want to insert the image.

2. Select a image from the Insert menu and press Set. The 
Ultrasound Image Box displays.

Figure 14-27. Ultrasound Image Box

3. Type the Heading text, modify the box properties, and 
change the heading text font, as necessary.

NOTE: For no heading, type a Space in the Heading text.

To keep the monitor image appearance, the ratio of width to 
height (W:H) should be 4:3. So, basically 640:480 for large 
images and 300:225 for two side-by-side images.

4. Select OK or Cancel.
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Cardiac Studies Wall Motion Analysis

1. Place the cursor where you want to insert the wall motion 
analysis and press Set.

2. Select Wall Motion Analysis from the Insert menu.

3. Select and set up the desired parameter.

� Bull�s Eye

Figure 14-28. Bull�s Eye Dialog Box

Figure 14-29. Bull�s Eye Report Example
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Cardiac Studies Wall Motion Analysis  (continued)

� Cut Planes

NOTE: The Cut Planes dialog box parameters are similar to the 
Bull�s Eye Dialog Box shown previously.

Figure 14-30. Cut Planes Report Example

� Score Table Box

Figure 14-31. Score Table Box Dialog Box

4. After you finish the setup, select OK or Cancel.
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OB/GYN (OB and GYN Only)

The OB Graph, Bar Graph and Anatomy can be entered into the 
Report.

1. Place the cursor where you want to insert the graph or 
anatomy and press Set.

2. From the Insert menu, select OB/GYN. The selection menu 
displays.

Figure 14-32. Selection Menu

3. Select the appropriate item as necessary. A dialog box 
displays.

� OB Graph

Figure 14-33. OB Graph Dialog Box
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OB/GYN (OB and GYN Only)  (continued)

a. Select the Measurement and Fetus Number.

b. Check Fetus Trending and Fetus Compare, if 
appropriate.

c. Modify the Layout, if necessary.

d. Select OK.

� Bar Graph

Figure 14-34. Bar Graph Dialog Box

a. Select the exam and fetus number.

b. Modify the Layout, if necessary.

c. Select OK.

NOTE: The Bar Graph already contains default application 
measurements.
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OB/GYN (OB and GYN Only)  (continued)

� Anatomy

Figure 14-35. Anatomy Dialog Box

a. Type the Heading.

b. Select qualifiers from the pull-down menu.

c. Select �Add all� to copy all measurements to the right 
column

d. Check the box in front of the measurement you need in 
the left column and select �Add�. The select 
measurements copy to the right column.

e. To remove measurements you do not need, check the 
boxes in front of those measurements in the right 
column, and select �Remove� or �Remove all�.

f. If you want to modify the properties, select Box 
Properties and set required parameters.
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Measurements 

Insert a field to display the measurements. The measured 
parameters displayed in the measurement display field are 
configured.

1. Place the cursor where you want to insert the measurement 
and press Set.

2. Select Measurements from the Insert menu and press Set. 
The Measurements Box displays.

 Figure 14-36. Measurement Box

3. Type the Heading text, select the Filter Criteria and 
measurements from the tree, as necessary.

4. Select OK or Cancel.
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Text Fields

1. Place the cursor where you want to insert the text and press 
Set.

2. Select Text Field from the Insert menu and press Set. The 
Text Field dialog box displays.

Figure 14-37. Text Field Dialog Box

3. Type the Heading Text. If you do not need the heading, type 
a space.

4. Select Display item.

� Ref.Reason: Reason for Referral.

� Comments: Gets information from the Comment field of 
the Patient screen and the Exam Comment field of the 
Worksheet.

� Diagnosis.

� Free Text: 1 - 8

5. Specify the border of the Text Field and Font as necessary.

6. Select OK or Cancel. 

The text is saved automatically into the corresponding area 
selected on this dialog box.
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Text Fields  (continued)

Editing an existing text field:

1. Move the cursor to the Text Field to be edited.

2. Press Set twice. The Text Field dialog box displays.

3. Edit the heading, the settings, or font, as necessary.

4. Select OK or Cancel.
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Fixed Text

1. Place the cursor where you want to insert the fixed text and 
press Set.

2. Select Fixed Text from the Insert menu and press Set. The 
Fixed Text dialog box displays.

Figure 14-38. Fixed Text Dialog Box

3. Type the text (e.g. hospital information, report title, or table 
title) and specify the border and font.

4. Select OK or Cancel.

Editing existing Fixed Text:

1. Move the cursor to the Fixed Text to be edited.

2. Press Set twice. The Fixed Text dialog box displays.

3. Edit the text, the border or font, as necessary.

4. Select OK or Cancel.
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Dropdown Text

1. Place the cursor where you want to insert the dropdown text 
and press Set.

2. Select dropdown Text from the Insert menu and press Set. 
The dropdown Text dialog box displays.

Figure 14-39. Dropdown Text Dialog Box

3. Select the appropriate display items:

� Dropdown Text 1 - 8

4. Type the heading Text.

5. Modify box properties, the heading text and font, and data.

6. Select OK or Cancel. 

7. Save the template.

To keep the same template name:

� Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

� Select Yes. The template retains the same name and 
adds �[user]�. For example, OB23-Basic[user]. 

To save the template with a new name:

� Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

� Enter the name of the new template, and press Set. The 
template receives the new name and adds �[user]�. For 
example, NewReport[user].
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Customize Menu

Page Color

1. To change the page color, select Page Color from the 
Customize Menu and press Set. The Color dialog box 
displays.

Figure 14-40. Color Dialog

2. Choose the desired color or create a new color.

3. Select OK or Cancel.

Table 14-6:  Customize Menu

Description

Page Color Changes the template color.

Preference The Preference menu for Archive Information field displays.
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Setting Preferences

To set preferences for the Archive Information:

1. Select Preferences from the Customize menu and press 
Set. The Preference Box displays. 

Figure 14-41. Preferences Box

2. Select the information to be modified and set the desired 
preferences.

3. Select OK or Cancel.

4. Save the template.



ReportWriter

14-56 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10

Report Presets

Utility Report Page

You can edit the report template and text on the Utility Reports 
page.

Templates

Left Column: The list of all templates (Factory Default, User 
defined, etc.) 

Right Column: The list of templates displayed on the template 
list.

 Figure 14-42. Report Template Tab
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Templates  (continued)

� To insert the template on the template list:

a. Select the application which you want to insert into the 
template from the pull-down menu above the right 
column.

b. Select the category (categories) and/or the template(s) 
in the left column.

c. Select the right arrow to copy the template to the right 
column.

� To remove the template from the template list but not from 
the system):

a. Select the template in the right column.

b. Use the left arrow to remove the template from the right 
column.

� To edit the template or to make a new template:

a. Enter Utility -> Reports -> Templates tab.

b. Select the appropriate template in the left column.

c. Select Edit Template. The Template Designer page 
displays.

d. Edit the template and save or save as with a new name.

If you use Save As with a new name, the new template 
is added to the left column. See �Designing Your Own 
Template� on page 14-27 for more information.

� To delete the template:

a. Select the template to be deleted.

b. Press Delete.

NOTE: The Predefined templates can not be deleted.
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Templates  (continued)

� To export the template:

a. Insert the removable media in the drive.

b. Move the cursor to �Export Templates� and press Set. 
The available user-defined templates display in the 
Export Templates window.

Figure 14-43. Export Templates

c. Select the template(s) to be exported.

NOTE: To select multiple templates, use the Ctrl or Shift keys.

d. Select the desired removable media under the Select 
Target Device field.

e. Select OK.

f. Press F3 to eject the media.

HINTS Export templates to removable media (CDs, DVDs, USBs) 
so, at a later time, you can import those templates to a 
system. Export only works on templates, not data.
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Templates  (continued)

� To import the template:

NOTE: Import only works on templates, not data.

a. Insert the removable media with the report template(s) 
to be imported.

b. Select Import Templates. The Import Template window 
displays.

Figure 14-44. Import Templates

c. Select the Source Device from the pull-down menu. 
Select OK.

d. Press F3 to eject the media.

NOTE: Imported templates are stored in the User defined 
templates\General directory. 

� To move the template from the left column to the right, or 
from the right to the left:

a. Select the template to be moved.

b. Select the Right Arrow or Left Arrow button.

� To move the template up or down in the right column:

a. Select the template to be moved.

b. Press the Up Arrow or Down Arrow button.
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Chapter 15

Recording Images

Describes how to record images. 
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Introduction

Overview

A typical workflow for connectivity might be as follows (this setup 
varies by each user setup): 

1. Select the dataflow, worklist for example.

2. Start a new exam. Select the patient. 

3. Perform the patient scan.

4. Store images as multi-frame CINE Loops and Raw DICOM 
data via the assigned print key.

5. Check the DICOM Job Spooler via F4 to verify delivery.

6. End the exam. 

7. Permanently store images via the Patient menu.
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Overview  (continued)

During an examination, the operator stores data, images and 
cineloops for immediate purposes. The Versana Active includes 
an integrated patient archiving system for data and image 
storage.

The Versana Active enables also storing of data and images to 
external databases (Network Server, removable media).

Dataflow combines archive, data, DICOM, and onboard records 
into one coherent workflow. Destination devices are configured 
and assigned to the print keys. You select the appropriate 
dataflow (Portable, etc.) according to your requirements. You 
manage the patient database (local, shared, or via a worklist 
broker). 

� DO NOT use the internal hard drive for long-term image 
storage. Daily backup is recommended. External storage 
media is recommended for image archive.

NOTE: DICOM images are stored to external media storage 
devices separately from patient data, which also needs to be 
backed up to a dedicated database-formatted external 
storage media. 

� If working off-line with a dataflow pointing to a DICOM 
server, the images stored during the examination may have 
to be manually resent in the DICOM spooler when 
reconnecting the unit. Resend all jobs that failed or are on 
hold.

In addition, stored images and cineloops can be saved to a 
removable media in the standard formats JPEG, MPEG, AVI 
and DICOM.

� You need to set up a protocol for locating images stored to 
external storage media for easy recall.

� GE IS NOT responsible for lost data if you do not follow 
suggested back-up procedures. GE WILL NOT aid in the 
recovery of lost data. 

Refer to Chapter 16 Customizing your system for instructions on 
setting up your system�s connectivity. 
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Adding Devices

To add a destination device (printer, worklist server, etc.) to this 
system, see �Device� on page 16-78. 

To verify a DICOM device, see �Device� on page 16-78.

Adding a Dataflow

To add a new dataflow to this system, see �Dataflow� on 
page 16-98.

Adding Devices to a Print Button

To add devices/dataflows to a print button, see �Button� on 
page 16-99.

Formatting Removable Media

To format removable media, see �Formatting removable media� 
on page 16-102.
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Storing Images and Cineloops

Overview

Images and cineloops that are stored during a current 
examination are displayed as thumbnails on the clipboard.

When an image is stored, all the additional information that is 
displayed is saved with it (i.e. probe and application selected, 
image setting, annotations or measurements).

See �Print Control� on page 16-64 for detailed settings related 
storing image/Cine.

The image archive is set by the dataflow selected (See 
�Dataflow� on page 16-98 for more information.)

Storing an image

To store an image, 

1. While scanning, press Freeze. 

2. Scroll through the CINE Loop and select the desired image. 

3. Press the Store key. 

The selected image is stored (per your preset instructions) 
and a thumbnail is displayed on the clipboard. 
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Storing a CINE Loop

A CINE Loop is a sequence of images recorded over a certain 
time frame. The stored CINE Loops are displayed 
chronologically on the clipboard. 

CINE Loops can be stored at any time during scanning. You can 
choose to preview the CINE Loop before storage and save the 
CINE Loop directly, as described below. 

Refer to �Print Control� on page 16-64 about the setting.

Previewing and Storing a CINE Loop

1. While scanning, press Freeze. 

2. Determine the best CINE Loop to store. 

3. Play the CINE Loop to review it. 

4. Press the Store key. 

Depending on whether the system has been configured to 
enable or disable �Preview Loop before store� (see �Print 
Control� on page 16-64), the following procedures enable the 
CINE Loop to be stored directly. 

Storing a CINE Loop Without Preview

If �Preview clip before store� is disabled, 

1. While scanning, press the Store key. 

2. The last valid CINE Loop is stored in the archive and a 
thumbnail is displayed on the clipboard. 

3. Scanning resumes immediately.

Storing a CINE Loop With Preview

If �Preview clip before store� is enabled, 

1. While scanning, press the Store key. 

2. The last valid CINE Loop is previewed. 

3. Adjust the CINE Loop, as necessary. 

4. Press the Store key. 

The movie clip thumbnail is displayed on the clipboard. 
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Image/Data Management

Reviewing Patient Images

Please refer to �Retrieving and editing archived information� on 
page 4-20 for detailed information on the following:

� Retrieving and editing archived information

� Searching for a patient

� Reviewing a patient exam

� Reviewing an image

� Deleting a patient, exam, or image

Backup/Restore Images

Please refer to �Backup and Restore� on page 16-25 and 
�EZBackup and EZMove� on page 16-29 for detailed information.
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Clipboard

The clipboard displays thumbnail images of the acquired data 
for the current exam. Images from other exams are not 
displayed on the current patient�s clipboard. 

All of the images can be viewed in the Active Images screen, 
available from the display or from the Archive menu. 

Figure 15-1. Clipboard

Saving the image /cine to the Clipboard

The active image/cine is stored and placed on the clipboard 
when you press the Store key. The clipboard contains preview 
images with enough resolution to clearly indicate the contents of 
the image. CINE Loops are indicated by a movie clip icon. 
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Previewing Clipboard Images

1. Select the Cursor key to obtain a cursor arrow.

2. Move the Trackball to position the pointer over the 
clipboard image you want to recall. 

3. An enlarged preview of the image is displayed on the 
left-hand side of the monitor. 

Recalling Images from the Clipboard

To recall images from the clipboard, 

1. Select the Cursor key to obtain a cursor arrow. 

2. Move the Trackball to position the pointer over the 
clipboard image you want to recall. 

3. Press Set to recall the image. 

To delete an image from the clipboard

1. Select the Cursor key to obtain a cursor arrow.

2. Place the cursor on the clipboard image you want to delete, 
then press Set to select the image.

3. Place the cursor on the Delete icon and press Set.

A warning message is displayed asking the user to confirm 
the action to perform.

4. Select Yes.
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Save As

Images and cineloops can be saved to a removable media or 
Network storage to View on a Windows PC in the following 
standard formats:

� Still images: JPEG, JPEG2000, DICOM and RawDICOM 
(Raw data + DICOM)

� Cineloops: WMV, AVI, DICOM and RawDICOM (Raw data + 
DICOM)

Images can also be stored as MPEG format as described on 
�MPEGvue� on page 15-24

To save images:

1. Insert the media into the drive or connect the USB drive to 
the system.

NOTE: If you have not formatted the media, the media will be 
formatted when you select Save As.

2. On the scan screen, press the Cursor key. The arrow cursor 
displays. 

3. Place the cursor on the image or CINE Loop in the clipboard 
to be saved and press Set. The image displays on the 
screen. 
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Save As  (continued)

4. Select save as icon in the lower, right-hand corner of the 
screen. The SAVE AS menu appears.

NOTE: If you save the image as an .avi file or .wmv file, run the 
CINE Loop before you select Menu. 

NOTE: You can not save 2D cineloop image as a .jpeg file.

Figure 15-2. Save As Menu

5. Select the media from the Save in archive pull-down menu.

6. Folder name: You can create the folder for the saved file. 

� Default is blank (The folder is not created)

NOTE: You can not edit the folder name when the folder is opened.

7. File name: The name of the file is automatically filled in, but 
you can change the file name in the File name field. 

NOTE: DO NOT use the following special characters when saving 
images: !, @, #, $, %, ^, &, *, (, ), |, :, ;, <, >, ?, /, ~, [, ], {, }. 
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Save As  (continued)

8. Store: Select Image only or Secondary capture. 

� Image only: Saves only the ultrasound image area.

� Secondary capture: Saves the ultrasound image area, 
title bar, and scan information area. Not available for 
DICOM or RawDICOM images. 

NOTE: If you select �WMV� for Save as type, Secondary capture is 
disabled.

9. Compression: Specify Compression. 

� None

� Rle

� Jpeg

� Jpeg2000

NOTE: If you select �WMV� for Save as type, Compression is 
disabled.

10. Quality: Specify image quality (between 10-100). A high 
quality setting gives a lower compression. 

NOTE: If you select �WMV� for Save as type, Quality is disabled.

11. Save as type: Select one of the following. 

� RawDICOM: saves the still image or CINE Loop in both 
GE raw format and DICOM format. 

� DICOM: saves the still image or CINE Loop in pure 
DICOM format. 

� AVI: Saves the CINE Loop in avi format. 

NOTE: Store �Image Only� is available if you select AVI for 
Type.

� JPEG: Saves the still image in jpeg format. 

� WMV: Saves the CINE Loop in wmv format

NOTE: WMV type is only available with CINE loop image.

� JPEG2000: Saves the still image in JPEG2000 format.

If you want to see all data saved onto the SSD, select 
�AllFiles(.*)�. All the data names display in the window.

NOTE: The Save button is disabled when you select �AllFiles�. 
Select each Save as type when you want to save data.
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Save As  (continued)

12. Press Save. 

The images are saved directly to the USB drives or Network 
storage whenever you press Save.

If you select �Transfer to CD/DVD�, the images are saved to 
the SSD buffer.

� If free space of the destination is not enough to save all 
selected images, then warning dialog appears.

� If the same file name is existed in the destination, the 
warning dialog displays.

OK: Overwrite file and continue to save selected 
images.

Cancel: Do not save images.

13. Repeat this step for as many images/clips to be saved.

14. After you have added all of the images/loops you want to 
save and are ready to write to the CD/DVD, transfer all the 
images at the same time. Press Save As --> Transfer To 
CD/DVD. 

A progress bar lets you know that the �Media transfer is in 
progress.� 

If total transfer size is bigger than CD/DVD free space size, 
then only the files that can be copied to CD/DVD are 
transferred. After the copy is finished, the warning dialog 
displays. Warning dialog shows total required file size and 
transferred file size. Press OK and you need to change CD/
DVD and press Transfer to CD/DVD again.
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Save As  (continued)

15. If you do not want to save the image to CD/DVD, select 
�Delete Files for Transfer� All images are deleted.

16. Press F3 to eject the media. Select CD/DVD Recordable or 
USB drive. 

NOTE: The Report Save As feature is somewhat different. As soon as 
you select to save a report, the report is saved. (CD/DVD) 

NOTE: If you save 3D image as an AVI file, an annotation text �COMP� 
appears at the top of the saved image which represents the 
compressed image.

NOTE: Verify the saved image works correctly on the Windows PC. If 
the image does not work, please save it again on the Versana 
Active. 

Table 15-1:  Image Format

.avi format .wmv format MPEGvue in Data Transfer

B, B+CF Multi frames Multi frames Multi frames

B+Dopploer Single frame Multi frames Single frame

B+M Single frame Multi frames Single frame

3D Multi frames N/A Single frame
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�SaveAs� Images

You can select the images at one time which you want store by 
SaveAs in the Active Image screen.

Features are almost same as usual SaveAs. See �Save As� on 
page 15-10 for more information.

NOTE: We suggest that you save the images page by page with 
�SaveAs� Images in Active Images. It takes time if you have 
many images or raw data.

NOTE: If the image has a filmstrip icon, this indicates a CINE Loop, 
which gets saved as a .wmv file; single images are saved as a 
jpeg file.

NOTE: �SaveAs� Images function doesn't support images which are 
query/retrieved.

1. In the Active Image screen, place the cursor on the image or 
CINE Loop to be saved and press Set. You can select multi 
images with multi pages.

2. Press �SaveAs� Images on the monitor display. The SaveAs 
menu appears.

Figure 15-3. �SaveAs� Images Menu
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�SaveAs� Images  (continued)

3. Ensure that Jpeg&WMV is selected, then press Save. 

If you are saving to USB, images are transferred as soon as 
you press Save; if you are saving via Transfer to CD/DVD, 
you need to save images to the hard drive, then images are 
transferred when you select Transfer to CD/DVD. See 
below. 
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Storing Images with More Resolution

To store images with more resolution than is available with the 
JPEG selection, select Save As and select AVI as the Save As 
Type. You can save single images as .avi files. 

Table 15-2:  Store Options

Image Type Store as Image Only Store as Secondary Capture

CINE Loop Gives you a loop of just the image (no 
title bar and scan information).

Gives you a single image of the video 
area. DO NOT DO THIS BECAUSE 
YOU DO NOT KNOW WHICH IMAGE 
FROM THE LOOP THAT YOU ARE 
GETTING. 

Still Image Gives you a single image (no title bar 
and scan information). 

Gives you a single image of the video 
area. 
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Data Transfer

Overview

The user can select and access the Exam Transfer services 
from the Exam Data Transfer screen.

� Import

� Export

� Worklist

� MPEGvue

� Q/R (Query/Retrieve)

NOTE: Ensure that all patients are exported or backed up BEFORE 
deleting them.

 Figure 15-4. Exam Data Transfer Screen
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Export/Import 

To move exams from one Ultrasound system to another system 
or to back up/retrieve exam information, you need to export/
import exam information. 

NOTE: Both database information and images are exported. No data is 
deleted from the local archive when exporting data. 

NOTE: Export/Import patient records may take more than ten (10) 
minutes. Please allow sufficient time to export/import patients. 

NOTE: You MUST verify the media you use BEFORE performing 
Export/Import. You must do this once each session. If you 
encounter problems, eject the media and then re-insert the 
media; then try the Export/Import again. 

NOTE: We STRONGLY recommend that you verify files on Eject when 
using Export.

Exporting Data

To export an exam(s) to a compatible Ultrasound system:

1. Format and label the removable media. Answer Yes/OK to 
the messages. 

NOTE: The system formats the unformatted CD-R/DVD-R 
automatically when you select Export on the data transfer 
screen. 

2. Press Active Images and select Data Transfer.

3. The Data Transfer screen is displayed. Select Export.

4. �Local Archive-Int.HD� displays on the Transfer From 
pull-down menu and the patient list included in the Local 
Archive displays.
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Exporting Data  (continued)

5. Select the destination at the Transfer To pull-down menu.

6. Select the patient(s) to export by using the Transfer From 
search field (the upper field). 

You can use Windows commands to select more than one 
patient. 

To select a consecutive list of patients, click the cursor on 
the first name, move the cursor to the last name, then press 
and hold down the Shift+Set key to select all the names.

To select a non-consecutive list of patients, click the cursor 
at the first name, move the cursor to the next name, then 
press and hold down the Ctrl+Set key, move the cursor to 
the next name, then press and hold down the Ctrl+Set key 
again, etc. 

You can also search for patients via the Search key and 
string. 

Or, use Select All to select all patient.

NOTE: You need to use your best judgment when moving patients� 
images. If there are lots of images or loops, then only move 
a few patients at a time. 

7. Press Transfer. The progress bar displays during the 
transfer.

8. Once the transfer is complete, press F3 to eject the media. 
Specify that you want to finalize the media. 

NOTE: To display exported DICOM or Raw DICOM images on a PC, 
you need the dedicated viewer.
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Importing Data

To import an exam(s) to another Ultrasound system:

1. At the other Ultrasound system, insert the media. 

2. Press Patient and select Data Transfer.

3. The Data Transfer screen displays. Press Import.

4. Select the media from the Transfer From pull-down menu.

5. The Transfer From search field shows the patients available 
for import from the removable media you just loaded onto 
the system. 

6. Select the patient(s) or the exam(s) from the list to be 
imported.

7. Press Transfer. The progress bar displays during the 
transfer.

8. Please wait for the patient information to be copied to this 
Ultrasound system. Informational messages appear while 
the import is taking place. 

9. Press F3 to eject the media.

NOTE: Use Import to restore EZBacked up and/or EZ Moved images. 

NOTE: You can retrieve from the media to the Local SSD, playback, or 
process exam information on the system as Raw Data.
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Query/Retrieve (Search and retrieve the data from DICOM device)

NOTE: For Query/Retrieve to find a patient, the patient MUST have a 
Patient ID. 

NOTE: Before you retrieve data from the Worklist server, make sure 
that default IP address is input in the Default Gateway field in 
Utility -> Connectivity -> TCP/IP. 

Query

1. Press Active Images and select Data Transfer. The Data 
Transfer screen displays.

2. Select Q/R. The patient/exam list in the Local Archive 
displays in the Transfer To section.

NOTE: Only �Local Archive - Int.HD� is enabled for Transfer To.

3. Select the Query/Retrieve server from the Transfer From 
pull-down menu.

NOTE: The server is configured in the Utility screen. Multiple 
servers are able to be configured.

4. Press Query in the Transfer From section. The Query is 
performed.

5. The server�s patient list displays.

NOTE: Press Query again to refresh the list.

Retrieve

1. Select the patient(s) or the exam(s) to be retrieved from the 
patient list.

2. Select Transfer. Retrieve the data from the Query/Retrieve 
Server. The progress bar displays during the transfer.
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Worklist (Search and retrieve the Patient/Exam information)

NOTE: Before you retrieve data from the Worklist server, make sure 
that default IP address is input in the Default Gateway field in 
Utility -> Connectivity -> TCP/IP. 

1. Press Active Images and select Data Transfer. The Data 
Transfer screen displays.

2. Select Worklist. The patient/exam list in the Local Archive 
displays in the Transfer To section.

NOTE: Only �Local Archive - Int.HD� is enabled for Transfer To.

3. The Worklist used last time is displayed on the monitor 
display. Press Query to refresh the list or select another 
Worklist server from the Transfer From pull-down menu.

NOTE: The worklist server is configured in the Utility screen. 
Multiple servers are able to be configured.

NOTE: You can configure whether the auto-refresh worklist has 
been enabled/disabled in the Utility screen. The system 
automatically refreshes the list when the exam data transfer 
accesses the Worklist server or changes the Worklist 
server.

4. Select the patient(s) or the exam(s) from the list.

5. Press Transfer. The progress bar displays during the 
transfer.
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MPEGvue

You can see the exam data on the Windows PC by using 
MPEGvue.

NOTE: If you want to label the removable media, format it before use. 
The system formats the unformatted CD-R/DVD-R automatically 
when you select MPEGvue on the data transfer screen. 

1. Insert the removable media.

2. Select Patient and select Data Transfer. The Data Transfer 
screen displays.

3. Select MPEGvue. The Patient list, which has images in the 
Local Archive, displays in the Transfer From section.

Start the media formatting automatically except USB HDD. 
Label the media with �YYYYMMDD_#�.

NOTE: Only �Local Archive - Int.HD� is enabled for the Transfer 
From.

4. Select the media from the Transfer To pull-down menu.

NOTE: Select Removable CD Archive if you use CD-R or DVD-R.

CAUTION DO NOT transfer more than 50 patients at one time.

CAUTION DO NOT use lossy compression images, such as JPG or 
MPEG images, for diagnosis.

CAUTION MPEGvue function is NOT compatible with other LOGIQ series 
products. Do NOT share the same USB Drive for MPEGvue 
between Versana Active and other LOGIQ series products.
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MPEGvue  (continued)

5. Select the patient(s) or the exam(s) from the list.

NOTE: If you press Clear in the Transfer From and Transfer To 
section, all the search criteria clears and the list is refreshed 
accordingly.

NOTE: Trying to save 3D loops using MPEGvue, the 3D loops are 
saved as still images. Use �Save As� to save 3D loops. 

6. Press Transfer, then select OK to continue. The progress 
bar displays during the transfer.

 Figure 15-5. Warning message
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MPEGvue  (continued)

When the transfer complete, the message OK displays in 
the Status Msg field and Operation completed message 
displays on the bottom of the screen.

 Figure 15-6. Completed patient

When the message �Not enough free space� displays during 
MPEGvue, 

� CD-R/DVD-R: Please change to a new media. 

� USB HDD/USB Flash Drive: Backup the current data in 
the USB device to the other media and clear the USB 
device. 
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MPEGvue  (continued)

NOTE: If an error dialogue and message displays during 
MPEGvue, reduce the number of exams to gain space, and 
perform MPEGVue once again to a new media (CD-R/
DVD-R) or the USB device.

 Figure 15-7. Error Dialogue

7. When the transfer is completed, press Exit to return to the 
scan screen and then eject the media.

NOTE: The capacity of media (number of patients) and the writing 
time depends on the data size of each patient. If you try to 
save an image larger than 1GB using MPEGvue, it may take 
a few hours to save the image. 

NOTE: Before you read the media on the PC, finalize the media on the 
Versana Active.

NOTE: Measurement graphics from the exam performed on the system 
are maintained with the MPEG exam.

CAUTION DO NOT use �Verify� when ejecting the CD/DVD if you 
transferred multiple patients to the media using MPEGVue.



Recording Images

15-28 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10

MPEGvue  (continued)

NOTE: Select �MPEG4 Windows Media Format (*.wmv)� when you 
save the Cine image from CD/DVD to the SSD while reviewing it 
on your PC.

NOTE: Measurement graphics from the exam performed on the system 
are maintained with the MPEG exam.

1. To read MPEG exams stored on a CD-R/DVD-R:

� Insert the MPEGVue CD-R/DVD-R in the computer 
DVD drive. The MPEGVue Patient list is displayed.

To read MPEGVue exams stored on other media:

� Insert the media containing the MPEG exams and 
double-click on the file Start_MPEGvue.bat. The 
MPEGVue Patient list is displayed.

 Figure 15-8. Patient list

CAUTION DO NOT modify the folder name and the folder configuration of 
MPEGvue which is created in the media.
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MPEGvue  (continued)

2. Select the desired examination date to display the images. 
The MPEGVue screen is displayed.

 Figure 15-9. MPEGvue screen

1. Freeze/run cineloop 

2. Scrolling tool when in Freeze

3. Display full screen

4. Save images as .wmv, .bmp, jpeg or .avi 

5. E-mail support

6. Video Setting Adjustment

7. Display previous/next image 

8. Display the MPEGVue patient list
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MPEGvue  (continued)

E-mail support

Sending images or examinations by e-mail.

NOTE: E-mail support and a desktop icon cannot be used on a 
non-English PC.

The selected image or the entire examination can be sent by 
e-mail as an attachment, providing the computer has a mail 
client application (e.g. MS Outlook, MS Outlook Express).

To send an image

1. Select the image to send on the clipboard and select the 
e-mail button. The e-mail dialogue window displays.

2. Check Send current image. The e-mail address window 
displays.

3. Select an existing address or enter a new address. Up to 10 
addresses can be stored.

4. Select Send. 

5. The e-mail with the image is sent and a Confirmation 
window displays. Select OK.

The person receiving the e-mail can open the image in Windows 
Media Player.
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E-mail support  (continued)

To send an examination

Examinations sent by e-mail as attachments are 
zip-compressed, encrypted and password protected. If the size 
of the exam is too large to be sent as a single attachment, it is 
divided into several zip file attachments and sent in several 
e-mails.

1. Open the examination to send in MPEG viewer and select 
the e-mail button. The e-mail dialogue window displays.

2. Check Send current exam. The e-mail address window 
displays.

3. Select an existing address or enter a new address.

4. Select Send. The Password window displays.

5. Enter a password and select OK. The exam is sent and a 
confirmation window displays. Select OK.

To open an MPEGvue exam from an e-mail

1. In the MPEG viewer press the E-mail button. The E-mail 
dialogue window is displayed.

2. Check Receive exam. The Password window is displayed.

3. Enter the password and select OK. The exam is 
uncompressed and opened in the viewer and the E-mail(s) 
containing the MPEG examination is deleted.
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Send To (Send the image to the DICOM Device)

�Send To� sends the selected exam for a patient and to 
interactively Send-To the exam to a destination DICOM device 
configured on the system. An exam in this case includes its 
images and any corresponding Structured Report.

1. Search and select the patient and press Review. The Exam 
View screen displays. 

2. Select the exam which has the images and press Send to.

 Figure 15-10. Send To

NOTE: You can only select �Local Archive - Int.HD� for Workflow.

3. The �Send To� Dialogue box displays. 

Select the destination device and press OK.

 Figure 15-11. Send To Dialogue Box

NOTE: The destination device is configured in the Utility screen. 
Multiple devices are able to be configured.

The successful/unsuccessful message is displayed at the 
bottom of the screen.
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Selectable Send To

�Selectable Send To� sends the selected images for an exam 
and to interactively Send-To the exam from Local Archive or 
DICOM Read to a destination DICOM device configured on the 
system.

1. Select a patient or an exam in the Archive menu.

2. Go to Active Images.

3. Select an image (images) and press Send To. Send To 
Dialogue displays

NOTE: If the image is not selected, warning dialog is displayed and 
no image is sent. 

4. Select a destination from pull-down menu and press OK.

�Selected image(s) is (are) send to� message displays on 
the status bar.

 Figure 15-12. Selectable Send To Dialogue Box
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Using the DICOM Spooler

To monitor/control DICOM jobs, press F4. You can view, resend, 
redirect, and delete images from the DICOM spooler by 
selecting a job, then specifying the action to be performed on 
this job. 

NOTE: If you find a failed job(s) in the Spooler, please remove the failed 
job(s) from the Spooler. 

Table 15-3:  Spooler status description

Status Description

Hold Waiting for user activity. Select Resend or Send-To to complete the job. 

Pending Waiting for the previous job(s) to finish (a previous job may be Active or 
Pending).
No user interaction required.

Append Not completed. 
Example 1: Direct Storing job. Waiting for more images or the end of the 
exam (by selecting New Patient or End Current Patient). 
Example 2: Print job with 3x3 images has only 8 images. Waiting for one 
more image or the end of the exam (by selecting New Patient or End Current 
Patient).

Active Signifies network activity (or connection attempt).

Success Sent successfully.

Failed Unsuccessful job attempt. Job stays in spooler. Select Retry or Delete to 
complete the job.

Done Finished successfully.
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External drives

Removable media

Removable media can be used for the following purposes:

� Long-term image storage: the final destination of the 
images, after they are moved out of the system hard disk by 
using the EZBackup/EZMove (see �EZBackup and EZMove� 
on page 16-29).

� Backup of patient database and system configuration 
presets (see �Backup procedure� on page 16-26)

� Export to copy a set of patient records to a third party 
DICOM review station.

� MPEGVue: review exported images on a Windows 
computer (see �MPEGvue� on page 15-24).

� Copy of system configuration presets between to units using 
the Backup/Restore feature (see �Preset synchronization� on 
page 16-28).

� SaveAs: Save images as JPEG, WMV, AVI, DICOM and 
RawDICOM for review on a standard Windows computer.

About removable media and long-term image storage

If CD/DVD is used, it is recommended to use Archive Grade or 
Medical Grade CD/DVD.

No matter which media is used, it is always highly 
recommended to make a backup of the media, which is the 
responsibility of the customer.

HINTS Keeping your media disc in an original media case or caddy all 
the time will prevent it from becoming dirty or damaged.
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DVD Drive

The DVD drive (Standard) is located at the top of the cabinet. 

You can use these to perform software upgrades, image 
archiving and service diagnostics.

You can use the following media for the multi-drive:

� CD-R (maximum writing speed: 48x)

� DVD-R (maximum writing speed: 16x)

Recommendation concerning CD and DVD handling

To avoid data loss, never touch the recordable surface of a disk. 
Handle the disk only by the outer edge. Do not place it face 
down on a hard surface. Fingerprints or scratches will make the 
disk unusable. Before usage, verify that the disk surface has no 
visible scratches. If there are any scratches, do NOT use the 
disk.

Insert a media

Insert a media with the eject button on the DVD drive. 

CAUTION DO NOT use or attempt to format CD-RW, DVD+R, DVD+RW 
or DVD-RW on the Versana Active DVD Multi-Drive.

CAUTION Due to the variety of disk types, we cannot guarantee that 
every media is available.

CAUTION When you put a media into the DVD drive, please make sure 
the media is placed in the right position. If the media is not 
placed in the right position, the media may be damaged.

CAUTION Make sure that the Disk tray is securely placed in each device 
during system operation. Mechanical damage may occur if 
other objects hit the tray.
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Eject a media

1. To eject a media, always press F3. DO NOT use the eject 
button on the drive. 

2. The Eject device menu is displayed. Select CD/DVD 
Recordable.

3. When ejecting a media, you are prompted if you wish to 
finalize the disk. If you do not finalize the disk, you can add 
files to the media at a later time. However, you may not be 
able to view the files stored on this disk with a standard PC. 
Finalizing a media, allows you to view these files using most 
standard PCs.

To verify that the data was successfully transferred to the 
media, Press F3, then select �Finalize� --> �Yes and Verify 
Files.� If there was a corruption to the media during an 
operation, the message, �An error occurred on the last disk. 
Please discard it and start over.� appears. In this case, 
please redo the operation with new media.

NOTE: When you press F3 with a blank media inside the DVD 
drive, the finalization menu displays. You can select �Yes� or 
�Yes and Verify Files�, but the system ejects the media 
without doing anything. 
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USB Hard Disk Drive and USB Flash Drive

Cautions and Warnings

WARNING DO NOT use the USB Hard Disk Drive for patient storage. The 
USB HDD is not considered a permanent storage device.

WARNING If you connect the USB HDD to a virus-infected computer, the 
USB HDD may also be infected with a computer virus.

CAUTION DO NOT plug in TWO Bus-powered USB Drives at the same 
time.

CAUTION When exporting a large quantity of patient data to the 
USB-HDD, the system may crash. If this occurs, the export is 
not completed properly. First, delete the data remaining in the 
USB-HDD, and then try again with a smaller number of 
patients.

CAUTION Disconnect the USB HDD when performing EZMove on the 
system.

CAUTION DO NOT use �Select All� when you export the patient data to 
the USB-HDD.
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Cautions and Warnings  (continued)

NOTE: Do not insert USB Memory devices (hard drives or flash drives) 
that contain multiple partitions into the scanner. Use single 
partitioned USB Drives.

NOTE: Some USB memory device manufacturers allow for executable 
partitions or ship pre-formatted new USB memory devices with 
multiple partitions pre-configured. BEFORE inserting any 
memory device into the scanner, insert it into a PC or MAC to 
verify that there is only a single partition. If multiple partitions 
exist, contact the USB manufacturer for the steps in reformatting 
the memory to a single partition.

USB Ports

You can use the USB port next to the control panel for USB flash 
drives.

Formatting the USB Flash Drive

NOTE: Before using the USB flash drive, format it in Utility -> 
Connectivity -> Removable media.

To format the USB Flash Drive

1. Insert the USB Flash Drive into the front USB port. 

2. Select Utility--> Connectivity--> Removable Media. 

3. Select USB Drive from the Removable Media pull-down 
menu. 

4. Type the USB Flash Drive label. 

5. Press Format. 
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Eject a USB Flash Drive/USB HDD

1. To eject a removable media, always press F3. DO NOT use 
the eject button on the drive. 

2. The Eject device menu is displayed. Select the relevant 
media.

3. Select USB Drive from the pull-down menu to disconnect 
the USB Drive. Disconnect the USB drive after the success 
dialogue is displayed. 

Remove the USB Drive from the USB port. 

NOTE: If the unsuccessful dialogue is displayed, retry after a while.

NOTE: Verify is NOT available on Flash Drives or Hard Disk Drive 
media.
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MPEGvue (Data Transfer)

To transfer a patient/exam to the USB Flash Drive or USB HDD, 

1. Insert the USB Drive into the front USB port. 

2. On the Active Images menu, select Data Transfer, then 
MPEGvue. Specify USB Drive in the transfer To: pull-down 
menu. Select the patient/exam you want to transfer. Press 
Transfer. 

3. When the transfer has been completed, press Eject (F3). 

Backup/Restore

To Backup/Restore to/from a USB Flash Drive or USB HDD, 

1. Insert the USB Drive into the front USB port. 

2. Press Utility -> Syetem ->Backup/Restore. Select the USB 
Drive as the media. 

3. Follow instructions for Backup/Restore. See �Backup and 
Restore� on page 16-25 for more information. 

4. When the Backup has been completed, press Eject (F3).

CAUTION After transferring images to a USB Drive using MPEGVue, 
verify that the images have actually transferred to the USB 
drive.



Recording Images

15-42 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10

SaveAs

NOTE: See �Save As� on page 15-10 for more information.

To save images to the USB Flash Drive or USB HDD, 

1. Insert the USB Drive into the front USB port. 

2. Select the image(s) to be saved. 

3. Select Save As menu in the lower, right-hand corner of the 
screen. Select the USB Drive as the archive media. 

4. Specify: Image only or Secondary Capture, type of 
compression, quality, and image save format (Raw DICOM, 
DICOM, Avi, Jpeg, or WMV). 

5. Press Save. When the images have been saved, press 
Eject (F3).

NOTE: If you perform the SaveAs function to the USB drive (:\Export) 
by RawDICOM format and review the data on your PC, the title 
of the data appears as 
�:\GEMS_IMG\2006_Oct\08(date)\xxxxx(PatientID)�.

Direct SaveAs

You can save the image directly to the USB Drive just by 
pressing a Print key. 

NOTE: �Direct SaveAs� doesn't supports WMV type.

1. Insert the USB Drive into the USB port. 

2. Select Save As from the pull-down menu in Utility -> 
Connectivity -> Service. Press Add. 

3. Select Save As in the list. Rename it in the Name field if 
needed. 

4. Select USB Drive in the Destination field.

5. Verify the service. 

6. Press Save.

7. Assign Save As to the appropriate print key in Button tab. 

8. Display the image on the monitor and press the print key. 
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Export/Import 

To export/import exams using the USB Flash Drive or USB 
HDD, 

NOTE: Before you export exams to the USB HDD, check �Export to 
USB HDD: Create DICOMDIR� in Utility -> Connectivity -> 
Miscellaneous. If you uncheck this parameter, you must import 
the data to review.

1. Insert the USB Drive into the front USB port. 

2. On the Patient menu, select Data Transfer, then Export/
Import. Specify USB Drive in the transfer To: pull-down 
menu. Select the patient/exam you want to transfer. Press 
Transfer. 

3. When Export/Import has completed, press F3.

EZBackup (USB HDD only)

1. Select �USB Drive� on the Utility -> System -> Backup/
Restore -> EZBackup/Move -> Media.

2. Follow instructions for EZBackup. See �EZBackup and 
EZMove� on page 16-29 for more information.

3. When EZBackup has completed, press F3.

NOTE: �Media capacity for estimate (MB)� in Utility -> System -> 
Backup/Restore -> EZBackup and EZMove are not effective 
when the Media is �USB HDD�. It only applies to the CD and 
DVD. 
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Network Storage Service

You can save patient data/images to the PC directly with the 
following functions, if you select Network Storage service.

� Save As

� Export/Import

� MPEGvue

� DICOM Read

NOTE: DO NOT share the folder used for Export/Import with other 
ultrasound systems. It causes loss of data if two or more 
systems access to the same folder. Please create the unique 
folder for each system.

NOTE: Before you export patient data/images using Network Storage, 
check �Export to Network Storage: Create DICOMDIR� in 
Utility -> Connectivity -> Miscellaneous. If you uncheck this 
parameter, you must import the data to review.

Potential risk

� Patient/Image data might not be sent at all with inaccurate 
network configuration.

� Patient/Image data might be lost by disconnecting the 
network.

� Patient/Image data might be damaged by unstable network/
data coupling.

� Patient/Image data might be mixed up by network/data 
coupling.

� Patient/Image data might be sent to wrong destination if 
network configuration is not inaccurate.

� The system might be attacked by a virus and vulnerable 
infection.

� Network is not connected by IP address conflict.

CAUTION After MPEGVue to Network Storage, the MPEGVue patient 
may not be listed in the To list. Make sure to confirm on the 
destination to storage whether the copy of data succeeded. 
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Versana Active Setup

NOTE: Create a Share folder on your PC on the network before 
continuing with this setup.

1. Select Utility -> Connectivity -> Device. 

2. Select Add.

3. Type the computer name in the Name field and Static IP 
address in the IP Address field. 

NOTE: Only use alphanumeric characters for the name.

NOTE: If you change Static IP Address after export, you cannot 
import patient data/image. In this case, type previous IP 
address again before import. 

 Figure 15-13. Network Storage Service setup - Device
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Network Storage Service  (continued)

4. Select Ping to verify the icon changes (smiley face 
appears). 

5. Select Service.

Select the Network Storage from the pull-down menu. 
Select Add. 

Specify the properties for this service.

� Name: Enter unique name that identifies this service.

NOTE: Do not use the same name for any other Service or 
device.

� Password: Enter the password used for logging onto the 
PC.

� User name: Enter the user name used for logging onto 
the PC.

� Shared Dir: Enter the Share name of the folder.

NOTE: Only use alphameric characters for the Shared Dir.

6. Select Save and select Verify to verify the icon changes 
(smiley face appears).

It takes a long time to access Network Storage Service by 
the condition of the network. 

Setup on your PC

Check with your network administrator about the LAN 
connection and setting method of the shared folder.
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Printing Options

Setting up Digital Peripherals

You set up digital peripherals from the Utility --> System --> 
Peripherals menu. 

NOTE: Printing using a standard printing service overrides the 
orientation and N-up feature of the printer preferences. Printer 
preferences are set up in the printer folder (via Utility-->System 
-->Peripherals. Select Properties under Standard Printer 
Properties). 
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Digital Printer Setup
There are two steps to do when setting up a digital printer: 
1) follow the procedure below for each printer, then 2) set up 
specific properties for each printer if you need. 

Follow this procedure for each printer:

1. Select Utility--> Connectivity--> Service. Add the Standard 
Print. Highlight Standard Print in the Service list. Select the 
printer from the Printer pull-down Properties menu. For the 
UP-D898 printer, select �Portrait� as orientation. 

2. Type the printer name in the Name field. This name is used 
on the Button screen. After you select the printer from the 
Printer pull-down Properties menu again, it turns white. 
Press Save. 

3. Select Button. Select the appropriate print key (Print1, 
Print2, Print3) from the Physical Print Buttons section as 
shown in the figure below. Select the printer from the 
MyComputer column and press >> to move it to the 
Printflow View column. Press Save. 

 Figure 15-14. Print buttons
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Sony UP-D898 Instructions

Follow these steps to set up the paper size of Sony UP-D898 
printer. 

1. Press Utility-->System-->Peripherals. Select the UP-D898 
from the pull-down menu under Standard Printer Properties. 
Click Properties.

Figure 15-15. Properties

2. Click Print -> Printing Preferences at the menu of Properties 
Window.

 Figure 15-16. Properties



Recording Images

15-50 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10

Sony UP-D898 Instructions  (continued)

3. Select Paper Size. Press Apply. Press OK.

Figure 15-17. Printing Preferences

4. Press Save, then Exit.



Printing Options

Versana Active � Basic User Manual 15-51
Direction 5840764-100 English Rev. 10

Setting up the Off-Line Paper Printer

You can connect an off-line paper printer via the USB 
connection. 

Figure 15-18. Patient Environment

CAUTION When using external commercial printers, the PUI (Printer USB 
Isolator) shall be used to provide safety protection.

CAUTION ONLY plug in devices to the USB ports located at the side of 
the system WHILE the Versana Active is NOT powered up. If 
you plug in a device while the Versana Active is powered on, 
your system may become unusable.

CAUTION DO NOT place an off-line paper printer inside the patient 
environment. This assures compliance to leakage current. 
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Setting up the off-line paper printer

NOTE: The printer driver is customized for the Versana Active at the 
factory; you do not need to change the settings. 

1. Connect the printer to the USB port. 

2. Select Utility--> Connectivity--> Service. Add the 
Standard Print service. 

 Figure 15-19. Connectivity -> Service Screen

3. Select the printer from the Printer pull-down Properties 
menu. 

NOTE: After selecting the printer, the field turns white. 

4. Set the following parameters in Properties: 

� Rows=3

� Columns=2

� Orientation=Portrait

� Right Margin (mm)=10

5. Type the printer name in the Name field. 

NOTE: This name is used on the Button screen. 
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Setting up the off-line paper printer  (continued)

6. Press Save, then select the Button tab. 

7. Select the Print key from the control panel. 

8. Select the printer from the MyComputer column and press 
�>>� to move it to the Printflow View column. 

 Figure 15-20. Connectivity -> Button Screen

9. If you want to assign this printer to the Standard Print Button 
on the Active Image Screen, select this printer at the Active 
Image Printer section. 

10. Press Save. 

NOTE: If you want settings other than 1 image per sheet, or 2x3 sheet, 
or to improve the image quality, refer to the manual that came 
with the printer. 
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Setting up the Printer to Print Reports

To set up the Off-Line Printer to print reports, 

1. Enter Utility--> System--> Peripherals. 

2. Select the printer from Default Printer pull-down menu. 

Figure 15-21. Report Printer Setup

3. Press Save. 

4. Press Print on the Report screen to print the report. 
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Chapter 16

Customizing Your System

Describes how to create system, user, and exam 
presets. 
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Preset

Overview

Preset Menus provides the following functionality: 

� System presets. View and update general system 
configuration settings, measurement settings, backup and 
restore data and configuration files. 

� Imaging presets. View and update exam and imaging 
parameters. 

� Comments presets. Set up comment libraries by 
application. 

� Body Patterns presets. Set up body pattern libraries by 
application. 

� Application presets. Configure application- and 
user-specific settings. 

� Test Patterns presets. Helps configure system settings. 

� Connectivity Setup. Define connection and communication 
setup, including exam dataflow information. 

� Measure presets. Customize exam studies, create 
measurements, set up manual sequencing, and create OB 
Tables. 

� Reports presets. Allows you to edit report template, 
diagnosis codes, and report comments. Please refer to 
Chapter 14 for more information. 

� Admin presets. Perform system administrator activities 
such as setting up user IDs and logon formats. 

� Service. Activates the Service Browser. 

� Scan Coach. Create, import/export, and manage Scan 
Coach programs. 

� Scan Assistant. Create, import/export, and manage Scan 
Assistant programs. 

� Preset Manager. Activates the imaging preset to create, 
edit, import and export user imaging presets.

� Search. You can search for a parameter on the Utility pages 
(Measure, Reports, and Service pages cannot be 
searched.) 

To access these functions, select the Utility on the keyboard, 
then select the appropriate menu key. 
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System Presets

Overview

System presets allows you to view or change the following 
parameters:

� General � Location, Date/Time, General User Interface, 
Ttile bar, Trackball, Key Usage, Utility, Scan Coach and 
Audio configuration

� System Imaging �  Biopsy Guides, Automatic Wide 
Screen, QAnalysis Statistics Value Display, Image Control 
and Display configuration

� System Measure � Measurement, Cursor and Results 
Window configuration, SonoBiometry (AFB)

� Backup/Restore � Backup, Media, EZBackup/EZMove, 
Restore, Detailed Restore of User Defined.

� Peripherals � Print and Store Options, Standard Printer 
properties, Default Printer and Setup configuration

� User Configurable Key � User Defined keys, Keyboard 
key.

� About � System software, patent, and image information
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Changing system parameters

To change system parameters:

1. Select Utility on the keyboard.

2. Then select System.

The System screen is displayed.

3. On the monitor display, move the Trackball to select the tab 
that has the information you want to change. 

4. Select values for the parameters you want to change.

5. To save the changes, select the Save button. Select Exit to 
return to scanning. In some cases, you may need to reboot 
the system for the change to take effect. 
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System/General Preset Menu

The System/General screen allows you to specify hospital name 
and system date and time.

 Figure 16-1. System/General Preset Menu
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System/General Preset Menu  (continued)

Table 16-1:  Location

Preset Parameter Description

Hospital Type the institution�s name.

Department Type the institution�s department name.

Preset Region  (restart 
needed)

Select region (None, Asia, EU, China, India, USA_LA, EAGM).

Language (restart needed) Select the appropriate language from the drop-down list.

Units Select metric or US units of measurement.

Regional Options Select to set up the keyboard. 

Table 16-2:  Date and Time

Preset Parameter Description

Time Format Select the time format: 12 Hr. AM/PM or 24 Hr.

Date Format Select the date format: dd/mm/yyyy, mm/dd/yyyy, or yyyy/mm/dd.

Default Century Select the default century for the system to use.

Date/Time Select to display the Date/Time Properties window, to specify the system 
date, time, time zone, and to auto adjust for daylight savings time. 

Table 16-3:  System Prompt Sound

Preset Parameter Description

System Prompt Sound Check box to initiate system operation prompt sound.

Table 16-4:  Title Bar

Preset Parameter Description

Hide Patient Data When set to Always, patient information is removed from the scanning screen 
Title bar and when storing images; or you can set this to remove patient 
information only when storing the image (On Store); or Never. 
Note: Upon recall of images with measurements, Dual image, the DICOM 
image is recalled. In this case, there is no patient data burned into the 
DICOM image. If you DO NOT want this to occur, set this to Never. 
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System/General Preset Menu  (continued)

Table 16-5:  Trackball

Preset Parameter Description

Speed Set how fast you want the Trackball to move while performing actions such 
as tracing the anatomy. 0=Slow; 20=Very Fast 

Acceleration Set how fast you want to trackball to move across the display. 0, 1, and 2 with 
0 being the slowest acceleration. 

Table 16-6:  Key Usage

Preset Parameter Description

Run Fast Key speed Select the maximum value of the key interval when running Fast Key.

Table 16-7:  Utility

Preset Parameter Description

Prompt for Save on Exit If selected, the system prompts you to save data when you select exit without 
saving.

Table 16-8:  Scan Coach

Preset Parameter Description

Always Use Protocol 
Preview

Show the protocol preview before the Scan Coach starts.

Table 16-9:  Scan Assistant

Preset Parameter Description

Always Use Doppler 
Cursor

Use the Doppler Cursor when you activate Scan Assistant. 

Table 16-10:  Audio

Preset Parameter Description

Reset Audio Volume Reset audio volume to default configuration.

Table 16-11:  Control Panel Key Backlight

Preset Parameter Description

Reset Control Panel Key 
Backlight

Reset control panel key backlight to default configuration.
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Language Keyboard Setup

NOTE: You must apply the changes on each setup page before moving 
to the next page. 

1. In Utility -> System -> General, select Regional Options. 

Figure 16-2. Region Option

2. Under Formats select desired language. 

Figure 16-3. Formats selection
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Language Keyboard Setup  (continued)

3. Under Location select desired location. 

Figure 16-4. Regional Options

4. Under Administrative, select Change system locale....

Figure 16-5. Administrative



Customizing Your System

16-10 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10

Language Keyboard Setup  (continued)

5. Select Apply when below message displays.

Figure 16-6. Change Regional Options

6. Select the language under Current system locale, then 
select OK. 

Figure 16-7. Set Language
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Language Keyboard Setup  (continued)

7. Select Cancel not to restart the system. 

Figure 16-8. Restart Request

8. Select Close to close the window.

Figure 16-9. Close Window
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Language Keyboard Setup  (continued)

9. Select Cancel to return to the system setting.

Figure 16-10. Restart Request

10. In Utility -> System -> General, select the language as 
desired, and then select Save.

Figure 16-11. Change the System Language

NOTE: Input language must match with system language to avoid 
corrupted words.

11. Click Restart now to restart the system.

Figure 16-12. Restart Request

12. When the system boots up, the system appears in the 
selected language. 

NOTE: To have the settings take effect, you MUST restart the system. 

NOTE: Press Alt+Shift to change the input language. 
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System/System Imaging Preset Menu

The System/System Imaging screen allows you to specify 
parameters for biopsy guides, automatic wide screen, QAnalysis 
statistic value display and image control and display.

 Figure 16-13. System/System Imaging Preset Menu 

Table 16-12:  Biopsy Guides

Preset Parameter Description

Show Center Line Displays center biopsy guideline. 

Show Outer Lines Displays outer biopsy guidelines. 

Enable 0.5cm markers Activates biopsy depth markers every 0.5cm. 

Show Biopsy Mark on CFM 
Simultaneous Mode

Displays the Biopsy Guideline on the image while in Simultaneous Mode. 

Show Biopsy Mark on 
Contrast Dual View Mode

Displays the Biopsy Guideline on the image while in Contrast Dual View 
Mode.



Customizing Your System

16-14 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10

System/System Imaging Preset Menu  (continued)

Table 16-13:  Automatic Wide Screen...

Preset Parameter Description

Dual Screen Automatically switch to Wide Screen when in Dual Screen. 

DualView (Simultaneous) Automatically switch to Wide Screen when in Simultaneous DualView 
Screen.

Contrast DualView Automatically switch to Wide Screen when in Contrast DualView Screen.

LOGIQ View Automatically switch to Wide Screen when in LOGIQ View.

QAnalysis Automatically switch to Wide Screen when in QAnalysis.

Table 16-14:  QAnalysis Statistic Value Display

Preset Parameter Description

Max Ratio When selected, the system displays the maximum Ratio of Color (Power) 
Doppler pixels in each ROI in Statistics result.

Time of Max Ratio When selected, the system displays in which frame the maximum Ratio of 
Color (Power) Doppler pixels occurs in Statistics result.

Min Ratio When selected, the system displays the minimum Ratio of Color (Power) 
Doppler pixels in each ROI in Statistics result.

Time of Min Ratio When selected, the system displays in which frame the minimum Ratio of 
Color (Power) Doppler pixels occurs in Statistics result.

Table 16-15:  Controls

Preset Parameter Description

Save Modified Preset of All 
Modes

Save all modes preset after modified

Auto Invert on Linear Steer When selected, for auto calcs, automatically inverts the timeline if needed 
when using ASO.

Auto Invert on ASO Automatically inverts the spectrum with ASO. 

Link Color/Doppler Invert When selected, the Doppler timeline scale inverts along with the color ROI.

Toggling Zoom Rotary 
Performs Depth

When selected, you can adjust the Depth by moving the toggle Zoom rotary.

Audio Volume Adjust the Audio Volume.

Control Panel Key 
Backlight

Adjust the control panel key backlight brightness.

Auto Freeze Automatically freezes the system after 120 seconds of inactivity.

Countdown Time For 
Contrast (sec)

When selected, you can configure the system to perform a countdown for the 
contrast injection.
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Reverse Depth Control Select to change key direction for the Depth control.

Reverse Steer Controls Select to change key direction for the Steer controls.

Turn Off CrossXBeam for 
LOGIQView (non-linear 
probe)

Deactivates CrossXBeam when you activate LOGIQView. 

Doppler Scroll Priority Set to 2D, Doppler, or Last Live Mode.

Activate M/D Cursor Select to activate M/D cursor.

Table 16-16:  Display

Preset Parameter Description

Horizontal Scale Select to display width markers. 

TGC Display Select to display TGC curve.

PW Velocity Units in cm/s Select to change scale on timeline from meters per second to centimeters 
per second.

Display image size
(probe selection required)

Select Default or Large. 

Highlight Image Parameter 
Changes

Select if you want the display to indicate which controls you adjusted by 
highlighting the new value on the display. 

Show Clipboard Deselect to hide the clipboard. 

Overlay Color (single 
visible dataset)

Select Red, Green, Blue or BW.

Hide Multiple Dataset 
Menu When Storing

Select to hide the Multiple Dataset Menu when storing.

Table 16-17:  Auto Zoom Linear Probe Images at Shallow Depth...

Preset Parameter Description

Single Screen Automatically zoom linear probe images at a shallow depth on a single 
screen. 

Dual Screen and DualView Automatically zoom linear probe images at a shallow depth on the dual and 
DualView screen. 

Table 16-15:  Controls (Continued)

Preset Parameter Description
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System/System Measure Preset Menu

The System/System Measure screen allows you to specify 
measurement parameters such as the type of default OB 
measurements and calculations. You can also define cursor and 
Results Window default functionality.

 Figure 16-14. System/System Measure Preset Menu 
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System/System Measure Preset Menu  (continued)
Table 16-18:  Measurement

Preset Parameter Description

Repeat Measurement Select No, Repeat, DefaultMeasure

OB Type Select which OB measurements and calculations studies to use: USA, 
Europe, Tokyo, Osaka, or ASUM.

EFW GP Select the source used to calculate EFW-GP Estimated Fetal Weight-Growth 
Percentile)

CUA/AUA for Hadlock Select to use CUA (Composite Ultrasound Age) or AUA (Average Ultrasound 
Age) as the default

Hadlock Table Type Select Hadlock 82 or Hadlock 84 tables

EFW Formula (Europe) Select the source used to calculate EFW (Europe) (Estimated Fetal Weight)

EFW Formula (Tokyo) Select the source used to calculate EFW (Tokyo) (Estimated Fetal Weight)

Add 1 week to EDD Select to add additional week to estimated date of delivery

OB Graph Display Select Single or Quad for displaying OB Graphs. 

OB Graph Single Display Select Last Meas or EFW Single OB Graph displayed by default.

Fix Caliper by Print key Select to use the Print key like the Set key. 
NOTE: If you select this during a generic volume measurement, the print key 
does not function like the Set key, but instead ends the measurement 
sequence and initiates the volume calculation based on the number of 
measurements taken so far. 

Change Caliper by 
Measure key

Check box to change Caliper by Measure key.

LV Study using straight line Sets straight line as the default for 2D LV studies. 

Side selections of Rt, Lt 
and Off

Select to use �Rt, Lt and Off� for Side Selection. When not selected, displays 
only �Rt and Lt�.
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System/System Measure Preset Menu  (continued)

Table 16-19:  SonoBiometry Option Selection

Preset Parameter Description

BPD/HC Setting Select Only BPD, Accept BPD manually then activate HC, or Accept Setting 
BPD automatically then activate HC.

2D Auto HC Ellipse

Select checkboxes to choose SonoBiometry options.
2D Auto BPD Caliper

2D Auto AC Ellipse

2D Auto FL/HL Caliper

Table 16-20:  Cursor 

Preset Parameter Description

Cursor Type Select whether to mark measurements with numbers or symbols.

Cursor Size Specify 12x12 or 9x9. 

Cursor Line Display If selected, after you press Set to complete a measurement, the cursor line is 
displayed. If not selected, after you press Set to complete a measurement, 
only the cursor number or symbol is displayed.

Cursor Ellipse Cross Line 
Display

Check box to display the cross line in Ellipse. 

D Manual Trace Cross 
Line Display

Check box to display the cross line with the caliper. 

Cursor Position Select 1st Cursor, 2nd Cursor, or Image Center. 

Color When Set 
(restart needed)

Select white, yellow, bright red, or orange. 

Color is displayed when 
trackball is moved

Is selected, color is displayed when trackball is moved. 
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System/System Measure Preset Menu  (continued)

Table 16-21:  Results Window

Preset Parameter Description

Result Window Mode 
Depend

Select this if you want the measurement result window to be repositioned, 
depending on the mode. 

Result Window Position 
X[0-800]

You can set the coordinates for the measurement result window when you do 
not have the result window set to be mode dependent. This is the X 
coordinate (left/right) 

Result Window Position 
Y[0-600]

You can set the coordinates for the measurement result window when you do 
not have the result window set to be mode dependent. This is the Y 
coordinate (up/down) 

Result Window 
Location-2D

Select the Result Window location on the Monitor Display.

Result Window 
Location-Timeline

Select the Result Window location.

Result Window Format Select Wide or Narrow. 

Font Color (restart needed) Select White, Off White, Yellow, Bright Red or Orange (reboots the system). 

Font Size (restart needed) Select Mini, Small, Medium, Large or Extra Large (reboots the system). 
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System/Backup and Restore Preset Menu

The backup and restore procedures described in this section are 
divided into two parts. The first part describes procedures to 
backup and restore patient data. The second part describes 
procedures to backup and restore system and user-defined 
configurations.

The Backup/Restore function enables the user to:

� Copy/Restore the patient archive.

� Copy/Restore the system configuration. The Copy/Restore 
system configuration feature enables the user to configure 
several units with identical presets, providing that the units 
have the same software version.

Depending on the system, you can use either a CD-R, DVD-R, 
USB Flash Drive, or USB Hard Disk for system backup/restore. 
For the sake of simplicity, we have used the CD-R in the 
following examples. 

NOTE: The system ONLY supports CD-R / DVD-R and DOES NOT 
support CD-RW / DVD+R. 

WARNING GE is not responsible for lost data if the suggested backup 
procedures are not followed and will not aid in the recovery of 
lost data.

WARNING The Versana Active is not intended to be used as a storage 
device; backup of the Patient and Image Database is your 
institution�s responsibility. GE is NOT responsible for any lost 
patient information or for lost images.

WARNING The system crash can cause the SSD corruption.The SSD is 
not considered a permanent storage device. Backup data on a 
regular basis. 
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System/Backup and Restore Preset Menu  (continued)

CAUTION To minimize accidental loss of data, perform EZBackup and 
Backup on a regular basis.   

1. First, perform EZBackup to save the images.

2. Next, perform Backup at Utility -> System -> Backup/
Restore. Enable the following checkboxes under Backup: 

� Patient Archive 

� User defined configuration

� Service

CAUTION Archived data is managed at the individual sites. Performing 
data backup (to any device) is recommended.

CAUTION Make sure to verify the media after writing of data, such as 
EZBackup, SaveAs or Export.     

Verifying media requires additional time, which varies 
depending on the amount of data backed up or exported.

CAUTION Before deleting a patient or image from the patient screen, 
make sure you have saved the data by EZBackup/Backup or 
Export and verify that the media transfer of data was 
successful. 
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System/Backup and Restore Preset Menu  (continued)

 Figure 16-15. System/Backup/Restore Preset Menu

Table 16-22:  Backup

Preset Parameter Description

Patient Archive Select to back up patient data.

User Defined Configuration Select to back up the user-defined configuration settings.

Service Select to back up Service settings.

Backup Select to begin the backup.

Table 16-23:  Media

Preset Parameter Description

Media Select media type to use for backup and restore. 
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System/Backup and Restore Preset Menu  (continued)

Table 16-24:  EZMove

Preset Parameter Description

Move Files Older Than in 
Days

The system will move images older than the number of days specified here. If 
you enter a zero (0), then all of the images from today on will be moved.

Media Select media type.

Media capacity for 
estimate (MB)

Specify the capacity of the backup media. 

Table 16-25:  EZBackup

Preset Parameter Description

Reminder Dialog Interval 
days

Specify the number of days after the last backup that you want the system to 
prompt you to perform an EZBackup/EZMove procedure (only for moving 
images). 

Enable Reminder Dialog Select to activate the EZBackup/EZMove reminder pop-up dialog. 

Media Select media type.

Media capacity for 
estimate (MB)

Specify the capacity of the backup media. 

Table 16-26:  Restore 

Preset Parameter Description

Patient Archive Select to restore patient data.

User Defined Configuration Select to restore the user-defined configuration settings.

Service Select to restore service iLinq and Network settings. 
CAUTION: DO NOT restore service presets on to a different Versana Active 
system. Only restore service presets to the same system. 

Restore Select to begin the restore process for the selected configuration files.
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System/Backup and Restore Preset Menu  (continued)

The detailed section of this menu allows you to restore one area 
at a time from the user defined configuration. This allows you to 
selectively restore what you want to restore across multiple 
machines. Check the box(es) you want to restore, insert the 
appropriate media, and press Restore. 

NOTE: When you restore backup data from the Utility menu, the 
Versana Active application usually restarts automatically when 
the restoring is complete.

Table 16-27:  Detailed Restore

Preset Parameter Description

Imaging Presets Select to restore imaging presets.

Connectivity Configuration Select to restore connectivity configurations.

Measurement 
Configuration

Select to restore measurement configurations.

Comment/Body Pattern 
Libraries

Select to restore comment and body pattern configurations.

Protocol Templates Select to restore Protocol Templates.

Fast Key Select to restore Fast Key. 

Utility-->Application 
Presets

Select to restore Utility--> Application presets. 

Custom Programs Select to restore Scan Coach/Assistant programs. 

All Others Select to restore all other configurations not listed in the Detailed Restore 
section. This includes parameters defined on the System preset menus.

Restore Select to begin the restore process for the selected configuration files.
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Backup and Restore

To minimize accidental loss of data, perform backup of the 
patient archives stored on the local hard drive DAILY as 
described in this section. Use a formatted Backup/Restore disk 
to back up patient archives from the hard drive, using the 
backup procedure described in this section. Data from the 
Backup/Restore disk may be restored to the local hard drive 
using the restore procedure.

NOTE: Backup/Restore Patient Archive/User Defined Configuration/
Service are not allowed to transfer between R1.1.x and R1.2.x, 
as these data are incompatible.
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Backup procedure

Back up patient data AFTER you�ve archived (via EZBackup/
EZMove) images so that the pointers to the patient�s images 
reflect that the images have been moved to removable media 
and are no longer on the hard drive. 

1. Insert a media into the drive or USB device into a USB port.

NOTE: About formatting media, See �Formatting removable media� 
on page 16-102 for more information..

2. In the archive screen, select the dataflow Local Archive - Int. 
HD.

3. Enter Utility-> System-> Backup/Restore.

The Backup/Restore screen is displayed.

4. In the Backup list,

� Select Patient Archive to backup the patient records.

� Select User Defined Configuration to copy system 
settings and user presets.

� Select Service to backup service presets.

NOTE: The detailed section of this menu decouples the user 
defined configuration above. This allows you to selectively 
restore what you want to restore across multiple machines. 

5. Specify where to save data in the media field.

6. Select Backup.

The system performs the backup. As it proceeds, status 
information is displayed on the Backup/Restore screen.

7. At the end of the process, the Backup completed message 
is displayed on the monitor.

Press Eject (F3) for eject media/disconnect USB.

8. Make sure to physically label the media. An identification of 
the system should also be noted on the media and a backup 
log should be kept.

File the media in a safe place.
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Restore procedure

1. Enter Utility-> System-> Backup/Restore.

The Backup/Restore screen is displayed.

2. In the Restore list,

� Select Patient Archive to restore the patient archive.

� Select User Defined Configuration to restore all 
system settings and user presets.

or

One or several system configuration items to restore 
parts of the Detailed Restore of User Defined.

� Select Service to backup service presets.

3. In the Media field, select the appropriate Source device.

4. Select Restore.

The system performs the restore. As it proceeds, status 
information is displayed on the Backup/Restore screen.

5. The Versana Active restarts automatically when Restore is 
done. 

CAUTION The restore procedure overwrites the existing database on the 
local hard drive. Make sure to insert the correct media.

You cannot restore the data between systems with different 
software versions.

CAUTION To avoid the risk of overwriting the local patient and report 
archives, DO NOT check Patient Archive when restoring 
user-defined configurations.
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Backup and restore strategy: user-defined configurations

In addition to generating a safety copy, the backup/restore 
function of the user-defined configuration (presets) can be used 
to configure several Versana Active systems with identical 
presets (preset synchronization).

Preset synchronization

The procedure for preset synchronization of several scanners is 
as follow:

1. Make a backup of the user-defined configurations on a 
removable media from a fully configured Versana Active 
system.

2. Restore user-defined configurations from the removable 
media to another Versana Active system (you can restore all 
the user-defined presets or select specific presets to restore 
via Detailed Restore).
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EZBackup and EZMove

EZBackup or EZMove allows you to manage hard disk space 
(move images off the hard drive) while maintaining the patient 
database on the scanner, as well as to back up the patient 
database and images. 

� EZBackup: Copy the data from the local SSD to the 
removable media.

� EZMove: Copy the data from the local SSD to the 
removable media. After copying the image file to the media, 
EZMove deletes the image file from the Local SSD.

HINTS PLEASE READ THIS

Ensure that you have established a data management protocol 
for your office/institution. You MUST manage the backup media 
by keeping a log and by creating a media filing system. 

For example, if you need to back up 500 MB/day, or 2.5 GB/
week, then you need to back up 5 CDs/s/week, or ~250CDs/
year. 

Generally speaking, you should back up the system when you 
have 10 GB of images to back up. 

You should assign the person who is in charge of performing 
the backups. Backups will vary by the volume of your work. You 
need to track how long it takes your office/institution to get to 
10 GB, and set the back-up parameters accordingly. 

Your office/institution needs to determine your backup strategy, 
for instance, backup weekly and move monthly. It should be an 
easy strategy to perform and to remember. And follow this 
same strategy/schedule consistently. 

It�s also useful to keep your more recent information on the 
hard drive since it�s easier to recall that way. 
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EZBackup and EZMove  (continued)

CAUTION You can still do a backup/move daily; but ALWAYS do a patient 
archive backup after each move. 

CAUTION Only cancel the backup/move in case of an emergency. The 
system completes backing up the current media and then 
cancels the operation.

CAUTION When EZBackup requires more than one disk (CD-R or 
DVD-R) for backup, a message appears when the first disk is 
full. If you select �Cancel� to stop the backup procedure and 
later try EZBackup again, all the data may not be backed up.

Select �Full Backup� on the first EZBackup wizard screen if the 
last time you were performing EZBackup you selected 
�Cancel�.

CAUTION If you use EZBackup or EZMove as a �true� patient archive, 
you must maintain a separate backup of the patient database 
(Patient Archive and Report Archive). If for any reason the 
Local Archive - Int HD gets corrupted or the base system 
software has to be reloaded, then the patient archive is the 
ONLY way to rebuild the EZBackup and EZMove patient 
archive. 

CAUTION DO NOT turn off the power while EZBackup is running. The 
data may be lost. It may take several hours for EZBackup to 
finish, depending on the amount of data being backed up.

The following may give the impression of a lockup, but 
EZBackup is continuing in the background.

� The progress bar does not move.

� The screen may become white.

� The hourglass icon keep turning.
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EZBackup and EZMove  (continued)

NOTE: Export/Import Patient data are not allowed to transfer between 
R1.1.x and R1.2.x, as these data are incompatible.

NOTE: EZBackup/EZMove are saved data as RAW data. If you import 
data to the system, you can modify the image data. 

NOTE: To display exported Raw DICOM images on a PC, you need the 
dedicated viewer.

NOTE: When backing up or moving reports using EZBackup and 
EZMove, use the USB HDD. DVDs and CDs are not supported 
for backing up or moving reports using EZBackup and EZMove.

NOTE: �Archived� information is saved to each exam during EZBackup. 
When you perform EZBackup, the system backs up the exams 
except for the archived exam.

NOTE: EZBackup/EZMove cannot span a single image across two (2) 
or more media. Therefore, if EZBackup/EZMove encounters an 
image that is greater than the capacity of the media, it skips the 
oversized image. 

NOTE: EZBackup/EZMove does not store images to media in 
sequential order. Instead it maximizes the most amount of 
images per media. 

NOTE: If the system locks up during the media auto format process, 
shutdown the system by holding down the power button and 
boot it up again. After the system is up, replace the media to a 
new one and execute EZBackup or EZMove again. To avoid a 
trouble such as data loss, do not reuse the failed media for any 
other function.

NOTE: If you try exporting a previously backed-up exam, the message 
�Can�t Find Source file� displays. The image data had already 
been removed from the hard disk drive with EZBackup/EZMove. 

CAUTION NEVER restore the patient archive from media made previous 
to the last move. 
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EZBackup and EZMove  (continued)

Basically, when you perform the EZBackup or EZMove 
procedure, you insert the media (or connect USB HDD if 
applicable), the system backs up/moves the images, and 
creates a reference between the patient database and the 
media�s volume. 

EZBackup/EZMove can take up to 20 minutes (or longer, 
depending on the size of the backup). Make sure to schedule 
this at the same time daily, when no patients are scheduled. 

1. Prepare unformatted media or the USB HDD before starting 
EZBackup/EZMove.

2. Specify the EZBackup/EZMove setup on the Utility --> 
System --> Backup/Restore page. 
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EZBackup and EZMove  (continued)

3. To start the EZBackup/EZMove procedure, go to the Patient 
menu and select EZBackup/EZMove. The EZBackup/
EZMove Wizard starts. 

NOTE: If you use the USB HDD, some wizards and the pop-up 
messages DO NOT appear. 

 Figure 16-16. Archive Screen
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EZBackup and EZMove  (continued)

4. Verify the information on the first page of the EZBackup/
EZMove Wizard, then press Next. 

Full backup options display on the first page of the 
EZBackup wizard. If you want to backup all of the exams in 
the range (even if the exam was previously backed up, 
check this option). If you uncheck this option, the system 
only backs up exams which have not yet been backed up. 

EZBackup does not back up the exams which were 
previously backed up once by EZBackup or Export. 

NOTE: You can set the range in Utility --> System --> Backup/
Restore --> Move files older than in days for EZMove. 

NOTE: If you update an exam which is already backed up, the 
exam is also backed up. 

Figure 16-17. EZBackup Wizard, Page 1
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EZBackup and EZMove  (continued)

5. Verify the information on the EZBackup/EZMove Wizard, 
Page 2. The backup may span multiple media. This page 
tells you how many media you need to do this backup. After 
you have gathered the media (allow for one extra media, 
just in case), you are ready to begin the backup. Press Next. 

If the storage capacity of the USB HD is insufficient, you will 
see the message, �Selected Location does not have enough 
free space.�

NOTE: The calculation for the number of backup CD is only an 
estimate. Allow for one additional CD when performing an 
EZBackup/EZMove.

NOTE: This message appears if you press Next without inserting 
the backup media: �Please insert a blank media...�. Insert 
the media and continue. 

Figure 16-18. EZBackup/EZMove Wizard, Page 2
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EZBackup and EZMove  (continued)

6. A pop-up message appears that provides you with the 
media label. Label the media, then insert the media. Press 
OK. 

Figure 16-19. Insert Media Message

a. Ensure that you label the media with not only the 
volume name indicated on the Insert Media Message, 
but with the name of the Versana Active system where 
this backup/move procedure was done. 

b. Update the EZBackup/EZMove log with this information 
the volume information and the location of the media. 

c. After the backup/move has been completed, file the 
media. 

Table 16-28:  Typical EZBackup/EZMove Log

Date
Scanner ID 

Name
Backup 

Images Y/N
Older than 

__ Days
Move 

Images Y/N

Media Label 
(and 

Scanner ID)
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EZBackup and EZMove  (continued)

7. A pop-up window shows the system is checking whether the 
media is inside the drive.

Figure 16-20. Check Media

� If the media is in the drive, the window automatically 
disappears when the checking is completed. The 
EZBackup progress then begins.

� If the media is not in the drive, a pop-up message 
appears notifying that there is no media in the drive. 
Press OK. 

Figure 16-21. Insert Disc Error

A pop-up message appears that provides you with the 
media label. Label the media, then insert the media. 
Press OK. 
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EZBackup and EZMove  (continued)

8. The status menu appears. When the backup/move has 
been completed, press Next. 

Figure 16-22. EZBackup Wizard Page 3

NOTE: When/if you need to insert the next media, a message 
appears providing you with the media label. Label the 
media, then insert the next media and press OK.
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EZBackup and EZMove  (continued)

9. When the backup is complete, the completed wizard page 
appears. Press Finish. 

Figure 16-23. EZBackup/EZMove Wizard, Page 4

10. Do a patient archive after each EZBackup/EZMove (move). 

We recommend attaching the patient list to the EZBackup/
EZMove media. Insert the media and select DICOM CD 
Read for dataflow (if you use a USB drive, select DICOM 
USB Drive Read). Select any patient and press the Set key 
to print the patient list on the digital printer. 

NOTE: Use Import to restore EZBackup images.
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To Review EZBackup/EZMove and Export Images

You can review backed up media via the Archive Menu, Import, 
and the DICOM Read dataflow. 

If you review EZMoved image,

1. Select the patient on the Patient Menu (on the same system 
where the EZMove was performed). 

2. Insert the media volume indicated on the Patient Menu. 

3. View the exam from the media. 

NOTE: You may need to insert a media volume prior to or after the 
recommended media. 

NOTE: If the patient is split over multiple media, images on the previous 
or next media are displayed as triangles. 

NOTE: To view the whole patient on the system, use Import, from as 
many media as you have for that patient. However, take care not 
to import studies over existing studies; duplicate or missing 
images may result. Delete the existing exam first. 
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System/Peripherals Menu

The System/Peripherals screen allows you to specify 
parameters for the printers.

Figure 16-24. System/Peripherals Preset Menu

Print and Store Options. Press Print and Store Options to go to 
the Utility --> Connectivity --> Miscellaneous setup page. 

Removable Media. Press Removable Media to go to the Utility  
--> Connectivity --> Removable Media page. 

Table 16-29:  Setup 

Preset Parameter Description

Standard Printer 
Properties: [Printer] and 
Properties, and 
Default Printer

Select to add an additional standard printer via the USB serial port and to 
configure digital printers. This activates the Windows Add Printer wizard. 
NOTE: Most printer drivers are available via Windows; however, newer 
printers may require you to load the manufacturer-supplied print driver (must 
be on CD-ROM). Refer to the Basic Service Manual for more information. 

Print Full Screen Select for the standard printer to print the full screen.

Enable Video Invert Select for the standard printer to print black on white rather than white on 
black.
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System/User Configurable Key

 Figure 16-25. User Configurable Key Preset Menu

Table 16-30:  Key Configurations

Parameter Description

0-9 The  keys are configurable.

Table 16-31:  Enable Hot Key

Parameter Description

Enable Numeric Hot Key Select to activate numeric hot key control.

Enable Alphabet Hot Key Select to activate alphabet hot key control.
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User Defined and Keyboard keys

User Defined Keys can be programmed as one of the following 
functions:

NOTE: Keyboard Keys can be programmed as one of the following 
functions, but some features are not supported.

Table 16-32:  User Defined and Keyboard Keys

Parameter Description

No Function No function.

Active Images Go to Active Images Screen.

Auto Dop. Calcs Turn on/off Auto Calcs in Doppler mode.

Biopsy Guideline Biopsy Guideline Display/change biopsy guide line.

Bluetooth Save Turn on/off bluetooth to save images.

CHI Turn on/off CHI mode.

Clear Saved 
Measurements

Clear all measurements in the selected measurement category. Display the 
Confirmation dialogue before delete data. 

CrossXBeam Turn on/off CrossXBeam.

ECG On/Off Turn on/off ECG.

FollowUp Compare scan result with last scan.

FollowUp Fusion Turn on/off FollowUp Fusion.

My Trainer Turn on/off My Trainer.

OB Graph Display Go to OB Graphy page.

Print3 Behave the function assigned to Print3 via Connectivity-> Button.

Removable Media Go to Media format menu in Utility.

SRI HD Turn on/off SRI HD.

Save as Display SAVE AS menu to save image.

Scan Assistant Turn on/off Scan Assistant.

BFlow Turn on/off BFlow Mode.

Breast Care Turn on/off Breast Care.

Contrast Turn on/off Contrast.

Contrast Triggle Adjust Contrast Triggle.

Elasto Turn on/off Elasto.

LOGIQView Turn on/off LOGIQ View.
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Needle Turn on/off Needle.

Stress echo Turn on/off Stress echo.

TVI Turn on/off TVI mode.

3D/4D Turn on/off 3D/4D.

CW Turn on/off CW Mode.

PDI Turn on/off PDI.

Table 16-32:  User Defined and Keyboard Keys

Parameter Description
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System/About Preset Menu

The System/About screen lists information about the system 
software.

 Figure 16-26. System About Menu

Table 16-33:  Software

Preset Parameter Description

Software Version The current software version on this system.

Software Part Number The software part number.

Build View The software build view.

Build Date The software build date.

Table 16-34:  Patents

Preset Parameter Description

Patents Lists system patents.

Table 16-35:  System

Preset Parameter Description

System Part Number The system part number.

System Date The system date.

CPU Manufacturer Indicate the CPU Manufacturer.

Gamma Version Indicate the Gamma Version.

Table 16-36:  Additional Information

Preset Parameter Description

Additional About 
Information

Select to open Additional About Information for hardware information: 
Module Name, Revision and Part Number.
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Imaging Presets

Overview
Imaging screens allow you to specify parameters for the 
following:

� B-Mode (B)

� Color Flow Mode (CF)

� Power Doppler Imaging (PDI)

� M-Mode (M)

� Anatomical M-Mode (AMM)

� Pulse Wave Mode (PW)

� Continuous Wave Mode (CW)

� Harmonics (HAR)

� Tissue Velocity Imaging (TVI)

� Tissue Velocity Doppler (TVD)

� General

 Figure 16-27. Imaging - Example

1. Model/application dependent setup parameters

2. Probe dependent setup parameters
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Changing imaging presets

To change imaging presets:

1. Select Utility on the keyboard.

2. On the Top/Sub menu, select Imaging. 

The system displays the Imaging screens.

 Figure 16-28. Example: B-Mode Preset

3. In the row across the top of the screen, select the mode.

The system displays two sets of parameters and settings. 
The left column lists all settings for the exam (for example, 
Abd). The right column lists settings that apply only to the 
exam and probe combination.

4. In the Preset list, select the exam.

5. In the Probe list, select the probe.

6. To change a parameter, do one of the following:

� Select the value from a list.

� Select one value from a choice of two or more buttons.

� Select or clear a check box.

7. After changing the parameters, to save the changes, select 
the Save button.

NOTE: When you Save changes to imaging parameters, the system 
saves changes to all modes, not just the mode currently 
displayed.
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Changing imaging presets  (continued)

NOTE: If you have problems with imaging, you can return parameters 
back to the original settings. Select the exam, probe, and mode, 
and then select Reload Factory Defaults. The system returns the 
selected parameters to the original settings.

For information about the specific parameters, refer to Chapter 5 
Optimizing the Image.
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General

 Figure 16-29. General Presets

You can specify a default probe per application and a default 
application per probe.

Default probe per application

1. To specify a default probe per application, select Utility --> 
Imaging --> General.

2. Select the default probe from the pull-down menu.

Default mode and application per probe

1. To specify a default application per probe, select Utility --> 
Imaging --> General.

2. Under Probe, specify the desired application from the 
pull-down menu.

Other setting

Checkmark the following field when you want the system to 
activate a certain display: 

� Simultaneous

� ECG

� ECG Display

� Sync Mode

If your system has the following options, you must assign the 
option to the button per application and probe.

� B or HAR(Harmonics)

� Acoustic Output (%)

NOTE: If you use the user-defined preset as default preset, re-select 
the preset in Utility whenever you overwrite the user-defined 
preset. 
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Comments Libraries Presets

Overview

Comment screens allow you to specify comment text and 
pointer options, to define comment libraries, and assign 
comment libraries to applications.

Comments Libraries/Libraries Preset Menu

1. On the comments Libraries tab, you can change and create 
comment libraries. A comment library is a list of comments 
that are associated with a specific application. The 
comments are listed in the library in the order in which they 
display on the Comment Menu on the screen. For each 
library, you can define two columns of comments for both 
left and right sides, with 13 rows available for each column.

 Figure 16-30. Comment Libraries Preset Menu 
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Comments Libraries/Libraries Preset Menu  (continued)

Table 16-37:  Libraries

Preset Parameter Description

Library The name of the comment library.

Left and Right Columns The list of comments for the selected library seperated by side.

User Defined Library The name of a new comment library that you want to create/delete.

Add to Existing You can add to the selection of comments.

Delete from Existing You can delete from the existing selection of comments.
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Defining Comments

1. In the Library field, select the library you want. 

The system displays all comments for the library. The 
comments are listed in the order that they are shown when 
you use comments.

2. To change or add an comment, select the comment or blank 
location and press Set, then do one of the following:

� Type the comment.

3. To save the changes, select the Save button.

Creating a new comments library

1. In the User Defined Library field, type a name for the library, 
then select Create.

The system creates a new library.

2. Enter comments as described in step 2 above.

3. To save the changes, select the Save button.

Deleting a user defined library

1. Select the library name which you want to delete from the 
pull-down menu. 

2. Press Delete. 

3. Press Save to save the changes. 
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Comments Libraries/Comments Preset Menu

On the Comments tab, you specify text and pointer options.

Figure 16-31. Comment/Comments Preset Menu

Table 16-38:  Text

Preset Parameter Description

Text Font Size Specify the font size. The font size increases as the number increases. 

Text color (Text1 and 
Text2)

Select the color for comment Text1 and Text2.

Text Boundary Select Group Move or Word Wrapping.

Enable Type Over Mode Select to type over existing comments. Position the cursor over the text to be 
changed, then start typing. 

Automatically Set Text If selected, the system sets the comment at the cursor position automatically 
when text entry is complete. 
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Comments Libraries/Comments Preset Menu  (continued)

After you change comment options, select Save to save the 
changes.

NOTE: Only use letters, numbers or underscore �_� when naming the 
user defined annotation libraries. The name MUST start with 
either a letter or underscore.

Table 16-39:  Arrow

Preset Parameter Description

Arrow Length Select the default pointer length.

Arrow Size Select the default pointer size.

Keep Arrow Angle Keep the angle of arrow pointer head until next change. 

Table 16-40:  General

Preset Parameter Description

Retain while entering or 
leaving timeline mode

If selected, the system keeps the comment(s) on the monitor display when 
you enter or leave timeline mode. 

TextOverlay in Multiple 
Image

When selected, and you select the F8 key to hide or show comments, if you 
are in multiple image, the system hides the text in both images. When 
cleared, the system only hides the text for the active image.

TextOverlay sequence You can specify to display Text1, Text2, or both. This allows you to have 
some comments that do not change during the exam while allowing you to 
change other comments. Toggle the F8 key to cycle through the 3 Text1/
Text12 states.

Erase When the image is 
unfrozen

Deletes comments when you unfreeze the image. If you check this 
parameter, Text2 automatically erase when you unfreeze the image.

Erase When the probe or 
application is changed

Deletes annotations when you change the application or probe.
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Comments Libraries/Applications Preset Menu

The Comments Libraries/Applications tab is a link to the 
Applications preset menu. The Applications preset screen 
allows you to specify which libraries belong to an application. 
You also specify which is the default library that displays when 
you use comments. 

Figure 16-32. Applications/Comments Link

The Applications/Comments screen can be accessed through 
either the Comments Libraries or Applications key.

Specifying which libraries belong to an application

1. On the Comments tab, in the Preset field, select the 
application.

2. In the Library Group Tabs fields, select the libraries for this 
application. 

NOTE: When you use comments, the default library is displayed. To 
use other libraries for the application, press the tab for the 
library.

3. To save the changes, select the Save button.

Using comments from a library

To use comments, press the Comment key on the Control 
Panel. Comments are then displayed on the screen.

Table 16-41:  Applications

Preset Parameter Description

Preset The name of the application preset.

Tabs A list of libraries for the application. 
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Body Patterns Presets

Overview

Body patterns screens allow you to specify body pattern options, 
to define body pattern libraries, and assign body pattern 
libraries.

Body Pattern Libraries/Libraries Preset Menu

On the Body Patterns Libraries tab, you can change and create 
body pattern libraries. A body pattern library is a list of body 
patterns that are associated with a specific application. The 
body patterns are listed in the library in the order in which they 
display on the control panel. For each library, you can define 
three columns of body patterns, with 8 rows in each column.

 Figure 16-33. Body Patterns Libraries Preset Menu
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Body Pattern Libraries/Libraries Preset Menu  (continued)

Table 16-42:  Body Patterns Libraries

Preset Parameter Description

Library The name of the body pattern application library.

Left, Middle and Right 
Columns

The list of body patterns for the selected library.

Body Pattern Image Displays the image of the currently selected body pattern.

User Defined 
Libraries-Create

The name of a new body pattern application library that you want to create.

User Defined 
Libraries-Delete 

Allows the selection of the user defined library to be deleted.

Copy from Existing A list of body patterns you can use to create an application library.

Hot Key The list of body patterns for the selected library can be assigned to 10 
designated alpanumeric keys as hot keys.
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Defining body patterns

1. In the Library field, select the application library you want.

The system displays all body patterns for the library. The 
body patterns are listed in the order that they are shown on 
the menu.

2. To change or add a body pattern, select the body pattern or 
blank location and press Set, then do one of the following:

� Type the body pattern name.

� Select the body pattern in the Copy from Existing list, 
and press Set. 

NOTE: When you select a body pattern name on the menu or in 
the Copy from Existing list, the system displays the 
pattern in the lower left corner of the screen.

3. To save the changes, select the Save button.

Creating a new body pattern library

1. In the User Defined Libraries field, type a name for the 
library, then select Create.

The system creates a new library.

2. Enter body patterns as described in step 2 above.

3. To save the changes, select the Save button.
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Body Pattern Libraries/Body Patterns Preset Menu

On the Body Patterns tab, you specify body pattern options.

 Figure 16-34. Body Patterns General Preset Menu

After you change body pattern options, select Save to save the 
changes.

Table 16-43:  Body Patterns

Preset Parameter Description

Erase When the probe or 
application is changed

If checked, when you change probes or applications, the system erases the 
body pattern.

Erase When the image is 
unfrozen

If checked, when you unfreeze the image, the system erases the body 
pattern.

Copy to active side in 
multiple image

If checked, when you use dual B-Mode, the system copies the body pattern 
to the active side of the dual image.

Body pattern background Select whether you want the body pattern background to be Transparent or 
Opaque.

Use Zoom Rotary key to 
select Body pattern

If selected, you can scroll through the body patterns with the Zoom control.

Bump Body Pattern 
Control for easy entry

If checked, allows you to quickly add a body pattern by nudging the control. 
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Body Pattern Libraries/Applications Preset Menu

The Body Patterns Library/Applications tab is a link to the 
Applications preset menu. The Body Patterns Applications tab 
allows you to select body pattern application libraries. You also 
specify which is the default library that displays when you use 
body patterns.

Figure 16-35. Applications/Body Patterns Link

The Applications/Body Patterns screen can be accessed 
through either the Body Pattern Libraries or Applications keys.

Figure 16-36. Body Patterns Applications Preset Menu

Table 16-44:  Applications

Preset Parameter Description

Preset Defines the Body Pattern option.

Select Library A list of body pattern applications. 
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Selecting body pattern application libraries

1. On the Body Patterns tab, in the Preset field, select the body 
pattern.

2. In the Library Group Tabs fields, select the application 
libraries for Body Patterns. 

3. To save the changes, select the Save button.

NOTE: When you use body patterns, the default library is displayed. To 
use other application libraries, press the tab for the library.

Using body pattern application libraries

See the following Body Patterns Small Parts. 

Figure 16-37. Body Patterns Small Parts

To select a body pattern library, select the tabs (for example, 
ABD or OB). 

To select body patterns, use the Body Pattern control on the 
Control Panel.
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Application Presets

Overview

Application Settings presets allow you to configure the 
application-specific settings (presets). 

Settings

 Figure 16-38. Application Settings Preset Menu

Table 16-45:  Preset

Preset Parameter Description

Preset Select the application that you want to specify the presets. 

Table 16-46:  Image Control and Display

Preset Parameter Description

Show kHz scale When selected, displays the kHz scale on the left side of the Doppler 
spectrum.
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Show Doppler Rate When selected, displays the Doppler rate (mm/s) below the Doppler spectrum. 

Anatomical Angle 
Correction

Select to keep the angle constant with regard to the anatomy. 

Join Dual Image for Linear Select to place linear probe dual images directly next to each other. 

Table 16-47:  When Entering Dual Image...

Preset Parameter Description

Duplicate Frozen Image to 
Opposite Side

When entering Dual Image, duplicate the frozen image to the opposite side. 

Duplicate Live Image to 
Opposite Side

When entering Dual Image, duplicate the live image to the opposite side. 

Table 16-48:  Patient Info

Preset Parameter Description

Titlebar Line 1 Select the patient information to display on the scanning screen Title bar.

Titlebar Line 2 Select the patient information to display on the scanning screen Title bar.

Titlebar Line 3 Select the patient information to display on the scanning screen Title bar.

Table 16-49:  Comments

Preset Parameter Description

Active function at Freeze Select None, Body Pattern, or Comments. If Body Pattern or Comment is 
selected, the Body Pattern or Comment is activated automatically when 
freezing the system.

Table 16-50:  Footswitch

Function Description

Left, Middle, Right Specify from the following for each footswitch pedal: No Function, Freeze, 
Next Heartcycle, Previous Heartcycle, Print 1,2, Update, Next Step (Scan 
Coach/ Assistant), Previous Step (Scan Coach/Assistant), or Scan Assistant 
Pause/Resume.

Table 16-51:  Preset

Preset Parameter Description

Show ECG Tab Check to the ECG Tab on the Screen.

Table 16-46:  Image Control and Display

Preset Parameter Description
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Print Control

You have to set parameters with each application.

 Figure 16-39. Print Control

Table 16-52:  Preset 

Preset Parameter Description

Preset Select Application from pull-down menu. You can set Time span for each 
application. 

Table 16-53:  Live Store 

Preset Parameter Description

P1/P2/P3 Select the behavior of Print key during live scan from Retrospective Clip, 
Single image only or None for each print key. 
None: Store a still image when you press P-key during Freeze. 
Retrospective clip: The system stores cine predetermined time before you 
press the Print button, based on the Time Span setting. 
Single image only: Store a still image during live scan each time you press 
P-Key.   

Table 16-54:  Time-Based Store

Preset Parameter Description

Time span [s] Select the number of seconds of CINE Loop storage. The default is 3 
seconds. 

Preview clip before store When selected, allows you to review cine loops before storage.
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Table 16-55:  ECG Based-Store

Preset Parameter Description

Time before heart cycle 
[ms]

Sets the storage time span before R-wave of the first heart cycle.

Time after heart cycle [ms] Sets the storage time span after R-wave of the last heart cycle.

Number of heart cycles Select the number of heart cycles to store. (Must be de-selected for single 
frame.)

Preview loop before store When selected, allows you to review cine loops before storage.
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Imaging Controls

For B, M, CF, PDI, PW, CW, CM and Cine mode, you can select 
which controls you want to be available on the primary menu for 
the selected application.

 Figure 16-40. Imaging Controls
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Comments and Body Patterns

Comments and Body Patterns were described earlier in this 
chapter.

Measurements

You can set the exam category measurement and calculation 
package you want to appear when you select the exam category 
Preset. 

 Figure 16-41. Application Measurements Menu
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Test Patterns

Overview

There are different test patterns available: Gray Bars, Color 
Bars, Resolution, Text, Brightness Calibration, White, Gray, Red, 
Green and Blue.



Configuring Connectivity

Versana Active � Basic User Manual 16-69
Direction 5840764-100 English Rev. 10

Configuring Connectivity

Overview

You use Connectivity functionality to set up the connection and 
communication protocols for the ultrasound system. This section 
gives an overview of each of the Connectivity functions. Each 
function is described in detail in the following pages. 

Structured Reporting

DICOM Structured Reporting provides the results of a procedure 
as structured data elements (well-defined fields) as opposed to 
unstructured data (large amounts of text undifferentiated by 
individual fields). This greatly improves query capability. DICOM 
Structured Reporting creates coded clinical data that can be 
used for clinical research, outcomes analysis, and disease 
management.

Supported parameters

The DICOM supported parameters are listed in the DICOM 
Conformance Statement at the following web site under DICOM 
- Ultrasound:

http://www.gehealthcare.com/usen/interoperability/dicom/
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Connectivity Functions

To set up your institution�s connectivity, you must login with 
administrator privileges. 

1. TCPIP: allows you to configure the Internet Protocol.

2. Device. allows you to set up devices. 

3. Service: allows you to configure a service (for example, 
DICOM services such as printers, worklist, and other 
services such as standard print) from the list of supported 
services. This means that the user can configure a device 
with the DICOM service(s) that particular device supports.

4. Dataflow: allows you to adjust the settings of the selected 
dataflow and associated services. Selecting a dataflow 
customizes the ultrasound system to work according to the 
services associated with the selected dataflow. 

5. Button: allows you to assign a pre-configured output 
service (or a set of output services) to the Print keys on the 
control panel. 

6. Removable Media: enables formatting (DICOM, database, 
or blank formatting) and DICOM verification of removable 
media.

7. Miscellaneous: allows you to set up the patient exam menu 
options, print and store options, and the order of the 
columns in the examination list on the Patient menu. 

8. Bluetooth. allows you to set up bluetooth device 
connection. 

9. Tricefy. allows you to set up tricefy connection. 

Configure these screens from left to right, starting with the Tcpip 
tab first. 

NOTE: The ultrasound system is pre-configured for many services, with 
default settings selected. You can change these services and 
settings as needed.

CAUTION You must restart the Versana Active (shutdown) after making 
any changes to connectivity settings in the Utility menus. This 
includes any changes on the TCPIP or dataflow setup screens.
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TCPIP

This configuration category enables users with administrative 
rights to set the TCPIP for the system and connected remote 
archive.

1. Type the name of the Ultrasound system in the Computer 
Name field. 

2. In the IP settings section, identify the ultrasound system to 
the rest of the network by one of the following:

� Dynamic Host Configuration Protocol (DHCP) can be 
used provided your network supports the DHCP 
protocol..

� Type the IP-Address. In this case, uncheck the �Enable 
DHCP� box and enter the IP address, Subnet Mask and 
default Gateway. Contact your network administrator if 
you are unsure what values to enter. 

NOTE: Do not set up the system with DHCP. The IP address 
MUST BE static for the diagnostic and DICOM to 
function correctly.

3. Select the Network Speed. 

4. Select Save settings. 

5. Restart the ultrasound system. 

NOTE: TCPIP settings do not get restored when restoring backups. 
This is per system design. The Versana Active IP address 
MUST BE unique.
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TCPIP  (continued)

 Figure 16-42. Connectivity TCPIP Preset Menu 

NOTE: Restart the system to activate any changes saved from this 
page. 

Table 16-56:  Computer Name

Preset Parameter Description

Computer Name Type the unique name for the Ultrasound system (no spaces in name).

Table 16-57:  IP settings

Preset Parameter Description

Enable DHCP DO NOT select this box to enable dynamic IP Address selection.
NOTE: The system shall disable IP-Address, Subnet Mask, and Default 
Gateway when the user chooses to use DHCP.

IP-Address Type the IP Address of the Ultrasound system. NOTE: IP stands for Internet 
Protocol. Every device on the network has a unique IP address. 

Subnet Mask Type the subnet mask address. NOTE: The Subnet Mask is an IP address filter 
that eliminates communication/messages from network devices of no interest 
to your system. 

Default Gateway Type the default gateway address.

Network Speed Select the network speed (Auto Detect, 10Mbps/Half/Full Duplex, 100Mbps/
Half/Full Duplex, or 1000Mbps/Auto-negotiate).

Table 16-58:  Wireless Network

Preset Parameter Description

Configuration Press this button to set up wireless network.

IP-Address Wireless Network IP Address of the Ultrasound system. 

Subnet Mask Wireless Network  subnet mask address.

Default Gateway Wireless Network default gateway address.
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Wireless Network Configuration

A wireless network is available on the Versana Active. When the 
WLAN is actvie, an icon appears in the status bar to indicate 
whether the WLAN is connected or disconnected.

Connecting to the WLAN

To connect the Versana Active to the WLAN:

1. Enter Utility -> Connectivity -> TCP/IP, and select 
Configuration under Wireless Network.

 Figure 16-43. WLAN setting on TCP/IP
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Connecting to the WLAN  (continued)

2. The Wireless Network Configuration tool appears. The 
wireless networks broadcasting in your area appear in the 
list. 

Highlight the wireless network you want to connect, and 
then select Connect from the bottom of the configuration 
page.

NOTE: Check �Enable Wireless Connection� if necessary.

Figure 16-44. Available Wireless Networks

3. A pop-up window appears. Select OK to continue.

Figure 16-45. Pop-up Window
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Connecting to the WLAN  (continued)

4. Choose the Security tab, select the Security type and 
Encrption type, and then input the network security key to 
connect the wireless network.

Figure 16-46. Network Properties Tab

5. A process bar is displayed while the system is attempting to 
connect the wireless network.

Figure 16-47. Process Bar
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Connecting to the WLAN  (continued)

6. The wireless network is connected successfully.

Figure 16-48. Network Configuration

Adding a Wireless Network

To add a WLAN profile (even for a network which is not yet 
available), 

1. Enter Utility -> Connectivity -> TCP/IP, and select 
Configuration under Wireless Network.

The Wireless Network Configuration tool appears. Available 
Wireless Networks appear.  

2. Select the Security tab. 

3. Select Add...

4. Add the following information to the Wireless Network 
Properties page: 

� Network Name (SSID)

� Network Authentication (Open, Shared Key, WPA, WPA 
PSK, WPA2, or WPA2 PSK). 

� Data Encryption

� Network Key

� Key Index

5. After you have filled in all the required information, press 
OK. To cancel adding this profile, press Cancel. 
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Removing a WLAN

To remove a WLAN profile (even for a network which is not 
available), 

1. Enter Utility -> Connectivity -> TCP/IP, and select 
Configuration under Wireless Network.

The Wireless Network Configuration tool appears. Available 
Wireless Networks appear.  

2. Select the Security tab. 

3. Select Remove. 

Customizing Wireless Network Settings

To customize an existing WLAN profile, 

1. Enter Utility -> Connectivity -> TCP/IP, and select 
Configuration under Wireless Network.

The Wireless Network Configuration tool appears. Available 
Wireless Networks appear.  

2. Select the Security tab. 

3. Select Customize...

4. Add the following information: 

a. Network Name (SSID)

b. Network Authentication (Open, Shared Key, WPA PSK, 
or WPA2 PSK). 

c. Data Encryption

d. Network Key

e. Key Index

5. After you have filled in all the required information, press 
OK. To cancel adding this profile, press Cancel. 
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Device

To add a new device, 

1. Press Add. 

2. Type the device name in the Name field. 

3. Type the device�s IP address in the IP Address field. 

Figure 16-49. Connectivity Device Preset Menu

To ping a device, 

1. Select the device. 

2. Press Ping. If the smiley face smiles, then the connection 
has been confirmed. If the smiley face frowns, then the 
connection has not been made. Check the device name and 
IP address. 

Table 16-59:  Device

Preset Parameter Description

Add/Remove Press Add to add a new device; press Remove to delete a device. 

Ping Press Ping to confirm that a device is connected. 

Properties: Name Type the name of the device. 

Properties: IP Address Type the device�s IP address. 

Properties: AE Title AE Title of the Versana Active. NOTE: Only available for MyComputer.

Properties: Port Number IP Port Number Used for DICOM, set by default to 104. NOTE: Only available 
for MyComputer.
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Service

For each Device that you added to the system, you need to set 
up the service(s) that device supports (you must be an 
administrator to update these screens). 

Figure 16-50. Connectivity Services Preset Menu

The Services screen has the following sections of information:

1. Destination Device - lists information about destination 
devices. You can select from a list of currently existing 
devices.

2. Service Type to Add - lists information about services for 
the destination device. You can add services, select from a 
list of currently existing services, and remove services.

3. Service Properties - lists parameters for the service 
currently selected in the Services section. The name and 
parameters in this section change, depending on what 
service is currently selected.
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Adding a service to a destination device

1. Select the service from the pull-down menu. Press Add. 

2. Specify the properties for this service. Press Save. 

3. Verify the service. 

Removing a service

1. Select the service. Press Remove. 

2. Press Save. 

Changing parameters for a service

There are certain parameters that may need to be set up for 
each service: 

Table 16-60:  Service Parameters: Common Service Parameters

Preset Parameter Description

Name Free text: give a descriptive name to the device.

AE Title The Application Entity Title for the service.

Port Number The port number of the service.

Maximum Retries Max # � the maximum number of times to try establishing a connection to the 
service.

Retry Interval (sec) Specify how often (in seconds) the system should try to establish a 
connection to the service. 

Timeout The amount of time after which the system will stop trying to establish a 
connection to the service.
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Many service parameters are specific to each type of service. 
The parameters are described on the following pages:

� DICOM Image Storage

� DICOM Performed Procedure

� DICOM Print

� DICOM Query/Retrieve

� DICOM Storage Commitment

� DICOM Worklist

� Standard Print

� USB Quick Save

� Save As

� Network storage

Enable Encryption Select to enable encryption on the data during data transfer when the DICOM 
server requires encryption.
The system supports Secure Sockets Layer 3.0 client protocol and Transport 
Layer Security 1.0 client protocol. Peer authentication is not supported.
The following are supported cipher suites:
� TLS_RSA_WITH_RC4_128_MD5
� TLS_RSA_WITH_RC4_128_SHA
� TLS_RSA_WITH_3DES_EDE_CBC_SHA
� TLS_DHE_DSS_WITH_3DES_EDE_CBC_SHA
� TLS_RSA_WITH_DES_CBC_SHA
� TLS_DHE_DSS_WITH_DES_CBC_SHA
� TLS_RSA_EXPORT1024_WITH_RC4_56_SHA
� TLS_RSA_EXPORT1024_WITH_DES_CBC_SHA
� TLS_DHE_ESS_EXPORT1024_WITH_DES_CBC_SHA
� TLS_RSA_EXPORT_WITH_RC4_40_MD5
� TLS_RSA_EXPORT_WITH_RC2_CBC_40_MD5
� TLS_RSA_WITH_NULL_MD5
� TLS_RSA_WITH_NULL_SHA
NOTE: Enable Encryption is only available with DICOM Image Storage and 
DICOM Worklist.

Table 16-60:  Service Parameters: Common Service Parameters

Preset Parameter Description
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DICOM Image Storage

DICOM Image Storage allows the system to send or receive 
ultrasound images in a format that can be interpreted by PACS.

 Figure 16-51. DICOM Image Storage Service

CAUTION GE does not warrant the operation if the DICOM format of send 
image (US, USMF, SC) does not correspond with the DICOM 
Server. 

Table 16-61:  DICOM Image Storage

Preset Parameter Description

Allow Clips Select to allow cine loop storage.

Allow raw data Select to save data in both TruAccess (raw data) and DICOM format. Clear to 
save in DICOM format only.

Compression Select the compression type: None, Rle, or Jpeg.

Max Framerate Select the maximum frame rate: Full, 25, or 30.

Color Support Select: Mixed, Gray or Color

Reopen per image Reopen per image 

Enable Structured 
Reporting

Select for Structured Reporting. 
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Key Image Notes Image deletion notification. ONLY available for the Direct Store Workflow and 
ONLY generated when there are images deleted during the exam. Selecting 
this lets the reader at the PACS system know which images have been 
deleted. An indicator is placed on deleted images with a reason, �Rejected for 
Quality Reasons,� for example. 

Table 16-61:  DICOM Image Storage (Continued)

Preset Parameter Description
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DICOM Performed Procedure

DICOM Performed Procedure provides an acknowledgement 
that a study has been performed.

Figure 16-52. DICOM Performed Procedure Service
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DICOM Print

DICOM Print provides the ability to send or receive ultrasound 
image data to DICOM printers.

 Figure 16-53. DICOM Print Service

Table 16-62:  Properties 

Preset Parameter Description

Format Indicates how many prints to print per page, for example, 1,1, 1,2, 1,3, up to 7,5. 
Partial prints are displayed as one print job.

Priority Specify the print job priority: High, Medium, or Low.

Medium Select the print medium: Clear Film, Paper, or Blue Film.

Copies Enter the number of copies. 

Orientation Specify whether to print the image Portrait (vertically) or Landscape (horizontally).

Film Size Specify the dimensions of the film size.

Film Destination Specify the film destination for the exposed filmMagazine � Store in a film 
magazineProcessor � Develop in a film processor

Magnification Specify how the printer magnifies the image to fit it onto the film.Replicate � 
Interpolated pixel are copies of the adjacent pixelsBilinear � Interpolated pixels are 
created by bilinear interpolations between the adjacent pixelsCubic � Interpolated 
pixels are created by cubic interpolations between the adjacent pixelsNone � No 
interpolation

Smoothing Type Specify the printer�s magnification interpolation for the output.

Trim Specify whether you want a trim box to be printed around each image on the film: 
Yes or No.

Min Density Enter a number indicating the minimum density level of the film.

Max Density Enter a number indicating the maximum density level of the film.
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Border Select to have the border area surrounding and between the images of the film: 
Black or White.

Empty Image Select to have a Black or White empty image.

Color Select whether to have the image Color or Grey.

Configuration 
Information

Enter vendor-specific image quality settings.

Film Session Label Type a name for the group of film labels associated with the print job.

Table 16-63:  Annotation 

Preset Parameter Description

Enable Lets you annotate the image. 

Table 16-62:  Properties  (Continued)

Preset Parameter Description
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DICOM Query/Retrieve

DICOM Query/Retrieve provides a list of patients sorted by 
query parameters. 

NOTE: Some PACS vendors only offer Query/Retrieve as an option. 
Please confirm that this service is available. 

Figure 16-54. DICOM Query/Retrieve Service

NOTE: If you are experiencing problems with slow responses from 
DICOM servers, increase the time-out in the DICOM server 
properties dialog. (Utility -> Connectivity -> Service -> Properties 
-> Maximum Retries and Timeout). Problems with slow 
responses may result in images being re-sent automatically and 
low transfer rates. The retry settings can be used to make jobs 
retry on bad networks. When portable (off-line), use minimum 
time-out and no retries or it will affect shutdown speed.

Table 16-64:  DICOM Query/Retrieve

Preset Parameter Description

Maximum Result Specify the maximum number of patient records you want the system to 
retrieve when searching the patient database.

Search Criteria Displays the Search Criteria window, where you can enter search parameters 
for the system to use when searching the patient database.
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DICOM Query/Retrieve  (continued)

Query/Retrieve Per Series

You can now display/retrieve multiple series by patient on the 
Patient--> Data Transfer--> Q/R page. 

 Figure 16-55. Q/R Per Series Example

Table 16-65:  DICOM Query/Retrieve Search Criteria 

Preset Parameter Description

Select Search Criteria to 
Add

Select the type of information that you want to define for search parameters. 
The following searches are allowed: Patient Name, Patient ID, Modality, 
Scheduled Procedure Start Date, Start Time, and End Time. 

Tags (at least one) The name of a tag selected to use for search criteria.

Properties: Value Type the value of the Selected Tag item. For example, if you select Referring 
Physician�s Name in the Select Tag field, you can enter the name of the 
physician in the Value field. 

Properties: Don�t Use Select to turn off the selected search criteria. To exclude a tag from the worklist 
query, select Don�t Use and then select Add to List.

Add Select to add the tag and value to the list of search criteria.

Remove Select to remove the tag and value from the list of search criteria.

Clear Clears all tags. 
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DICOM Storage Commitment

DICOM Storage Commitment provides acknowledgement from 
PACS that the study has been accepted into archive.

 Figure 16-56. DICOM Storage Commitment Service

Table 16-66:  DICOM Storage Commitment

Preset Parameter Description

Associated Storage This selection is based on the services entered by the user. 
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DICOM Worklist

DICOM Worklist provides a list of patients sorted by query 
parameters.

 Figure 16-57. DICOM Worklist Service

Table 16-67:  DICOM Worklist

Preset Parameter Description

Maximum Result Specify the maximum number of patient records you want the system to 
retrieve when searching the patient database.

Search Criteria Displays the Search Criteria window, where you can enter search parameters 
for the system to use when searching the patient database.
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DICOM Worklist  (continued)

Table 16-68:  DICOM Worklist Search Criteria 

Preset Parameter Description

Select Search Criteria to 
Add

Select the type of information that you want to define for search parameters. 
The following searches are allowed: Patient Name, Patient ID, Modality, 
Scheduled Procedure Start Date, Start Time, and End Time. 

Tags (at least one) The name of a tag selected to use for search criteria.

Properties: Value Type the value of the Selected Tag item. For example, if you select Referring 
Physician�s Name in the Select Tag field, you can enter the name of the 
physician in the Value field. 

Properties: Don�t Use Select to turn off the selected search criteria. To exclude a tag from the worklist 
query, select Don�t Use and then select Add to List.

Add Select to add the tag and value to the list of search criteria.

Remove Select to remove the tag and value from the list of search criteria.

Clear Clears all tags. 
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Standard Print

Figure 16-58. Standard Print Service

Table 16-69:  Standard Print

Preset Parameter Description

Printer Select the printer. 

Rows Specify 1-5. 

Columns Specify 1-5. 

Orientation Specify Landscape/Portrait

Top Margin (mm) Specify the top margin (0-51mm)

Bottom Margin (mm) Specify the bottom margin (0-51mm)

Left Margin Specify the left margin (0-51mm)

Right Margin Specify the right margin (0-51mm)
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Save As

Figure 16-59. Save As

Table 16-70:  Save As

Preset Parameter Description

Destination Specify destination device, Hard Drive, USB Flash 
Drive. 
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USB Quick Save

Figure 16-60. USB Quick Save

Table 16-71:  USB Quick Save

Preset Parameter Description

Name Type the name.

Destination Specify destination device: USB key or 
NetworkStorage. 

DirectoryNamingFormat Specify the directory naming format.
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Setting up a Printer

Use Standard Print for digital peripherals. These are printers 
with either a USB interface or Ethernet interface (Sony 
UP-D898MD, for example). 

On the Utility --> Connectivity --> Button page, select the Print 
key in the upper, left-hand corner of the display. In the middle 
portion of the page, under Available Input/Outputs, select the 
printer you want to configure. Next, press the two right arrows 
(>>) in the upper, right-hand corner of the page to move this 
printer into the Printflow View. 

You can also configure the Standard Print button that appears 
on the Active Images screen. 

Example: For instance a report printer, on the Utility --> 
Connectivity --> Service page, in the Service Type to Add box, 
and press Add. In the properties box on the upper, right-hand 
side, select the type of device and in the Properties box in the 
lower, left-hand side, type in a unique descriptive name for this 
device. 
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Network Storage

The Network Storage service provides the following:

� MPEGvue patient data to a Windows compatible file share.

� Send images (JPEG), video (AVI) and reports (PDF) to a 
Windows compatible file share with the USB Quick Save 
service.

� Exporting is allowed to a network storage location.

NOTE: Before setting up the ultrasound system, a Windows 
compatible file share must be setup on the network to 
connect to. The user that is connecting to the share must 
have Full Control rights and permissions to the shared 
folder. For additional help creating users or configuring file 
shares, please consult your operating system 
documentation.

NOTE: Do not connect multiple ultrasound systems to the same 
share.

 Figure 16-61. Network Storage Service

NOTE: The password used to connect to the shared folder must only 
contain numbers and letters.

NOTE: The account used to connect to the shared folder must be local 
to the device hosting the shared folder.

NOTE: If the shared folder exists on a Domain Controller, an active 
directory account is acceptable to use.
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Network Storage  (continued)

NOTE: If the device hosting the shared folder is running Windows 
Server 2008 R2 or later, you will have to enable NTLM in the 
local security policy on the server.

Table 16-72:  Network Storage Service

Preset Parameter Description

Name Enter unique name that identifies this service.
NOTE: Do not use the same name for any other Service or device.

Password Enter the password used for logging onto the PC.

User Name Enter the user name used for logging onto the PC.

Shared Dir Enter the Share name of the folder, not the entire UNC path. For example if 
the UNC path to the share is \\server\images, you would enter images as the 
name in the Shared Dir field.
NOTE: Only use alphanumeric characters for the Shared Dir.
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Dataflow

A dataflow is a set of pre-configured services. When you select 
a dataflow, the ultrasound system automatically works according 
to the services associated with the dataflow. The Dataflow tab 
allows you to select and review information about dataflows. You 
can also create, change, and remove dataflows.

Set up dataflows for the services. 

NOTE: You must be logged on as Administrator to use the Dataflow tab.

 Figure 16-62. Dataflow Preset Menu

CAUTION DO NOT rename the factory default dataflow. 

Table 16-73:  Dataflow 

Preset Parameter Description

Name Select the dataflow from the list.

Direct Store Select to store data directly to archive (no buffer storage).

Hidden Select so that this dataflow does not appear as a Dataflow on the Patient 
menu. 

Default Dataflow Select to use this dataflow as the default dataflow when you start the system.
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Button

You can assign print buttons via the Utility --> Connectivity --> 
Button page. 

Assigning print buttons. First select the print button to configure 
on the upper, left corner of the page. Then select the device you 
want to add in the middle part of the page, under Available Input/
Outputs. Then click on the right arrow in the top right corner of 
the page. 

NOTE: You can configure each print key to multiple output devices/
dataflows. 

NOTE: Only attach one DICOM service per print key (e.g., PACS and 
DICOM printer). Multiple DICOM devices should be configured 
via a dataflow.

NOTE: When using a print key to send an image directly to a DICOM 
device, this causes a single DICOM association per image. Most 
devices (all known printers) work fine with this. However, some 
storage devices, such as ALI, Kodak Access, and Cemax, 
assume that the end of each association is the end of the exam 
and can result in a new folder for each image. In the Utility 
menu, select a single association or open PR for the desired 
DICOM storage device. 

 Figure 16-63. Button Preset Menu
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Table 16-74:  Physical Print Buttons

Preset Parameter Description

M&A only (no images) Configures the system to send a DICOM structured report only; no image 
isgenerated or sent. 

Table 16-75:  Still Images

Preset Parameter Description

Format RawDICOM, DICOM, or M&A. 

Compression Always set to None. 

Table 16-76:  Cllips/Volumes

Preset Parameter Description

Cllips: Add Multiframe Data Checkbox

Compression None, Rle, Jpeg, Jpeg2000

Quality Lossless, 99, 98, 97, ... 50
Note: The default Compression for Clips is JPEG85. It is strongly 
recommended to keep the Compression set to JPEG85.

Table 16-77:  Active Images Page

Preset Parameter Description

Standard Print Lets you send to a Windows-based printer. 
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Removable Media

The Removable Media tab allows you to:

� Verify the DICOM directory on removable media.

� Verify the free space of the media.

� Verify that the media is finalized or unfinalized.

� Verify that the media is formatted or unformatted.

� Format removable media (rewritable CD/DVD or USB 
device).

 Figure 16-64. Removable Media Preset Menu

The bottom of the screen lists properties of the selected media.

Table 16-78:  Tools

Preset Parameter Description

Removable Media Select the removable media to format or verify.

Label Type a label for a new removable media (free text).

Verify � Select to verify DICOM directory on removable DICOM disk.
� Verify the free space of the media.
� Verify that the media is finalized or unfinalized.
� Verify that the media is formatted or unformatted.

Format Select to format removable media.

Quick Format To format the media quickly, check this box. If you uncheck this box, the 
media is formatted with a full format. New media should always be formatted 
with a full format. 
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Removable Media  (continued)

Formatting removable media

1. Select the removable media from the Media list.

2. Type a name for the removable media in the Label field.

NOTE: Do not use the following characters for labelling:

\ / : ; . , * < > | + = [ ]

3. Select Format. Confirm OK or Cancel. 

4. An information window confirms when the format has been 
completed. Select OK to exit. 

Verifying removable media

1. Select the removable media from the Media list.

2. Select Verify.
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Miscellaneous

The Miscellaneous tab allows you to configure tools related to 
patient management and print and store options. You can 
specify default system functionality, such as whether patient ID 
is required when you archive data, or if you want the system to 
automatically search the archive for a patient when you enter 
patient data.

 Figure 16-65. Miscellaneous Preset Menu

Table 16-79:  Patient/Exam Menu Options

Preset Parameter Description

Use birthdate In the Patient information window, enter either the patient age or the 
birthdate:When selected, enter birth date, then the age is 
calculated.Whencleared, enter age (birth date field not available).

Auto search for patient In the Search/Create Patient window: When selected, the system 
automatically searches through the selected patient archive, while the user 
enters patient information.When cleared, the automatic search tool is turned 
off. If you are trying to keep the past patient data confidential, DO NOT use 
this feature. 

Automatic generation 
ofpatient ID

In the Search/Create Patient window: When selected, the Patient ID is 
notrequired when entering a new patient in the archive. The 
systemautomatically generates an ID number. When cleared, the Patient ID 
isrequired when entering a new patient in the archive.
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Auto Archiving patient data Archives patient data automatically. 

After [End Current Patient], 
go to

Select go to Worklist screen or Patient screen when ending the current 
patient. 

Keep Search String Search string is kept rather than cleared. 

Worklist Auto Query Automatically queries the worklist server. 

Show BBT Show BBT field on the OB patient screen to input the basal body 
temperature.

Double click on patient list 
to start 

Select Review or New Exam to display each time you double click on the 
patient name in the patient list on the Patient menu.

Detail Mode Select to display Detail Mode, rather than Exam View, when you select the 
patient name in the patient list on the Patient menu. You can also type 
comments while in Detail Mode.

Export to USB HDD: 
Create DICOMDIR

Create DICOMDIR is a DICOM file format which contains how the directory 
and DICOM files structured for diagnostic portable media behave. It is 
important for portability between the Versana Active to PACS. If you want to 
save exams to the USB Hard drive and look at it on the PACS, the 
DICOMDIR is a must.

Export to Network storage: 
Create DICOMDIR

Automatic Disable Patient 
Data

Select to automatically disable patient data. 
If selected, locks the patient name, date of birth and gender (like Patient ID). 
The Factory Default for this preset is unchecked.

Remember Cursor Position 
on the Transfer Screen

To set a default cursor location on the Data Transfer screen: 
1. Select the �Remember cursor position in the Transfer screen� preset and 

press Save. 
2. On the Data Transfer screen, move the cursor to the desired field. 
3. Exit out of the Data Transfer screen. When returning to the Data Transfer 

screen, the cursor location is in the position your selected. 

Quick New Patient Entry Select to store new patient automatically by pressing the Patient key.

Table 16-80:  Patient/Exam Message Options

Preset Parameter Description

Patient info exist in logfile Check box to select.

Request acknowledge of 
End Exam action

When selected, the user is asked to confirm action when ending an 
examination.

Warn Image Store without 
Patient

Select to receive a warning when you press the Print key without an active 
patient.

Warn Register to No 
Archive

Select to receive a warning when you register a patient to the �No Archive� 
data flow. Select a different data flow for permanent storage of patient data.

Warn image store to Read 
Only dataflow

The system posts a warning message if you attempt to store images to a 
read-only Dataflow. 

Table 16-79:  Patient/Exam Menu Options (Continued)

Preset Parameter Description
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Warn video titles exist in 
the internal storage

The system posts a warning if the video titles exist on the internal DVR flash 
memory. 

Table 16-81:  Print and Store Options

Preset Parameter Description

P[1-3] Key Sound Select None, Click, Chimes, Ding, Ding-Dong, or Whoosh. 

Store Dual as Dicom Only Select to always store dual images as a DICOM (secondary capture) store, 
rather than Raw DICOM. 

Dual When Color Support 
is Mixed

Dataflow Mixed is not available. While transferring dual images to the PACS, 
send black and white images as gray; send color images as color. Set up 2 
services (one gray and one color), set up 2 dataflows, and set up 2 buttons. 
Each button needs to be tied to a different service.
Select if you want to keep the user preset for Color Photometric Interpretation 
while in Dual mode.

Store Multiframe for Sec 
Capture Loops

Select if you want the CINE loop stored as secondary capture.

Enable Whizz Capture 
Area

Check box to select. 

Store 2D Loop with 
Timeline Data

Check box to select. 

Patient List Print-Font Size Select font size. 

Image Order Scheme Select to Direct Store images in Acquisition Order, Scan Coach/Assistant 
Order, or Off.
� Off. The clipboard on the Ultrasound system shows the image in the order it 

was acquired. Therefore, re-stored images appear where you�d expect. 
However, on the PACS system, images appear in arrival order or in image 
number order. 

� Acquisition Order. From the Ultrasound system perspective, the same as 
�Off.� But on the PACS system (if based on image number order), images 
are displayed consistently with the way they are stored on the Ultrasound 
system. 

� Scan Coach/Assistant Order. You can define the storage order (reading 
order) via Scan Coach/Assistant Creator. Therefore, based on the order 
defined in Scan Coach/Assistant, images are re-ordered and displayed in 
this manner both on the Clipboard and on the PACS system. 

Table 16-82:  Other ID Options 

Preset Parameter Description

Enable Other ID Not selected is the Default.
If selected, allow entering Other ID, such as Citizen Service Number, Burger 
Service Number (BSN), National Health System (NHS) number, along with 
patient ID information on the Patient Screen.

Table 16-80:  Patient/Exam Message Options

Preset Parameter Description
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Validation Format If the Enable Other ID preset is selected, the system validates the format of 
�Other ID� when an ID is entered. Choose: NHS Number *** ** *****, Letters 
and Numbers, Numbers, or Any (no restriction)

Table 16-82:  Other ID Options  (Continued)

Preset Parameter Description
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Bluetooth

To add a new bluetooth device, 

1. Press Add New Device. 

2. Type the device name in the Name field. 

Figure 16-66. Connectivity Bluetooth Preset Menu

Table 16-83:  Device

Preset Parameter Description

Add New Device/Remove Press Add new device to add a new device; press Remove to delete a 
device. 

Properties: Name Type the name of the device. 

Properties: MAC Address Unique network card address. NOTE: Only available for MyComputer.

Properties: Enabled Select to enable bluetooth device. 

Properties: Image Transfer 
Support

Select to enable image transfer.

Properties: Date Added Display the new device added date.
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Tricefy Uplink

New GE Versana ultrasound systems have Tricefy Uplink 
pre-installed. Additional software is not necessary for using 
Tricefy Uplink; simply activate your account using the following 
steps.

1. Press Utility -> Connectivity -> Tricefy.

NOTE: The Tricefy tab is only available on machines that have 
Tricefy Uplink option.

 Figure 16-67. Tricefy Menu

2. Enable Tricefy checkbox, and enter the email address to 
authorize the account. Press � Activate account� to 
activate your account, this process may take up to 30 
seconds, and a dialog will pop up if succeeded. And you will 
receive a notification email, click the link to complete the 
whole activating process.

Figure 16-68. Activate Tricefy Account
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Tricefy Uplink  (continued)

3. Add Tricefy Uplink to Print workflow.

� Click Button to configure the P- Buttons for sending 
and sharing images.

 Figure 16-69. Button Menu

� Select Print1 (or Print2, Print3) which you would like to 
use. Then Select Trice Archive and press >> button to 
add it to Printflow View, press Save. Now when you 
press the P1 button, the image will be sent to your 
Tricefy cloud.

 Figure 16-70. Configure the P-Button for Tricefy Uplink
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Tricefy Uplink  (continued)

4. If you want to share the images to patient, please add Trice 
Patient to Printflow View. And also remember input the 
patient�s Phone number or email address.

Figure 16-71. Share Images to Patient

NOTE: If you have any problem with Tricefy Uplink settings, please 
contact your GE service/sales representative.
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Tricefy Uplink  (continued)

For using Q&R function on Tricefy Uplink, please follow the 
settings:

� Login to Tricefy.

� Choose Accounts from the top-right dropdown menu (the 
person icon, see image below).

� If you have multiple account memberships you now select 
which account to view settings for.

� In the account settings, choose �Uplinks� from the left-hand 
menu.

� Each Uplink is listed here and there is a checkbox to enable/
disable Q/R.

NOTE: The changes take 10-60s to propagate.
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Measure

Please refer to Chapter 7, General Measurements and 
Calculations for more information on setting up Measurement 
and Analysis Presets. 
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Reports

Refer to Chapter 14 for more information. 
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System Admin

Overview

The Admin screen has the following three sections:

� System Administration � lists all the options implemented 
in the system.

� Users � allows you to define user IDs, specify operator�s 
registration, operator�s rights, and registration of staff 
related to an examination (for example, referral doctors and 
sonographers).

� Logon � defines logon procedures.

� User policies � defines user name policy and password 
policy.
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System Admin

The System Admin screen has information about any options 
implemented for the system.

 Figure 16-72. System Admin Preset Menu 

Table 16-84:  System Administration

Preset Parameter Description

Product The name of the product.

HW Number The hardware number of the product.

System Serial Number The serial number of the product.

SW Option Key The software option key section.

Enter New Option Key Type the key for the option you wish to add and press Add. 

Installed Option Keys Lists the key for the installed options. 

Remove To remove a software option key, select the key in the SW Option Key list, 
and then select Remove.
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Options A list of the option name and status.

Status Lists each option�s effectivity. 

Table 16-85:  Service

Preset Parameter Description

Enable Automatic Request 
for Service

Check this box to enable the system to send system-generated requests for 
service, without your intervention. 

Enable IQC Check this box to enable the Image Quality Check function. 

Table 16-86:  Protecting Health Information (PHI) 

Preset Parameter Description

Prevent Writing to 
Removable Media-CD/
DVD/USB (requires 
reboot)

Prevent from copying data including Patient Information to external storage 
device. 
Media: USB Memory / USB HDD / CD-R / DVD-R
Function: Export / MPEGVue / EzBackup / EzMove / Save As / Save As 
Images / Report Save As / Backup Patient Archive and Report Archive from 
Utility

Table 16-87:  Disk Encryption 

Preset Parameter Description

Disk Encryption Select to encrypt the local patient data drive or removable media.

Table 16-88:  Change System Password

Preset Parameter Description

Change System Password Select to configure system password.

Table 16-89:  Change DataBase Password

Preset Parameter Description

Change DataBase 
Password

Select to configure database password.
Note: Do not use special characters when changing the database password.

Table 16-84:  System Administration

Preset Parameter Description



System Admin

Versana Active � Basic User Manual 16-117
Direction 5840764-100 English Rev. 10

Disk Encryption

Disk Encryption is a function to protect the patient information on 
the device and prevent unauthorized access to PI/PHI, 
especially when the device is stolen. The encryption AES is 256 
bit.

NOTE: Disk Encryption can also protect the user data stored on 
removable device.

NOTE: The steps for Removable Media Encryption and Local Patient 
Data Drive Encryption are the same.

CAUTION The user must make backups and take care of the encryption 
password/passphrase and recovery key. It is the customer�s 
responsibility for storing the data. GE will have no back door or 
any responsibility or possibility of recovering the data.
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Disk Encryption  (continued)

NOTE: Encryption is set as �ON� for Local patient data drive after 
software installation. User can not turn off the Disk Encryption. 
But user can turn on and off the Disk Encryption for Removable 
Media.

 Figure 16-73. Encryption ON

You could change password as you wish.

� Select Change Password and you will be prompted to enter 
old password/passphrase which you previously set up in EZ 
Configuration Wizard, refer to step 3 of �EZ configuration 
Wizard� on page 6-39.

Figure 16-74. Enter Current Password
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Disk Encryption  (continued)

� Enter new password/passphrase,  and re-enter it to confirm.

 Figure 16-75. Change Password 1

� Press OK.

 Figure 16-76. Change Password 2
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Disk Encryption  (continued)

Turn on Disk Encryption of Removable Media on R1.1.x and 
R1.2.x.

1. Login as administrator. Press Utility -> Admin -> System 
Admin -> Disk Encryption.

 Figure 16-77. Disk Encryption 1



System Admin

Versana Active � Basic User Manual 16-121
Direction 5840764-100 English Rev. 10

Disk Encryption  (continued)

2. Select Encryption ON. A confirmation message pops up, 
press Continue to continue the encryption process.

Figure 16-78. Disk Encryption 2

3. Enter a password or a passphrase and re-enter to confirm. 
Press Continue.

Figure 16-79. Disk Encryption 3
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Disk Encryption  (continued)

4. Insert a USB and select it to record the recovery key. You 
can also press Print recovery key to print the recovery key, 
or you can press Hide recovery key to hide the recovery 
key.

Press Continue.

 Figure 16-80. Disk Encryption 4

5. When the recording process is completed, a confirmation 
dialog pops up, press OK.

 Figure 16-81. Disk Encryption 5
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Disk Encryption  (continued)

6. Encryption process begins.

You can press Pause to pause the encryption process.

 Figure 16-82. Disk Encryption 6

7. When the encryption process completes, press Finish.

NOTE: The encryption process for patient data drive may take thirty 
minutes or more.

CAUTION Make sure to keep the password/passphrase, recovery key 
and any back up of these in secure place, not accessible 
for unintented audience.
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Pause Encryption

1. During encryption process, you can press Pause to stop the 
encryption process.

 Figure 16-83. Encryption Pause 1

2. A confirmation dialog pops up, press Yes to continue or No 
to cancel.

 Figure 16-84. Encryption Pause 2
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Resume Encryption

1. Press Utility -> Admin -> System Admin -> Disk 
Encryption. Press Resume.

 Figure 16-85. Encryption Resume 1

2. A confirmation dialog pops up, press Yes to resume 
conversion or press No to cancel.

 Figure 16-86. Encryption Resume 2
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Resume Encryption  (continued)

3. Encryption of patient data is ongoing. Please do not use the 
system until the process is completed.

 Figure 16-87. Encryption Resume 3

Change Password

After the encryption process is completed, you can change the 
password as you wish (for Disk Encryption of Removable Media 
on R1.1.x).

1. Press Utility -> Admin -> System Admin -> Disk 
Encryption. Press Change Password.

 Figure 16-88. Change Password 1
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Change Password  (continued)

2. Enter new password/passphrase,  and re-enter it to confirm.

 Figure 16-89. Change Password 2

3. Press OK.

 Figure 16-90. Change Password 3
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Change Recovery Key

After the encryption process is completed, you can change the 
recovery key as you wish (for Disk Encryption of Removable 
Media on R1.1.x and R1.2.x).

1. Press Utility -> Admin -> System Admin -> Disk 
Encryption. Press Save/Change Recovery Key.

 Figure 16-91. Change Recovery Key 1

2. Insert a USB to store the new recovery key.

 Figure 16-92. Change Recovery Key 2
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Change Recovery Key  (continued)

3. Press OK.

 Figure 16-93. Change Recovery Key 3

 Figure 16-94. Change Recovery Key 4

Unlock with user entered key & recovery key

When the patient data is in locked status, you can unlock it with 
user entered key and recovery key.

You can insert the USB with recovery key, or you can input the 
password or recovery key manually to unlock the system.

NOTE: If you press Cancel, the system will stay in locked status and 
some of the functions will be not available.

 Figure 16-95. Unlock Dialog
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Disk Decryption

1. For Disk Encryption of Removable Media on R1.1.x and 
R1.2.x, if you want to decrypt the patient data, you can 
press Utility -> Admin -> System Admin -> Disk 
Encryption. Select Encryption Off. 

Figure 16-96. Decryption 1

2. A confirmation dialog pops up, press Yes to continue.

3. Decryption of patient data is ongoing. Please don�t use the 
system until the process is completed.

 Figure 16-97. Decryption 2

4. When the decryption process is completed, press Finish.
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Change System Password

Change System Password is a function to protect the privacy 
and prevent unauthorized access to the system especially when 
the user is not nearby. 

To configure the system password, select Utility -> Admin -> 
System Admin -> Change System Password.

Figure 16-98. Change System Password 1

Figure 16-99. Change System Password 2
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Users

The Users screen allows you to define user IDs. It also allows 
you to specify operators registration, operator�s rights setting, 
and registration of staff related to an examination (for example, 
referring and interpreting physicians).

Figure 16-100. Users Preset Menu

Table 16-90:  User List 

Preset Parameter Description

User List Lists the user ID for all system users. 

Identity Type the operator�s user ID, Password, Prefix, Last Name, First Name, Middle 
Name, Suffix, Phone Number. 

Group Membership Select the user�s group:Operator (sonographers, doctors, or any person using 
the ultrasound system); Ref.Phys. (referring physician can be associated to the 
patient examination in the extended Patient information window(; Perf.Phys. � 
physician performing the exam can be associated to the patient examination in 
the extended Patient information window. 

Operator Rights Admin � If selected, the operator has extended rights with access to the 
administrative setup functionality. The operator can also perform advanced 
operations

State Info Lists the state information for the selected operator.
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Creating a user

1. Select Add.

2. Type the user ID. ENSURE that you DO NOT include the 
following characters in a user�s ID: slash (/), dash (-), 
asterisk (*), question mark (?), an underscore (_), or blank 
spaces. Also, DO NOT set up a user with the same initials/
signifier. 

3. Type the user�s information in the Identity section.

4. Select the user�s group(s).

5. If the user needs full configuration and advanced operations 
access, select Admin.

6. Press Save. 

NOTE: DO NOT add users with the same initials/signifier. The system 
allows you to do this; however, the first user is erased and only 
the second remains.

NOTE: When adding a new user, press Add first. Then edit the ID from 
the default of �NewUser� and edit the other fields. DO NOT 
press Add again unless you actually want to create another 
user. Press Save after adding one or more users. The user 
listed as NewUser on the list will be updated with the edited ID 
when you re-enter this screen.

Changing a user configuration

1. Move the Trackball to a user ID in the User List.

2. Make the desired changes.

Deleting a user

1. Move the Trackball to a user ID in the User List.

2. Select Remove.

The user is removed from the User List.
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Logon

The Logon section defines log on procedures.

Figure 16-101. Administrative Logon Preset Menu 

Table 16-91:  Logon

Preset Parameter Description

Auto Logon Specifies logon procedures:
� When blank, the user must select a user ID and enter a password when 

logging on.
� When selected, the system is started automatically, using the last user 

logon.

Common Network Login Specifies the user ID and password used to access the network.User � User 
ID for network accessPassword � Password for network access

Connectivity Maintenance Reset to factory default.
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User policies

The user policies section defines user policies procedures.

 Figure 16-102. Administrative User policies Preset Menu 

Table 16-92:  User policies

Preset Parameter Description

User policies Specifies policy level: Lowest, Medium, High, Highest.

User name policy Specifies minimum and maximum user name length.

Password policy Specifies minimum and maximum password length, minimum number of 
character sets required in the password and password history.
� Minimum number of character sets required (upper case/lower case/digits/

non-alphanumeric):
� Password cannot contain user name option.
� Reload Default Policy

Table 16-93:  Security Levels

Security Level Complexity Rules

Lowest Autologon available. No password complexity rules.

Medium Autologon unavailable. Passwords must meet the following criteria:
� Minimum password length of 8.
� Minimum of 3 character sets.
� Minimum of 1 upper case characters.
� Minimum of 1 lower case characters.
� Minimum of 1 digits.
� Password cannot contain user name.
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HIgh Autologon unavailable. Passwords must meet the following criteria:
� Minimum password length of 10.
� Minimum of 4 character sets.
� Minimum of 1 upper case characters.
� Minimum of 1 lower case characters.
� Minimum of 1 digits.
� Minimum of 1 non-alphanumeric characters.
� Password cannot contain user name.

Highest Autologon unavailable. Passwords must meet the following criteria:
� Minimum password length of 14.
� Minimum of 4 character sets.
� Minimum of 1 upper case characters.
� Minimum of 1 lower case characters.
� Minimum of 1 digits.
� Minimum of 1 non-alphanumeric characters.
� Password cannot contain user name.

Table 16-93:  Security Levels

Security Level Complexity Rules
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Service

Press Service to activate the Service browser interface. 
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Scan Coach

Scan Coach Manager

Please refer to Chapter 5 for information on using the Scan 
Coach Manager to Import and Export Scan Coach Programs. 
This section covers how to use the Scan Coach Creator and 
how to export the Scan Coach Creator from the Versana Active 
to a PC. 

Activating the Scan Coach Creator

To activate the Scan Coach Creator on the Versana Active, 
press the Creator key. 

 Figure 16-103. Scan Coach Manager
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Scan Coach Creator

Overview

The Scan Coach Creator is used to build customized Programs 
that can be imported onto the Versana Active. These Programs 
automate many of the steps normally performed manually by the 
user, thereby reducing the number of user actions and the 
amount of time to perform an exam.

 Figure 16-104. Tool Layout Overview

NOTE: Scan Coach Button is not available for Scan Assistant, only for 
Scan Coach. 

1. Menu and ToolBars
2. Scan Coach Button
3. Steps
4. Scan Coach Attributes
5. Rule Checking
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Overview  (continued)

The Scan Coach Creator tool can be used both on the scanner 
and as an off scanner tool. Where there are differences in 
behavior, this user�s guide uses the term �on scanner� to indicate 
when the tool is running on the scanner and �off scanner� to 
indicate when the tool is running off the scanner. 

File Handling

When using Scan Coach Creator off the scanner, it is very 
important to organize the programs in a way that will make it 
easy to import the programs onto the scanner. Each Program is 
a computer file. While these computer files can be copied, 
pasted and deleted like any other computer file, the Program 
files are only viewable using the Scan Coach Creator.

Off-Scanner Directory Structure

The Scan Coach Creator organizes the Programs in a directory 
structure that allows easy importing into the Versana Active. In 
order to be imported, all Programs must be stored in a 
LOGIQ_SCAN_COACH Programs Directory. Within this 
directory, one or more user-specified directories are created. 
Within each of these user-specified directories are the category 
directories (VAS, ABD, etc.) that hold the actual Programs.

The dialog in the figure below allows the user to specify the 
location of the LOGIQ_SCAN_COACH directory (root directory) 
and to either select an existing User Program Directory or create 
a new one.

Figure 16-105. Directory Structure
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Off-Scanner Directory Structure  (continued)

The Directory Structure dialog can be accessed via the File 
menu. 

Figure 16-106. File Menu

Figure 16-107. File Toolbar

File Extensions

Factory defined Programs have an .ep (exam Program) 
extension while user-defined Programs have an .uep (user 
exam Program) extension. Both factory and user-defined 
Programs can be read into the Scan Coach Creator, but only 
user-defined Programs are created. If a factory Program is read 
into the Scan Coach Creator and then edited, it is saved as a 
user-defined Program.

Upon installation of the Scan Coach Creator, files with a .ep or 
.uep extension are automatically associated with the Scan 
Coach Creator.
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Exporting Programs from Versana Active

Factory or user-defined Programs on the Versana Active are 
easily exported for editing with the Scan Coach Creator.

On the Versana Active:

1. Insert a USB storage device (or CD/DVD).

2. Select Utility -> Scan Coach.

3. Select Export.

4. Select the media type and specify a directory. If a directory 
is specified that already exists, the Export adds the 
Programs along with any existing Programs. If the names of 
Programs are the same, use the resulting dialog to decide 
how to continue.

5. Select the Program to be exported and export them.
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Importing Programs to Versana Active

Programs created with the Scan Coach Creator are easily 
imported to the Versana Active.

Copy the complete LOGIQ_SCAN_COACH directory from the 
system to a USB device (or CD/DVD). The 
LOGIQ_SCAN_COACH directory needs to be at the top level 
(not in a subdirectory) on the USB device (or CD/DVD).

Example of Directory structure:

LOGIQ_SCAN_COACH

MyUserNameDirectory

ABD

CARD

GYN

OB

VAS

On the Versana Active:

1. Insert the USB device (or CD/DVD).

2. Select Utility -> Scan Coach.

3. Select Import.

4. Select the media type.

5. Select the Programs to be imported and import them. If you 
attempt to import Programs that already exist with the same 
name, use the resulting dialog to decide how to continue.
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Creating New Programs

A new Program is created by selecting File -> New, by clicking 
on the New document icon in the Toolbar, or by using the 
keyboard shortcut Ctrl+N. 

1. Before creating a New Program, select Single Step in the 
Toolbar.

Figure 16-108. File Toolbar

2. Proceed to add/update your settings for the Step: Step 
Name, Instructions, etc.

3. Once finished, highlight the finished Step.

 Figure 16-109. Highlight Step to Copy
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Creating New Programs  (continued)

4. Select Edit -> Copy

Figure 16-110. Edit -> Copy

5. In the Toolbar along the left, select Insert Step Before 
Selected or Insert Step After Selected.

Figure 16-111. Insert Step

6. Highlight the copied step and proceed to edit accordingly.

7. Proceed to follow the same procedure to add more steps to 
your Program.

8. When you are done, select Check to verify your Steps.

Figure 16-112. Rule Check and results area

9. The results are listed as to whether the Scan Coach Rule 
Check Passed or if any Issues were detected. Issues found 
when running the check do not mean the Program is 
unusable. 

NOTE: The rule check may report an unequal number of left and 
right steps. This may or may not be the expected result. If a 
change is made in response to the rule check results, a new 
rule check can be run to see if the issue has been resolved.
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Opening New Programs

Multiple Programs can be open at the same time by selecting 
File -> Open. Each Program will open within the primary Scan 
Coach Creator window.

Opening Existing Programs

An existing Program is opened by selecting File -> Open, by 
clicking on the File -> Open icon in the Toolbar, or by using the 
the shortcut Ctrl+O. Finding the Program file (.ep or .uep) and 
opening the file automatically opens the file in the Scan Coach 
Creator. Multiple Programs can be opened at the same time.
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Saving Programs

Programs are saved via the Save or Save As functions available 
on the File Menu and the File Toolbar. Save is also available via 
the Ctrl+S keyboard shortcut. �Save� saves the Program using 
its current name and file location. �Save As� allows the name 
and file locations to be edited.

When Saving a Program, the Scan Coach Creator provides an 
opportunity to run a rule check on the Program before saving it 
as shown in the following figure. Yes runs the rule check, No 
bypasses the rule check and Cancel cancels the Save request. 
See �Rule Checking� on page 16-174 for more details on Rule 
Checking Programs.

Figure 16-113. Program Rule Check Reminder

NOTE: The name of a Program is appended with an asterisk (*) when 
the Program has been changed, but those changes have not yet 
been saved.

A Program can be closed without saving it using the Close 
selection on the File Menu or by using the �X� in the upper right 
corner of the Program window.
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Sharing Programs

If you want to share a program with someone else, the file can 
simply be sent via e-mail as an attachment or copied onto a 
media. If the person receiving the program has the Scan Coach 
Creator tool installed, he can simply open the file and then use 
�Save As� to save it to an appropriate directory. See Section 3.1. 
If the person receiving the program does not have the Scan 
Coach Creator tool installed, he can still load the program onto a 
scanner by creating the following directory structure on a media 
device, copying the file to one of the category directories and 
then importing the protocol onto the scanner.

Top Level Directory on media: LOGIQ_SCAN_COACH User 
Program Directory: Any user nameCategory Directories: Abd, 
Card, Gyn, OB, Ped, SMP, UR, Vas.
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Views

A Program is made up of a series of steps. Each step is made 
up of various step attributes. The step and step attribute data 
can be viewed in many ways using the Scan Coach Creator. 
The different ways to look at the data are called Views. The view 
of choice is selected from the View Selection Menu or the View 
Toolbar Menu.

Figure 16-114. View Selection Menu

Figure 16-115. View Toolbar Menu
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Single Step Views

There are two Single Step views: Basic and All. The Basic view 
shows the most common attributes of the selected step. The All 
view shows all of the attributes of a given step.

For both views, the step names are shown on the left with the 
active step highlighted. The step attributes appear on the right 
and are separated into four groupings:

General attributes at the top

Imaging and Comment attributes on the left

Measure attributes on the right.

 Figure 16-116. Basic Single Step View

1. Steps
2. Step Attributes
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Scan Coach Features

Scan Coach allows the user to program the steps in an exam 
and to program certain attributes for each step. The attributes 
are what give the Scan Coach Program behavior. The tables 
below provide the names of all attributes along with a 
description of how each one is interpreted by the Scan Coach 
feature.
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General Attributes

Table 16-94:  General Attributes

Attribute 
Name Selections Description

First Step 
Default

Other Steps 
Default

Store Order (Not Applicable) Button used to enable 
the Store Order 
Definition dialog so that 
the Store Order can be 
set

Advance On Store Advance to the next step 
and go live after Print / 
Image Store (e.g P1 
key). This can be a 
single image store or a 
loop store. 

Print Same as 
previous step

Store & Unfreeze Advance to the next step 
after Print / Image Store 
(e.g. P1 key) and 
unfreeze. This can be a 
single image store or a 
loop store.

User Selection Advance to next step 
only after next step is 
manually selected 
(e.g. down arrow)

Instructions [Any Text] User notes displayed in 
the Scan Coach 
Navigation menu when 
the step is active

Blank Same as 
previous step

Optional Optional (checked) An optional step is given 
a check mark during 
Program execution even 
if no image is acquired

Mandatory Same as 
previous step

Mandatory 
(unchecked)

A mandatory step is 
given a check mark only 
if an image is acquired 
for the step

Learn Probe On (checked) Learn and change the 
probe for the user

Off Off

Off (unchecked) No probe change
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Comment Attributes

Table 16-95:  Comment Attributes

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default

Comment 1, 
Comment 2

[Any Text] User annotation 
associated with the 
step. When editing in a 
Multi Step View, use 
Alt+Enter to create a 
new line.

Same as Step 
Name attribute

Same as Step 
Name attribute

Location 1, 
Location 2

Top Left Annotation is placed in 
the top left corner of 
the image area

Location 1: 
Bottom Center

Same as 
previous step

Middle Left Annotation is placed in 
the middle left side of 
the image area

Bottom Left Annotation is placed in 
the bottom left corner 
of the image area

Location 2: 
Dual Right: 
Bottom Center

Top Center Annotation is placed in 
the top center of the 
image area

Bottom Center Annotation is placed in 
the bottom center of 
the image area

Top Right Annotation is placed in 
the top right corner of 
the image area

Mid Right Annotation is placed in 
the middle right side of 
the image area

Bottom Right Annotation is placed in 
the bottom right corner 
of the image area

Dual Left: Bottom 
Center

Annotation is placed 
on the bottom center 
of the left image in 
dual screen

Dual Left: Top Left Annotation is placed 
on the top left of the 
left image in dual 
screen
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Dual Right: Bottom 
Center

Annotation is placed 
on the bottom center 
of the right image in 
dual screen

Dual Right: Top Left Annotation is placed 
on the top left of the 
right image in dual 
screen

BP1, 2 Blank Body Pattern not 
specified. Scan Coach 
does not set Body 
Pattern.

Blank Same as 
previous step

BP1, 2 Body pattern 
graphics with or 
without probe 
position

Selected Body Pattern 
with or without probe 
position will be set.

Blank Same as 
previous step

BP Specify (Not applicable) Button used to enable 
the Body Pattern 
Selection dialog so 
that the Body Pattern 
graphic can be 
selected and probe 
position can be set

BP Clear (Not applicable) Clears BP1, BP2 
defined for the step

BP Probe On (checked) BP Probe mark will be 
set by Scan Coach

Off Same as 
previous step

Off (unchecked) Probe mark not 
specified. Scan Coach 
does not set Probe 
mark.

Table 16-95:  Comment Attributes (Continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Imaging Mode Attributes

The probe and application associated with a program is not 
configurable. Instead, the scanner remembers the last probe 
and application used for a given Scan Coach program and 
automatically selects them the next time the program is started.

Table 16-96:  Imaging Mode Attributes

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default

Color Mode On (checked) Color Doppler is 
on

Off Same as previous 
step

Off (unchecked) Color Doppler is 
off

PW Doppler Mode On (checked) PW Doppler is on. 
If PW Doppler is 
not on and the 
new activated step 
indicates that 
Doppler should be 
on, the Mode 
Cursor is 
displayed or, if the 
Mode Cursor is 
already displayed, 
then PW Doppler 
is turned on.

Off Same as previous 
step

Off (unchecked) PW Doppler is off

M Mode On (checked) M-Mode is on Off Same as previous 
step

Off (unchecked) M-mode is off

CW Mode On (checked) CW Mode is on Off Same as previous 
step

Off (unchecked) CW Mode is off
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Dual Off Dual screen not in 
use

Off Same as previous 
step

Left Active Dual screen is 
active and the left 
image is the active 
image.

Right Active Dual screen is 
active and the 
right image is the 
active image.

DualView (simul) DualView is active 
(both left and right 
images are live)

Dual on 
Freeze

DualView is active 
on freeze

3D On (checked) 3D on Off Same as previous 
step

Off (unchecked) 3D off

LOGIQView On (checked) LOGIQView on Off Same as previous 
step

Off (unchecked) LOGIQView off

Table 16-96:  Imaging Mode Attributes (Continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Imaging Preference Attributes

Imaging Preferences work slightly different than other attributes. 
For example, if an abdomen Program has 20 steps and all steps 
have the Harmonics attribute set to Default, then Scan Coach 
will not affect the harmonics setting. Now, assume that steps 
10-12 are gallbladder steps and that the harmonics attribute has 
been set to on for these steps. When transitioning into this group 
of steps (step 9 to step 10, e.g.), harmonics will be turned on (or 
remain on if it was previously on). If harmonics is then manually 
turned off in step 10 then Scan Coach will not turn it back on 
when advancing to step 11. In other words, a group of 
consecutive steps with the same Imaging Preference are treated 
as a group by Scan Coach and not as individual steps.

Table 16-97:  Imaging Preference Attributes

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default

Harmonics Off Harmonics off Default Same as previous 
step

On Harmonics on

Default Harmonics not 
specified. Scan 
Coach does not 
set Harmonics on 
or off.

Virtual Convex Off Virtual Convex off Default Same as previous 
step

On Virtual Convex on

Default Virtual Convex not 
specified. Scan 
Coach does not 
set Virtual Convex 
on or off.

CrossXBeam Off CrossXBeam off Default Same as previous 
step

On CrossXBeam on

Default CrossXBeam not 
specified. Scan 
Coach does not 
set CrossXBeam 
on or off.
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PDI Off PDI off Default Same as previous 
step

On PDI on

Default PDI not specified. 
Scan Coach does 
not set PDI on or 
off.

Color/Doppler 
Steer

Left Color/Doppler 
steered to the left

Center Same as previous 
step

Center Color/Doppler not 
steered

Right Color/Doppler 
steered to the right

Table 16-97:  Imaging Preference Attributes (Continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Measurement Attributes

Table 16-98:  Measure Attributes

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default

B/M Measure 
Trigger

Measure Key Initiate �Measure 1" 
attribute when the 
Measure key is 
manually selected.

None None

Freeze Key Initiate �Measure 1" 
attribute when the 
image is frozen.

Store Image Initiate �Measure 1" 
attribute when the 
Measure key is 
manually selected or 
the image is stored. 
This is used to store / 
print an image and 
then measure on it 
and then store it 
again. Therefore, the 
Advance On Print 
attribute is ignored on 
the first store / print 
when the Measure 
Trigger attribute is set 
to Image Store.

None Measurements are 
not triggered by Scan 
Coach. The �Measure 
1" attribute is ignored.

Side Rt The side 
measurement 
qualifier is set to 
Right side of the body

Rt Derived from 
Step Name 
attribute if 
possible. 
Otherwise, same 
as previous step

Lt The side 
measurement 
qualifier is set to 
Right side of the body

None The side 
measurement 
qualifier is not used 
(neither Right nor 
Left)
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Fetus A The fetus 
measurement 
qualifier is set to 
Fetus A

A Same as 
previous step

B The fetus 
measurement 
qualifier is set to 
Fetus B

C The fetus 
measurement 
qualifier is set to 
Fetus C

D The fetus 
measurement 
qualifier is set to 
Fetus D

Location Prox The location 
measurement 
qualifier is set to 
Proximal

Prox Same as 
previous step

Mid The location 
measurement 
qualifier is set to 
Middle

Dist The location 
measurement 
qualifier is set to 
Distal

None The location 
measurement 
qualifier is not used

Measure 1 Various 2D or 
M-mode 
measurements

Specifies the first 2D 
or M-mode 
measurement to be 
initiated. The point at 
which the 
measurement is 
initiated is based 
upon the Measure 
Trigger attribute. See 
Section 6 for more 
information.

Blank Blank

Table 16-98:  Measure Attributes (Continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Measure 2 Various 2D or 
M-mode 
measurements

Specifies the second 
2D or M-mode 
measurement to be 
initiated after the 
measurement 
associated with the 
Measure 1 attribute is 
completed. See 
Section 6 for more 
information

Blank Blank

Measure 3 Various 2D or 
M-mode 
measurements

Specifies the second 
2D or M-mode 
measurement to be 
initiated after the 
measurement 
associated with the 
Measure 2 attribute is 
completed. See 
Section 6 for more 
information.

Blank Blank

Dop Vessel Assign Various Doppler 
measurement 
Vessel folders

Specifies the Vessel 
folder to assign auto 
calcs to. The 
assignment happens 
when the image is 
stored / printed (P1 
key, e.g.). See 
Section 6 for more 
information.

Blank Blank

Auto Calcs Default Auto Calcs state not 
specified. Scan 
Coach does not set 
Auto Calcs state.

Default Same as 
previous step

Off Auto Calcs state set 
to Off

Frozen Auto Calcs state set 
to Frozen

Live Auto Calcs state set 
to Live

Table 16-98:  Measure Attributes (Continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Auto Calc Params Various Auto Calc 
parameters

Specifies the auto 
calc parameters to be 
used. 

Default Same as 
previous step

Default Auto Calc parameters 
are not specified. 
Scan Coach does not 
set the Auto Calc 
parameters.

Auto Calc Specify [Not Applicable] Button used to enable 
the Auto Calcs 
Parameter Selection 
dialog so that the 
Auto Calc Params 
attribute can be set

[Not Applicable] [Not Applicable]

Auto Calc Default [Not Applicable] Button used to set the 
Auto Calcs Params 
attribute to Default.

[Not Applicable] [Not Applicable]

Double Print On (checked) If an Image Store / 
Print (P1 key, e.g.)  is 
performed on an 
image with 
measurements, the 
image is stored / 
printed two times, 
once with the 
measurements and 
once without.

Off Same as 
previous step

Off (unchecked) No special Store / 
Print behavior.

Table 16-98:  Measure Attributes (Continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Double Print On (checked) If an Image Store / 
Print (P1 key, e.g.)  is 
performed on an 
image with color, the 
image is stored / 
printed two times, 
once with color and 
once without. If 
double print on color 
and double print on 
measurements are 
both configured to be 
on, the image is 
stored / printed two 
times, once with the 
measurements and 
once without.

Off (unchecked) No special Store / 
Print behavior.

View Worksheet On (checked) The worksheet is 
turned on

Off Off

Off (unchecked) The worksheet is not 
turned on

Table 16-98:  Measure Attributes (Continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default



Customizing Your System

16-164 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10

Measurements

Because there are many measurements available on the 
Versana Active and because the measurement package is 
highly customizable, there is some special handling for 
measurements. The Measurement attributes affected by this 
special handling are Measure 1-3 and Vessel.

Selecting a Measurement Package

The Measurement selection menu can be used to specify which 
measurement package is to be used for the Program. The 
Measurements packages are organized by category and 
subcategory. The choices for the Measure 1-3 and Vessel 
attributes are limited by the selection of category and 
subcategory. To select a subcategory, select a category, move to 
the subcategory list and select a subcategory. To select all 
subcategories for a given category, select the category and then 
reselect the Measurements menu item to remove the menu.

A single Program is not allowed to have measurements from 
multiple categories, but it may have measurements from 
multiple subcategories.

Figure 16-117. Measurements Menu
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User-Defined Measurements

User-defined subcategories and individual measurements can 
be used with the Scan Coach feature. To do so, the Scan Coach 
Creator needs to know about the user-defined measurements 
on the Versana Active.

On the Versana Active, use the Scan Coach utility menu to 
Export Programs to a USB storage device (or CD/DVD). On the 
export menu, check the �Export user config data� checkbox to 
store the user-defined measurement information to the Program 
User Directory on the media. The name of the file is 
UserConfigSystemFile.res. When this file exists in the Program 
User Directory, then it is used. Otherwise, the default file 
installed with the Scan Coach Creator is used.

Figure 16-118. Program Export Menu on Versana Active
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Navigating Programs

In addition to moving the windows pointer and selecting an item, 
there are several keyboard controls that navigate a Program.

Table 16-99:  Keyboard Program Navigation

Keyboard Entry Step Selected Step Attribute Selected

Up Arrow Moves to previous step Single Step View: Varies based on 
the step attribute selected.Multi Step 
View: Moves to same step attribute 
in the previous step.

Down Arrow Moves to next step Single Step View: Varies based on 
the step attribute selected.Multi Step 
View: Moves to same step attribute 
in the next step.

0~9 Press Arabic numeral button, then 
the program will jump to the 
correspondent step. If the step is 
higher than 9, please press two key 
rapidly. 

Single Step View: Varies based on 
the step attribute selected.Multi Step 
View: Moves to the previous step 
attribute.
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Editing Programs

When editing Programs, changes can be made at both the step 
level and the step attribute level. Steps can be added, inserted, 
moved, deleted, copied and pasted. Step attributes can be 
modified for a given step or across multiple steps.

Editing Steps

The step toolbar allows steps to be inserted, moved up and 
down, and deleted. For steps to be moved, one or more 
consecutive steps must be selected. Some of the controls have 
shortcuts (Control Key + another key).

When the last step in a Program is selected, the Enter key 
automatically appends a new step to the end of the Program 
and selects the new step. When the Enter key is pressed on any 
other step, the next step is activated. The up and down arrows 
can also be used to move between steps.

Figure 16-119. Step Toolbar

1. Insert Step above selected step (Ctrl+l)
2. Insert Step below selected step
3. Move selected step(s) up (Ctrl+Up Arrow)
4. Move selected step(s) down (Ctrl+Down Arrow)
5. Delete selected step(s)
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Editing Steps  (continued)

The Edit Menu and Edit toolbar provides access to the Cut, 
Copy, Paste and Paste Special features. The Undo and Redo 
actions also appear on Edit Menu and Edit Toolbar.

Figure 16-120. Edit Menu

Figure 16-121. Edit Toolbar

When selecting multiple steps for Cutting or Copying, the Shift + 
Left Mouse and Ctrl + Left Mouse key combinations can be 
used. Multiple steps are also selected by holding the Left Mouse 
key and dragging across the steps of interest. When pasting 
steps they are added after the currently selected step.

The Paste Special control allows copied steps to be pasted with 
some modification. For example, the steps associated with the 
Right Kidney can be Copied and Pasted so that they are 
converted into Left Kidney steps during the paste. The Paste 
Special dialog is shown in the figure below. Simply select the 
desired Conversion and choose the �Paste� key. 
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Editing Steps  (continued)

� Step Name (Text)

� Comment 1 (Text)

� Comment 2 (Text)

� Side (Measurement qualifier)

� Location (Measurement qualifier)

� Fetus (Measurement qualifier)

Figure 16-122. Paste Special Dialog
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Editing Steps  (continued)

The Define Conversions key is used to define the text that is 
converted. An example is shown in the figure below. If an exact 
case match is found, it is used for the conversion. If there is a 
match, but with different case, it is used only if there is not an 
exact case match.

There are 3 user-defined conversions that can be edited and 
named. These user-defined conversions can also be used to 
perform a find and replace capability.

Figure 16-123. Define Conversions Dialog
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Editing Step Attributes

To edit a step attribute simply select the step attribute and edit it, 
such as picking from a drop down menu, checking or 
unchecking a box or typing in text.

This will take the original step's content and copy it down the 
highlighted steps. This is also available when multiple attributes 
are selected within the same step.

If a step attribute is not editable, it may be because the attribute 
requires a different attribute to be set a particular way in order to 
become enabled. These dependencies are outlined below.

Undo/Redo

The Undo feature allows the previous action to be undone. For 
example, pressing undo 6 times will undo the last 6 changes. 
Redo cancels the Undo of an action. For example, pressing 
undo 6 times will undo the last 6 changes and then pressing 
Undo 2 times will cause only the last 4 actions to be undone.

Table 16-100:  Step Attribute Dependencies

Step Attribute Dependency

PDI Color step attribute must be checked

Color / Dop Steer Color or PW step attribute must be checked

Measure 1 Measure Trigger must not be set to None

Measure 2 Measure 1 must be set

Measure 3 Measure 1 and Measure 2 must be set
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Editing the Current Program on the Scanner

If you are currently using a Scan Coach program and choose to 
edit that program while using it, the program will be reloaded 
when scanning is restarted. If the number of steps is changed, 
the checkmarks that were in place before editing are cleared. If 
the number of steps in the program has not changed, the 
checkmarks that were in place before editing are maintained.

The current program can be restarted at any time by selecting 
the Stop button on the Scan Coach navigation window and 
selecting restart.

Editing Predefined Programs

1. Enter Utility->Scan Coach->Scan Coach 
Manager->Predefined Programs. Select preferred 
predefined program.

2. Press Edit to display the Scan Coach Creator window. Edit 
the predefined program via the toolbar at the left side.

3. Save the program.

4. Enter Utility -> Scan Coach ->Scan Coach Manager -> 
Custom Programs. Press arrow button to move the edited 
program to the Program Selections column.

5. Press Scan Coach key on the control panel to activate the 
Scan Coach function. 

6. Select the edited program.

You can follow the procedure below to edit the Predefined 
Program while using it:

1. Press Stop Button, then select Edit and the system will 
open the Scan Coach Creator window. 

2. Edit the predefined program via the toolbar at the left side.

3. Save the program. Press Stop button, then exit the Scan 
Coach.

4. Enter Utility -> Scan Coach ->Scan Coach Manager -> 
Custom Programs. Press arrow button to move the edited 
program to the Program Selections column.

5. Press Scan Coach key on the control panel to activate the 
Scan Coach function.

6. Select the edited program.
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Editing the Custom Programs

1. Enter Utility->Scan Coach->Scan Coach 
Manager->Custom Programs. Select preferred custom 
program.

2. Press Edit to display the Scan Coach Creator window. Edit 
the custom program via the toolbar at the left side.

3. Save the programs.

4. Enter Utility -> Scan Coach ->Scan Coach Manager -> 
Custom Programs. Press arrow button to move the edited 
program to the Program Selections column.

5. Press Scan Coach key on the control panel to activate the 
Scan Coach function. 

6. Select the edited program.

You can follow the procedure below to edit the Custom Program 
while using it:

1. Press Stop Button, then select Edit and the system will 
open the Scan Coach Creator window. 

2. Edit the predefined program via the toolbar at the left side.

3. Save the program.

4. Press Stop Button, then select Restart. The edited program 
is activated.
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Rule Checking

Scan Coach Creator allows Programs to be checked. During a 
rule check, Scan Coach Creator applies a series of rules against 
the Program being checked and reports any inconsistencies 
between the rules and the Program. This rule check is intended 
to find potential issues in the Program before it is tested on a 
Versana Active. Issues found when running the check do not 
mean the Program is unusable. It means that if there happens to 
be a problem with running the Program, the first place to look 
would be at the Issue noted when you ran the Check.

For example, if there is a step name Right Kidney and the 
Measurement Location is set to �Left�, the rule check would 
report this inconsistency. 

Running a Rule Check

The �Check� button below the Program area is used to initiate a 
rule check. The results are displayed in the Rule Check Results 
window to the right of the button. A rule check is also initiated 
when attempting to save a Program that has not previously 
passed a rule check.

 Figure 16-124. Rule Check Button and Rule Check Results
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Rule Check Results

If the issue is specific to a particular step, double-clicking on the 
issue number in the Rule Check Results window selects the 
step associated with the issue. The results are intended to be 
potential issues and therefore may be ignored at the discretion 
of the user. For example, the rule check may report that there 
are an unequal number of left and right steps. For a particular 
Program, this may be the expected result. If a change is made in 
response to the rule check results, a new rule check can be run 
to see if the issue has been resolved.
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Customization

The Customize Menu is shown below:

Figure 16-125. Customize Menu

The column widths of the steps and step attributes are 
customizable. The desired width is set by selecting and dragging 
the line separating column headers. These adjustments are 
remembered for the next time the Scan Coach Creator is used.

The locations of the toolbars are customizable. The location is 
set by selecting and dragging the toolbar gripper as shown in 
the figure below. The toolbars can be placed at the top, left, right 
or bottom of the Scan Coach Creator.

Figure 16-126. Gripper used for Toolbar placement

Help

Help is available via the About Menu or the F1 key.

1. Toolbar Gripper
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Scan Assistant

Scan Assistant Manager

Please refer to Chapter 6 for information about how to use Scan 
Assistant and how to use the Scan Assistant Manager to Export 
Scan Assistant Programs. Please refer to �Scan Coach� on 
page 16-138 about how to use the Scan Assistant Creator and 
how to export the Scan Assistant Creator from the Versana 
Active. 

Activating the Scan Assistant Creator

To activate the Scan Assistant Creator on the Versana Active, 
press the Creator key. 

 Figure 16-127. Scan Assistant Manager



Customizing Your System

16-178 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10

Search

Opens up a search window to find a parameter on the utility 
pages. 

To search for a utility parameter, 

1. Select Search. 

2. Type in the search string. For instance, if you�re searching 
for Patient info, you could just type �patient�. 

Figure 16-128. Search Example

3. A list of possible matches appears to the right. Select the 
correct match. 

NOTE: You cannot perform a search on the Measure, Reports, or 
Service utility pages. 
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3D/4D

Overview

NOTE: 3D/4D presets are only available for R1.1.x and R1.2.x.

3D/4D presets allow you to set up application-specific settings 
(presets) for each 4D image acquisition type. You can define 
different application-specific settings for RAB2-6-RS probe. 
Refer to Chapter 5 for more information. 

4D Presets

To set up 4D presets:

1. Press Utility on the control panel.

2. Select 3D/4D.

The system displays the 4D Presets screen. Click on the 
plus sign (+) that appears next to RAB2-6-RS probe.

3. To select the application, click on the plus sign (+) that 
appears next to the desired application.

4. To select the acquisition type, click on the plus sign (+) that 
appears next to the desired application.

5. Click the desired application under the acquisition type. The 
Display tab is selected.
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Display tab

Figure 16-129. Display Preset Parameters

Table 16-101:  Image Display

Preset Parameter Description

Tile Determines the number of display windows. Values include: 1 (Single), 2 
(Dual), and 4 (Quad).

Visualization Determines the method of display for working with images. Selections 
available: Sectional, Render,TUI.

3D Orientation (degrees) Determines the orientation of the ROI on the monitor display. Values include: 
0, 90, 180, 270.

Zoom Factor Determines the magnification factor of the zoom.

Orientation Help Activate Orientation Help. 

Table 16-102:  Pre-mode ROI

Preset Parameter Description

ROI Center (cm) Determines the vertical center of the region of interest. Values vary by probe.

ROI Span (cm) Determines the height of the region of interest. Values vary by probe.

Tilt (degrees) Determines the degree of tilt from the vertical center location of the ROI. 
Values vary by probe. 
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Width (degrees) Determines the width of the ROI. Values vary by probe. 

Volume Angle Set the range of the volume sweep. Values vary by probe. Listed in degrees 
for curved probes, cm for linear probes.

Table 16-103:  Quality Setting

Preset Parameter Description

Setting Set quality setting -- balances speed with line density. Selections are Low, 
Mid1, Mid2, Hi1. High combines the highest density with the slowest speed. 
Low combines the lowest density with the highest speed. 

Table 16-102:  Pre-mode ROI (Continued)

Preset Parameter Description
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Render Tab

Figure 16-130. Render tab

Table 16-104:  Render 

Preset Parameter Description

Render Mode 1:Mode2 Set render mode values. Surface Smooth, Surface Texture, Transp Max, 
Transp X-Ray, or TransMin (Render 1). Surface Smooth, Light, Gradient 
Light, Transp Max, Transp X-Ray, or Transp Min (Render 2). 

Mix (% Render Mode 2) Set mix of Render 1 / Render 2 Mode, 0-100. 

Lower Threshold Set a lower threshold below which weaker echoes are removed, 0-255. 

Transparency Set the transparence of the image, 10/20-250. The higher the number, the 
more transparent the gray scale information.

Render View Direction Set the direction in which the ROI is viewed. 
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Orientation Markers tab

Figure 16-131. Orientation Markers tab

Table 16-105:  Orientation Markers

Preset Parameter Description

Initial Body Position Set Head, Feet, Front, or Back

Body Rotation (degrees) Set 0, 45, 90, 135, 180, 225, 270, or 315. 

Probe Rotation (degrees) Set 0, 45, 90, 135, 180, 225, 270, or 315. 

Probe Tilt (degrees) Set 0, 45, 90, -45, or -90. 

Probe Position Horizontal (0-Left;100-Right) Set 0-100. 

Probe Position Vertical (0-Top;100-Bottom) Set 0-100. 
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TUI tab

Figure 16-132. TUI Tab

Table 16-106:  TUI

Preset Parameter Description

Display Format Set 1x1, 1x2, 2x2, or 3x3.

Total Slices Set 3, 5, 7, 9, 11, 13, 15, 17, or 19. 

Slice Distance (mm) Set from 0.5 ~ 40. 
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Advanced tab

Figure 16-133. Advanced tab

Table 16-107:  Advanced

Preset Parameter Description

Upper Threshold Sets the higher threshold above which weaker echoes are removed. 
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Chapter 17

Probes and Biopsy

This chapter consists of the information of each probe 
and describes some special concerns, biopsy kits and 
accessories as well as basic procedures for attaching a 
biopsy guide to the different types of probes. 
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Probe Overview

Ergonomics

Probes have been ergonomically designed to:

� Handle and manipulate with ease.

� Connect to the system with one hand.

� Be lightweight and balanced.

� Have rounded edges and smooth surfaces.

� Stand up to typical wear by cleaning and disinfectant 
agents, contact with approved gel, etc.

Cables have been designed to:

� Connect to system with appropriate cable length.

Cable handling

Take the following precautions with probe cables:

� Keep free from wheels.

� Do not bend the cable acutely.

� Avoid crossing cables between probes.
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Probe orientation

Each probe is provided with an orientation marking. This mark is 
used to identify the end of the probe corresponding to the side of 
the image having the orientation mark on the display.

Figure 17-1. Orientation Marking on Probe (Example)

1. Orientation Mark

Labeling

Each probe is labeled with the following information:

� Seller's name and manufacturer

� GE part number

� Probe serial number

� Month and year of manufacture

� Probe designation-provided on the probe grip and the top of 
the connector housing, so it is easily read when mounted on 
the system and is also automatically displayed on the 
screen when the probe is selected.

 Figure 17-2. Displayed Probe Information
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Probe Naming Conventions

Probe Usage

For details on connecting, activating, deactivating, 
disconnecting, transporting and storing the probes, See �Probes� 
on page 3-40 for more information.

Table 17-1:  Probe Naming Convention

Type Frequency Connector Type

C = Convex
L = Linear
S = Sector

�4� in 4C-RS RS
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Care and Maintenance

Environmental Requirements

Probes should be operated, stored, or transported within the 
parameters outlined below.

CAUTION Ensure that the probe face temperature does not exceed the 
normal operation temperature range.

Table 17-2:  Probe Environmental Requirements

Operational Storage Transport

Temperature 10  - 40  C
50  - 104  F

For RAB2-6-RS:
18  - 30  C
65  - 86  F

0  - 55  C
32  - 131  F

For RAB2-6-RS:
-10  - 50  C
14  - 122  F

-40  - 55  C
-104  - 131  F

For RAB2-6-RS:
-10  - 50  C
14  - 122  F

Humidity 5 - 85%
non-condensing

5 - 85%
non-condensing

5 - 85%
non-condensing

Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa

CAUTION Check the room temperature before you use the probe. 

CAUTION Ensure that the probe face temperature does not exceed the 
normal operation temperature range.
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Planned maintenance program

It is recommended to keep a maintenance log and note all probe 
malfunctions. Follow the maintenance schedule below to ensure 
optimum operation and safety:

After each use:

� Inspect the probe.

� Clean the probe.

� Disinfect the probe.

Before each use:

� Inspect the probe.

CAUTION Improper handling can lead to early probe failure and electric 
shock hazards.

DO follow the specific cleaning and disinfection procedures 
provided in this chapter and the chemical manufacturers 
instructions.

Failure to do so will void probe warranty.

CAUTION Transesophageal, endocavity and intraoperative probes 
require a special handling. Refer to the user documentation 
enclosed with these probes.
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Inspecting the probe

After each use:

1. Inspect the probe�s lens, cable, casing, and connector for 
cracks, cuts, tears, and other signs of physical damage. 
Look for any damage that would allow liquid to enter the 
probe. If any damage is found, do not use the probe until it 
has been inspected and repaired/replaced by a GE Service 
Representative.

2. Look for damage that might allow liquid into the probe.

Before each use:

1. Inspect the probe.

2. Look for damage that might allow liquid into the probe.

3. Test the functionality of the probe.

 Figure 17-3. Probe parts

CAUTION If any damage is found, DO NOT use the probe until it has 
been inspected and released for further use by a GE service 
representative.

CAUTION Inspect the probes for sharp edge or rough surfaces that 
could injure sensitive tissue.

Inspect the probe�s lens, cable, casing, and connector for 
cracks, cuts, tears, and other signs of physical damage.

1. Housing
2. Strain relief
3. Seal
4. Lens
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Probe Care Cards

The Probe Care Card contains a list of chemicals that have been 
tested for compatibility with GE Ultrasound probes. The 
reprocessing instructions provided in this document have been 
validated with the chemicals specified in Table 17-8 on 
page 17-29.  

The Probe Care Card is supplied with every probe and can also 
be downloaded from:

Adequate cleaning and disinfection between patient cases are 
necessary to prevent disease transmission. All probes must be 
thoroughly cleaned prior to disinfection. The level of disinfection 
required is based on patient contact. 

� Probes that contact mucosal or non-intact skin require 
cleaning followed by High-Level Disinfection by either 
soaking or use of a Trophon EPR. Verify probe compatibility 
on the GE probe website shown below. 

� Probes that contact intact skin require cleaning followed by 
Intermediate-Level Disinfection (wipe or spray). 

Table 17-3:  Documentation Web Site

Documentation Web Site

Support Documentation Library Web Site:

http://www3.gehealthcare.com/en/Support/Support_Documentation_Library

Table 17-4:  Probe Web Site

Probe Web Site

Ultrasound Probe Web Site

http://www.gehealthcare.com/transducers
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Probe Care Cards  (continued)

With the exception of the chemicals listed in Table 17-8, the 
chemicals listed in Table 17-10, Table 17-11 and Table 17-12 
have been validated for compatibility only. Therefore, only those 
agents listed in Table 17-8 are recommended due to validated 
efficacy, and any reprocessing performed using chemicals not 
listed in Table 17-8 must be validated by the user.

� Verify probe compatibility using Table 17-5, Table 17-8, 
Table 17-10, Table 17-11, and Table 17-12, as well as the 
Ultrasound Probe Website listed above.

Table 17-5:  Automated High-level Disinfectants Compatible with Non-TEE probes

Chemical 
Name Manufacturer

3
S

c-R
S

6
S

-R
S

1
2S

-R
S

1
2L

-R
S

L
8

-1
8

i-R
S

4
C

-R
S

E
8C

-R
S

E
8

C
s-R

S

L
K

7
60

-R
S

9
L

-R
S

8
C

-R
S

L
6

-1
2

-R
S

R
A

B
2-6-R

S

trophon EPR Nanosonics 
Limited

X X X X X X X X X X X X

trophon2 Nanosonics 
Limited

X X X X X X X X X X X X

CAUTION CREUTZFIELD-JACOB DISEASE

This device is not indicated for neurological use. Neurological 
contact on patients with this disease MUST BE avoided. If a 
device/probe becomes contaminated, there is no adequate 
means to disinfect it. In this case, the contaminated device/
probe MUST BE discarded in accordance with local biologic 
waste hazard procedures.

Biological
Hazard
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Probe Pre-Treatment at the Point of Use (Rquired for All Probes)

The pre-treatment step is for removal of gel and gross 
contamination. 

1. After each use, remove protective sheath from the probe 
and gently remove all coupling gel from the probe by wiping 
with soft, lint-free cloth.

2. Wipe the probe with one of the wipes listed in Probe Care 
Card from the strain relief to the lens. Use a second wipe 
and wipe from the strain relief, down the cable. Wipe the 
cable with a lint-free cloth dampened with potable water to 
remove chemical residue. Dispose of the cloth, wipe and 
gloves in the clinical trash.

Figure 17-4. Cleaning the Probe Cable

NOTE: Use of wipes listed in the Probe Care Card may result in 
discoloration of the cable.

CAUTION DO NOT use abrasive paper products when cleaning or wiping 
a GE Ultrasound probe. The use of abrasive wipes can 
damage the soft lens (acoustic window). 
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Probe Pre-Treatment at the Point of Use (Rquired for All Probes)  

(continued)

3. After each use, inspect the lens, cable, and housing of the 
probe. Look for any damage that would allow liquid to enter 
the probe. If the probe is damaged, do not place it into any 
liquid (e.g. for disinfection) and do not use it until it has been 
inspected and repaired/replaced by a GE Service 
Representative.

 Figure 17-5. Inspect the Lens, Cable, and Probe House After Each Use

WARNING Use caution when cleaning the connector. This cable 
connector should only be cleaned with a slightly dampened 
cloth or wipe. Exposure to excessive moisture will result in 
damage to the probe and possibly the ultrasound console. 
DO NOT wet the connector/console interface surface or 
labels.

1. Cleaning only portion
2. Cleaning only or cleaning and disinfection portion
3. Cleaning followed by appropriate level of disinfection



Probes and Biopsy

17-12 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10

Cleaning with Wipes

Manual cleaning is required to ensure the probes are cleaned to 
the extent necessary for further processing. Choose the most 
appropriate method, either the wipe or enzymatic soak. 

1. Hold the probe at the proximal end near the strain relief 
cable. DO NOT suspend or hold the probe by the cable as 
this may damage the probe. 

2. Dispense a cleaning wipe from the wipe canister. 

3. Gently wipe the probe with a cleaning wipe from the cable 
strain relief to the distal end. Gently wipe the probe�s lens. 

NOTE: Pay special attention to lens, edges, and groves. 

4. Turn the probe and continue wiping until the entire surface 
of the probe has been cleaned. As the wipe becomes visibly 
soiled, discard the wipe into clinical trash and dispense 
fresh wipes as needed. 

5. Wrap a clean wipe around a soft nylon bristle brush to 
access crevasses, such as biopsy notches, on the surface 
of the probe. 

6. Visually inspect the probe for any remaining soil and, if 
necessary, repeat steps 3 through 5 until the probe is visibly 
clean.
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Probe Manual Cleaning Instructions � Enzymatic Detergent 

1. Ensure the probe has been disconnected from the console. 
Put on a clean pair of gloves and fill a sink or basin with 
warm potable water (30 - 40°C) to a level allowing 
immersion of the probe up to the immersion line shown in 
the user manual.

2. Prepare the cleaning solution in accordance with the 
detergent manufacturer�s instructions.

3. Immerse the probe in the prepared cleaning solution up to 
the immersion line and ensure no air bubbles are trapped on 
the surface. Do not submerge probe beyond the immersion 
line shown in the user manual and in Figure 17-13 on 
page 17-24.

4. Brushing with a clean, soft, nylon bristle brush from the base 
of the cable strain relief to the distal tip is critical to ensure 
cleaning and disinfection efficacy.   

Figure 17-6. Cleaning the probe using a brush

CAUTION Do not use the brush on the probe lens. 
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Probe Manual Cleaning Instructions � Enzymatic Detergent  (continued)

Figure 17-7. Probe Lens Examples

5. Continue brushing the probe for not less than the minimum 
contact time listed on the detergent manufacturer�s label. 

6. Visually inspect the probe for soil. Repeat Steps 3 through 5 
until all visible soil has been removed from the surface of the 
probe.

7. Rinse the probe under running warm potable water (30 - 
40°C) for not less than 2 minutes. Scrub the surface of the 
probe with a clean, soft, nylon bristle brush from the base of 
the cable strain relief to the distal tip. 

8. Visually inspect the device in a well-lit area to ensure all 
surfaces are free from residual cleaning solution. Repeat 
Step 7 if visible cleaning solution is observed.

9. Thoroughly dry the probe using a clean lint-free soft and dry 
cloth or wipe.

CAUTION DO NOT use the brush on the probe lens. 

CAUTION DO NOT use a twisting motion or abrasive paper products 
when wiping the probe as this may damage the soft lens.
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Cable and Connector Manual Cleaning

1. The cable and connector surfaces can be cleaned with the 
cleaners or wipes listed in the Probe Care Card.

NOTE: Use of wipes listed in the Probe Care Card may result in 
discoloration of the cable.

2. Wipe the cable with a lint-free cloth dampened with potable 
water to remove chemical residue.

Figure 17-8. Cleaning the Probe Cable

WARNING Use caution when cleaning the connector. This cable connector 
should only be cleaned with a slightly dampened cloth or wipe. 
Exposure to excessive moisture will result in damage to the 
probe and possibly the ultrasound console. DO NOT wet the 
connector/console interface surface or labels.
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Probe Intermediate-Level Disinfection - Spray

For Intermediate-Level Disinfection of surface-contacting 
probes, choose either the spray or wipe method. 

NOTE: Probes that contact only intact skin may be disinfected in this 
manner. All probes that contact non-intact skin or mucous 
membranes (e.g., endocavitary, Transesophageal) require 
High-Level Disinfection. 

1. Put on a new pair of gloves and spray enough disinfectant 
solution to saturate a new disposable lint-free wipe or cloth. 

2. Holding the probe near the strain relief, apply the dampened 
cloth to the patient contacting lens. Wipe the probe from the 
lens to the strain relief, slightly rotating the probe after each 
wiping pass.

3. After the probe has been completely wiped, dampen a 
second wipe with disinfectant and starting at the probe lens 
begin wiping the probe in a rotating motion moving down 
towards the strain relief. Spray disinfectant directly on the 
recessed areas and ridges to saturate.

Figure 17-9. Disinfecting the Probe Moving from Lens to Strain 
Relief

CAUTION After each use, inspect the lens, cable, and housing of the 
probe. Look for any damage that would allow liquid to enter the 
probe. If the probe is damaged, do not place it into any liquid 
(e.g. for disinfection) and do not use it until it has been 
inspected and repaired/replaced by a GE Service 
Representative.
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Probe Intermediate-Level Disinfection - Spray  (continued)

4. Once the probe has been completely wiped, dampen a third 
wipe with disinfectant and continue wiping the probe as 
needed to ensure the surface remains wet for the required 
exposure time. Use as many wipes as needed and respray 
disinfectant on recessed areas and ridges, to ensure all 
surfaces remain wet for the minimum required contact time 
listed in the disinfectant manufacturer�s instructions for use.

5. Dry all surfaces of the probe using a soft, lint-free wipe or 
cloth. 

6. Saturate a soft, lint-free wipe with de-ionized or purified 
water (remove excess water, wipe should be damp but not 
dripping) and thoroughly wipe all surfaces of the probe to 
remove chemical residue. Discard the wipe.

7. A total of three (3) rinses are required. Repeat Step 6 two 
additional times using new wipes and water.

8. Thoroughly dry all surfaces of the probe using a soft, 
lint-free wipe or cloth, changing wipes/cloths when 
necessary to ensure the probe is completely dry. Visually 
inspect the probe to ensure all surfaces are dry. Repeat 
drying steps if any moisture is visible.

9. If the probe is not immediately reused, store the probe in a 
manner that will protect and keep the probe from being 
recontaminated. This may be accomplished by placing the 
probe in a storage cabinet with filtered air flow and/or by 
using a disposable storage cover placed over the probe. 

WARNING Failure to properly rinse probes with water following 
disinfection may cause skin irritation. 
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Probe Intermediate-Level Disinfection - Disinfectant Wipe 

1. Put on a new pair of gloves. Holding the probe near the 
strain relief, apply the wipe to the patient contacting lens. 
Wipe the probe from the lens to the strain relief, slightly 
rotating the probe after each wiping pass.

2. After the probe has been completely wiped, use a second 
wipe and starting at the probe lens begin wiping the probe in 
a rotating motion moving down towards the strain relief. 
Wring the wipe above recessed areas, seams, and ridges to 
drip disinfectant directly onto these less accessible 
surfaces. 

Figure 17-10. Disinfecting the Probe Moving from Lens to 
Strain Relief

NOTE: Probes that contact only intact skin may be disinfected in 
this manner. All probes that contact mucous membranes 
(e.g., endocavitary, Transesophageal) require High-Level 
Disinfection. 

CAUTION After each use, inspect the lens, cable, and housing of the 
probe. Look for any damage that would allow liquid to enter the 
probe. If the probe is damaged, do not place it into any liquid 
(e.g. for disinfection) and do not use it until it has been 
inspected and repaired/replaced by a GE Service 
Representative.
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Probe Intermediate-Level Disinfection - Disinfectant Wipe  (continued)

3. Once the probe has been completely wiped, use a third 
wipe and continue wiping the probe as needed to ensure the 
surface remains wet for the required exposure time. Use as 
many wipes as needed and drip additional disinfectant on 
recessed areas and ridges, to ensure all surfaces remain 
wet for the minimum required contact time listed in the 
disinfectant manufacturer�s instructions for use. 

Figure 17-11. Disinfecting the Probe

4. Dry all surfaces of the probe using a soft, lint-free wipe or 
cloth.

5. Saturate a soft, lint-free wipe with de-ionized or purified 
water (remove excess water, wipe should be damp but not 
dripping) and thoroughly wipe all surfaces of the probe to 
remove chemical residue. Discard the wipe.

6. A total of three (3) rinses are required. Repeat Step 5 two 
additional times using new wipes and water.

WARNING Failure to properly rinse probes with water following 
disinfection may cause skin irritation. 
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Probe Intermediate-Level Disinfection - Disinfectant Wipe  (continued)

7. Thoroughly dry all surfaces of the probe using a soft, 
lint-free wipe or cloth, changing wipes/cloths when 
necessary to ensure the probe is completely dry. Visually 
inspect the probe to ensure all surfaces are dry. Repeat 
drying steps if any moisture is visible.

8. If the probe is not immediately reused, store the probe in a 
manner that will protect and keep the probe from being 
recontaminated. This may be accomplished by placing the 
probe in a storage cabinet with filtered air flow and/or by 
using a disposable storage cover placed over the probe. 
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Probe High Level Disinfection � Soak

High-Level Disinfection is required for devices that contact intact 
mucous membranes or non-intact skin. High Level Disinfection 
can be performed using either a disinfectant soaking method or 
an automated system such as Trophon® EPR. 

1. Ensure the probe has been disconnected from the console. 
Put on a clean pair of gloves and fill a sink or basin with 
High-Level Disinfectant diluted in accordance with the 
disinfectant manufacturers instructions to a level allowing 
immersion of the probe up to immersion line shown in the 
Ultrasound console�s user manual.

NOTE: Cleaning and disinfection instructions for Transesophageal 
probes are documented in the Transesophageal Probe Care 
Card and User Manual. 

NOTE: All semi-critical probes* that contact mucous membranes 
require High-Level Disinfection. 

*Semi-critical probes are probes that contact mucous 
membranes or non-intact skin. 

NOTE: Handles of semi-critical probes that are not submerged 
during High-Level Disinfection require low or 
Intermediate-Level Disinfection to avoid cross 
contamination. 

CAUTION After each use, inspect the lens, cable, and housing of the 
probe. Look for any damage that would allow liquid to enter the 
probe. If the probe is damaged, do not place it into any liquid 
(e.g. for disinfection) and do not use it until it has been 
inspected and repaired/replaced by a GE Service 
Representative.
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Probe High Level Disinfection � Soak  (continued)

2. Immerse probe in the disinfectant up to the immersion line 
and ensure no air bubbles are trapped. Ensure the probe 
remains in the disinfectant for at least the minimum contact 
time listed in the disinfectant manufacturer�s instructions for 
use. 

NOTE: Over-exposing ultrasound probes to high-level disinfectants 
may damage the ultrasound probe. NEVER exceed the 
disinfectant manufacture�s maximum exposure time. 

Figure 17-12. Probe suspended in disinfectant basin

3. Thoroughly rinse the probe by immersing it in a large 
volume of critical (purified) water for a minimum of 1 (one) 
minute. Remove the probe and discard the rinse water.

Do not reuse the water. Always use fresh volumes of water 
for each rinse. Repeat Step 3 two additional times, for a total 
of 3 (three) rinses.

CAUTION Ensure that the probe is suspended. The probe face should not 
be resting against the tank/basin surface and should be in full 
contact with the liquid. Carefully place the probe in the basin, 
taking care not to damage the transducer lens. 

WARNING Failure to properly rinse probes with water following 
disinfection may cause skin irritation. 
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Probe High Level Disinfection � Soak  (continued)

4. Thoroughly dry all surfaces of the probe using a soft, 
lint-free wipe or cloth, changing wipes� cloths when 
necessary to ensure the probe is completely dry. Visually 
inspect the probe to ensure all surfaces are clean and dry. 
Repeat drying steps if any moisture is visible.

5. If the probe is not immediately reused, store the probe in a 
manner that will protect and keep the probe from being 
recontaminated. This may be accomplished by placing the 
probe in a storage cabinet with filtered air flow and/or by 
using a disposable storage cover placed over the probe. 

The instructions provided above have been validated to properly 
prepare GE Ultrasound probes for re-use. It remains the 
responsibility of the processor to ensure that the processing is 
performed as specified in this document. This may require 
verification and routine monitoring of the process. 
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Probe High Level Disinfection � Soak  (continued)

 Figure 17-13. Probe Immersion Levels, 1=Fluid Level  

Table 17-6:  Description of Pictogram for Probe Immersion Levels

Pictogram Description

Fluid Level
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Probe High Level Disinfection � Soak  (continued)

WARNING Use only high-level disinfectants that are listed in the Probe 
Care Card enclosed with the probe. In addition, refer to the 
local / national regulations.

Do not steam autoclave or subject the probe to Ethylene Oxide 
(ETO).

WARNING Do not immerse the probe in liquid beyond the level specified 
for that probe (see Figure 17-13).

Never immerse the probe connector or probe adapters in liquid.

The probe should not be exposed to the disinfectant longer 
than specified to achieve the desired effect.

DO NOT soak or saturate probes with solutions containing 
alcohol, bleach, ammonium chloride compounds or hydrogen 
peroxide.

WARNING CREUTZFELDT-JACOB DISEASE

Neurological use on patients with this disease must be 
avoided. If a probe becomes contaminated, there is no 
adequate disinfecting means.

CAUTION Ensure that you follow the probe disinfection procedure 
provided by GE.

Table 17-7:  Description of Pictogram on Probe Care Cards

Pictogram Description Standard

�ATTENTION� - Consult accompanying documents� is 
intended to alert the user to refer to the operator 
manual or other instructions when complete information 
cannot be provided on the label.

ISO 7000-0434A

�CAUTION� - Dangerous voltage (the lightning flash 
with arrowhead) is used to indicate electric shock 
hazards.

IEC 60417-6042
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Biohazard - Patient/user infection due to contaminated 
equipment.
Usage
� Cleaning and care instructions
� Sheath and glove guidelines

ISO7000-0659

Ultrasound probes are highly sensitive medical 
instruments that can easily be damaged by improper 
handling. Use care when handling and protect from 
damage when not in use. 

N/A-by GE Healthcare

Do not immerse the probe into any liquid beyond the 
level specified for that probe. Refer to the user manual 
of the ultrasound system.

N/A-by GE Healthcare

Since there is a possibility of having negative effects on 
the probe, observe the specified immersing time by the 
germicide manufacturer strictly. Do not immerse the 
probe in liquid chemical germicides more than the time 
prescribed in the care card.

N/A-by GE Healthcare

�Consult accompany document� - Refer to the 
ultrasound system user manual for important probe 
care and cleaning instruction.

ISO 7010-M002

Table 17-7:  Description of Pictogram on Probe Care Cards (Continued)

Pictogram Description Standard

CAUTION Review the probe care card that is packed with each probe. 

CAUTION Please refer to the probe care card for GE approved probe 
disinfectants.
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Probe High-Level Disinfection - Trophon® EPR

When performing High-Level Disinfection of GE ultrasound 
probes with the Trophon® EPR, it is not necessary to disconnect 
the probe from the ultrasound system. The probe must be 
inactive (not selected) during the disinfection cycle.

1. Upon completion of probe cleaning, ensure the probe has 
been thoroughly dried with a clean, lint-free soft and dry 
cloth or wipe. Carefully dry the probe by wiping from the 
distal tip to the strain relief. 

2. Visually inspect the probe to ensure the probe is visibly 
clean. 

3. Follow the Trophon instructions for probe placement and 
operation of the Trophon system. Incorrect positioning of the 
probe may lead to High-Level Disinfection not being 
achieved. 

4. Once the Trophon High-Level Disinfection cycle is complete, 
don a new set of gloves and promptly remove the probe 
from the Trophon machine. DO NOT allow the probe to 
remain in the machine for extended periods of time. 

CAUTION DO NOT use abrasive paper products when cleaning or wiping 
a GE Ultrasound Probe. The use of abrasive wipes can 
damage the soft lens (acoustic window). 

CAUTION DO NOT use a twisting motion when wiping the probes as this 
may damage the soft lens. 

CAUTION Damage to the probe may occur if the probe is placed in 
contact with the Trophon chamber wall. Curved probes must be 
correctly positioned in the chamber using the Curved Probe 
Positioner (CPP) supplied with the Trophon system. 
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Probe High-Level Disinfection - Trophon® EPR  (continued)

5. Hold the probe at the proximal end near the strain relief 
cable. DO NOT suspend or hold the probe by the cable, as 
this may damage the probe. 

6. Wipe the probe from the distal end to the proximal end with 
a clean, lint-free soft and dry cloth or wipe to remove any 
residual hydrogen peroxide from the probe surface.  

7. If the probe is not immediately reused, store the probe in a 
manner that will protect and keep the probe from being 
recontaminated. This may be accomplished by placing the 
probe in a storage cabinet with filtered air flow and/or by 
using a disposable storage cover placed over the probe. 

CAUTION DO NOT use a twisting motion or abrasive paper products 
when wiping the probe.
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Chemicals Used for Efficacy Validation

The table below lists the products and intended use (clean, 
Intermediate-Level Disinfection, High-Level Disinfection) that 
were validated. 

A full list of chemicals tested for compatibility is available at the 
GE Probe Web Site: 

Table 17-8:  Chemicals used for Efficacy Validation

Product Type Trade Name Manufacturer

Minimum 
Contact 

Time Active Ingredient

Cleaning (Wipe) Oxivir® Tb Diversey N/A Hydrogen Peroxide

Enzymatic Detergent 
(Soak)

Enzol®
 (Cidezyme®)

Advanced 
Sterilization 
Products® (J&J)

1-Minute 
Soak

Proteolytic Enzymes

MetriZyme� Metrex�

Prolystica® 2X
Concentrate 
Presoak & Cleaner

Steris

Intermediate-level 
Disinfectant (wipe)

Oxivir® Tb Diversey 10-Minute 
Exposure

Hydrogen Peroxide

High-level 
Disinfectant (Soak)

Cidex® OPA Advanced 
Sterilization 
Products (J&J)

10-Minute 
Soak

Ortho-phthalaldehyde

McKessen OPA/28 McKesson

Table 17-9:  Probe Web Site

Probe Web Site

Ultrasound Probe Web Site

http://www.gehealthcare.com/transducers
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Table 17-10:  Cleaners Compatible with Non-TEE probes

Trade Name Manufacturer
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AniosClean Excel D Laboratoires Anios X X X X X X X X X X X X X

Aniosyme X3 Laboratoires Anios X X X X X X X X X X X X X

Aniosyme DD1 Laboratoires Anios X X X X X X X X X X X X

Bodedex Forte BODE Chemie GmbH 
(HARTMANN)

X X X X X X X X X X X X

Cidezyme / Enzol Advanced Sterilization 
Products

X X X X X X X X X X X X

Eco-Zyme 
Multi-Tiered 
Enzymatic Detergent

Pro-Line Solutions Inc. X X X X X X X X X X X X

EmPower Metrex X X X X X X X X X X X X

Endozime The Ruhof Corporation X X X X X X X X X X X X

Endozime Sponge The Ruhof Corporation X X X X X X X X X X X X

Endozime AW Triple 
Plus with APA

The Ruhof Corporation X X X X X X X X X X X X

Endozime SLR The Ruhof Corporation X X X X X X X X X X X X

Endozime SLR 
Sponge

The Ruhof Corporation X X X X X X X X X X X X

Enzyclean II Dual 
Enzyme Detergent

Micro-Scientific 
(Weiman)

X X X X X X X X X X X X X

gigasept AF Schulke & Mayr GmbH X X X X X X X X X X X X

gigazyme Schulke & Mayr GmbH X X X X X X X X X X X X

gigazyme X-tra Schulke & Mayr GmbH X X X X X X X X X X X X

Intercept Detergent Mediavators X X X X X X X X X X X X

Matrix Whiteley Medical X X X X X X X X X X X X

Metrizyme Metrex X X X X X X X X X

Prolystica 2X 
Concentrate 
Enzymatic Presoak 
and Cleaner

STERIS Corporation X X X X X X X X X X X X

Prolystica STERIS Corporation X X X X X X X X X X X X

Pure Enzymatic 
Detergent

EndoChoice X X X X X X X X X X X X X
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Revital-Ox Enzymatic 
Detergents (with or 
without dye and 
fragrance)

STERIS Corporation X X X X X X X X X X X X X

Sekusept 
MultiEnzyme

Ecolab X X X X X X X X X X X X

Septanios MD Laboratoires Anios X X X X X X X X X X X X

Cygnus Simple2 
Multi-Tiered 
Enzymatic Detergent 
(bottle or sponge kits)

Cygnus Medical X X X X X X X X X X X X

Soft Soap All manufacturer X X X X X X X X X X X X

Valsure Enzymatic 
Cleaner

STERIS Corporation X X X X X X X X X X X X X

Table 17-10:  Cleaners Compatible with Non-TEE probes

Trade Name Manufacturer
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Table 17-11:  Low and Intermediate-level Disinfectants Compatible with Non-TEE probes

Product 
type Chemical Name Manufacturer
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Liquid/
Spray

Accel INTERVention 
RTU

Diversey 
(Sealed Air)

X X X X X X X X X X

Accel TB RTU Diversey 
(Sealed Air)

X X X X X X X X X X

Acryl-Des Schulke & Mayr 
GmbH

X X X X X X X X X X X X

Acrylan Antiseptica 
Chem. Phar. 
Produkte

X X X X X X X X X X X X

Alcohol 70% Ethanol 
on a wipe

All 
manufacturer

X X X X X X X X X X X X

Alcohol 70% 
Isopropanol on a wipe

All 
manufacturer

X X X X X X X X X X X X

Bacillol 30 Foam BODE Chemie 
GmbH 
(HARTMANN)

X X X X X X X X X X X X

Bacillol AF BODE Chemie 
GmbH 
(HARTMANN)

X X X X X X X X X X X X

Bacillol plus BODE Chemie 
GmbH 
(HARTMANN)

X X X X X X X X X X X X

Biguacid-S Antiseptica 
Chem. Phar. 
Produkte

X X X X X X X X X X X X

CaviCide Metrex X X X X X X X X X X X X

CaviCide 1 Metrex X X X X X X X X X X X X

CaviCide AF Metrex X X X X X X X X X X X X X

Cidalkan Alkapharm X X X X X X X X X X X X

Clinell Universal Spray GAMA 
Healthcare Ltd

X X X X X X X X X X X X

Clorox broad spectrum 
quaternary disinfectant 
cleaner

CloroxPro X X X X X X X X X X X X
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Liquid/
Spray

Clorox Healthcare 
Hydrogen Peroxide 
Cleaner Disinfectant 
Liquids and Spray

CloroxPro X X X X X X X X X X

Hibitane (5% 
Chlorhexidine 
gluconate)

All 
manufacturer

X X X X X X

Mikrozid sensitive liquid Schulke & Mayr 
GmbH

X X X X X X X X X X X X

Optim 33TB RTU SciCan X X X X X X X X X X

Oxivir Tb RTU Diversey 
(Sealed Air)

X X X X X X X X X X

PCS 1000 Oxidizing 
Disinfectant/
Disinfectant Cleaner

Process 
Cleaning 
Solutions Ltd

X X X X X X X X X X X X X

Protex disinfectant 
spray

Parker 
Laboratoires 
Inc.

X X X X X X X X X X X X

SurfaSafe Laboratoires 
Anios

X X X X X X X X X X X X

Surfa�Safe Premium Laboratoires 
Anios

X X X X X X X X X X X X X

Transeptic Spray Parker 
Laboratoires 
Inc.

X X X

Liquid/
Spray

Tristel Duo ULT Tristel Solutions 
Limited

X X X X X X X X X X X X

Table 17-11:  Low and Intermediate-level Disinfectants Compatible with Non-TEE probes
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Wipes Accel INTERVention 
Wipes

Diversey 
(Sealed Air)

X X X X X X X X X X

Accel TB Wipes Diversey 
(Sealed Air)

X X X X X X X X X X

Anios Quick Wipes Laboratoires 
Anios

X X X X X X X X X X X X

Asepti-Wipes II Ecolab X X X X X X X X X X X X X

Bacillol 30 Tissues BODE Chemie 
GmbH 
(HARTMANN)

X X X X X X X X X X X X

Bacillol AF Tissues BODE Chemie 
GmbH 
(HARTMANN)

X X X X X X X X X X X X

Bactinyl Lingettes 
desinfectantes 
inodores

Laboratoire 
Garcin-Bactinyl

X X X X X X X X X X X X

CaviWipes Metrex X X X X X X X X X X X X X

CaviWipes 1 Metrex X X X X X X X X X X X X

CaviWipes AF Metrex X X X X X X X X X X X X X

Cidalkan Wipes Alkapharm X X X X X X X X X X X X

Cleanisept Wipes Dr. Schumacher 
GmbH

X X X X X X X X X X X X X

Cleanisept Wipes forte Dr. Schumacher 
GmbH

X X X X X X X X X X X X X

Clinell Clorox Wipes GAMA 
Healthcare Ltd

X X X X X X X X X X X X

Clinell Universal 
Sanitising wipes or 
Clinell Universal wipes

GAMA 
Healthcare Ltd

X X X X X X X X X X X X

Table 17-11:  Low and Intermediate-level Disinfectants Compatible with Non-TEE probes
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Wipes Clorox Healthcare 
Bleach Germicidal 
wipes

CloroxPro X X X X X X X X X X X X

Clorox Healthcare 
Hydrogen Peroxide 
Cleaner Disinfectant 
Wipes

CloroxPro X X X X X X X X X X

Clorox Healthcare 
Multi-Surface Quat 
Alcohol Cleaner 
Disinfectant Wipes

CloroxPro X X X X X X X X X X X X

Clorox Healthcare 
VersaSure Cleaner 
Disinfectant Wipes

CloroxPro X X X X X X X X X X X X

Dispatch hospital 
cleaner disinfectant 
towels with bleach

CloroxPro X X X X X X X X X X X X

General purpose 
disinfectant wipes

Total Solutions X X X X X X X X X X X X

Intercept Wipes Medivators X X X X X X X X X X X X

Matrix Wipes Whiteley 
Medical

X X X X X X X X X X X X

Mikrobac tissues BODE Chemie 
GmbH 
(HARTMANN)

X X X X X X X X X X X X

Mikrozid sensitive 
wipes

Schulke & Mayr 
GmbH

X X X X X X X X X X X X

Mikrozid universal 
liquid and Mikrozid 
universal wipes

Schulke & Mayr 
GmbH

X X X X X X X X X X X X

Optim 33TB Wipes SciCan X X X X X X X X X X

Table 17-11:  Low and Intermediate-level Disinfectants Compatible with Non-TEE probes
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Wipes Oxivir Tb Wipes Diversey 
(Sealed Air)

X X X X X X X X X X

PCS 1000 Oxidizing 
Disinfectant/
Disinfectant Cleaner 
Wipes

Process 
Cleaning 
Solutions Ltd

X X X X X X X X X X X X X

Protex disinfectant 
wipes

Parker 
Laboratories 
Inc.

X X X X X X X X X X X X

Protex ULTRA 
Disinfectant Wipes

Parker 
Laboratories 
Inc.

X X X X X X X X X X X X X

Reynard Premier 
Disinfectant Wipes

Reynard Health 
Supplies

X X X X X X X X X X X X

Reynard Neutral 
Detergent Wipes

Reynard Health 
Supplies

X X X X X X X X X X X X

Sani-Cloth Active Ecolab X X X X X X X X X X X X X

Sani-Cloth Active PDI X X X X X X X X X X X X X

Sani-Cloth AF 
Germicidal Disposable 
Wipe

PDI X X X X X X X X X X X X

Sani-Cloth AF3 
Germicidal Disposable 
Wipe

PDI X X X X X X X X X X X X

Sani-Cloth Bleach 
Germicidal Disposable 
Wipe

PDI X X X X X X X X X X X X

Sani-Cloth Plus 
Germicidal Disposable 
Cloth

PDI X X X X X X X X X X X X X

Table 17-11:  Low and Intermediate-level Disinfectants Compatible with Non-TEE probes
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Wipes Sani-Cloth Prime 
Germicidal Disposable 
Wipe

PDI X X X X X X X X X X X X

Saraya Surface 
Sanitizing wipes

Saraya X X X X X X X X X X X X

Septiwipes Dr. Schumacher 
GmbH

X X X X X X X X X X X X X

Shodokku Super wipes Hakujuji X X X X X X X X X X X X

Sofuraito disinfecting 
wipes

Asahi Kasei 
Chemicals 
Corporation

X X X X X X X X X X X X

SONO Ultrasound 
Wipes

Advanced 
Ultrasound 
Solutions Inc.

X X X X X X X X X X X X

Sukitto-Cloth wipes Osaki Medical 
Corporation

X X X X X X X X X X X X

Sukitto-Cloth wipes 
refill

Osaki Medical 
Corporation

X X X X X X X X X X X X

Super Sani-Cloth 
Germicidal Disposable 
Wipe

PDI X X X X X X X X X X X X

Tristel Pre-Clean Wipes Tristel Solutions 
Limited

X X X X X X X X X X X X

Tristel Rinse Wipes Tristel Solutions 
Limited

X X X X X X X X X X X X

Tristel Sporicidal Wipe - 
Activated Wipe

Tristel Solutions 
Limited

X X X X X X X X X X X X

Tristel Trio Wipes 
System

Tristel Solutions 
Limited

X X X X X X X X X X X X

trophon Companion 
Cleaning Wipes

Nanosonics 
Limited

X X X X X X X X X X X X X

trophon Companion 
Drying Wipes

Nanosonics 
Limited

X X X X X X X X X X X X X

Tuffle 5 Vernacare Ltd X X X X X X X X X X X X

Table 17-11:  Low and Intermediate-level Disinfectants Compatible with Non-TEE probes

Product 
type Chemical Name Manufacturer

4
C

-R
S

E
8C

-R
S

3
S

c
-R

S

6
S

-R
S

1
2S

-R
S

L
6

-1
2

-R
S

9
L

-R
S

R
A

B
2-6-R

S

1
2L

-R
S

L
8

-1
8

i-R
S

L
K

7
60

-R
S

E
8

C
s-R

S

8
C

-R
S



Probes and Biopsy

17-38 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10

Wipes V Wipes Whiteley 
Medical

X X X X X X X X X X X X

Wet Wipe Chlorine 
Disinfection

Wet Wipe A/S X X X X X X X X X X X X

Wet Wipe PHMB 
Disinfection

Wet Wipe A/S X X X X X X X X X X X X

Wet Wipe Triamin 
Disinfection

Wet Wipe A/S X X X X X X X X X X X X X

Wet Wipe Universal Wet Wipe A/S X X X X X X X X X X X X

Wip�Anios Excel Laboratoires 
Anios

X X X X X X X X X X X X X

Wip�Anios Premium Laboratoires 
Anios

X X X X X X X X X X X X

Table 17-11:  Low and Intermediate-level Disinfectants Compatible with Non-TEE probes
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Table 17-12:  High-level Disinfectants Compatible with Non-TEE probes

Product 
type Chemical Name Manufacturer
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Aidal Plus (Only HLD, 
not sterilization)

Whiteley Medical X X X X X X X X X X X X

Anioxy-Twin Laboratoires Anios X X X X X X X

Anioxyde 1000 Laboratoires Anios X X X X X X X

Bacillocid rasant BODE Chemie 
GmbH 
(HARTMANN)

X X X X X X X X X X X X

Cidex Advanced 
Sterilization 
Products

X X X X X X X X X X X X

Cidex OPA Advanced 
Sterilization 
Products

X X X X X X X X X X X X

Cidex Plus Advanced 
Sterilization 
Products

X X X X X X X X X X X

gigasept FF neu Schulke & Mayr 
GmbH

X X X X X X X X X

gigasept PAA 
Concentrate

Schulke & Mayr 
GmbH

X X X X X X X

McKesson OPA 28 McKesson X X X X X X X X X X X X

Metricide 14 Metrex X X X X X X X X X X X X

Metricide 28 Metrex X X X X X X X X X X X X

Metricide Plus 30 Metrex X X X X X X X X X X X X

Metricide OPA Plus Metrex X X X X X X X X X X

Opal Whiteley Medical X X X X X X X X X X X X
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H
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Opaster�Anios Laboratoires Anios X X X X X X X X X X X X

Opidex OPA Firson Co. Ltd. X X X X X X X X X X X X

Rapicide High-Level 
Disinfectant and Sterilant 
(glutaraldehyde, use as 
HLD only)

Medivators Inc X X X X X X X X X X X

Rapicide OPA 28 Medivators Inc X X X X X X X X X X X X

Revital-Ox Resert High 
Level Disinfectant

STERIS 
Corporation

X X X X X X

Steranios 2% (use as 
HLD only)

Laboratoires Anios X X X X X X X X X X X X

Wavicide-01 Medical Chemical 
Corporation

X X X X X X X X X X X X

P
ow

d
er

Gigasept pearls Schulke & Mayr 
GmbH

X X X X X X X

HMC NF (HMC 9) mdd Company 
GmbH

X X X X X X X

Rely+On PeraSafe The Chemours 
Company

X X X X X X X

Sekusept Aktiv Ecolab X X X X X X X

Sekusept Easy Ecolab X X X X X X X

Table 17-12:  High-level Disinfectants Compatible with Non-TEE probes
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Covering the Transducer using a Sterile, Protective Sheath

1. Place an appropriate amount of gel inside the protective 
sheath and/or on the transducer face.

NOTE: Failure to use imaging gel may result in poor image quality.

2. Insert transducer into sheath, making sure to use proper 
sterile technique. Pull cover tightly over transducer face to 
remove wrinkles and air bubbles, taking care to avoid 
puncturing the sheath.

Figure 17-14. Applying the Sheath

NOTE: No gel was applied to the probe in this photo. 

3. Secure the sheath in place.

NOTE: Failure to use a sheath that fully covers the transducer to 
the cable strain relief may lead to cross-contamination of the 
transducer.

4. Inspect the sheath to ensure there are no holes or tears. If 
the sheath becomes compromised, stop the procedure and 
replace immediately.

CAUTION Protective barriers may be required to minimize disease 
transmission. Probe sheaths are available for use with all 
clinical situations where infection is a concern. Use of legally 
marketed, sterile probe sheaths is mandatory for intra-cavitary 
and intra-operative procedures. 

1. Secure the Sheath with a rubber 
band.  

2. The probe sheath should extend 
past the end of the probe to the 
probe�s cable. 
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Probe Safety

Handling precautions 

Electrical shock hazard 

WARNING Ultrasound probes are highly sensitive medical instruments 
that can easily be damaged by improper handling. Use care 
when handling and protect from damage when not in use. DO 
NOT use a damaged or defective probe. Failure to follow these 
precautions can result in serious injury and equipment 
damage.

Electrical
Hazard

The probe is driven with electrical energy that can injure the 
patient or user if live internal parts are contacted by conductive 
solution:

� DO NOT immerse the probe into any liquid beyond the 
level indicated by the immersion level diagram. Refer to the 
immersion illustration in the Probe Cleaning Process 
section. Never immerse the probe connector or probe 
adaptors into any liquid.

� DO NOT drop the probes or subject them to other types of 
mechanical shock or impact. Degraded performance or 
damage such as cracks or chips in the housing may result.

� Prior to each use, visually inspect the probe lens and case 
area for cracks, cuts, tears, and other signs of physical 
damage. DO NOT use a probe which appears to be 
damaged until you verify functional and safe performance. 
You must perform a more thorough inspection, including 
the cable, strain relief, and connector, each time you clean 
and disinfect the probe. 

� Before inserting the connector into the probe port, inspect 
the probe connector pins. If a pin is bent, do not use the 
probe until it has been inspected and repaired/replaced by 
a GE Service Representative.

� DO NOT kink, tightly coil, or apply excessive force on the 
probe cable. Insulation failure may result.

� Electrical leakage checks should be performed on a routine 
basis by GE Service or qualified hospital personnel. Refer 
to the service manual for leakage check procedures.
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Mechanical hazards 

CAUTION A defective probe or excessive force can cause patient injury or 
probe damage:

� Observe depth markings and do not apply excessive force 
when inserting or manipulating intracavitary probes.

� Inspect probes for sharp edges or rough surfaces that 
could injure sensitive tissue.

� DO NOT apply excessive force to the probe connector 
when inserting into the probe port. The pin of a probe 
connector may bend.
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Special handling instructions

Using protective sheaths

Instructions. Custom made sheaths are available for each 
probe. Each probe sheath kit consists of a flexible sheath used 
to cover the probe and cable and elastic bands used to secure 
the sheath.

Sterile probe sheaths are supplied as part of biopsy kits for 
those probes intended for use in biopsy procedures. In addition 
to the sheath and elastic bands, there are associated 
accessories for performing a biopsy procedure which are 
included in the kit. Refer to the biopsy instructions for the 
specific probes in the Discussion section of this chapter for 
further information.

Reordering. To reorder sheaths, please contact your local 
distributor or the appropriate support resource. 

CAUTION Protective barriers may be required to minimize disease 
transmission. Probe sheaths are available for use with all 
clinical situations where infection is a concern. Use of legally 
marketed, sterile probe sheaths is mandatory for intra-cavitary 
and intra-operative procedures.

CAUTION Devices containing latex may cause severe allergic reaction in 
latex sensitive individuals. Refer to FDA's March 29, 1991 
Medical Alert on latex products.

CAUTION Do not use pre-lubricated condoms as a sheath. In some 
cases, they may damage the probe. Lubricants in these 
condoms may not be compatible with probe construction.

CAUTION DO NOT use an expired probe sheath. Before using probe 
sheaths, verify whether the term of validity has expired.
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Endocavitary Probe Handling Precautions

If there is disinfectant leaking from the probe, DO NOT use the 
probe until it has been inspected and released for further use by 
a GE service representative.

CAUTION Sterile/sanitary sheaths are to be used on the probe during its 
actual use with patients. Wearing gloves protects the patient 
and operator.

CAUTION Disinfectant Exposure to Patient: contact with a disinfectant 
to the patient's skin or mucous membrane may cause an 
inflammation. If this happens, refer to the disinfectant�s 
instruction manual.

Disinfectant Exposure from Probe Handle to Patient: DO 
NOT allow the disinfectant to contact the patient. Only immerse 
the probe to its specified level. Ensure that no solution has 
entered the probe�s handle before scanning the patient. If 
disinfectant comes into contact with the patient, refer to the 
disinfectant�s instruction manual.

Disinfectant Exposure from Probe Connector to Patient: 
DO NOT allow the disinfectant to contact the patient. Only 
immerse the probe to its specified level. Ensure that no solution 
has entered the probe�s connector before scanning the patient. 
If disinfectant comes into contact with the patient, refer to the 
disinfectant�s instruction manual.
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Probe handling and infection control

This information is intended to increase user awareness of the 
risks of disease transmission associated with using this 
equipment and provide guidance in making decisions directly 
affecting the safety of the patient as well as the equipment user.

Diagnostic ultrasound systems utilize ultrasound energy that 
must be coupled to the patient by direct physical contact.  
Depending on the type of examination, this contact occurs with a 
variety of tissues ranging from intact skin in a routine exam to 
recirculating blood in a surgical procedure. The level of risk of 
infection varies greatly with the type of contact.

One of the most effective ways to prevent transmission between 
patients is with single use or disposable devices. However, 
ultrasound transducers are complex and expensive devices that 
must be reused between patients. It is very important, therefore, 
to minimize the risk of disease transmission by using barriers 
and through proper processing between patients. 

CAUTION Risk of Infection. ALWAYS clean and disinfect the probe 
between patients to the level appropriate for the type of 
examination and use FDA-cleared probe sheaths where 
appropriate. 

CAUTION Adequate cleaning and disinfection are necessary to prevent 
disease transmission. It is the responsibility of the equipment 
user to verify and maintain the effectiveness of the infection 
control procedures in use. Always use sterile, legally marketed 
probe sheaths for intra-cavitary and intra-operative procedures.
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Probe handling and infection control  (continued)

CAUTION In order for liquid chemical disinfectants to be effective, all 
visible residue must be removed during the cleaning process. 
Thoroughly clean the probe, as described earlier before 
attempting disinfection.

You MUST disconnect the probe from the Versana Active prior 
to cleaning/disinfecting the probe. Failure to do so could 
damage the system. 

DO NOT soak probes in liquid chemical disinfectant for longer 
than is stated by the disinfectant instructions for use. Extended 
soaking may cause probe damage and early failure of the 
enclosure, resulting in possible electric shock hazard. 

WARNING Ultrasound transducers can easily be damaged by improper 
handling and by contact with certain chemicals. Failure to 
follow these precautions can result in serious injury and 
equipment damage.

� Do not immerse the probe into any liquid beyond the level 
specified for that probe. Never immerse the transducer 
connector or probe adapters into any liquid.

� Avoid mechanical shock or impact to the transducer and do 
not apply excessive bending or pulling force to the cable.

� Transducer damage can result from contact with 
inappropriate coupling or cleaning agents:

� Do not soak or saturate transducers with solutions 
containing alcohol, bleach, ammonium chloride 
compounds or hydrogen peroxide

� Avoid contact with solutions or coupling gels containing 
mineral oil or lanolin

� Avoid temperatures above 50 C.

� Inspect the probe prior to use and after use for damage or 
degeneration to the housing, strain relief, lens and seal. Do 
not use a damaged or defective probe.
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Coupling gels

Applying In order to assure optimal transmission of energy between the 
patient and probe, a conductive gel or couplant must be applied 
liberally to the patient where scanning will be performed.

Precautions Coupling gels should not contain the following ingredients as 
they are known to cause probe damage:

� Methanol, ethanol, isopropanol, or any other alcohol-based 
product

� Mineral oil

� Iodine

� Lotions

� Lanolin

� Aloe Vera

� Olive Oil

� Methyl or Ethyl Parabens (para hydroxybenzoic acid)

� Dimethylsilicone

� Polyether glycol based

� Petroleum

WARNING Do not use unrecommended gels (lubricants). They may 
damage the probe and void the warranty. Please refer to the 
probe care card for GE approved probe gels.

CAUTION Do not apply gel to the eyes. If there is gel contact to the eye, 
flush eye thoroughly with water.

WARNING User should select the Non-toxic and nonirritating GEL.



Probe Overview

Versana Active � Basic User Manual 17-49
Direction 5840764-100 English Rev. 10

Planned Maintenance

The following maintenance schedule is suggested for the 
system and probes to ensure optimum operation and safety.

Returning/Shipping Probes and Repair Parts

US Department of Transportation and GE policy requires that 
equipment returned for service MUST be clean and free of blood 
and other infectious substances.

When you return a probe or part for service (Field Engineer or 
customer), you need to clean and disinfect the probe or part 
prior to packing and shipping the equipment.

Ensure that you follow probe cleaning and disinfection 
instructions provided in the Basic User Manual/User Guide.

This ensures that employees in the transportation industry as 
well as the people who receive the package are protected from 
any risk.

Sterile Ultrasound Procedures

ONLY ultrasound gel that is labeled as sterile, is sterile. 

Ensure you always use sterile ultrasound gel for those 
procedures that require sterile ultrasound gel.

Once a container of sterile ultrasound gel is opened, it is no 
longer sterile and contamination during subsequent use is 
possible.

Table 17-13:  Planned Maintenance Program

Do the Following Daily After Each Use As Necessary

Inspect the Probes X X X

Clean the Probes X X

Disinfect Probes X X
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Probe Discussion

Introduction

The Versana Active supports the following types of probes: 

� Convex Array. Convex Array probes.

� Linear Array. Linear Array probes.

� Sector Phased Array. Sector Phased Array probes.

� Volume Probes. 4D probe: Convex Array.

CAUTION Probes for transvaginal and transrectal applications require 
special handling. Transvaginal/transrectal examinations and 
probe insertions should be performed only by personnel with 
adequate training. Refer to the user documentation enclosed 
with these probes.
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Application

Table 17-14:  Probe Indications for Use

Probe Application
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Fetal/Obstetrics X X X X

Abdominal X X X X

Gynecology X X X X

Urology X X X X

Pediatric X X X X X X X

Small Organ (includes breast, testes, thyroid) X X X X

Neonatal Cephalic X X X

Adult Cephalic X

Cardiac - Adult X

Cardiac - Pediatric X X X X

Vascular/Peripheral Vascular X X X X X

Musculoskeletal Conventional X X X X X X

Musculoskeletal Superficial X X X X

Thoracic/Pleural X X X X X

Transcranial X X X

Transrectal X X

Transvaginal X X

Interventional 
guidance

Tissue biopsy X X X X X X X

Fluid drainage X X X X X X X X

Vascular access X X X

Non-vascular access X X X X X X X
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Features

Table 17-15:  Probe Features

Probe Application
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B Mode X X X X X X X X X X X X X

M Mode X X X X X X X X X X X X X

PW Doppler Mode X X X X X X X X X X X X X

CW Doppler Mode X X X

Color Doppler Mode X X X X X X X X X X X X X

Color M Doppler Mode X X X

Power Doppler Mode X X X X X X X X X X X X X

Harmonic Imaging X X X X X X X X X X X X X

Coded Pulse2 X X X X X X X X X

3D, 4D Imaging mode X

TUI X

Combined modes1 X X X X X X X X X X X X X

Breast Care X X X X

Strain Elastography 
Imaging

X X X

Contrast Imaging X

LOGIQ View X X X X X X X X X X X X X

Easy 3D X X X X X X X X X X X X

Auto IMT X X X X

Scan Assistant X X X X X X X X X X X X X

Scan Coach X X X X X X X X X X X X X

AMM X X X X X X

CAMM X X X

TVM X X X

TVI/TVD X X X

Stress Echo X

Bflow/Bflow Color X X X X
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NOTE: Not all features, products, probes or peripherals described in 
this document may be available or cleared for sale in all 
markets. Please contact your local GE Ultrasound 
representative to get the latest information.

Sono Biometry X X

Advanced 3D X X X X X X X X X X X X

Auto EF X

Breast Productivity X X X X

Thyroid Productivity X X X X

Auto Bladder X X X X

Follow-up tool X X X X X X X X X X X X X

Needle Recg. X X X X

Whizz X X X X X X X X X X X X X

My Trainer

Biopsy X X X X X X X X

1. Combined modes are B/M, B/Color M, B/PWD or CWD, B/Color/PWD or CWD, B/Power/PWD or CWD.
2. Coded Pulse is for digitally encoded harmonics.

Table 17-15:  Probe Features

Probe Application
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Specifications

Table 17-16:  System Probe Definitions

Probe Designation
Center Image 

Frequency (MHz)
Frequency 

Range (MHz)

Doppler 
Frequency 

Range (MHz)

4C-RS 3.1 MHz ± 10% 2.0~5.0 2.0~3.3

E8Cs-RS 6.5 MHz ± 20% 4.0~10.0 4.0~6.0

3Sc-RS 2.75 MHz ± 10% 1.7~4.0 1.7~3.3

L6-12-RS 7.75 MHz ± 20% 4.0~13.0 4.0~6.0

12L-RS 7.5 MHz ± 20% 4.2~13.0 4.2~7.7

6S-RS 4.5 MHz ± 10% 2.5~7.0 2.5~4.5

12S-RS 7.75 MHz ± 10% 4.1~12.0 4.1~6.7

LK760-RS 7.15 MHz ± 10% 3.5~10.0 3.5~5.0

E8C-RS 6.5 MHz ± 20% 4.2~10.0 4.2~6.3

8C-RS 6.5 MHz ± 20% 4.2~10.0 4.2~6.3

9L-RS 5.25 MHz ± 20% 4.0~10.0 4.0~5.0

L8-18i-RS 9.5 MHz ± 20% 6.7~18.0 6.7~10.0

RAB2-6-RS  3.3 MHz ± 10% 2.0~6.0 2.0~4.0
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Slice Thickness Specification

Table 17-17:  Slice Thickness Specification

Probe Designation Probe Slice Thickness Specification [mm]

4C-RS <= 12.0mm

E8Cs-RS <= 13.0mm

3Sc-RS <= 16.0mm

L6-12-RS <= 8.0mm

12L-RS <= 8.0mm

6S-RS <= 8.0mm

12S-RS <= 8.0mm

LK760-RS <= 12.0mm

E8C-RS <= 13.0mm

8C-RS <= 13.0mm

9L-RS <= 14.0mm

L8-18i-RS <= 8.0mm

RAB2-6-RS <= 12.0mm
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Probe Illustration

Convex Probe

Table 17-18:  Convex Probe Illustration

Probe Illustration Probe Illustration

4C-RS E8C-RS

8C-RS E8Cs-RS
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Linear Probe

Table 17-19:  Linear Probe Illustration

Probe Illustration Probe Illustration

L6-12-RS
12L-RS

L8-18i-RS
LK760-RS

9L-RS
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Sector Probe

4D Probe

Table 17-20:  Sector Probe Illustration

Probe Illustration Probe Illustration

3Sc-RS 6S-RS

12S-RS

Table 17-21:  4D Probe Illustration

Probe Illustration Probe Illustration

RAB2-6-RS



Biopsy Special Concerns

Versana Active � Basic User Manual 17-59
Direction 5840764-100 English Rev. 10

Biopsy Special Concerns

Precautions Concerning the Use of Biopsy Procedures

WARNING Do not freeze the image during a biopsy procedure. The image 
must be live to avoid a positioning error.

Biopsy guidezones are intended to assist the user in 
determining optimal probe placement and approximate the 
needle path. However, actual needle movement is likely to 
deviate from the guideline. Always monitor the relative 
positions of the biopsy needle and the subject mass during the 
procedure.

CAUTION The use of biopsy devices and accessories that have not been 
evaluated for use with this equipment may not be compatible 
and could result in injury.

CAUTION The invasive nature of biopsy procedures requires proper 
preparation and technique to control infection and disease 
transmission. Equipment must be cleaned as appropriate for 
the procedure prior to use.

� Follow the probe cleaning and disinfection procedures and 
precautions to properly prepare the probe.

� Follow the manufacturer's instructions for the reprocessing 
of biopsy devices and accessories.

� Use protective barriers such as gloves and probe sheaths.

� After use, follow proper procedures for decontamination, 
cleaning, and waste disposal.
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Precautions Concerning the Use of Biopsy Procedures  (continued)

CAUTION Improper reprocessing methods and the use of certain cleaning 
and disinfecting agents can cause damage to the plastic 
components that will degrade imaging performance or increase 
the risk of electric shock. 

See �Probe Safety� on page 17-42 for more information.

WARNING NEVER reuse the TR5° disposable biopsy guide attachment 
and Disposable sterile Ultra-Pro II Needle guide kits.

CAUTION Wear sterile gloves during the biopsy procedure. Be mindful of 
touching any non-sterilized surfaces to avoid cross 
contamination.



Preparing for a Biopsy

Versana Active � Basic User Manual 17-61
Direction 5840764-100 English Rev. 10

Preparing for a Biopsy

Displaying the Guidezone

Activate the Biopsy Kit by selecting it from the B-Mode.

The available biopsy options appear when Biopsy Kit is 
selected. There are fixed and adjustable angle biopsy kits and 
plastic/disposable and reusable biopsy guides available with the 
Versana Active depending on the probe. Select the desired 
biopsy kit. 
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Displaying the Guidezone  (continued)

 Figure 17-15. Biopsy Guidezones for the 4C-RS Probe

The biopsy guidezone represents a path of the needle. The dots 
which make up the guidezones is the depth readout where: 

� Yellow represent 1 cm increments. 

� Red represents 5 cm increments.

The display should be carefully monitored during a biopsy for 
any needle deviation from the center line or guidezone.

Before scanning, verify the needle can be visualized within the 
imaging plane. User appropriate needle length to reach target 
area. 
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Displaying the Guidezone  (continued)

The Biopsy Guidezone adjusts along with image adjustments, 
such as image inversion/rotations, zoom and depth changes.

The needle may vary from the center line or guidezone for 
various reasons:

� Needle barrel to needle clearance or strength.

� Bracket manufacturing tolerance.

� Needle deflection due to tissue resistance.

� Needle size chosen. Thinner needles may deflect more.

Table 17-22:  Biopsy Guide Availability

Probe Fixed Angle

Multi-Angle

MBX1
 (cm)

MBX2
 (cm)

MBX3
(cm)

4C-RS 4 6 10

E8Cs-RS TR5: 85 Degree (15.3 cm) 
RU: 90 Degree

3Sc-RS 4.2 5.7 8.2

L6-12-RS 1.5 2.5 3.5

12L-RS 1.5 2.5 3.5

E8C-RS TR5: 85 Degree (15.3 cm) 
RU: 90 Degree

9L-RS 4 5.5 7

RAB2-6-RS 4 6 8

DANGER
 

Failure to match the guidezone displayed to the guide may 
cause the needle to track a path outside the zone.

It is extremely important that when using the adjustable angle 
biopsy guides, the angle displayed on the screen matches the 
angle set on the guide, otherwise the needle will not follow the 
displayed guidezone which could result in repeated biopsies or 
patient injury.
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Preparing the Biopsy Guide Attachment

Convex, Sector and Linear probes have optional biopsy guide 
attachments for each probe. The guide consists of a reusable 
bracket to attach to the probe, disposable needle clip to attach to 
the bracket, sheath, gel (sterile gel if necessary) and disposable 
needle barrels.

The disposable needle barrels are available for a variety of 
needle sizes.

The bracket is packaged non-sterile and is reusable. To avoid 
possible patient contamination, ensure bracket is properly 
cleaned, sterilized or disinfected before each use.

Disposable components are packaged sterile and are single-use 
only. Do not use if integrity of packing is violated or if expiration 
date has passed.

CAUTION Please refer to the manufacturer's instructions included in the 
biopsy kit.
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Fixed Needle Biopsy Guide Assembly

Preparation

To prepare the endocavitary probe for use:

1. Remove the probe from the box and carefully examine it for 
any damage.

2. If the biopsy guide is to be attached, use the filling removal 
tool to clean out the attachment area on the probe head.

Figure 17-16. Attachment Filling Removal

a. Probe Head

b. Attachment

c. Filling Removal Tool

3. Clean, then disinfect the probe.

NOTE: Ensure that protective gloves are worn.

WARNING DO NOT use the needle with the catheter (soft tube). There is a 
possibility of breaking the catheter in the body.

CAUTION Before inserting the needle, scan the patient to determine the 
correct puncture depth and site. Only the sterile/sanitary 
sheath and rubber band are on the probe during the pre-needle 
placement scanning.
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Installing the sheath

To install the sheath:

1. Remove the sheath from its package. Do not unroll the 
sheath.

NOTE: Remember to rinse all sanitary probe sheaths of powder 
before placing on the probe. Powder can degrade the 
displayed image.

2. Place an adequate amount of ultrasound gel inside the 
sheath tip (the gel is between the sheath inner surface and 
the probe aperture).

NOTE: Ensure that only acoustic coupling gel is used for this 
purpose.

3. Place the sheath tip over the probe aperture and then pull 
the sheath end toward the probe handle.

4. Inspect the sheath for nicks, cuts or tears.

Figure 17-17. E8C-RS Probe with Sheath

a. Probe Handle

b. Probe Body

c. Sanitary Sheath

5. Rub a finger over the tip of the probe to ensure all air 
bubbles have been removed.
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Biopsy Guide Preparation

1. If a biopsy is to be performed, snap the metal or plastic 
biopsy guide on to the probe over the sheath.

Figure 17-18. Disposable Biopsy Guide 5 degree Angle

Figure 17-19. Reusable Biopsy Guide

a. Fix with a screw

2. Place an adequate amount of ultrasound gel on the gel-filled 
sheath tip�s outer surface.

3. Ensure the guide is properly seated and secure by pushing 
forward on the needle insertion end of the guide until the 
attachment node is firmly in place in it�s hole.

CAUTION Patient injury or repeated biopsies may result. The needle 
placement will not be as intended if the needle guide is not 
properly seated and secure.
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Multi Angle Biopsy Guide Assembly

1. Scan the patient and identify the target for biopsy. Move the 
probe to locate the target to the center of the image. Enable 
the system biopsy guidezone and try guidezone angles 
MBX1 to MBX3 to decide the best angle setting for needle 
path.

Figure 17-20. Example

2. Pull up on the knob (Figure 17-21 a) to freely move the 
needle guide attachment. Align the knob with the selected 
position of the needle guide attachment.

Push the knob down (Figure 17-21 b) into the desired slot to 
secure the angle position of the needle guide attachment.

Figure 17-21. Pull up and push down the knob

WARNING DO NOT attempt to use the biopsy bracket and needle guide 
until the manufacturer's instructions, provided with the biopsy 
bracket and needle guide in the kit, have been read and 
thoroughly understood.



Preparing for a Biopsy

Versana Active � Basic User Manual 17-69
Direction 5840764-100 English Rev. 10

Multi Angle Biopsy Guide Assembly  (continued)

3. Fit a convex of the biopsy bracket (a) in a concave of the 
probe (b).

Figure 17-22. Probe/Bracket Alignment

Hold the side (a) and tuck down the needle guide side (b) 
until it clicks or locks in place. 

Figure 17-23. Probe/Multi-angle Bracket Alignment 2

4. Place an adequate amount of coupling gel on the face of the 
probe.
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Multi Angle Biopsy Guide Assembly  (continued)

5. Place the proper sanitary sheath tightly over the probe and 
biopsy bracket. Use the rubber bands supplied to hold the 
sheath in place.

Figure 17-24. Applying Sanitary Sheath

6. Snap the needle guide onto the biopsy guide bracket.

Figure 17-25. Snap the needle guide
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Multi Angle Biopsy Guide Assembly  (continued)

7. Push the locking mechanism towards the bracket to secure 
the lock (a). Make sure the needle guide is firmly attached to 
the bracket.

Figure 17-26. Lock the Needle guide

8. Choose the desired gauge (size) needle barrel. Twist it back 
and forth to remove it from the plastic tree.

Figure 17-27. Needle Barrel

9. Place the needle barrel into the needle clip with the desired 
gauge facing the needle clip and snap into place.

Figure 17-28. Needle Barrel Installation
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Multi Angle Biopsy Guide Assembly  (continued)

Remove the biopsy guide

1. Hold the other side and push out the needle clip attachment 
side. See Figure 17-29.

Figure 17-29. Remove the biopsy guide

CAUTION Prevent damage to the probe lens with finger nails. 
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Releasing the needle

According to the following procedure, you remove the needle 
from a probe and an assembly without moving the needle.

Figure 17-30. Release the needle from assembly

a. Push the knob portion of a sleeve in the direction of the 
arrow.

b. The needle is released from the assembly.

c. Push the probe and the assembly in the direction of the 
larger arrow to remove the needle.
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4D Biopsy Guide Assembly - Representative Example

4D Probe

Figure 17-31. Mounting the Biopsy Needle Guide to the 4D 
Probe

1. Fit the biopsy guide bracket onto the probe.

2. Fix the bracket by locking the frame on the opposite side of 
the needle guide.

3. Snap the needle guide onto the biopsy guide bracket, refer 
to �Multi Angle Biopsy Guide Assembly� on page 17-68 for 
detailed information.

NOTE: Needle guide sterilization with autoclave possible.
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4D Probe Biopsy Needle Path Selection

To select the needle path and verify that the path of the needle is 
accurately indicated within the guidezone on the system 
monitor, perform the following before use:

1. Properly install the bracket and biopsy guide.

2. Scan in a container filler with water (47° C). 

3. Select Biopsy kit. The available biopsy options from the 
Primary Menu.

Select the biopsy guidezone where the needle echo passes 
through the center of the guidezone. Use the selected 
biopsy guidezone when performing the biopsy.

Biopsy Needle Path Verification

To verify that the path of the needle is accurately indicated within 
the guidezone on the system monitor, perform the following:

� Properly install the bracket and biopsy guide.

� Scan in a container filled with water (47° C).

� Display the biopsy guidezone on the monitor.

� Ensure that the needle echo falls within the guidezone 
markers.
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The Biopsy Procedure

1. Place coupling gel on the scanning surface of the probe/
sheath/biopsy guide assembly.

2. Activate the biopsy guidezone on the system through the 
B-Mode menu. When using multi-angle guides, ensure that 
the proper guidezone angle is displayed.

3. Scan to locate the target. Center the target in the electronic 
guidezone path.

NOTE: Enabling color flow would allow for visualization of the 
vascular structure around the area to be biopsied.

4. Place the needle in the guide between the needle barrel and 
needle clip. Direct it into the area of interest for specimen 
retrieval.

WARNING Biopsy procedures must only be performed on live images.

WARNING Please wear sterilized gloves during the biopsy procedure, 
meanwhile do not operate the console and any non-sterilized 
area in case any cross infection.

WARNING Please wear sterilized gloves during scanning with TV+TR 
probe and cover the probe with a sterile sheath to avoid cross 
contamination.

CAUTION For surgery/intra-operative procedures, a sterile environment is 
required. Therefore, both the operator and probe sheath need 
to be sterile.
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Post Biopsy

When the biopsy is complete, remove the needle barrel, needle 
clip and probe sheath. Properly dispose of these items in 
accordance with current facility guidelines.

Clean and disinfect the probe. See ? Care and Maintenance� on 
page 17-5 for more information.

The biopsy bracket can be cleaned and disinfected in a 
recommended disinfecting agent and reused. Please refer to 
biopsy guide manufacturer�s manuals for further information. 

CAUTION When the biopsy needle guide kit is opened, all parts must be 
discarded after the procedure whether they have been used or 
not.
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Chapter 18

User Maintenance

This chapter supplies assistance information, system 
care and maintenance instructions, Quality Assurance 
and Privacy and Security. 
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Clinical Measurement Accuracy

Basic Measurements

The following information is intended to provide guidance to the 
user in determining the amount of variation or measurement 
error that should be considered when performing clinical 
measurements with this equipment. Error can be contributed by 
equipment limitations and improper user technique. Be sure to 
follow all measurement instructions and develop uniform 
measurement techniques among all users to minimize the 
potential operator error. Also, in order to detect possible 
equipment malfunctions that could affect measurement 
accuracy, a quality assurance (QA) plan should be established 
for the equipment that includes routine accuracy checks with 
tissue mimicking phantoms.

Please be advised that all distance and Doppler related 
measurements through tissue are dependent upon the 
propagation velocity of sound within the tissue. The propagation 
velocity usually varies with the type of tissue, but an average 
velocity for soft tissue is assumed. This equipment is designed 
for, and the accuracy statements listed on are based on, an 
assumed average velocity of 1540 m/s. The percent accuracy 
when stated applies to the measurement obtained (not the full 
scale range). Where the accuracy is stated as a percent with a 
fixed value, the expected inaccuracy is the greater of the two.
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Basic Measurements  (continued)

Table 18-1:  System Measurements and Accuracies

Measurement Units Useful Range Accuracy

Limitations
or

Conditions

Depth mm Full Screen <=10%

Angle degree Full Screen <=5%

Distance:

Axial mm Full Screen <5%

Lateral mm Full Screen <5% Linear Probes

Lateral mm Full Screen <5% Convex Probes

Lateral mm Full Screen <5% Sector Probes

Circumference:

Trace mm Full Screen <=10% Linear Probes, 
Convex Probes, 
Sector Probes

Ellipse mm Full Screen <=5% Linear Probes, 
Convex Probes, 
Sector Probes

Area:

Trace mm2 Full Screen <=5% Linear Probes, 
Convex Probes, 
Sector Probes

Ellipse mm2 Full Screen <=5% Linear Probes, 
Convex Probes, 
Sector Probes

Time s Timeline Display <5% M mode,  AM mode, 
CM mode, PWD 
mode, CWD mode

Slope mm/s Timeline Display <=10% M mode,  AM mode, 
CM mode,

Doppler SV Position mm Full Screen <=2 mm PWD mode

Doppler Velocity cm/s From 0 to 100 cm/s
From 100 to 130 cm/s

<15%
<10%

PWD mode, CWD 
mode

Doppler Angle 
Correction

cm/s From 0-80 <=5% PWD mode
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Clinical Calculation Accuracy

Estimate the overall inaccuracy of a combined measurement 
and calculation by including the stated inaccuracy from the basic 
measurement accuracy statements.

Calculation formulas and databases are provided as a tool to 
assist the user, but should not be considered an undisputed 
database, in making a clinical diagnosis. The user is 
encouraged to research the literature and judge the equipment 
capabilities on an ongoing basis in order to assess its utility as a 
clinical tool.

CAUTION Diagnostic errors may result from the inappropriate use of 
clinical calculations. Review the referenced source of the 
stated formula or method to become familiar with the intended 
uses and possible limitations of the calculation.
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Anti-Virus Software Note

Anti-virus software IS NOT present on the Versana Active 
system. Since the Versana Active is already protected against 
attack by the measures listed below, no Anti-virus software is 
deemed necessary. 

� Only communication ports required for system operation are 
enabled. 

� Only operating system services required by system 
application software are enabled. 

� Software programs CANNOT be loaded onto the Versana 
Active (e.g., e-mail, web browser, etc.). 

� An auto-executable file CANNOT be run automatically on 
the Versana Active. 

� The Versana Active software includes the latest MS 
Windows security protection. 

We have worked diligently to develop a combination of the 
safety measures noted above and the security standards of 
Windows 10 Enterprise 2016 LTSB to provide a degree of safety 
against Viruses, Worms, Trojan Horses, etc., especially for a 
system used in a professional hospital grade networking 
environment that also typically features its own sufficient safety 
measures.
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System Care and Maintenance

Overview

The user must ensure that safety inspections are performed at 
least every 12 months according to the requirements of the 
patient safety standard IEC 60601-1 (1988). Refer to the Service 
manual, Chapter 10.

Only trained persons are allowed to perform the safety 
inspections mentioned above.

Technical descriptions are available on request.

To ensure that the unit constantly operates at maximum 
efficiency we recommend that the following procedures be 
observed as part of the customer�s internal routine maintenance 
program.

Contact the local Service Representative for parts or periodic 
maintenance inspections.

WARNING Do not perform system care and maintenance in the patient 
environment.
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Expected Service Life Description

The expected service life for the Versana Active system and 
probes is identified in this table:

Inspecting the System

Table 18-2:  Expected Service Life

Equipment/Accessory Expected Service Life

Versana Active system The expected service life for the Versana Active is at least seven (7) 
years from the manufacturing date under the provision of regular 
maintenance by authorized service personnel.

Versana Active probes The expected service life for the Versana Active probes meets or 
exceeds five (5) years from the date the probe is placed in service, under 
the provision that the customer follows the care instructions provided on 
the Probe Care Card that accompanies the Versana Active instructions 
for Use.

CAUTION To avoid electrical shock hazard, do not remove panels or 
covers from console. This servicing must be performed by 
qualified service personnel. Failure to do so could cause 
serious injury.
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Maintenance Schedule

Follow this Maintenance Schedule to maintain optimum system 
function and patient care:

Table 18-3:  Versana Active Maintenance Schedule

Monthly Weekly Daily After Each Patient

Inspect the following on 
a monthly basis:
� Connectors on cables 

for any mechanical 
defects.

� Entire length of 
electrical and power 
cables for cuts or 
abrasions.

� Equipment for loose or 
missing hardware.

� Control panel and 
keyboard for defects.

� Casters for proper 
movement and locking 
operation (for Cart 
only).

Clean and disinfect the 
following on a weekly 
basis:
� Console

� System Cabinet
� Removable 

Trackball/
Trackball

� Air Filters 
(weekly, or as 
needed, for 
Cart only)

� Footswitch (for 
Cart only)

� B/W Printer(for 
Cart only)

� CD/DVD-R 
Multi Drive(for 
Cart only)

� Monitor, Monitor Frame 
and Cart

� Operator Controls

Clean and Disinfect the 
following areas where 
Cross Contamination 
can occur:
� Operator Panel
� Monitor Frame
� Front and Rear 

Handles

Clean and Disinfect the 
following after each patient:
� Probe
� Biopsy Bracket, as 

applicable.
Additionally, Clean and 
Disinfect any area on the 
system that has visible 
contamination from the 
previous exam
Note: Biopsy Accessories 
must be cleaned and 
disinfected or disposed of 
after each patient. Refer to 
the Probes Chapter, for 
instructions on probe 
cleaning, disinfection and 
inspection. 

WARNING Do not perform system care and maintenance in the patient 
environment.
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Maintenance Schedule  (continued)

Disinfection

Effective Disinfection is always a balance between safe 
inactivation of infectious agents and undesirable side effects. 
Due to the generally uneven and irregular surface of Ultrasound 
consoles, a comprehensive surface disinfection process cannot 
be recommended by the manufacturer.

CAUTION To avoid electrical shock hazard, do not remove panels or covers from 
console. This servicing must be performed by qualified service 
personnel. Failure to do so could cause serious injury.

If any defects are observed or malfunctions occur, do not operate the 
equipment but inform a qualified service person. Contact a Service 
Representative for information.

CAUTION When performing cleaning and disinfection procedures, to prevent the 
risk of system damage, always observe the following precautions:

� Use only cleaning and disinfection materials and solutions as 
recommended in the procedures described below.

� Never use thinner, benzene, ethanol or methanol alcohol, 
abrasive cleaners, or other strong solvents, as these may cause 
damage to the cabinet or LCD panel. Only use isopropyl alcohol, 
when instructed to do so.

� Do not spray any liquid directly onto the Versana Active 
covers, LCD Display or keyboard.

� Do not allow any chemical agents to drip or seep into device 
openings or connections.

� Use only recommended cleaners or disinfectants on system 
surfaces. Immersion-type disinfectants are not approved for use 
on system surfaces.

� DO NOT scratch or press on the panel with any sharp objects, 
such as pencils or pens, as this may result in damage to the 
panel.

� Make sure not to spill or spray any liquid on the controls, into the 
system cabinet, or in the probe connection receptacle.

� Prior to cleaning, turn OFF power to the system and disconnect 
the mains cable.
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Cleaning and Disinfecting the system
These cleaners/disinfectants can be used anywhere on the 
console (Operator Panel, Monitor, Probe Holders, Cart, etc.), 
except for the probes. Refer to �Care and Maintenance� on 
page 17-5 for probe disinfectant information and web links.

Always consult the cleaner or disinfectant manufacturer�s 
instructions for proper use of their product. Wear appropriate 
personal protective equipment (PPE) as indicated by the 
manufacturer.

Appropriate cleaners/disinfectants for the console that have 
been validated for compatibility are shown below:

WARNING Ensure that you follow the cleaning procedure and use the 
cleaning agents provided in this manual.

Table 18-4:  Compatible Chemicals for Cleaning/Disinfectants

Manufac- 
turer

Graphic System 
Cabinet

Operator 
Control 
Panel

Monitor Cart       
(top table/
body/
base)

Cleaning agents

PDI Easy 
Screen 
Cleaning 
Wipe

Professional 
Disposables 
International, 
Inc.

X X X X

70% 
isopropyl 
alcohol

General X X X X

Wet Wipe General X X X X

Disinfectants [1]
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PDI 
Sani-Cloth 
Plus

Professional 
Disposable 
International, 
Inc.

X X X X

Protex Ultra PARKER 
LABORATO
RIES INC.

X X X X

Tristel Wipes Tristel 
Solution 
Limited

X X X X

Sono 
Ultrasound 
Wipes

Advanced 
Ultrasound 
Solutions 
Inc.

X X X X

Clorox wipes The Colorox 
Company

X X X X

CaviWipes Metrex 
Research

X X X X

Table 18-4:  Compatible Chemicals for Cleaning/Disinfectants

Manufac- 
turer

Graphic System 
Cabinet

Operator 
Control 
Panel

Monitor Cart       
(top table/
body/
base)
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NOTE: The graphics in the table are only for illustrational purposes. 
Refer to the actual cleaners for the specific information.

PDI Super 
Sani-Cloth 
Plus

Professional 
Disposables 
International, 
Inc.

X X X X

[1]: Effective Disinfection is always a balance between safe inactivation of infectious agents and undesirable 
side effects. Due to the generally uneven and irregular surface of Ultrasound consoles, a comprehensive 
surface disinfection process cannot be recommended by the manufacturer.

Table 18-4:  Compatible Chemicals for Cleaning/Disinfectants

Manufac- 
turer

Graphic System 
Cabinet

Operator 
Control 
Panel

Monitor Cart       
(top table/
body/
base)
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Cleaning and Disinfecting the system  (continued)

CAUTION Do not use T-Spray I (Original T-Spray) or SaniCloth Plus (red 
cap).

WARNING Ensure that you follow the cleaning procedure and use the 
cleaning agents provided in this manual.

WARNING All cleaners and disinfectants NOT on this list are unapproved 
by GE. Failure to follow guidelines could result in damage to 
the device.

CAUTION When processing the operator control panel, make sure not to 
spill or spray any liquid on the controls, into the system cabinet, 
or in the probe connection receptacle.

CAUTION Avoid using ALCOHOL (ISOPROPANOL) 70% inside the 
trackball. ALCOHOL (ISOPROPANOL) 70% may also 
compromise the durability of the paint used on the console 
controls.

CAUTION To avoid liquids entering the product, DO NOT spray any liquid 
directly onto the surfaces. ALWAYS use a cloth or wipe.
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Console

Cleaning the Versana Active Console

The Versana Active Console includes the System enclosure, 
Monitor, Monitor Frame, Operator Panel, Probe Holders and 
Cart. For Probes Reprocessing, see �Care and Maintenance� on 
page 17-5.

Always clean visible soil from surfaces first before disinfecting 
the Console.

Follow the cleaning/disinfecting frequency suggested in 
�Maintenance Schedule� on page 18-8.

To clean the system,

1. Moisten a soft, non-linting cloth with a mild, general 
purpose, non-abrasive soap and water solution or approved 
cleaning/disinfecting agent.

NOTE: The cloth/wipe should be damp, not dripping wet and 
running. Moisture should not drip into the crevices anywhere 
on the console.

NOTE: Refer to Table 18-4 on page 18-10 for a list of compatible 
solutions to be used on the Console.

2. Use a gentle wiping action to clean any surface on the 
console.

3. Wipe off excess cleaning agents.

NOTE: Do not spray any liquid directly into the unit.

NOTE: DO NOT scratch or press on the panel with any sharp 
objects, such as pencils or pens, as this may result in 
damage to the panel.

HINTS A scrubbing action with the wipe may be necessary to help 
remove stubborn soil from the surfaces. However be careful 
with this action over cervices and gaps in the surface to prevent 
liquid from being scraped off the wipe and entering the product.
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Disinfecting the Versana Active Console

For disinfectants to be effective, the surface must first be clean. 
Refer to �Cleaning the Versana Active Console� on page 18-14.

ALWAYS follow the manufacturer�s instructions concerning the 
use of the disinfectant and follow the contact time to be sure the 
disinfectant�s kill claims are accomplished.

Follow the cleaning/disinfecting frequency suggested in 
�Maintenance Schedule� on page 18-8.

Disinfect the desired surfaces of the console. To prevent cross 
contamination, surfaces that are often touched during exams 
should be disinfected after every patient. To disinfect the 
system,

1. Moisten a non-linting cloth with a liquid disinfectant or 
remove pre-moistened disinfectant wipe from the container.

2. Wet the surfaces by gently applying the cloth or wipe. Avoid 
high pressure or squeezing the wipe to avoid having the 
liquid enter the gaps and cervices of the Console. Scrubbing 
is not necessary in the disinfecting step; evenly applying the 
liquid is the goal.

3. Let the surface remain wet for the appropriate contact time.

4. If the surface does not remain wet for the full contact time, 
apply an additional application of the disinfectant, as 
necessary, to extend the time.

5. After the contact time has expired, remove excess liquid 
with a dry sterile cloth.

6. To avoid disinfectant buildup, or to remove disinfectant 
residue which may cause skin irritation, perform a rinse step 
with a sterile damp cloth.

CAUTION If a cleaner/disinfectant wipe was used to clean off visible soil 
per the above section, a second, fresh cleaner/disinfectant 
product should be used for the disinfectant step.
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Monitor and Monitor Frame

Monitor

To clean the Monitor:

1. Moisten a soft, non-linting cloth with a mild, general 
purpose, non-abrasive soap and water solution.

NOTE: The cloth should be damp, not dripping wet.

� Wipe down the top, front, back, and both sides of the 
monitor.

2. Wipe off excess cleaning agents with a non-linting cloth.

NOTE: Never use thinner, benzene, alcohol (ethanol, methanol, or 
isopropyl alcohol), abrasive cleaners, or other strong solvents, 
as these may cause damage to the monitor.

For disinfection for this part, refer to system level disinfection 
Page �Disinfecting the Versana Active Console� on page 18-15.

Monitor Frame

To clean the monitor frame:

1. Moisten a soft, non-linting cloth with a mild, general 
purpose, non-abrasive soap and water solution.

NOTE: The cloth should be damp, not dripping wet.

2. Wipe down the top, front, back, and both sides of the 
monitor frame.

3. Wipe off excess cleaning agents with a non-linting cloth..

NOTE: DO NOT scratch or press on the panel with any sharp 
objects, such as pencils or pens, as this may result in 
damage to the panel.

For disinfection for this part, refer to system level disinfection 
Page �Disinfecting the Versana Active Console� on page 18-15.
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Control panel and keyboard

NOTE: Diligent cleaning of the console reduces the risk of spreading 
infection from person to person, and also helps to maintain a 
clean working environment.

Only use the following cleaners on the Control panel:

� A non-abrasive soap and water solution (e.g. Palmolive 
Dishwashing Liquid, manufactured by Colgate-Palmolive)

� Sani Wipes Alcohol-free (manufactured by Micorgen Inc.)

� T-Spray II (manufactured by Pharmaceutical Innovations, 
Inc.)

To clean the Control panel:

1. Turn off the power of the system.

2. Moisten a soft, non-linting cloth with water or a mild, 
non-abrasive soap and water solution.

3. Gently wipe the surface of the console.

4. Use a cotton swab to clean around keys or controls. Use a 
toothpick to remove solids from between keys and controls.

When cleaning the operator control panel, make sure not to 
spill or spray any liquid on the controls, into the system 
cabinet, or in the probe connection receptacle.

5. In the event that disinfection is required or any stubborn 
stains remain, absorb a small quantity of isopropyl rubbing 
alcohol on a soft, on-linting cloth. Wipe the surface of the 
console. Make sure no liquid drips on or between the keys. 
Allow to dry.

To clean the keyboard:

1. Clean the keyboard as described above for the Control 
panel.

2. In the event that disinfection is required or any stubborn 
stains remain, absorb a small quantity of isopropyl rubbing 
alcohol on a soft, dust-free cloth. Wipe the surface of the 
key caps. Make sure no liquid drips on or between the keys. 
Allow to dry.

For disinfection for this part, refer to system level disinfection 
Page �Disinfecting the Versana Active Console� on page 18-15.
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Probe Cleaning Notes

Cleaning and disinfection solution for Probe and Console are 
different, please avoid control panel damage while cleaning/
disinfecting probes.

Probe shall not stay in probe holder on the Ultrasound system 
during cleaning/disinfection.

If you use a spray cleaner, spray AWAY from the Ultrasound 
system. Spray can damage the TGC controls.

 Figure 18-1. DO NOT Spray a Probe While in its Holder

CAUTION NEVER use any cleaner or disinfectant containing alcohol.
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Cleaning the Trackball

Dust is often building up behind the ball, so it interferes with the 
ball rotation and for optical trackballs the light used for sensing. 
To get access for cleaning, you need to remove the ball. 

The ball is held in position by the Dust Gasket.

1. Power off the system.

2. Rotate the retainer counterclockwise until it can be removed 
from the keyboard.

Figure 18-2. Rotate the retainer

3. Separate the trackball and the retainer. Wipe off any oil or 
dust from the trackball, retainer and the trackball housing 
using a cleaner or cotton swab.

4. Assemble the trackball and retainer, then put it into the 
housing and rotate it clockwise until its notches are set in 
position.

CAUTION When cleaning, make sure not to spill or spray any liquid into 
the trackball housing (keyboard or system).
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Probe holder (for Cart only)

1. Clean the probe holders with warm water and a damp cloth 
to remove all traces of gel.

2. In the event that disinfection is required or any stubborn 
stains remain, absorb a small quantity of isopropyl rubbing 
alcohol on a non-linting cloth. Wipe the surface of the probe 
holder. Make sure no liquid drips into the system. Allow to 
dry.

For disinfection for this part, refer to system level disinfection 
Page �Disinfecting the Versana Active Console� on page 18-15.

System cabinet

1. Moisten a soft, non-linting cloth with a mild, general 
purpose, non-abrasive soap and water solution or a general 
purpose disinfectant.

2. Wipe down the top, front, back and both sides of the 
cabinet. Do not spray any liquid directly onto the unit.

3. In the event that disinfection is required or any stubborn 
stains remain, absorb a small quantity of isopropyl rubbing 
alcohol on a soft, dust-free cloth. Wipe the system cabinet 
and allow to dry.

For disinfection for this part, refer to system level disinfection 
Page �Disinfecting the Versana Active Console� on page 18-15.

Footswitch (for Cart only)

To clean the footswitch:

1. Moisten a soft, non-abrasive folded cloth with a mild, 
general purpose, non-abrasive soap and water solution.

2. Wipe the external surfaces of the unit then dry with a soft, 
clean, cloth.

3. In the event that disinfection is required or any stubborn 
stains remain, absorb a small quantity of isopropyl rubbing 
alcohol on a soft, dust-free cloth. Wipe the footswitch and 
allow to dry.

For disinfection for this part, refer to system level disinfection 
Page �Disinfecting the Versana Active Console� on page 18-15.
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Cleaning the air filter (for Cart only)

Clean the system's air filter to ensure that a clogged filter does 
not cause the system to overheat and reduce system 
performance and reliability. It is recommended the filter be 
cleaned every two weeks, but the requirements will vary due to 
your system use.

1. Power off the system.

2. Remove the air filter with hand.

Figure 18-3. Remove the Air Filter

CAUTION DO NOT operate the unit without the air filter in place.

Allow the air filter to dry thoroughly before re-installing it on the 
unit.
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Cleaning the air filter (for Cart only)  (continued)

3. Dust the filter with a vacuum cleaner and/or wash it with a 
mild soapy solution.

If washed, rinse and dry the filter before re-installation.

4. Put back the air filter in the direction as marked on the 
bottom cover.

Figure 18-4. Install the Air Filter
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Other Maintenance

Replacing illuminated key caps/lamps

Contact a local Service Representative when a key cap or lamp 
needs to be replaced.

Battery Replacement and Disposal 

Battery replacement every three years is recommended.

Contact a local Service Representative for the replacement of 
the battery. Used batteries will be discarded appropriately by 
GE.

NOTE: Disposing of the battery should meet local law and regulatory 
requirements.
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Prevention of static electricity interference

Interference from static electricity can damage electronic 
components in the system. The following measures help to 
reduce the likelihood of electrostatic discharge:

� Wipe the alphanumeric keyboard and monitor with lint-free 
tissue or a soft cloth dampened with anti-static spray on a 
monthly basis.

� Spray carpets with anti-static spray because constant 
walking on carpets in or near the scanning room may be a 
source of static electricity.

Disposal

This symbol indicates that waste electrical and electronic 
equipment must not be disposed of as unsorted municipal waste 
and must be collected separately. Please contact an authorized 
representative of the manufacturer for information concerning 
the decommissioning of your equipment.

Table 18-5:  WEEE symbol

Rear of the system and Probe connector
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Troubleshooting

Please refer Service Manual if other messages appear on the 
monitor display.

Table 18-6:  Error messages

The system has detected the lower air filter requires 
cleaning. Please clean the lower  air filter.
1. Shutdown the system.
2. Clean the air filter according to �Cleaning the air 

filter (for Cart only)� on page 18-21.

System temperature is too high. System will shut 
down.
1. Shutdown the system.
2. Clean the air filter according to �Cleaning the air 

filter (for Cart only)� on page 18-21.

System voltage fault. System will shut down.
1. Select OK and reboot the system. 
2. If the same message appears after reboot, shut 

down the system. Then turn on the system 
according to �Power On� on page 3-23.

System Error. Please reboot the system.
1. Select OK and reboot the system.
2. If the same message appears after reboot, shut 

down the system. Then turn on the system 
according to �Power On� on page 3-23.
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Assistance

Supplies/Accessories

Not all features, products, probes or peripherals described in 
this document may be available or cleared for sale in all 
markets. Please contact your local GE Ultrasound 
representative to get the latest information.

Contact the distributor, GE affiliate or sales representative for 
approved peripherals. For HCATs, contact your sales person.  

The following supplies/accessories have been verified to be 
compatible with the system:

CAUTION DO NOT connect any probes or accessories without approval 
by GE.

CAUTION Use only GE approved internal equipment when replacing an 
internal peripheral.

The user or the operator should never install/replace the 
internal peripheral. Service representatives authorized by 
GEHC will install/replace the internal peripheral.
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Peripherals
Table 18-7:  Peripherals and Accessories for Versana Active system

Accessory Units

Sony UP-D898MD Printer Each

Sony UP-D25MD Printer Each

Thermal Printer Media (Note: Printer Paper) Each

Portable CD/DVD Writer Each

Footswitch MKF 2-MED GP26 Each

Footswitch FSU-1000 Each

USB Stick Each

USB HDD Each

ECG-USB1: ECG module and ECG patient cable Each

Wireless Adapter Each

Bluetooth Adapter Each

Printer USB Isolator Each

Battery Each

Power adapter without cord (ACDC only) Each

VSN A Base Cart Each

Versana Active Advanced Fixed Cart Each

Versana Active Advanced Height-Adj Cart Each

Video Output Adapter Each

Versana Active Spare Battery Charger Each
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Peripherals  (continued)

NOTE: Versana Active Advanced Cart includes Versana Active 
Advanced Fixed Cart and Versana Active Advanced Height-adj 
Cart.

Some peripherals have seperate operator manuals. Please refer 
to Table 18-9 for the detailed User Instruction list.

Table 18-8:  Peripherals and Accessories for Versana Active Advanced Cart

Accessory Units

Cart Battery Each

EMI Filter Each

Gel Warmer Each

Power Transformer Each

3-Probe Port Each

Printer (DC or AC) Each

4D Box Each

Paper Tray Each

Accessory Tray Each

Printer and DVD Shelf Each

Print Base Plate Each

ECG Module Shelf Each

Table 18-9:  User Instructions

Accessory User Instruction Description

VSN A Base Cart VSN A Base Cart User Instruction

Versana Active Advanced Fixed Cart Versana Active Advanced Cart User Instruction

Versana Active Advanced Height-Adj Cart Versana Active Advanced Cart User Instruction

Video Output Adapter Video Output Adapter User Instruction

Versana Active Spare Battery Charger Versana Active Spare Battery Charger User Instruction

Versana Active Advanced Cart Battery Versana Active Advanced Cart Battery User Instruction
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Probe
Table 18-10:  Probes and Accessories

Probe HCAT Biopsy Guide

Biopsy 
Guide
HCAT

Biopsy Guide
HCAT

4C-RS
Convex

H4000SR Multi-angle, disposable  
needle guide with a 
reusable plastic bracket

E8385NA

8C-RS
Convex

H40402LS Not Available N/A N/A

E8C-RS
Convex

H40402LN Fixed angle, disposable  
needle guide with a 
reusable plastic bracket

E8385MJ

Fixed angle, reusable 
with a stainless steel 
bracket

H40412LN

E8Cs-RS
Convex

H48062AF Fixed angle, disposable  
needle guide with a 
reusable plastic bracket

E8385MJ

Fixed angle, reusable 
with a stainless steel 
bracket

H40412LN

3Sc-RS
Sector

H45041DL Multi-angle, disposable  
needle guide with a 
reusable plastic bracket

H46222LC

6S-RS
Sector

H45021RP Not Available N/A N/A

12S-RS
Sector

H44901AB Not Available N/A N/A
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L6-12-RS
Linear

H48062AC Multi-angle  (in plane 
biopsy kit), disposable  
needle guide with a 
reusable plastic bracket

H40432LC

12L-RS
Linear

H40402LY Multi-angle (in plane 
biopsy kit), disposable  
needle guide with a 
reusable plastic bracket

H40432LC

Infinite-angle (in plane 
biopsy kit), disposable  
needle guide with a 
reusable plastic bracket

H48392LT

Transverse bracket (out 
of plane biopsy kit), 
disposable needle guide 
with a reusable plastic 
bracket

H48392LL

LK760-RS
Linear

H44901AF Not Available N/A N/A

L8-18i-RS
Linear

H40462LF Not Available N/A N/A

9L-RS 
Linear

H40442LL Multi-angle, disposable 
needle guide, with a 
reuseable plastic bracket

H4906BK N/A

RAB2-6-RS
4D

H48681WR Multi-angle, disposable 
needle guide, with a 
reuseable plastic bracket

H48681ML

Table 18-10:  Probes and Accessories

Probe HCAT Biopsy Guide

Biopsy 
Guide
HCAT

Biopsy Guide
HCAT
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System Data

Features/Specifications

Table 18-11:  Physical Attributes

Dimensions and Weight
� Height: within 58 5 mm
� Width: within 362 5 mm
� Length: within 390 5 mm
� Weight:  less than 6 kg with battery, but without any 

probes or peripherals

� Console Design
� SSD (At least 200GB)
� 1T SSD (option)
� Integrated speakers
� User adjustable audio output control on keyboard
� Ergonomic design
� Handle

Keyboard
� Alphanumeric keyboard 
� Interactive back-lighting
� Protective film

15.6� Monitor
� High-Resolution monitor
� Opening angle adjustment: 170 degrees.
� Horizontal/Vertical View angle: 80 degrees
� Brightness and contrast adjustment

Electrical Power
� Voltage:100-240 VAC (+/-10%)
� Frequency: 50/60 Hz
� Power: Consumption less than 2.0A, 175VA with 

on- board peripherals (if powered by ACDC 
adapter); Consumption less than 450VA with 
on-board peripherals (if powered by Versana 
Active Advanced Cart)

Cart Design
� Wheels
� Integrated transducer cable management facility
� Handle
� Gel Holder
� Probe Holder

Cart Options (for Versana Active Advanced Cart 
only)
� Gel Warmer
� Cart Battery
� Power Transformer
� 3-Probe Port
� EMI filter
� UP-D898DC Printer

Table 18-12:  Inputs and Outputs Signal

External Inputs and Outputs
� HDMI port
� Ethernet port
� USB ports
� Composite Video out and S-Video out through an 

external Video Adapter from HDMI
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Table 18-13:  System Overview

Operating Modes
� B-Mode
� Harmonic Imaging (Phase Invension Harmonic)
� M-Mode
� Color Flow Mode (CFM)
� Power Doppler Imaging (PDI)
� Directional Power Doppler Imaging
� PW Doppler (with HPRF)
� Cine Mode
� Anatomical M-Mode
� Color M-Mode
� CW (Continued Wave) Doppler (option)
� Static 3D/ Realtime 4D (option)
� TVI(Tissue Velocity Imaging),TVD(Tissue Velocity 

Doppler) and TVM(Tissue Velocity M Mode image)

System Options
� DICOM
� LOGIQ View 
� Auto-IMT 
� SonoBiometry (AFB)
� Auto EF (ejection fraction) measurement
� TUI (Tomographic Ultrasound Imaging)
� Stress Echo
� Advanced 3D/ Easy 3D
� B-Flow/ B Flow color
� Needle recognition
� Follow-up tool
� Auto Bladder Volume measurement
� Thyroid productivity
� Breast productivity
� Breast care
� Elastography 
� Contrast Imaging
� Scan Coach
� Tricefy

Peripheral Options
� B/W image printer
� Color image printer
� Report printer
� ECG
� Wireless adapter
� Removable storage medium
� Footswitch
� Battery
� CD/DVD drive
� Spare battery charger
� Bluetooth adapter
� Video output adapter
� VSN A Base Cart
� Versana Active Advanced Fixed Cart
� Versana Active Advanced Height-Adj Cart
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Quality Assurance

Introduction

A good Quality Assurance Evaluation program consists of 
periodic systematic actions that provide the user with adequate 
confidence that their diagnostic ultrasound system will produce 
consistently high quality images and quantitative information.

Therefore, it is in the best interests of every ultrasound user to 
routinely monitor equipment performance.

The frequency of Quality Assurance evaluations should be 
based on user's specific needs and clinical practice.

Periodic monitoring is essential in order to detect the 
performance changes that occur through normal aging of 
system components. Routine equipment evaluations may also 
reduce the duration of exams, number of repeat exams, and 
maintenance time required.

For details on system and peripheral routine preventive 
maintenance instructions, See �System Care and Maintenance� 
on page 18-6 for more information.
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Typical Tests to Perform

Quality assurance measurements provide results relating to 
system performance. Typically these are:

� Axial Measurement Accuracy

� Lateral Measurement Accuracy

� Axial and Lateral Resolution

� Penetration

� Functional & Contrast Resolution

� Gray Scale Photography.

With these tests, a performance baseline can be set at 
installation with the phantom in your department. Future test 
results can be compared to the baseline in order to maintain a 
record of system performance trends.

Frequency of tests

Quality assurance tests are used to determine whether a 
scanner is providing the same level of performance from day to 
day.

The frequency of testing varies with the amount of system usage 
and modes to be tested. It is recommended that the user 
perform quality assurance tests at least every three months or 
every 400 patient studies. Tests should also be performed when 
a question about system performance exists.

A mobile system may require more frequent tests.

Image quality should also be tested immediately after the 
following events:

� Service calls

� System upgrades/modifications

� Dropped probe, power surge, etc. 
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Phantoms

Quality Assurance Evaluations should be done with phantoms 
and test objects that are applicable to the parameters being 
evaluated or to the user's clinical practice.

Typical phantoms are composed of material that acoustically 
mimic human tissue. Pins, anechoic and echogenic targets are 
physically positioned to provide information for a variety of tests.

Doppler phantoms are currently expensive and complicated to 
deal with on the user level. If a problem with any Doppler 
parameters or measurement is suspected, contact a local 
service representative for evaluation.

The RMI 403GS phantom is still available. Due to the superior 
penetration and resolution capabilities of GE ultrasound 
systems, the RMI 405GSX is recommended. It is the most 
current one available to our field service personnel and will 
provide the targets and extended life necessary for consistent 
system testing.
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Phantoms  (continued)

 Figure 18-5. Phantoms

1. Penetration

2. Axial Distance Measurement

3. Functional Resolution

4. Lateral Resolution

5. Lateral Distance Measurement

6. Axial Resolution

7. Contrast Resolution and Gray Scale Photography

8. Gray Scale Plane Targets
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Baselines

An absolute necessity for a quality assurance program is 
establishing baselines for each test or check. Baselines are 
established after the system has been verified to be working 
properly at installation or after a repair. If a probe or major 
assembly is replaced, new baselines should be generated.

Baselines can be made by adjusting system parameters to 
prescribed levels or to the best possible image. The key factor to 
remember is reproducibility. The same conditions must be 
reproduced for each periodic check.

All system parameters not displayed on the monitor should be 
recorded for the permanent record.

Periodic Checks

Periodic checks should be performed in accordance with your 
facility�s quality assurance requirements. For the data to be 
valid, periodic checks should mimic the baseline setup 
parameters.

The resulting image, when scanning the phantom exactly as 
before, should be recorded and compared to the baseline. 
When a matching image is obtained, it can be assumed that the 
system performance has not degraded from the baseline.

If a significant difference between the baseline and periodic 
check is noted, double check the system setup and repeat the 
test. If the difference between the baseline and periodic check 
persists, contact a local Service Representative.

Failing to reproduce the control settings as in the baselines will 
introduce errors in the data and potentially invalidate the results.
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Results

Lack of standardization among test instruments, the wide range 
of acceptance criteria, and incomplete knowledge regarding the 
significance of certain performance parameters prohibit the 
establishment of absolute performance criteria for these tests.

Quality Assurance Evaluation results should be compared to 
previously-recorded results. 

Performance trends can then be detected. Unacceptable 
performance or diminishing trends should be identified for 
maintenance or repair before a malfunction or inappropriate 
diagnosis occurs. 

The user should determine the best method for recording and 
archiving the baseline and periodic checks. In most cases the 
choice is hard copy.

It is important to maintain good consistent records for 
inspections that may arise, as well as to detect system 
performance trends.
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System Setup

The user should tailor the tests to their particular needs. It is 
certainly not necessary to make all checks with all probes. A 
representative example, with the probes used most often by the 
customer, should be adequate in judging system performance 
trends.

Use a gray scale phantom as the scan object for the tests. 
Commercial phantoms are supplied with its own operator 
manual. Be familiar with proper phantom operating procedures 
prior to use for quality assurance evaluations.

1. Adjust image monitor. Brightness and contrast should be set 
to the normal viewing of a good gray scale image.

2. Check all recording devices for proper duplication of image 
monitor. Ensure that what is seen is what is recorded. 

3. Annotate non-displayed image processing controls. 

4. Set TGC slide pots to center (detent) position. 

5. Place focal zone marker(s) in area of interest for an 
optimum image.

Test Procedures

The following are recommended Quality Assurance tests. A brief 
description of the test, the benefit it provides and steps to 
accomplish the test are supplied.

The importance of recording scan parameters and consistent 
record keeping cannot be stressed enough. Reproducibility to 
monitor system trends is the key to quality assurance 
evaluations.

Using the system's dual image display format is often very 
convenient and saves recording media.
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Axial distance measurements

Description

Axial measurements are the distance measurements obtained 
along the sound beam. See Figure 18-5 for more information.

Benefit

The accurate measurement of the size, depth and volume of a 
structure is a critical factor in determining a proper diagnosis. 
Most imaging systems use depth markers and/or electronic 
calipers for this purpose.

Method

Axial distance should be measured in the near, mid and far fields 
as well as in zoom. If necessary, different depths or fields of 
view can be tested.

Procedure

To measure axial distance:

1. Scan a test phantom with precisely-spaced vertical pin 
targets. Adjust all scan controls, as necessary, for the best 
image of the pin targets to typical depths for the probe being 
used.

2. Press Freeze to stop image acquisition and perform a 
standard distance measurement between the pins at 
different points in the image. Record all images for 
archiving.

3. Scan the vertical pins in zoom or at different depth/scale 
factors.

4. Press Freeze to stop image acquisition; repeat the distance 
measurements between pins and record the images for 
archiving.

5. Document the measurements for reference and future 
comparison.

Contact a Service Engineer if vertical measurements differ by 
more than 1.50% of the actual distance.
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Lateral distance measurements

Description

Lateral measurements are distance measurements obtained 
perpendicular to the axis of the sound beam. See Figure 18-5 on 
page 18-36 for more information.

Benefit

The purpose is the same as vertical measurements. 
Precisely-spaced horizontal pin targets are scanned and results 
compared to the known distance in the phantom.

Method

Lateral distance should be measured in the near, mid and far 
fields as well as in zoom. If necessary, different depths of fields 
of view can be tested.

Procedure

To measure lateral distance:

1. Scan a test phantom with precisely-spaced horizontal pin 
targets. Adjust all scan controls, as necessary, for the best 
image of the pin targets from side to side.

2. Press Freeze to stop image acquisition and perform a 
standard distance measurement between the pins at 
different points in the image. Record all images for 
archiving.

3. Scan the horizontal pins in zoom or at different depth/scale 
factors.

4. Press Freeze to stop image acquisition; repeat the distance 
measurements between pins and record the images for 
archiving.

5. Document the measurements for reference and future 
comparison.

Contact a Service Engineer if horizontal measurements differ by 
more than 3mm or 3% of that depth, whichever is greater.



User Maintenance

18-42 Versana Active � Basic User Manual
Direction 5840764-100 English Rev. 10

Axial resolution

Description

Axial resolution is the minimum reflector separation between two 
closely-spaced objects to produce discrete reflections along the 
axis of the sound beam. It can also be monitored by checking 
the vertical size of known pin targets. See Figure 18-5 on 
page 18-36 for more information.

Axial resolution is affected by the transmitting section of the 
system and the probe.

Benefit

In clinical imaging, poor axial resolution displays small 
structures lying close together as a single dot. This may lead to 
improper interpretation of the ultrasound image.

Procedure

To measure Axial resolution:

1. Scan a test phantom with precisely-spaced vertical pin 
targets. 

2. Adjust all scan controls, as necessary, for the best image of 
the pin targets to typical depths for the probe being used.

3. Press Freeze to stop image acquisition.

4. Perform a standard distance measurement of the pin 
vertical thickness at different points in the image. Record all 
images for archiving.

5. Scan the vertical pins in zoom or at different depth/scale 
factors.

6. Press Freeze to stop image acquisition; repeat the vertical 
thickness measurements of the pins and record the images 
for archiving.

7. Document the measurements for reference and future 
comparison.

Axial resolution should remain stable over time. Contact a 
Service Engineer if any changes are observed.
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Lateral resolution

Description

Lateral resolution is the minimum reflector separation between 
two closely spaced objects to produce discrete reflections 
perpendicular to the axis of the sound beam. It can also be 
monitored by checking the horizontal size of known pin targets. 
See Figure 18-5 on page 18-36 for more information.

Lateral resolution is dependent upon the beam width produced 
by the probe. The narrower the beam, the better the lateral 
resolution.

The beam width is affected by the frequency, degree of focusing, 
and distance of the object from the face of the probe.

Benefit

Clinically, poor lateral resolution will display small structures 
lying close together as a single dot. This may lead to improper 
interpretation of the ultrasound image.

Procedure

To measure lateral resolution:

1. Scan a test phantom with precisely-spaced horizontal pin 
targets.

2. Adjust all scan controls, as necessary, for the best image of 
the pin targets from side to side.

3. Press Freeze to stop image acquisition and perform a 
standard distance measurement of the horizontal thickness 
of a pin at different points in the image. Record all images 
for archiving.

4. Scan the horizontal pins in zoom or at different depth/scale 
factors.

5. Press Freeze to stop image acquisition; repeat the 
horizontal thickness measurements of the pins and record 
the images for archiving.

6. Document the measurements for reference and future 
comparison. 

Pin width should remain relatively constant over time (�1mm). 
Dramatic changes in pin width may indicate beam forming 
problems. Contact a Service Engineer if beam width changes 
consistently over 2 to 3 periodic tests. 
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Penetration

Description

Penetration is the ability of an imaging system to detect and 
display weak echoes from small objects at large depths. See 
Figure 18-5 on page 18-36 for more information.

Penetration can be affected by the system's: 

� Transmitter/receiver

� Degree of probe focusing

� Attenuation of the medium

� Depth and shape of reflecting object

� Electromagnetic interference from local surroundings. 

Benefit

Weak reflecting echoes are commonly produced from the 
internal structure of organs. Definition of this tissue texture is 
important in the interpretation of the ultrasound findings.

Method

Scan a phantom to see how echoes begin to fade as depth is 
increased. The maximum depth of penetration is the point at 
which homogeneous material in the phantom begins to lose 
brightness.

Procedure

To measure penetration:

1. Set the front panel TGC slide pots to their center (detent) 
position.

2. Gain and acoustic output can be adjusted, as necessary, 
since these values are displayed on the monitor.

3. Scan a test phantom along the vertical pin targets to typical 
depths for the probe being used.

4. Perform a standard distance measurement from the top of 
the image displayed to the point at which homogeneous 
material in the phantom begins to lose brightness.

5. Document the depth measurement for reference and future 
comparison. 

Contact a Service Engineer if the depth of penetration shifts 
more than one centimeter (1cm) when using the same probe 
and same system settings.
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Functional resolution

Description

Functional resolution is an imaging system's ability to detect and 
display the size, shape, and depth of an anechoic structure, as 
opposed to a pin target. See Figure 18-5 on page 18-36 for 
more information.

The very best possible image is somewhat less important than 
reproducibility and stability over time. Routine tests at the same 
settings should produce the same results.

Benefit

The data obtained will give a relative indication of the smallest 
structure the system is capable of resolving at a given depth.

Procedure

To measure functional resolution:

1. Set the front panel TGC slide pots to their center (detent) 
position.

2. Gain and acoustic output can be adjusted as necessary, 
since these values are displayed on the monitor.

3. Scan a test phantom with a vertical row of anechoic cyst 
targets to typical depths for the probe being used.

4. Evaluate the cysts at various depths for a good (round) 
shape, well-defined borders and no fill in. Remember, TGC 
slide pots are centered and should remain fixed. This may 
NOT provide optimal cystic clearing.

5. Document all results for future reference and comparison.

Contact a Service Engineer if a greatly distorted image is 
obtained.
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Contrast resolution

Description

Contrast resolution is the ability of an imaging system to detect 
and display the shape and echogenic characteristics of a 
structure. See Figure 18-5 on page 18-36 for more information.

Specific values measured are less important than stability over 
time. Routine tests at the same settings should produce the 
same results.

Benefit

A correct diagnosis is dependent upon an imaging system's 
ability to differentiate between a cystic or solid structure versus 
echo patterns from normal surrounding tissue.

Method

A phantom with echogenic targets of different sizes and depths 
should be used.

Procedure

To measure contrast resolution:

1. Set the front panel TGC slide pots to their center (detent) 
position. Set dynamic range to 54 db.

2. Gain and acoustic output can be adjusted, as necessary, 
since these values are displayed on the monitor.

3. Scan a test phantom with echogenic targets at the depths 
available.

4. Evaluate the echogenic targets for contrast between each 
other and between the surrounding phantom material. 
Remember, TGC slide pots are centered and should remain 
fixed. This may NOT provide an optimal scan image.

5. Document all results for future reference and comparison.

Contact a Service Engineer if the echogenic characteristics or 
shapes of the targets appear distorted.
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Gray Scale photography

Description

Poor photography will cause loss of low level echoes and the 
lack of contrast between large amplitude echoes. See 
Figure 18-5 on page 18-36 for more information.

Benefit

When photographic controls and film processors are properly 
adjusted, weak echoes, as well as strong echoes, are accurately 
recorded on film.

Procedure

1. Adjust the camera according to the manufacturer's 
instructions until the hard copy and video display are equal.

2. Scan the phantom and it's echogenic contrast targets.

3. Make a hard copy photograph of the display and compare it 
to the image on the video monitor for contrast and weak 
echo display.

4. Document all results for future reference and comparison.

Contact a Service Engineer if camera cannot duplicate what is 
on the image monitor.

NOTE: Optimization of brightness/contrast controls on the display 
monitor is imperative in order to make sure that the hardcopy 
and monitor look alike.

The display monitor is adjusted first. The hardcopy camera or 
printer is adjusted to match the display monitor.
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Setting up a Record Keeping System

Preparation

The following is needed: 

� Quality Assurance binder.

� Hard copy or electronic file of images.

� Quality Assurance Checklists. 

� Display the following information while testing quality 
assurance: 

� Acoustic Output

� Gain

� Depth

� Probe

� Dynamic Range

� Set up new patient to be the name of the test.

� Annotate the following: 

� Any control where its value is NOT displayed. 

� Significant phantom information.

Record Keeping

Complete the following: 

1. Fill out the Ultrasound Quality Assurance Checklist for each 
probe, as scheduled. 

2. Make a hard copy or archive the image. 

3. Compare images to baseline images and acceptable 
values. 

4. Evaluate trends over previous test periods. 

5. File hard copy or electronic file of images and checklist in 
Quality Assurance binder. 
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Ultrasound Quality Assurance Checklist 

Table 18-14:  Ultrasound Quality Assurance Checklist (Part 1)

Performed By Date

System Serial Number

Probe Type Probe Model Serial Number

Phantom Model Serial Number Room Temperature

Acoustic Output Gain Focal Zone

Gray Map TGC Depth

Monitor Setting

Peripheral Settings

Other Image Processing Control Settings

Table 18-15:  (Part 2)

Test

Baseline
Value
Range

Tested 
Value

Image 
Hardcopy/
Archived

Acceptable? 
Yes/No

Service 
Called 
(Date)

Date
Resolved

Vertical
Measurement
Accuracy

Horizontal
Measurement
Accuracy

Axial
Resolution

Lateral
Resolution

Penetration

Functional
Resolution

Contrast
Resolution

Gray Scale
Photography
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Privacy and Security

Introduction

This section describes Privacy & Security considerations for 
Ultrasound System of Versana Active, the Privacy & Security 
capabilities, and how they are configured and used 
appropriately.

For general usage of the system and how to access the 
configuration of the Privacy & Security features described, 
please refer to �Customizing Your System� on page 16-1.

This manual assumes that the reader understands the concepts 
of Privacy & Security. Privacy is the property of protecting the 
personal private interests of patients. Security protects both 
system and information from risks to confidentiality, integrity, 
and availability. Security protects Privacy but also protects more 
broadly against these risks. Privacy requires security. In 
Healthcare one must balance privacy, security, and safety. Most 
of the time there isn�t a conflict between these three domains of 
risk. The healthcare provider organization is encouraged to use 
risk management procedures to assess and prioritize privacy, 
security, and safety risks. Through the use of risk management, 
one can determine how to best leverage the capabilities 
provided in the Versana Active products.
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Abbreviations and Definitions

Abbreviations

Table 18-16:  Abbreviations

DHCP Dynamic Host Configuration Protocol

DICOM Digital Imaging and Communication in Medicine

DNS Dynamic Name System

DS Directory Server

GE General Electric

GEHC GE Healthcare

ID Identity

LAN Local Area Network

MDS2 Manufacturer Disclosure Statement for Medical Device Security

OS Operating System

PACS Picture Archiving and Communication System

PHI Protected Health Information

PI Personal Information

SOP Service-Object Pair (DICOM)

SSL Secure Socket Layer 

TLS Transport Layer Security

UID Unique Identifier (DICOM)

USB Universal Serial Bus

XML Extensible Markup Language
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Definitions

Table 18-17:  Definitions

Data flow Communication between the Versana Active product and other information 
providers on the network takes the form of dataflows. Each dataflow defines the 
transfer of patient information and images between the system and the input/
output sources.

Encryption at rest Encryption of patient data stored on the system.

Encryption in transit Encryption of patient data when in transit between the device and an external 
device, like a PACS.

InSite Agent The client part of the InSite ExC service platform. The Agent is integrated in the 
Ultrasound System.

InSite ExC A GE Healthcare remote service platform.

InSite Server The server part of the InSite ExC service platform.

Local Archive Archive containing images and patient information, residing locally on the 
Ultrasound System.

System administrator A user having an Ultrasound System user account with administrator privileges.

Versana Active 
Ultrasound System

A GE Healthcare ultrasound scanner.
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Privacy and Security Environment

The GE Healthcare Versana Active Ultrasound Systems has 
been designed for an intended use with the following 
expectations of Privacy & Security protections included in the 
environment where this product will be used:

� The system should be connected to a secured network, not 
open to unintended users.

� The Versana Active Ultrasound System computer should be 
physically secured in a way that it is not accessible for 
unintended users.

� External media containing images, patient data, reports and 
logs should be secured. When no longer used, the data 
should be securely deleted and/or the media should be 
securely deleted.

� The monitors of the Versana Active Ultrasound System 
computer should be placed in a way limiting the visibility of 
the screen content to the user only.
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Privacy and Security Capabilities

The GE Healthcare Versana Active Ultrasound System Software 
incorporate a broad assortment of capabilities to enable Privacy 
& Security. This section describes the capability and use of 
these Privacy & Security capabilities.

Access Controls

The access control features may be used to help control access 
to sensitive information. Access control includes user account 
creation and assigning privileges.

It is supported for access control by local user management on 
the device. 

Local user management on the system

It describes the user management and access control integrated 
on the system.

Identity Provisioning

The provisioning of user accounts includes the steps of account 
creation, maintenance, and suspension of the account when it is 
no longer needed. A user account is created for the use by a 
specific individual. It is associated with access rights and is 
recorded in security audit logging.
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Identity Provisioning  (continued)

Management of user accounts

User accounts are created, maintained and suspended by users 
with administrator privileges (see User manual for details).

When received from factory the system has two predefined user 
accounts:

� �ADM�:  An administrative user account.

� �USER�: A normal user account without administrative 
privileges.

When receiving the Versana Active Ultrasound System, it is 
recommended to do the following steps to ensure control of the 
user accounts on the system:

� Set password of the �ADM� account.

� Create user accounts for each individual user of the system:

� Give each user the needed privileges.

� Make sure to give administrative privileges only to users 
intended to do administrative tasks on the system, like 
configuring dataflows, managing users on the system, 
inspecting audit logs etc. As administrative privileges 
give the user access to privacy and security related 
configurations on the system, there should be a limited 
number of users with these privileges.

� It is recommended to create individual users for each 
person going to use the system. This is essential for the 
audit logging, to associate actions performed on the 
system with individual persons. 

Maintenance of user accounts

It is recommended to establish administrative routines for 
removing user accounts no longer being used.
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Identity Provisioning  (continued)

User information stored on the system

The following information can be entered for a user defined on 
the system:

� ID (Mandatory)

� Password (Mandatory)

� Prefix (Optional)

� Last name (Optional)

� First name (Optional)

� Middle name (Optional)

� Suffix (Optional)

� Phone number (Optional)

The user password is not stored in cleartext on the system.

Username and password restrictions

The restrictions for usernames and passwords are:

� Usernames can be 3 - 64 characters long.

� Password can be 6- 64 characters long.

It is recommended to enable and configure username and 
password policies to ensure sufficient user name length and to 
force usage of strong password. See �Username and password 
policies� on page 18-59.

Identity provisioning by use of Backup/Restore

Users defined on a system cannot be copied from one system to 
another by use of the systemís build in Backup/Restore 
functionality (See �System/Backup and Restore Preset Menu� on 
page 16-20 for more details about Backup/Restore 
functionality).
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Username and password policies

Rules for the local user accounts can be set by enabling the 
username and password policies from Config/Admin/User 
Policies, and by customizing these policy settings.

The following settings are available:

� Maximum Times Of Login Try with Wrong Password: 3/5/10.

� Auto Lock Out After X Days Without Successful Login: 30/
60/90.

� Minimum number of character sets (upper case/lower case/
digits/non-alphanumeric):

� Minimum upper case characters: 1 character.

� Minimum lower case characters: 1 character.

� Minimum digits: 1 character.

� Minimum non-alphanumeric chars: 0 character.

� Update Password Every X Days: 0/30/60/90 (0=disabled).

The defined username and passwords policies cannot be 
backed-up and restored by use of the normal Backup/Restore 
functionality.

User Authentication 

The user authentication verifies that the user attempting to use 
the system is indeed the user associated with the account given.

To be authenticated on the system, the username and password 
entered in the login dialog must match what is registered in the 
system's local user management system. A successful user 
authentication will grant the user access to the system.

Assigning Access Rights

The assigning of access rights is the administrative process to 
associate permissions with user accounts.

On the Versana Active Ultrasound System Software this is done 
by granting the user account membership to zero or more role 
based groups in the system. Each of these groups has a set of 
predefined user rights assigned.

Only users with the �Admin� rights have access to manage user 
accounts.

See User Manual for details about user groups and the rights/
permissions associated with each user group.
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Blocking / unblocking of users

If configured, a user account can be blocked for a time limited 
period due to the user entering incorrect password multiple 
times. In addition, a system administrator can manually block a 
user account.

User accounts being blocked manually must be unblocked 
manually. User accounts blocked due to consecutive incorrect 
passwords will be blocked for preconfigured time, according to 
the settings in the User Policies. These accounts can also be 
unblocked manually by a system administrator.

Change user password

User�s password can be changed by the user himself at login, or 
by a system administrator from Utility/Admin/Users.

Automatic logon

The Versana Active Ultrasound System has an �Autologon� 
feature. If enabled, this will automatically log in the last logged in 
user or a predefined user to the system, without any access 
control.

For privacy and security reasons, it is recommended NOT to use 
this functionality on the Versana Active Ultrasound System.

LDAP

Versana Active Ultrasound System support integration with 
LDAP compliant directory servers. If the system is configured to 
use LDAP (Utility/LDAP), the access control and user 
authentication is performed with use of services from the 
connected directory server. The authentication will be done by 
the directory server, while the access control to the system is 
done with data received from the directory server.
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Identity Provisioning

Management of user accounts

When using LDAP, the user accounts on the directory server 
(DS) must be managed outside the Versana Active Ultrasound 
System. It will not be possible to change user passwords or any 
other properties of the user accounts from the Versana Active 
Ultrasound System.

User information stored on the system

In general, there should be no user information stored on the 
system if LDAP is used. Users that are defined in the local user 
management system will remain on the system, with exception 
of the ADM user, these accounts will not be active.

To be able to log on to the system with no network connectivity, 
the system has an option for caching of LDAP user information. 
This can be enabled by a system administrator.

If caching is enabled, the system will have time limited storage 
of user information received from the DS. See �Caching of users� 
on page 18-60 for more information.

Username and password restrictions

The systems restrictions for usernames and passwords are:

� Usernames can be 1 - 32 characters long.

� Password can be 0 - 256 characters long.

Username and password policies

When using LDAP, username and password policies are 
managed by the DS. The local username and password policy 
on the system will then have no effect on LDAP users.

User Authentication

When a user is logging in, the system will send an 
authentication request with the entered user credentials to the 
configured DS. If the authentication is successful and the user 
has access rights to the system, the user will be granted access.
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Assigning Access Rights

The access right to the system is controlled by the DS 
authentication of the user, together with use of the user�s DS 
group membership. To get access to a system, a user must be a 
member of one or more DS groups specified on the Versana 
Active Ultrasound system.

DS group membership is used to assign the user privileges on 
the system.

When configuring a Versana Active Ultrasound System to use 
LDAP, proper user groups must be created or identified on the 
DS. The users of the system must be assigned the proper DS 
group membership. 

For example, users that are going to use the system as 
�Sonographer� can be part of a 
�Versana_Active_Utrasound_Sonographers� DS group, while 
users going to be have �Sys admin� rights could be part of a 
�SysAdmin� group.

There is a group mapping tool in the system�s Utility/LDAP page. 
Use this tool to map DS groups to operator groups on the 
Versana Ultrasound system.

Caching of users

To enable off line usage, the systems support caching of user 
information and off-line authentication. The caching can be 
turned on / off by a system administrator.

For a user to be able to log on when off line, he/she must 
previously have performed a successful logon on the system 
when on-line, and still have valid (i.e. not timed out) cached user 
information on the system.

The caching is time-limited per individual user. The lifetime of 
the cached information is configurable. If the lifetime has 
expired, the user will not be able to log on when offline. The time 
stamp is reset when a successful on-line authentication is done 
by the user.
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Service access

An on-site GE service engineer can gain special access to the 
Versana Active Ultrasound System by the use of a Secure 
Service Access. Secure Service Access is a secure service key 
platform for GE medical devices. It is intended to provide 
increased protection of GE�s proprietary service tools and also 
to eliminate the need for periodic replacement of service keys. 
With the service access the service engineer will gain access to 
the system, including access to the Windows desktop and the 
systemís file system.

If configured and accepted by a user of the Versana Active 
Ultrasound System, a GE service engineer can access the 
system remotely via the InSite remote service platform. A 
remote service session must be initiated by a user of the 
system.

Patient Privacy Consent Management

Patient Privacy Consent Management is the process of 
supporting the patient expressing their privacy requirements. 
This is distinct from other forms of consent such as the consent 
to treat. 

There is no integrated functionality in the system for Patient 
Privacy Consent Management. If needed operational routines 
must be established.
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Privacy & Security Audit Logging and Accountability Controls

Privacy & Security Audit Logging and Accountability Controls 
support security surveillance, privacy investigations and 
reporting.

The Versana Active Ultrasound System Software have 
integrated functionality for audit logging, including audit logging 
of privacy related events. The audit log functionality includes 
search and display capabilities for logged events on the system.

Access to audit logging information

Both system administrators and users can access the audit log 
information.

Audit logging content

The following events are captured by the audit logging of the 
Versana Active Ultrasound System Software:

� User login and logout of the system

� Images added and removed

� Save As

Information elements of the audit log:

� Event type

� User ID

� Time stamp, including date and time

� System name

� Dataflow name

� Study or Series Instance UID

� SOP instance UID

The information elements are logged for the events where they 
are applicable.
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Management of Audit logs

Back up of audit logs

Back up of audit logs can be done by exporting audit logs to an 
external device. User shall have Service Access before 
performing the exportation. Press Alt + D to request the audit log 
exporting. If user have the Operator Right of Anonymous, he/
she can choose whether to Anonymous the audit logs in the 
dialog.

Remember that audit logs and exported audit log files do contain 
Personal Information (PI) if Anonymous is not chosen and must 
be handle according to applicable regulations and guidelines for 
handling of PI / PHI.

Note that exported audit log files are stored unencrypted as text 
files (*.txt) and compressed as zip files. 

Audit log retention

There is no limitation in the audit log retention, except the 
available disk space on the system.
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Information Protection

This section of the manual focuses on Privacy & Security 
operations, and contains information to guide in the preparation 
of a secure environment for the Versana Active Ultrasound 
Systems.

Security operations, best implemented as part of an overall 
�defense in depth� information assurance strategy, are used 
throughout an Information Technology system that addresses 
personnel, physical security and technology. The layered 
approach of defense in depth limits the risk that the failure of a 
single security safeguard will allow compromise of the system.

System interconnections

Network connectivity is required for several of the system�s 
features:

� DICOM connectivity to other DICOM devices.

� Remote archive storage on another networked, compatible 
GE system.

� Image storage via the �Save As� feature to network share.

� Patient data XML export to network share.

� Viewing external video stream on the Versana Active 
Ultrasound System.

� Remote service capabilities given by GE�s InSite ExC 
remote service platform.

The interconnections are described in more detail in 
Table 18-18, and illustrated in Figure 18-6. For a particular 
installation, typically a subset of the interconnections is utilized.

Table 18-18:  System interconnections

Source/
Destination Network Service Description

PACS / 
DICOM server

DICOM Optional connection to PACS / DICOM server for patient 
and image archiving / retrieval. DICOM storage, DICOM 
Query/Retrieve and DICOM Worklist are supported.

Image Vault Remote Sybase 
connection and 
Network file sharing

Optional connection to Image Vault archive, for patient and 
image archiving / retrieval.

Network file share Network file sharing Save As dataflows can be configured to use a network 
share as output.
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For details regarding protocols, port numbers and firewall 
configurations, please see �Inbound firewall configuration� on 
page 18-67 and �Outbound firewall configuration� on page 18-67

 Figure 18-6. System Interconnections

InSite server HTTPS - initiated 
from the Versana 
Active Ultrasound 
System.

Optional connection to InSite remote service server.

DICOM printer DICOM Optional connection to DICOM printer.

Printer N/A Optional connection to Windows/network printer.

CD/DVD Optional internal 
CDC/DVD player

Optional DVD player can be used for reading and writing of 
images and patient data.

USB storage device USB If feature is enabled, an USB storage device can be 
connected for reading and writing of images and patient 
data.

Bluetooth Bluetooth Optional bluetooth usb dongle can be used for sending 
images to paired devices.

Tricefy Remote archive Optional connection to tricefy server for patient and image 
archiving / retrieval.

Table 18-18:  System interconnections

Source/
Destination Network Service Description
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Network Requirements

Minimum Throughput

� Response time 50 ms maximum.

� Recommended minimum 100 Mbit/sec for wired network for 
large image file transfer.

Host Characteristic

� TCP/IP network.

� Both DHCP and static IP allocation are supported.

� The Versana Active Ultrasound Systems cannot be a 
Windows Domain member.

Network Protocols 

Physical and Link Layer Interface

� Ethernet IEEE 802.3 10BASE-T, 100BASE-TX and 
1000BASE-T.

� Isolated LAN connection (to prevent increased leakage 
current).

Internet Protocol Version

� IPv4.
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Network Security

GE strongly recommends that medical information systems are 
operated in a secure network environment that is protected from 
unauthorized intrusion. There are many effective techniques for 
isolating and protecting medical information systems, including 
implementing firewall protection, demilitarized zones (DMZs), 
Virtual Local Area Networks (VLANs) and network enclaves.

The Versana Active Ultrasound System is supported with an 
internal firewall. The following two sections describe the 
configuration of the firewall and the guidance for configuring the 
IT infrastructure where it is connected.

Inbound firewall configuration

All inbound connections are blocked by the Versana Active 
Ultrasound System's internal firewall, with the exemptions listed 
in the table below.

Outbound firewall configuration

All outbound connections are blocked by the Versana Active 
Ultrasound System�s internal firewall, with the exemptions listed 
in the table below..

Table 18-19:  Inbound firewall exemption for the system

Local port Remote port Protocol Application Controlled

Any Any ICMPv4 Any

Any Any UDP EchoLoader MFC Application

Any Any TCP EchoLoader MFC Application

3306 Any TCP Any

Table 18-20:  Outbound firewall configuration for the system

Local port Remote port Protocol Application Controlled

Any Any Any python

Any Any ICMPv4 Any

Any 445 TCP Any

Any 80 TCP Any

Any 515, 9100 TCP Any

Any 123 UDP Any

Any 161 UDP Any

Any 80, 443 TCP svchost
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Local Archive - Security capabilities

The Versana Active Ultrasound System Software are provided 
with an internal archive, for storing images and patient data 
locally on the system. The Local Archive�s file repository and 
patient database are not supporting file sharing or remote 
connection. These can only be accessed locally. The patient 
database is in addition to having no remote access possibilities, 
also protected by database authentication.

DICOM connections - Security capabilities

The DICOM connection works as defined by DICOM guidelines. 
The application accepts connection only to/from DICOM entities 
with IP-address, AE Title and port number matching the 
configured parameters in the Versana Active Ultrasound System 
Software.

The communication sessions are on demand, always initiated 
locally from the system.

The Versana Active Ultrasound System�s internal firewall will 
have exemptions for ports used by the defined DICOM 
dataflows in the system. Defining a new DICOM dataflow, or 
changing an existing, will cause the internal firewall 
configuration to change automatically. This will ensure that only 
ports configured for a dataflow will have an exemption in the 
internal firewall.

Transport Layer Security (TLS) protocol provides privacy and 
data integrity between two or more communicating computer 
applications. The user can enable this feature for DICOM by 
checking on the �Enable Encryption� in Utility/Connectivity/
Service.

Network shares

Network file share access can be secured by a defining a 
dedicated user on the server side. The user credentials for the 
network share user must be entered in the configuration UI on 
the Versana Active Ultrasound System Software. If no user 
credentials are configured, the system will try connecting with 
default credentials.

Remote Service - Security capabilities

See �Remote Service� on page 18-81 for description of the 
Remote Service and the Remote Service security capabilities.
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Wireless Security

Due to the broadcast nature of wireless communication, 
wireless devices require special security consideration. There 
are effective techniques and tools for improving the security of 
wireless communication devices.

Wireless protocols on the System

The following wireless protocols are supported:

� IEEE 802.11a

� IEEE 802.11b

� IEEE 802.11g

� IEEE 802.11n

� IEEE 802.11ac

The following security protocols are supported on the wireless 
interface:

� None

� WEP

� WPA/WPA2 Personal

� WPA/WPA2 Enterprise

To increase the wireless security, it is recommended to use 
WPA2 Enterprise with AES encryption.

NOTE: Less-secure wireless encryption type WPA and AES is not 
supported on this device anymore, please use other methods 
instead.

Wireless Adaptor is an optional device of the Versana Active 
systems.
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Removable Media Security

PI/PHI stored on removable media

USB storage device can be set as encrypted by system while 
CDs and DVDs does not support the encryption. Users with the 
Operator Right of Admin can access the Disk Encryption 
configuration page and set the security level for patient data 
stored on the removable USB storage device to Encryption ON. 
Key is stored on USB /password is entered manually.

Data stored on removable media as USB storage devices 
(Security level for patient data is Encryption OFF), CDs and 
DVDs, is stored unencrypted on the media. The data could 
contain personal information (PI) / personal health information 
(PHI). As a result, these storage devices and the content on the 
storage device must be physically protected and handled 
according to applicable regulations and guidelines for handling 
personal information (PI) / protected health information (PHI).

If not in conflict with the purpose of storing data to removable 
media, it is strongly recommended to anonymize the data when 
storing data to external media. See �De-Identification 
Capabilities� on page 18-75. This reduces the risk of disclosing 
PI/PHI if the media is lost, left unattended etc.

If data containing PI/PHI is to be stored on removable media, it 
is recommended to consider the use of removable USB storage 
device with the setting of security level for patient data as 
Encryption ON, or other USB storage media with build in 
security functionality, like encrypted USB drives with integrated 
keypad. 
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Removable media on the System

The Versana Active Ultrasound System supports removable CD/
DVD drive (optional) and it supports USB connected storage 
devices. CD/DVD discs and USB storage device are used for:

� Exporting and importing patient data and images.

� System back-up and export of audit logs.

� Upgrading system and application software.

� Storing service logs during service sessions.

Optional CD/DVD drive

Removable CD/DVD drive is an option for the Versana Active 
Ultrasound System.

Data stored on CD/DVD media is stored unencrypted. 

AutoPlay disabled

AutoPlay (known as �AutoRun� on older OS) is disabled on the 
system to prevent automatic execution of software stored on 
removable media connected to the Versana Active Ultrasound 
System.

Data destruction

Versana Active Ultrasound Software does not have internal 
functionality for secure deletion of data stored on the removable 
devices.

Approved procedures and tools should be used for secure 
removal of data stored on removable media, according to 
applicable regulations and guidelines for handling patient 
information / personal information (PI) / protected health 
information (PHI).
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Data at Rest Security

Versana Active Ultrasound System

The Versana Active Ultrasound System supports encryption of 
patient data stored on the system. 

By default, the User Partition is Encryption ON and other 
partitions encryption are OFF.

To improve the protection and confidentiality of patient data 
stored on the system, it is strongly recommended to enable the 
�Disk Encryption� feature on the Local Patient Data Drive before 
starting using the system.

Encryption at rest

A system administrator can enable �Disk Encryption� from the 
system�s configuration page. When enabling disk encryption for 
the local patient data drive, the user has to set a user defined 
password to be used to unlock the encrypted patient 
information. Before starting the encryption process the system 
will generate a recovery key, which can be used to unlock the 
encrypted disk in case the password is forgotten. 

The selected encryption password and the recovery key must be 
stored and managed in a safe and secure manner. It is the 
responsibility of the user and the owner of the system to take 
care of these keys. If the keys are lost, the patient data stored on 
the system will be lost. There is no way for GE Healthcare to 
recover the data if the keys are lost. 

The disk encryption is using 256-bit encryption key length for 
protecting patient data stored on the system. The encrypted 
data includes both the patient data and the ultrasound images 
stored on the system.

The security of the system, with respect to encryption at rest, 
relies on the user�s protection of the recovery key and the 
encryption password. If adversary gets hold on an encrypted 
system, or the system�s hard-disk, together with either of these 
keys, the encryption at rest will have no effect and give no 
protection of the data. 

For those using automatic unlock with recovery key stored on 
USB, it is recommended to remove the USB when the system is 
not used.



Privacy and Security

Versana Active � Basic User Manual 18-73
Direction 5840764-100 English Rev. 10

Versana Active Ultrasound System  (continued)

Unlocking an encrypted system

When starting up a system with encryption enabled, the 
encrypted patient information must be unlocked. This can be 
done in three ways:

� The user enters the encryption password.

� The user enters the recovery key.

� A USB storage device containing the recovery key is 
connected to the system and the system unlocks the 
encrypted patient data automatically at startup.

NOTE: When an encrypted system is unlocked, it will remain unlocked 
until the system is restarted.

Encryption password is lost

If the encryption password is lost, the patient information can be 
unlocked by use of the recovery key. When unlocked, a system 
administrator can set a new encryption password on the system 
from the configuration page on the system.

Changing the keys

The encryption password can be changed by both system 
administrator and user.

Encryption at rest is disabled

If the disk encryption is disabled, data is stored unencrypted on 
the system.

File system protection

Access to the systems Windows desktop and the file system is 
prevented for both users with and without system administrative 
privileges. To access Windows desktop and the systems file 
system, service access is required see �Service access� on 
page 18-61.
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Back-up

The Versana Active Ultrasound System Software back-up 
feature stores data unencrypted to the back-up target. This 
includes back-up of images and patient information. The 
back-up data will be unencrypted even if the �Security level for 
Patient data stored on the system� is Encryption ON on the 
Versana Active system. 

The target for the back-up, either removable media or servers, 
must be secured to ensure the privacy and security of the 
backed-up data. 

External dataflows

The Versana Active Ultrasound System supports 
interconnections to external storage systems (DICOM servers). 
The privacy and security of data stored on the external system 
are outside the scope of this document. 
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Data Integrity Capabilities

Integrity assurance is implemented to software updates 
packages for the Versana Active Ultrasound System. Software 
Upgrade USB flash is of USB CD ROM format to prevent from 
malicious modifications, and the installation of the malicious 
software will be prohibited.

De-Identification Capabilities

The Versana Active Ultrasound System Software contain 
de-identification (anonymization and pseudonymizing) 
capabilities to limit privacy and security risks to sensitive 
information.

When exporting images by the Save As function, there is an 
option to anonymize the image. Check the check box to activate 
de-identification when saving. The check box is unchecked by 
default. After generation of the new patient, the anonymized 
patient data can be transferred to removable storage device.

De-identification is done by clearing or overwriting all meta data 
containing PI / PHI in the image files. Note that the image itself 
(the pixel data) may still contain PI / PHI, e.g. in labels or 
captions in the image.  
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Business Continuity

To ensure business continuity several options must be 
considered related to the data storage. The target for the images 
and patient archive must be chosen to ensure safe storage of 
the data. Both internal and external alternatives are supported. 

Patient archive solutions

The Versana Active Ultrasound System supports several 
alternatives for storing images and patient information, both 
internal and external:

� Local Archive: local storage on the Versana Active 
Ultrasound System Software computer.

� DICOM storage: storage on DICOM / PACS server.

See �System interconnections� on page 18-64 for overview of 
the Versana Active Ultrasound System Software 
interconnections, and the user manual for further details about 
the available dataflows.

Securing data on Local Archive

If Local Archive is used on the Versana Active Ultrasound 
System, backup and/or transfer procedures must be established 
for the Local Archive. 

Securing data on DICOM/PACS servers

If external archive is used, make sure to establish backup 
procedures for the external archive. The business contingency 
planning of data stored on DICOM / PACS servers is outside the 
scope of this document.

Secure Wipe

Secure wipe is intended to erase all the patient data with the 
software on the system before the system will be shipped for 
service.
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System Protection
The System needs to be configured and maintained in a way 
that continually protects Privacy & Security.

Malicious Software Protection

The computing environment is increasingly hostile, and threats 
continue to grow from malicious software, including computer 
viruses, worms, Trojan horses, denial of service attacks, and 
other malware. Vigilant defense on many levels is required to 
keep systems free from compromise by malicious software. In 
most cases, effective protection requires cooperation and 
partnership between GE and our customers.

The Versana Active Ultrasound System

Commercial Anti-virus software is commonly used on 
general-purpose computers to detect the presence of malicious 
software (virus, Trojan horse, worm, etc.). Anti-virus software is 
useful on general-purpose computers as they typically cannot 
be sufficiently hardened against the attack vectors used by 
malicious software. 

The Versana Active Ultrasound Systems however, are single 
purpose (dedicated) devices that have controlled intended use. 
For the Versana Active Ultrasound Systems, �whitelisting� 
protection is a better solution for protecting the systems against 
malware. The Versana Active systems utilizes the 
�DeviceGuard� whitelisting provided with Windows 10. Only 
binaries trusted by the Versana Active white-list (the �CI Policy�) 
will run. All other binaries will be blocked by DeviceGuard.

UEFI �SecureBoot� is enabled on the systems to prevent 
adversary from booting the system from a not trusted, bootable 
media. SecureBoot and Windows �TrustedBoot� will protect the 
system from malware targeting the systems boot process.

Additional reading

For more information on Malicious Software Protection, refer to 
the following two whitepapers by the Joint NEMA/COCIR/JIRA 
Security and Privacy Committee:

� �Defending Medical Information Systems Against Malicious 
Software�, December 2003, http://www.medicalimaging.org/
policy-and-positions/joint-security-and-privacy-committee-2/

� �Patching Off-the-Shelf Software Used in Medical 
Information Systems�, October 2004, http://
www.medicalimaging.org/policy-and-positions/
joint-security-and-privacy-committee-2/
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The Versana Active Ultrasound System - system protection

The Versana Active Ultrasound System contains additional 
features to improve local operational security.

No Windows desktop access

Users of the Versana Active Ultrasound System do not have 
access to the Windows desktop nor to the Windows file system 
on the Versana Active Ultrasound System.

The users will have no access to internet web-browsing, e-mail 
clients, installing any software on the system nor adding files 
(except for application related files through the application).

Windows features disabled

The following Windows features are disabled:

� Remote Desktop Connection

� Remote Assistance

� Windows AutoPlay feature

� Administrative Shares (the Administrative Shares are 
hidden)

� C: drive visibility

Windows services disabled

Many Windows services are unused and disabled on the 
Versana Active Ultrasound System.

See full list of disabled Windows services in Table 18-22.

GE Healthcare service access

To access the Versana Active Ultrasound System in service 
mode, an SSA USB service dongle and a service password are 
required. A GE Healthcare field engineer will be needed for 
accessing the system in service mode.

When in service mode the field engineer will have access to 
Windows desktop and file system.
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The Versana Active Ultrasound System - system protection  (continued)

Automatic screen lock

The Versana Active Ultrasound System has a configurable 
inactivity screen feature. It can be configured to lock the screen 
after a predefined inactivity time. The inactivity time can be 
configured to 10 minutes or higher. When screen is locked, no 
patient information is visible on the screen. To unlock, the user 
must enter the password of the current logged in user.

It is recommended to enable screen lock after minimum time of 
inactivity.

Windows user and password

To access the Windows OS functionality of the Versana Active 
Ultrasound System, a service dongle and password are 
required. However, a system administrator can still change the 
password of the underlying Windows user from Utility/Admin/
System Password. Users of the system will never need to use 
this password. The only reason to change the password will be if 
the user, for security reasons, prefer to define his own password 
instead of the factory defined default password.
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The Versana Active Ultrasound System Change Management

Versana Active Ultrasound System operative system

The Versana Active Ultrasound System is based on Microsoft 
Windows 10 IoT.

Windows 10 IoT Enterprise is a full version of Windows 10 with 
specialized features to create dedicated devices locked down to 
a specific set of applications and peripherals. Windows 10 IoT 
LTSB has a different lifecycle plan than standard Windows 10.

Security updates / patches

GE Healthcare is constantly monitoring for security 
vulnerabilities applicable for the products. This includes 
vulnerabilities in the application software, third party 
components and the underlying operative system. For the 
operative system, this includes regular review of vulnerability 
announcements from Microsoft.

Announced vulnerabilities in the operative system or other third- 
party components, are assessed based on the Versana Active 
Ultrasound Systemís configuration and use.

When needed, GE Healthcare release security updates / 
patches for the products and makes these available to 
customers through GE Healthcare Service.

How to contact GE

For privacy and security concerns regarding GE products, 
please see:

http://www.ge.com/security

Table 18-21:  Operative system

FAMILY PRODUCT Description and Version

Windows 10 IoT Windows 10 IoT Enterprise 2016 LTSB High End (ESD), 64 Bit
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Remote Service
Often the fastest, most efficient and cost-effective manner to 
provide service is to connect to the Versana Active Ultrasound 
System remotely. Every effort is made to ensure that this 
connection is as secure as possible.

The GE Healthcare InSite ExC remote service platform is 
integrated in Versana Active Ultrasound System. InSite ExC 
enables real-time application support, problem diagnosis and 
repair.

InSite ExC remote service

The two major technical components of InSite are the Agent and 
the Server. The Agent is installed on the Versana Active 
Ultrasound system, while the Server resides within GE 
Healthcare. The Agent establishes secure communications to 
the Server via the Internet.

Key Security Features

The key security features of the InSite platform include the 
following:

� Communication from the Agent to the Server is initiated by 
the on-site user securely via an outbound connection over 
port 443 (HTTPS). No fixed IP address is required on the 
device.

� The Agent always connects to a known IP address (the 
Server). The ability to identify the Server is therefore 
guaranteed, because the Server is visible to the Agent only 
via a known IP address.

� The Agent communicates with the Server via transmissions 
that require password authentication. Data transmissions 
are encrypted using the Secure Socket Layer (SSL) protocol 
over port 443.

� Inbound Firewall on the Versana Active Ultrasound System 
is not compromised. Web services standard protocol using 
only outbound HTTPS Port 443.

Data Privacy

In some cases, GE Healthcare may encounter personal 
information (PI) / protected health information (PHI) as part of 
the troubleshooting procedures or under data access rights 
granted to GE Healthcare. Access to this data is limited to GE 
Healthcare authorized personnel only. Personal information (PI) 
/ protected health information (PHI) encountered as part of 
remote service sessions will be handled according to GE 
Healthcareís standards for handling personal information (PI) / 
protected health information (PHI).
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Personal Information Collected by the Product

Information collection and use

The Versana Active Ultrasound System Software are collecting 
patient demographic information, personal or protected health 
information for the use within the system. 

Information entered for user accounts defined in the systems 
local user management is also stored on the system.

The following types of information are collected for the purposes 
of patient medical diagnosis, user management, audit logging 
and/or debug logging:

� Patient demographics.

� Medical diagnostics and measurements.

� Ultrasound images.

� Facility information.

� Provider information.

� Device data

Patient information collected is either entered manually by the 
user of the system, or it is received through one or more of the 
system�s dataflows.

Details on what data is collected, used and disclosed can be 
achieved by contacting GE Healthcare.

Manual information collection

Only PI needed for the purpose of treatment or healthcare 
operations should be collected. The system supports collection 
of PI that is related for such usage only. However, the system 
might support collection of more data than will be used for a 
particular installation. The user should limit the collect of PI to 
what is really needed.

The user should be careful not entering personal identifiable 
information in free text fields in the system, as this information is 
not anonymized by the de-identification procedure, see 
�De-Identification Capabilities� on page 18-75.

Information disclosure

If the Versana Active Ultrasound System are connected to 
remote network shares and external media, like CD/DVD and 
USB storage devices, patient demographics, medical 
diagnostics, measurements and ultrasound images will be 
communicated to/from the connected device, see �System 
interconnections� on page 18-64.
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Retention and destruction of personal information

Retention and destruction of patient data

The information collected is stored on the system until it is 
manually removed.

Requirements and policies for limited collection and/or 
destruction of Patient Information on the system must be 
implemented by establishing appropriate operational 
procedures. 

Patients and exams can be deleted from the Local Archive on 
the system by a system administrator manually selecting and 
deleting patients / exams.

Retention and destruction of user information, local user accounts

User information for user accounts created and managed locally 
on the system will remain on the system until manually removed. 

Requirements and policies for limited collection and/or 
destruction of user information on the system must be 
implemented by establishing appropriate operational 
procedures.

User accounts can be deleted from the system by a system 
administrator manually selecting and deleting user accounts.

Retention and destruction of user information, LDAP user accounts

See �Caching of users� on page 18-60 for caching of LDAP user 
information.

Secure deletion of PI / PHI

GEHC Service has procedures and tools for secure deletion all 
PI / PHI on the system.
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Individuals authorization for collection, use and disclosure of PI/PHI

Some users of Versana Active systems might face requirements 
and policies for letting individuals (the patients) authorize the 
collection, use and disclosure of PI/PHI. There is no support for 
such functionality in the system. Such requirements can only be 
implemented by operational procedures.

Information to individuals of collection, use and disclosure of PI/PHI

Some users of Versana Active systems might face requirements 
and policies for informing individuals (the patients) about the 
collection, use and disclosure of PI/PHI. There is no support for 
such functionality in the system. Such requirements can only be 
implemented by operational procedures.
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Security Vulnerability Scanning

Potential security vulnerabilities of the Versana Active 
Ultrasound System are revealed using �Nessus� from Tenable 
Network Security. This is a security scanning tool that United 
States Department of Defense and Hospital IT organizations use 
to check for vulnerabilities on their networks. Identified 
vulnerabilities are mitigated as appropriate based on risk 
assessment of the product.

Security scanning is performed during the development of the 
Versana Active Ultrasound Products.
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Potential Hazardous Situations Resulting from Failures of the IT 

Network

Hazardous situations

The following general hazardous situations have been identified 
as potentially hazardous as a result of the IT network failing to 
provide the required characteristics specified above.

� Delayed or impaired access to images or other exam 
information or patient data.

� Permanent loss of images or other exam information or 
patient data.

� Corruption of images or other exam information or patient 
data.

� LAN connection loss during operation may cause loss of 
data, and damage data integrity.

Warning

In addition to the hazardous situations identified above, 
connection of the Versana Active Ultrasound System Software 
to a network that includes other equipment could result in other 
unidentified risks to patients, operators or third parties. The 
responsible organization should identify, analyze, evaluate and 
control these risks on an ongoing basis including after changes 
to the network such as those listed below, which could introduce 
new risks and require additional analysis.

� Changes in network configuration.

� Connection of additional items to the network.

� Disconnecting items from the network.

� Update of equipment connected to the network.

� Upgrade of equipment connected to the network



Privacy and Security

Versana Active � Basic User Manual 18-87
Direction 5840764-100 English Rev. 10

MDS2

The �Manufacturer Disclosure Statement for Medical Device 
Security� MDS2 is provided as a statement of the security and 
privacy capabilities using a well-known standard disclosure 
format. 

Please see MDS2 for Versana Active as below:
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MDS2  (continued)

 Figure 18-7. Versana Active MDS2
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MDS2  (continued)

 Figure 18-8. Versana Active MDS2
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MDS2  (continued)

 Figure 18-9. Versana Active MDS2
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MDS2  (continued)

 Figure 18-10. Versana Active MDS2
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MDS2  (continued)

 Figure 18-11. Versana Active MDS2
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MDS2  (continued)

 Figure 18-12. Versana Active MDS2
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Disabled Windows Services

The following Windows services are unused and disabled on the 
Versana Active Ultrasound System:

Table 18-22:  Disabled Windows Services

Name Description Startup Type

Auto Time Zone Updater Automatically sets the system time zone. Disabled

Internet Connection Sharing 
(ICS)

Provides network address translation, addressing, 
name resolution and/or intrusion prevention 
services for a home or small office network.

Disabled

Microsoft App-V Client Manages App-V users and virtual applications. Disabled

Net.Tcp Port Sharing 
Service

Provides ability to share TCP ports over the net.tcp 
protocol.

Disabled

Remote Registry Enables remote users to modify registry settings on 
this computer. If this service is stopped, the registry 
can be modified only by users on this computer. If 
this service is disabled, any services that explicitly 
depend on it will fail to start.

Disabled

Routing and Remote 
Access

Offers routing services to businesses in local area 
and wide area network environments.

Disabled

Shared PC Account 
Manager

Manages profiles and accounts on a SharedPC 
configured device.

Disabled

Smart Card Manages access to smart cards read by this 
computer. If this service is stopped, this computer 
will be unable to read smart cards. If this service is 
disabled, any services that explicitly depend on it 
will fail to start.

Disabled

User Experience 
Virtualization Service

Provides support for application and OS settings 
roaming

Disabled

Windows Time Maintains date and time synchronization on all 
clients and servers in the network. If this service is 
stopped, date and time synchronization will be 
unavailable. If this service is disabled, any services 
that explicitly depend on it will fail to start.

Disabled
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All Third-Party or Open-Source Software

The following software is used on the Versana Active Ultrasound 
System:

Table 18-23:  Third-Party or Open-Source Software

Product                                                    
(Title of the OTS Software) Manufacturer Version

Intel Network Driver Intel 20.2.241.0

Intel Graphic Driver Intel 26.20.100.7985

Intel Management Engine Components Intel 11.0.0.1177

Intel Rapid Storage Technology Intel 14.6.0.1029

Realtek High Definition Audio Driver Realtek Semiconductor Corp. 6.0.1.7534

VC++ 2005 x64 Microsoft 8.0.56336

VC++ 2005 x64 Microsoft 8.0.61000

VC++ 2010 x64 Microsoft 10.0.30319

VC++ 2010 x86 Microsoft 10.0.30319

VC++ 2013 x64 Microsoft 12.0.30501.0

VC++ 2015 x86 Microsoft 14.0.22816.0

VC++ 2015 x64 Microsoft 14.0.22816.0

VC++ 2017 x64 Microsoft 14.16.27024.1

VC++ 2017 x86 Microsoft 14.16.27024.1

MySQL Server Oracle 6.3.7

Notepad++ - 5.9

7z Igor Pavlov 18.05

HP Universal Printing PCL 6 Driver HP -

Sony UP-898 Series Printer Driver Sony -

Sony UP-D25MD Printer Driver Sony -

Susi Advantech 4.1.14940.0

Norav Norav Medical. 2.2.7600.16385

Cisco Aironet Installation Program Cisco Aironet 7.1

CSD GE Healthcare 1.0.0.1

Python 3.6.8 Python 3.6.8150.0

Qt Qt 4.8.6
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Index

Symbols

% Stenosis, 9-33
generic measurement, 7-69
M-Mode, 9-38

�SaveAs� Images, 15-15

Numerics

3D Acquisition, 5-179
3D/4D imaging

introduction, 5-189
manipulating the volume of interest, 5-221
operational controls, 5-199
prinicples of operation, 5-191

3D/4D presets, changing
Advanced, 16-185

A

A/B Ratio
Doppler generic measurement, 7-84
generic measurement, 7-76
M-Mode generic measurement, 7-78
M-Mode measurements, 9-38

abdomen exam
general guidelines, 8-2

Abdominal Circumference (AC), measuring, 9-10
Acceleration time (AT)

OB/GYN vessel measurement, 7-87
Acceleration, measuring, 7-87
accessories

ordering, 1-8
requesting a catalog, 1-8

accessory
connector panel, 3-16

accessory connector panel illustration, 3-17
Acclimation time, 3-22
accuracy

clinical calculation, 18-4
clinical measurement, 18-2

acoustic output
default levels, 2-41

Active Images, 4-33
Admin

overview of Utility screen, 16-114
Admin screen

Logon, 16-134, 16-135

System Admin, 16-115
Users, 16-132

administrator
specifying system, 16-132

AFI, see Amniotic Fluid Index (AFI)
ALARA (as low as reasonably achievable), bioeffects, 
2-5
Alpha Hip, pediatric measurement, 13-7
Amniotic Fluid Index (AFI), measuring, 9-21, 9-23
Anatomical M-Mode

activating, 5-42
overview, 5-41

Angle Correct, adjusting
Doppler Mode, 5-74

Angle Steer, adjusting
Color Flow, 5-52
Doppler Mode, 5-75

Angle, B-Mode generic measurement, 7-75
annotating an image

introduction, 6-15
text overlays, 6-18
using the annotation library, 6-20
using typed words, 6-19

Annotations Libraries Presets Menu, 16-50, 16-55
annotations, prresets, 16-53
Antero-postero trunk diameter and transverse trunk 
diameter (APTD-TTD), 9-23
Antero-postero trunk diameter by transverse trunk 
diameter (AxT), 9-24
application presets

selecting, 4-35
user-defined, 4-35

Applications
setting presets, 16-62

Applications Preset Menu, 16-60
area measurements

ellipse, 7-43
spline, 7-46
trace, 7-44, 7-45, 7-46

AUA
OB worksheet, 9-43

Audio Volume, adjusting in Doppler Mode, 5-76
Auto Optimize (Auto), adjusting, 5-8
Auto Vascular Calculation, see also Manual Vasuclar 
Calculation

overview, 11-9
Auto Vascular Calculation, see also Manual Vasuclar 
calculations
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activating, 11-10
setting up calculation parameters, 11-10

AutoEF
Results, 10-33
the endocardial border, 10-24
the endocardial border trace, 10-26
Tracking Validation, 10-31

B

backing up data
EZBackup/Move, see EZBackup/Move, using

Backup and Restore Preset Menu, 16-20
Baseline, adjusting

Color Flow, 5-51
Doppler Mode, 5-78

biological hazards, 2-12, 2-14
Biparietal Diameter (BPD), 9-14
Bladder volume, measuring, 12-5
B-Mode imaging

intended uses, 5-2
optimizing, 5-2
scanning hints, 5-4
typical exam protocol, 5-3

B-mode measurement
Echo Level, 7-48

B-Mode measurements
Gynecology exam, 9-81
OB, 9-10

B-Mode measurements, general, 7-41
B-Mode measurements, generic

% Stenosis, 7-69
A/B Ratio, 7-76
Angle, 7-75
Volume, 7-71

B-Mode measurements, mode
circumference and area (ellipse), 7-43
circumference and area (spline trace), 7-46
circumference and area (trace), 7-44
distance, 7-42

body pattern application libraries, selecting, 16-61
Body Patterns, 6-22

General tab, 16-59
Body Patterns Preset Menu, 16-59
brightness, video, 3-56
Buttons screen

Connectivity, 16-99

C

Calculations
selecting, 7-8

calculations
OB worksheet, 9-45, 9-46
urology, 12-3

calipers, description, 7-5
Cardio-Thoracic Area Ratio (CTAR), 9-25
Care and maintenance

cleaning the system, 18-10
inspecting the system, 18-7

Caution icon, defined, 2-4
CF/PDI Auto Sample Volume, adjusting, 5-57
CF/PDI Center Depth, adjusting, 5-58
CF/PDI Frequency, adjusting, 5-58
CF/PDI Width, adjusting, 5-50
CINE loop

previewing only, 15-6
storing and previewing, 15-6
storing without previewing, 15-6

CINE mode
activating, 6-11
introduction, 6-11
synchronizing loops, 6-13
using, 6-12

circumference measurements
ellipse, 7-43
spline, 7-46
trace, 7-44, 7-45, 7-46

Clinical
calculation accuracy, 18-4
measurement accuracy, 18-2

Coded Harmonic Imaging (CHI), activating, 5-13
Color Flow imaging

intended uses, 5-44
optimizing, 5-44
Power Doppler, 5-59

colorizing an image, 5-23
comments, see annotating an image
Compression, adjusting

Doppler Mode, 5-79
Connectivity

Buttons, 16-99
configuring, 16-69
overview of screens, 16-69
presets, 16-69
TCPIP, 16-71

console
transporting, 3-39

contacts
clinical questions, 1-8
Internet, 1-8
service questions, 1-8

Control Panel
description, 3-46

controls
annotation function, 3-52
display function, 3-51
measurement function, 3-52
mode function, 3-51
operator, 3-46
record function, 3-51

Crown Rump Length (CRL), measuring, 9-14
CUA

OB worksheet, 9-43
Cursor Moving, adjusting, 5-82
Curved Anatomical M-Mode, 5-43
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CW Doppler
activating, 5-83
exiting, 5-83
overview, 5-83
steerable, 5-83

D

D/S ratio, 7-83
Danger icon, defined, 2-4
Data transfer

MPEGvue, 15-24
dD Ratio, pediatric measurement, 13-8
Depth, adjusting, 5-5
device labels, 2-45
devices

acceptable, 2-36
unapproved, 2-36

distance measurement
general, 7-42

Doppler Auto Calc Average Cycle, using, 7-55
Doppler measurements

OB/GYN, 9-39
Doppler measurements, generic

A/B Ratio, 7-84
D/S ratio, 7-83
Heart Rate, 7-83
Pulsatility Index (PI), 7-82
Resistive Index (RI), 7-82

Doppler measurements, mode
TAMAX/TAMEAN, 7-52
time interval, 7-51
velocity, 7-50

Doppler Mode
generic study, 7-80

Doppler Mode, general measurements, 7-50
Doppler Mode, PW

intended uses, 5-67
optimizing, 5-67
typical exam protocol, 5-68

DVD Multi drive
location, 15-35

Dynamic Range, adjusting
B-Mode, 5-20

E

Easy 3D, 5-181
Echo level measurement, 7-48
Edge Enhance, adjusting, 5-24
editing

patient information, 4-26
user-defined calculations, 7-34

EFW growth percentile
OB worksheet, 9-45

Elastography, 5-134
Elastography, 2D measurement, 5-139
Elastography, how to use, 5-137

electrical
configurations, 3-3

electrical hazard, 2-11
electromagnetic compatiblity (EMC), 2-19
ellipse measurement, general, 7-43
EMC (electromagnetic compatiblity), 2-19
End diastole (ED)

OB/GYN vessel measurement, 7-87
Endometrium thickness (Endo), GYN exam, 9-85
Environmental requirements

probes, 17-5
environmental requirements, 3-4
equipment safety, 2-11
Erasing

measurements, 7-11
Estimated Fetal Weight (EFW), 9-26
exam

definition of terms, 7-3
deleting, 4-18
OB, 9-2
workflow, 7-3

explosion hazard, 2-13
EZBackup/Move, using, 16-29

F

Fast Key, 6-27
fast key, create, 6-27
fast key, start, 6-29
Femur Length (FL), measuring, 9-15
Fetal growth bar graph, 9-49, 9-56
Fetal growth curve graph, 9-49

description, 9-50
multiple fetus, 9-60
quad view, 9-52
selecting, 9-51

Fetal trending
fetal growth curve graph, 9-54

Fetal Trunk Area (FTA), measuring, 9-27
Fetus

entering number of, 9-57
selecting on an OB worksheet, 9-43

Fetus Compare
multiple fetus, 9-60

Flash Suppression, adjusting, 5-56
Flow Volume, 7-58, 7-85
focal zone, see Focus, adjusting
Focus, adjusting, 5-7
folders, measurement

adding, 7-29
Follicle measurements, GYN exam, 9-82
Foot Length (Ft), measuring, 9-31
Footswitch, 3-18
Frame Average, adjusting

B-Mode, 5-24
Color Flow, 5-55

freezing an image, 6-9
Frequency, adjusting, 5-14
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FV, 7-58, 7-85

G

Gain, adjusting
B-Mode, 5-6
Color Flow, 5-48

Gels, coupling, 17-48
General imaging

changing presets, 16-49
generic studies and measurements, 7-66
Generic study

Doppler mode, 7-80
Gestational Sac (GS), 9-16
GYN exam

endometrium thickness, 9-85
follicle measurements, 9-82
ovaries measurements, 9-86
uterus measurements, 9-87

Gynecology exam, 9-79
B-Mode measurements, 9-81
starting, 9-80

H

hazards, 17-9
biological, 17-44
electrical, 17-42
mechanical, 17-43

hazards, safety symbols, 2-5
hazards, types

biological, 2-12, 2-14
electrical, 2-9, 2-11
explosion, 2-13
mechanical, 2-9

Head circumference (HC), 9-17
Heart Rate

Doppler generic measurement, 7-83
M-Mode generic measurement, 7-79

Hip Dysplasia, pediatric measurement, 13-5
Humerus Length (HL), measuring, 9-32

I

iLinq, using, 6-30
images

deleting, 4-18
recalling from clipboard, 15-9
reviewing, 4-33
storing, 15-5

Imaging presets, changing
General, 16-49

Imaging presets, overview, 16-46
Indications for Use, 1-7
information, requesting, 1-8
Intravessel ratio, calculating, 11-28

L

labeling probes, 17-3
Libraries Preset Menu, 16-56
Line Density Zoom, adjusting B-Mode, 5-22, 5-53
Line Density, adjusting

B-Mode, 5-22
Color Flow, 5-53

log on procedures
defining, 16-134, 16-135

Logon
Admin screen, 16-134, 16-135

M

M Color Flow imaging, 5-65
M color flow, activating, 5-66
managing images

media handling tips, 15-37, 15-40
Manual Vascular Calculation, 11-14
Map values, changing, 5-25
Measurement & Analysis screen

accessing, 7-14, 9-63
selecting a study or measurement, 7-17

measurement controls, location, 7-4
Measurement information

OB worksheet, 9-44
measurement parameters, changing or adding, 7-33
Measurements, 9-39

% Stenosis, 9-33
% Stenosis (M-Mode), 9-38
erasing, 7-11
general instructions, 7-7, 7-12
OB, 9-8

AFI, 9-21, 9-23
measurements, general, 7-6
measurements, generic

overview, 7-66
Measurements, types

AxT, 9-24
cardio-thoracic area ratio, 9-25

measurements, types
abdominal circumference, 9-10
amniotic fluid index (AFI), 9-21, 9-22
antero-postero trunk diameter and transverse 

trunk diameter (APTD-TTD), 9-23
biparietal diameter, 9-14
crown rump length, 9-14
estimated fetal weight, 9-26
femur length, 9-15
fetal trunk area, 9-27
foot length, 9-31
gestational sac, 9-16
head circumference, 9-17
humerus length, 9-32
nuchal translucency, 9-32
occipitofrontal diameter, 9-33
spinal length, 9-34
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thorax transverse diameter, 9-36
tibia length, 9-37
transverse abdominal diameter, 9-35
transverse cerebellar diameter, 9-35
ulna length, 9-37

measurements, using
adding, 7-29
automatically starting in workflow, 7-27
calipers, 7-5
changing, 7-28
deleting, 7-35
selecting in different category, 7-9

Method
OB worksheet, 10-54

method, OB worksheet, 9-44
Minimum diastole (MD)

OB/GYN vessel measurement, 7-87
M-Mode

CAMM, 5-43
M-Mode imaging

intended uses, 5-38
optimizing, 5-38
scanning hints, 5-40
typical exam protocol, 5-38

M-Mode measurements, 9-38
OB, 9-38

M-Mode measurements, generic
% Stenosis, 7-77
A/B Ratio, 7-78
Heart Rate, 7-79

M-Mode measurements, mode
time interval, 7-60
tissue depth, 7-59

M-Mode, general measurements, 7-59
Mode Cursor, displaying

B-Mode, 5-16
moving the system, 3-39

during transport, 3-39
MPEGvue, 15-24

E-mail support, 15-30
Multiple fetuses, 9-57

identifying, 9-58
on OB worksheet, 9-61

N

Network Storage Service, 15-44
new patient

scanning, 4-10
nl

Calculation Formulas
Left Ventricular, 10-3

Cardiac Output, 10-57
Automatic Calculation, 10-57

Cardiology
Cubed Method, 10-3

Cubed Method, 10-3
General Calculations

Cardiac Output (CO), 10-57
Left Ventricular

Calculation Formulas, 10-3
Measurements

Cubed Method, 10-3
Nuchal Translucency (HL), measuring, 9-32

O

OB
graph, 9-49
identifying multiple fetuses, 9-58
measurements, 9-8
patient data, 9-5

OB exam
preparing, 9-2
starting, 9-4

OB graphs, 9-49
fetal growth bar graph, 9-56
patient data, 9-55
viewing, 9-50

OB measurements
B-Mode, 9-10
Doppler mode, 9-39
M-Mode, 9-38

OB measurements, types
abdominal circumference (AC), 9-10
amniotic fluid index, 9-22
amniotic fluid index (AFI), 9-21
antero-postero trunk diameter and transverse 

trunk diameter (APTD-TTD), 9-23
antero-postero trunk diameter by transverse 

trunk diameter, 9-24
biparietal diameter, 9-14
cardio-thoracic area ratio, 9-25
crown rump length, 9-14
estimated fetal weight, 9-26
femur length, 9-15
fetal trunk area, 9-27
foot length, 9-31
gestational sac, 9-16
head circumference, 9-17
humerus length, 9-32
nuchal translucency, 9-32
OB/GYN vessels, 9-39
occipitofrontal diameter, 9-33
spinal length, 9-34
thorax transverse diameter, 9-36
tibia length, 9-37
transverse abdominal diameter, 9-35
transverse cerebellar diameter, 9-35

OB mulitgestational, 9-57
OB worksheet, 9-42

AUA, 9-43
calculations, 9-45, 9-46
CUA, 9-43
EFW growth percentile, 9-45
measurement information, 9-44
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method, 9-44, 10-54
multiple fetuses, 9-61
patient data, 9-43
selecting ultrasound age, 9-43

OB/GYN vessel measurements, 7-87
acceleration, 7-87
acceleration time, 7-87
end diastole, 7-87
minimum diastole, 7-87
peak systole, 7-87
selecting, 9-41

OB/GYN vessel study, 9-39
Occipitofrontal Diameter (OFD), measuring, 9-33
optimizing images

B-Mode, 5-2
Color Flow, 5-44
Doppler, PW, 5-67
M-Mode, 5-38

options
system, 16-115

Orientation Help, 3D/4D iamging, 5-209
ovaries, measurement, 9-86

P

Packet Size, adjusting, 5-57
Patient data

OB, 9-5
OB graphs, 9-55
OB worksheet, 9-43

patient data
deleting, 4-18
searching, 4-20

patient exam
reviewing, 4-32

patient list
entering, 4-13
printing, 4-19

patient safety, 2-7
Peak systole (PS)

OB/GYN vessel measurement, 7-87
Peak systole/end diastole ratio, Doppler generic 
measurements, 7-83
pediatric exam

calculations, 13-3
preparing, 13-2

pediatric measurements, types
alpha HIP, 13-7
dD ratio, 13-8
hip dysplasia, 13-5

peripherals
connector panel, 3-16
connector panel illustration, 3-17

peripherals, digital
setting up, 15-47

Phantoms, 18-35
Plot Both, fetal trending, 9-54
Position, adjusting color, 5-50

post-processing controls, overview, 6-10
Power, 3-19

connection
USA, 3-19

Cord, 3-39
On/Off, 3-23
switch, location, 3-23

power
power up sequence, 3-24
shut down, 3-33

Power Doppler imaging, 5-59
Preset Program menu

Acoustic Output
Fetal Exposure, 9-3
General Warning, 9-3
Prudent Use, 9-3

presets
organizing folders and measurements, 7-22

presets, changing
Anootations/Libraries, 16-50
Body Patterns, 16-56, 16-59, 16-60
Connectivity, 16-69
Imaging, 16-46
System, 16-3

presets, overview, 16-2
PRF, adjusitng, 5-24
PRF, adjusting

Color Flow, 5-48
print keys

assigning to a device or dataflow, 16-99
Privacy and Security, 18-50
Probe handling and infection control, 17-46
probe orientation, 3D.4D imaging

abdominal, 5-198
Probes

connecting, 3-41
probes

activating, 3-43
cable handling, 3-43, 17-2
coupling gels

coupling gels, probes, 17-48
deactivating, 3-43
disconnecting, 3-44
environmental requirements, 17-5
ergonomics, 17-2
immersion levels, 17-24
labeling, 17-3
planned maintenance, 17-49
probe orientation, 17-3
safety, 17-42

using protective sheaths, 17-44
storing, 3-45
transporting, 3-45

Prostate volume, measuring, 12-6
prudent use, 2-4
PS/ED or ED/PS Ratio, measuring, 7-83
Pulsatility Index (PI), Doppler generic measurement, 
7-82
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Q

QAnalysis, 5-156
Drift Compensation, 5-169
Exit, 5-172
generating a trace, 5-160
manipulating the sample area, 5-163
Select Image Range, 5-159
smoothing, 5-168

QAPlot Control
horizontal sweep, 5-169

Quality Assurance, 18-33
baselines, 18-37
frequency of tests, 18-34
Introduction, 18-33
periodic checks, 18-37
phantoms, 18-35
record keeping, 18-48
system setup, 18-39
test descriptions, 18-39
typical tests, 18-34

Quick Angle, adjusting, 5-74

R

Read Zoom, activating, 6-3
real-time 4D imaging

acquiring data, 5-214
stopping acquisition, 5-221

Record keeping, 18-48
rejecting low level echos, 5-25
removable media

verifying, 16-102
Renal volume, measuring, 12-9
Render view, 3D/4D imaging, 5-208
Report Writer reports

activating, 14-4
creating, 14-3
editing, 14-9
factory templates, 14-8
inserting images, 14-19

Resistive Index (RI), Doppler generic measurement, 
7-82
Results window, 7-7
reverse, adjusting, 5-21
rotating an image, 5-26

S

S/D Ratio, Doppler measurement, 7-83
safety

electromagnetic compatiblity (EMC), 2-19
equipment, 2-11
hazards, 2-5, 2-11, 2-13, 2-14, 2-41, 17-42, 

17-43, 17-44
biological, 17-9
smoke and fire, 2-12

labels, 2-45

patient, 2-7
acoustic output hazard

hazard, types
acoustic output, 2-10

electrical hazards, 2-9
mechanical hazards, 2-9
patient identification, 2-7

patient training, ALARA, 2-10
personnel, 2-11
precaution icons, defined, 2-4
precaution levels, defined, 2-4
probes, 17-42

handling precautions, 17-46
Sample Volume, adjusting, 5-57
sample volume, adjusting

gate position, 5-73
length, 5-73

Scale, adjusting
Doppler Mode, 5-80

Scalpel, 3D/4D imaging, 5-224
Scan Assistant

Availability, 5-246
Definitions, 5-247
Description, 5-248
Exporting Programs, 5-256
Setting Up, 5-249
Using, 5-254

Sectional view, 3D/4D imaging, 5-207
service, requesting, 1-8
Simultaneous, activating, 5-77
site requirements, before the system arrives, 3-3
Size, adjusting

Color Flow, 5-50
small parts exam

thyroid measurements, 8-5, 8-6
Spatial Filter, adjusting, 5-56
Spectral Doppler, see Doppler Mode, PW
Spectral Trace method, 5-82
Spinal Length (SL), measuring, 9-34
starting an OB exam, 9-4
Static 3D imaging, 5-226

acquiring data, 5-226
Steer, adjusting, 5-15
studies

OB/GYN vessels, 9-39
study

adding, 7-29
definition, 7-3
deleting, 7-35
generic, 7-66
organizing, 7-22

Sweep Speed, adjusting, 5-40
System

acclimation time, 3-22
system

electrical configurations, 3-3
environmental requirements, 3-4
options, 16-115
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power down, 3-33
System Admin

Admin screen, 16-115
System Imaging Preset Menu, 16-13
System Measure Preset menu, 16-16
System presets, changing

General, 16-5
System About, 16-45
System Imaging, 16-13
System Measure, 16-16
System Peripherals, 16-41
System/Backup and Restore, 16-20

System presets, overview, 16-3
System/General Preset Menu, 16-5

T

TAD (transverse abdominal diameter), 9-35
TAMAX/TAMEAN, Doppler mode measurement

manual trace, 7-52
TCD (transverse cerebellar diameter), 9-35
TCPIP

Connectivity, 16-71
Test Patterns

overview, 16-68
TGC, adjusting, 5-18
Thorax transverse diameter (ThD), 9-36
Threshold, adjusting, 5-55
Thyroid measurements, 8-5, 8-6
Tibia Length, measuring, 9-37
TIC analysis

activating, 5-96
curve fitting, 5-125
exiting, 5-97
generating a trace, 5-102
manipulating the sample area, 5-110
smoothing, 5-118

TIC Plot Control
horizontal sweep, 5-117
line style, 5-117
overview, 5-115
vertical auto scaling, 5-116

Tilt, adjusting, 5-19
Time Gain Compensation, see TGC, adjusting, 5-18
Time interval

Doppler mode measurement, 7-51
M-Mode measurement, 7-60

Tissue depth, M-Mode measurement, 7-59
Tissue Velocity Imaging, 5-61
Trace Direction, adjusting, 5-82
Trace measurement, general, 7-44, 7-45, 7-46
Trace Sensitivity, adjusting, 5-82
Transparency Map, adjusting, 5-56
Transverse Abdominal Diameter (TAD), 9-35
Transverse Cerebellar Diameter (TCD), 9-35
TVI, 5-64

Quantitative Analysis, 5-156

U

Ulna Length, OB measurements, types, 9-37
Ultrasound age

selecting on OB worksheet, 9-43
Update, activating, 5-77
urology exam, preparing, 12-2
urology measurements

bladder volume, 12-5
prostate volume, 12-6
renal volume, 12-9

user IDs
defining, 16-132

user-defined calculations, editing, 7-34
user-defined measurement, adding, 7-31
Users

Admin screen, 16-132
Uterine cavity, amniotic fluid index (AFI), 9-21
Uterus measurements, 9-87
Utility function

changing measurements and studies, 7-36
Utility screens

Admin, 16-114
connectivity, 16-69

V

Vascular exam preparation, 11-2
Vascular worksheets

editing, 11-23
saving and printing, 11-33
typing examiner�s comments, 11-27
vessel summary, 11-30
viewing, 11-20

Velocity, Doppler measurement, 7-50
verifying

removable media, 16-102
Vessel summary, vascular exam, 11-30
Virtual Convex, adjusting, 5-17
Volume measurement, B-Mode generic 
measurement, 7-71

W

Wall Filter, adjusting
Color Flow, 5-49
Doppler Mode, 5-81

Warning icon, defined, 2-4
width, adjusting, 5-19
word wrap, annotation, 6-19
Worksheet

changing data, 7-62
OB, 9-42
viewing, 7-61

Write Zoom, activating, 6-3
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XYZ

zooming an image
bioeffects, 6-2
introduction, 6-2
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